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Foreword
Welcome to The Fairlight Audio Guide to DaVinci Resolve 20
DaVinci Resolve 20 is the only post-production solution that combines editing, color 
correction, visual effects, motion graphics, and audio post-production all in one software 
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough for 
the most experienced professionals. DaVinci Resolve lets you work more efficiently 
because you don’t have to learn multiple apps or switch software for different tasks. It’s like 
having your own post-production studio in a single app!

DaVinci Resolve 20 adds editing with transcriptions from audio, film look creator and 
ColorSlice six vector grading, IntelliTrack AI for panning audio to match vision, broadcast 
replay for live multicamera broadcast editing, layout and replay with speed control, and 
so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 20 that is completely free! 
We’ve made sure that this version of DaVinci Resolve includes more features than any paid 
editing system. That’s because at Blackmagic Design we believe everybody should have 
the tools to create professional, Hollywood-caliber content without having to spend 
thousands of dollars.

I invite you to download your copy of DaVinci Resolve 20 today and look forward to seeing 
the amazing work you produce!

Grant Petty  
Blackmagic Design
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Who This Book Is For
This hands-on training guide is designed for DaVinci Resolve editors, audio newcomers, 
and experienced audio professionals who want to create, enhance, and mix soundtracks 
in the Fairlight page. 

Getting Started
Welcome to The Fairlight Audio Guide to DaVinci Resolve 20, an official Blackmagic Design-
certified training book that teaches professionals and students the art of sound design, 
recording, editing, sweetening, and mixing, as well as how to get the most out of audio 
tracks created and edited in DaVinci Resolve. Beginning audio editors and assistants will 
find clear workflow-driven lessons, while seasoned audio professionals will quickly grasp 
Fairlight’s user-friendly tools for realizing incredible sound. Each lesson takes you step by 
step through practical, real-world projects such as an exciting podcast intro, scenes from 
a narrative film, and the soundtrack for a 3D Fusion VFX sequence. You’ll start building a 
basic podcast intro and then move on to editing dialogue, sound effects, and music. Next, 
you’ll record tracks and focus on balancing, panning, and repair. From there, you’ll move 
on to explore sound design secrets to create original sound effects, layer sound, and use 
Fairlight FX plug-ins to add depth and dimension to your tracks. Finally, you’ll step through 
mixing techniques to balance, sweeten, pan, automate, bounce, and deliver your 
finished soundtrack.

As you step through the lessons, you’ll gain experience with Fairlight’s powerful features, 
including ADR tools; working with the sound library; video and audio scrollers; using the 
Focus mode multipurpose tool; applying Fairlight FX, Track FX, and AI tools to your clips 
and tracks to enhance your soundtrack; as well as mixing and automating tracks, 
processes, effects, and more! Best of all, you no longer need to send projects out to 
another audio application, because DaVinci Resolve puts professional audio post tools just 
a click away from your editing tools and timeline.

This guide blends practical, hands-on exercises with the real-world “craft” of audio post-
production, such as sound editing, dialogue editing, dialogue repair and replacement, 
sound design, sound effects editing, and mixing. As you step through Resolve’s real-world 
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audio post-production tools and workflows, you’ll discover new techniques for whatever 
tasks you take on. You’ll delve deep into audio editing and mixing in the Resolve’s Fairlight 
page to explore tricks and techniques used by professional audio editors, sound 
designers, and engineers to enhance the soundtracks in your projects.

After completing this book, you are encouraged to take the 50-question online proficiency 
exam to receive a Certificate of Completion from Blackmagic Design. The link to the exam 
is located at the end of this book.

About DaVinci Resolve 20
DaVinci Resolve is the world’s fastest-growing and most advanced end-to-end post-
production software, with everything you need, from syncing and organizing media to 
editing, visual effects, color grading, audio post, mixing, and delivery. 

What You’ll Learn
In these lessons, you’ll work with multiple projects and timelines to learn fundamental and 
advanced practical techniques in several audio production genres. You’ll acquire real-world 
skills that you can apply to real-world productions.

Lesson 1 
Plunges you into creating a narrative podcast intro from scratch while you explore the 
Fairlight page interface and tools to build the soundtrack. 

Lesson 2 
Focuses on a variety of tools and techniques for editing dialogue. 

Lesson 3 
Covers sound effects and music editing using powerful tools unique to the Fairlight page. 

Lesson 4 
Walks you through four practical recording techniques: recording voiceover (VO); setting 
up and performing automated dialogue replacement (ADR); using Resolve’s built-in 
oscillator to record noise and tones; and exploring the Foley Sampler plug-in to record 
sampled footsteps in sync with video. 
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Lessons 5 and 6 
Focus on balancing, panning, and repairing audio clips and tracks. In Lesson 5, you’ll 
balance dialogue clip levels within each track. Then, explore panning clips and tracks in the 
mixer and viewer. In Lesson 6, you’ll use advanced Fairlight FX dialogue repair tools such as 
the De-Hummer, Noise Reduction, and AI-based Track FX plug-ins—as well as the gate 
dynamics processor in the mixer to remove hum, noise, and enhance tracks. 

Lesson 7 
Dives into creative tools and plug-ins to manipulate and distort sound to emulate echo and 
outdoor PA system speakers. Plus, you’ll work with modulation, pitch, and speed changes 
to create original sound effects, including waves and dragon roars. 

Lesson 8 
Walks you through working with busses, including auxiliary busses for shared effects, 
submix busses for controlling similar tracks, and output busses for determining the format 
for monitoring and delivering your soundtrack. 

Lesson 9 
Demystifies the art of mixing and sweetening your soundtrack and covers the tools and 
techniques you’ll use to polish and complete a mix.

Lesson 10 
Steps you through bouncing your mix and delivering a finished soundtrack with and 
without video. 

Lesson 11 
Explores the Fairlight page’s immersive tools for creating, monitoring, and delivering 
ambisonics and Dolby Atmos sound.
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The Blackmagic Design Training 
and Certification Program 
Blackmagic Design publishes several training books that take your skills further in 
DaVinci Resolve 20. They include:

	— The Beginner’s Guide to DaVinci Resolve 20

	— The Colorist Guide to DaVinci Resolve 20

	— The Editor’s Guide to DaVinci Resolve 20

	— The Fairlight Audio Guide to DaVinci Resolve 20

	— The Visual Effects Guide to DaVinci Resolve 20

	— Advanced Visual Effects in DaVinci Resolve 20

 DAVINCI RESOLVE 20

Advanced Visual Effects in

Download 
DAVINCI 

RESOLVE 20
Free!

Authors: Damian Allen, Dion Scoppettuolo

 DAVINCI RESOLVE 20

Download 
DAVINCI 

RESOLVE 20
Free!

 The Beginner’s Guide to

Authors: Chris Roberts, Simon Hall

 DAVINCI RESOLVE 20

 The Colorist Guide to

Download 
DAVINCI 

RESOLVE 20
Free!

Authors: Daria Fissoun, CSI

 DAVINCI RESOLVE 20

Download 
DAVINCI 

RESOLVE 20
Free!

 The Editor’s Guide to

Author: Chris Roberts

 DAVINCI RESOLVE 20

The Visual Effects Guide to

Download 
DAVINCI 

RESOLVE 20
Free!

Authors: Damian Allen, Tony Gallardo, Dion Scoppettuolo

Whether you want to learn more advanced editing techniques, color grading, or visual 
effects, Blackmagic Design certified training offers a learning path for you. 

Getting Certified
After completing this book, you are encouraged to take a 1-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link 
to the online exam can be found on the Blackmagic Design training webpage. The 
webpage also provides additional information on our official Training and Certification 
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training.

System Requirements
This book supports DaVinci Resolve 20 for macOS and Windows. If you have an older 
version of DaVinci Resolve, you must upgrade to the current version to follow along with 
the lessons.

http://www.blackmagicdesign.com/products/davinciresolve/training
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NOTE  The exercises in this book refer to file and resource locations that will differ 
if you use the software version from the Apple Mac App Store. For the purposes of 
this training book, we recommend that macOS users download and use the 
DaVinci Resolve software from the Blackmagic Design website rather than from 
the Mac App Store.

Download DaVinci Resolve
To download the free version of DaVinci Resolve 20 or later from the 
Blackmagic Design website:

1	 Open a web browser on your Windows or macOS computer.

2	 In the address field of your web browser, type  
www.blackmagicdesign.com/products/davinciresolve.

3	 On the DaVinci Resolve landing page, click the Download button.

4	 On the download page, click the button corresponding to your computer’s 
operating system.

5	 Follow the installation instructions to complete the DaVinci Resolve installation.

When you have completed the software installation, follow the instructions in the following 
sections to launch DaVinci Resolve and download the media files used throughout this book.

DaVinci Resolve 20 Quick Setup
When DaVinci Resolve 20 is successfully installed, you can launch the application for the 
first time.

macOS users will find the DaVinci Resolve application in their Applications folder. Double-
click the DaVinci Resolve folder and then double-click the DaVinci Resolve application icon. 
Alternatively, you can use Launchpad or Spotlight search to locate and launch 
DaVinci Resolve.

Windows users will find a shortcut added to their Desktop. Alternatively, click the Start 
menu, search for “DaVinci Resolve,” and press Enter to launch the application.

http://www.blackmagicdesign.com/products/davinciresolve
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When DaVinci Resolve 20 opens for the first time, a Welcome splash screen details the new 
features available in the current version.
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1	 If required, you can change the language used. You can also learn more about these 
and hundreds of other amazing features available in DaVinci Resolve 20 by clicking 
Learn More. Otherwise, click Continue.

Next, you are invited to go through the Quick Setup process. Experienced users can 
skip this process by clicking “Skip and Start Right Now,” but new users are advised to 
follow the process. It will only take a couple of minutes and is useful for understanding 
how Resolve works.
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2	 Click the Quick Setup button.

3	 DaVinci Resolve will check your system to ensure that your operating system and 
graphics card will perform well. If both pass this test, click Continue.
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Next, you will be asked what type of project you would like to begin. DaVinci Resolve 
supports projects at different resolutions, from Standard Definition (SD) and High 
Definition (HD) to Ultra High Definition (UHD) and beyond.

4	 If you know the resolution you commonly work with, you can set that here. Otherwise, 
leave the resolution set to 1080 HD and click Continue.

NOTE  You can learn more about setting up DaVinci Resolve for your system 
in the DaVinci Resolve Reference Manual, available via the Help menu in 
DaVinci Resolve. 

The next screen asks where you would like to store your media. This does not refer to 
the video, audio, and graphics files you’ll edit and grade, but rather the ancillary files 
Resolve will need to create as you work. This location is commonly referred to as a 
“scratch disk” and is set to your current user’s Movies folder (macOS) or Videos folder 
(Windows) by default.
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5	 Leave this set to the default location and click Continue.

On the next screen, you will be asked which keyboard layout you would like to use. This 
is specifically relevant if you’re familiar with using another nonlinear editor; however, 
throughout this guide, you will be introduced to keyboard shortcuts that use the 
DaVinci Resolve keyboard layout. So, if you change the layout at this point, you may 
find those shortcuts won’t work.
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6	 For now, leave the layout set to DaVinci Resolve and click Continue.

Congratulations! You have completed the Quick Setup process and have changed 
precisely nothing regarding DaVinci Resolve’s default setup. Nevertheless, you have 
also gained an insight into some aspects of using DaVinci Resolve that will serve you 
well as you continue learning about the application and how it uses your system.

7	 Click Start to launch and begin enjoying DaVinci Resolve 20!

Once loaded, DaVinci Resolve will open to the cut page, which is the default starting 
page for all projects. However, this is not the usual place to begin working with 
DaVinci Resolve. Instead, you should now exit the application in readiness to begin the 
first lesson in this book.



xxiiGetting Started

8	 Choose DaVinci Resolve > Quit DaVinci Resolve or press Command-Q (macOS) or 
Ctrl-Q (Windows).

DaVinci Resolve 20 will close.

Get the Lesson Files
To perform the steps detailed in the exercises throughout this book, the Fairlight Audio 
Guide lesson files must be downloaded to your macOS or Windows computer. After saving 
the files to your hard drive, extract the file and copy the folder to your Movies folder 
(macOS) or Videos folder (Windows).

To Download and Install the DaVinci Resolve Lessons Files
When you are ready to download the lesson files, follow these steps:

1	 Open a web browser on your Windows or Mac computer.

2	 In the address field of your web browser, type  
www.blackmagicdesign.com/products/davinciresolve/training.

3	 Scroll the page until you locate The Fairlight Audio Guide to DaVinci Resolve 20.

4	 Click the Lesson Files Part 1 link to download the media for the first lesson of the 
book. The R20 Fairlight Part 1.zip file is roughly 165 MB in size. 

5	 Click the Lesson Files Part 2 link to download media and projects for Lessons 2–11. 
The R20 Fairlight Part 2.zip file is roughly 6.5 GB in size. 

6	 Click the Lesson Files Part 3 link to download the additional media and projects you 
will use for Lessons 2–10. The R20 Fairlight Part 3.zip file is roughly 7.65 GB in size. 

7	 Click the Lesson Files Part 4 link to download immersive audio files for the projects 
you will use for Lesson 11. The R20 Fairlight Part 4.zip file is roughly 2.56 GB in size. 

8	 After downloading all four zip files to your computer, open your Downloads folder and 
double-click to unzip them if they haven’t unzipped automatically.

9	 In your chosen storage location—for example, Documents—create a new folder called 
R20 Fairlight Book Media.

http://www.blackmagicdesign.com/products/davinciresolve/training
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10	 From your Downloads folder, drag the R20 Fairlight Part 1, R20 Fairlight Part 2, 
R20 Fairlight Part 3, and R20 Fairlight Part 4 folders into the R20 Fairlight Book Media 
folder you created in the previous step.

Your media is ready for the first lesson.

Download the Fairlight Sound Library 
You can download the Fairlight Sound Library, a royalty-free collection of more than 500 
professionally recorded Foley sounds that you can use in your own projects, directly from 
the Sound Library panel. The Fairlight Sound Library features Foley sounds such as 
footsteps, body falls, door creaks, and more. This free sound library is designed to work 
with the Fairlight Foley Sampler plug-in, which lets you use the mouse or a MIDI keyboard 
to trigger sounds so they can be recorded in sync with the video onscreen. You only need 
to download and install the Fairlight Sound Library once on your system. Once it has been 
installed, you can use it with any DaVinci Resolve project on your system. 

To download the Fairlight Sound Library:

1	 Open DaVinci Resolve, if necessary. 

2	 In the Project Manager window, open a new project or an existing project. Any project 
will work.
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3	 In the Fairlight page, in the interface toolbar at the upper left of the page, click the 
Sound Library tab to show the Sound Library panel.

If the Fairlight Sound Library is not installed on your system, you will see the following 
message, along with a Download button.

NOTE  If you do not see the “Download DaVinci Resolve’s Free Sound Library” 
message in the Sound Library panel, you already have it installed, and you can 
proceed to Lesson 1. 
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You can register, download, and install the free Fairlight Sound Library now or later. 
This is optional and not required to follow along with the book exercises or 
certification exam.

4	 Click the Download button to go to the Blackmagic Design website support page and 
the Blackmagic Fairlight Sound Library 1.0 Register & Download form. 

5	 Fill out the online form and start the download. Once the download is complete, run 
the installer.

The installer creates a library (database) and indexes the sounds automatically so they 
will be ready to use the next time you open DaVinci Resolve. 

MORE INFO  You can learn more about the Sound Library in the “Using the 
Fairlight Page” section of the DaVinci Resolve Reference Manual available via the 
Help menu.
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Introducing Blackmagic Cloud
DaVinci Resolve is the world’s only complete post-production solution that lets everyone 
work together on the same project at the same time. Traditionally, post-production follows 
a linear workflow with each artist handing off to the next, introducing errors and 
mountains of change logs to keep track of through each stage. With DaVinci Resolve’s 
collaboration features, each artist can work on the same project, in their own dedicated 
page with the tools they need. 

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers 
work together simultaneously from anywhere in the world. Plus, they can review each 
other’s changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server, 
and follow the simple instructions to set up a new project library—all for one low 
monthly price! 

Once this library is created, you can access it directly from the Cloud tab in the Project 
Manager to create as many projects as you need—all stored securely online. Then invite up 
to 10 other people to collaborate on a project with you. With a simple click, they can relink 
to local copies of the media files and start working on the project immediately, with all their 
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on 
the same project at the same time—edit assistants, editors, colorists, dialogue editors, 
and visual effects artists can now all collaborate wherever they are in the world in a way 
never before possible.

Media Sync with Blackmagic Cloud Store
Now you don’t need to buy expensive proprietary storage that needs an entire IT team to 
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the 
huge media files used by Hollywood feature films. You can also have multiple Blackmagic 
Cloud Stores syncing the media files with your Dropbox account so that everyone has 
access to the media files for the project.

To find out more about these exciting workflows, visit  
blackmagicdesign.com/products/davinciresolve/collaboration.

http://blackmagicdesign.com/products/davinciresolve/collaboration
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Audio post-production is more than 
simply adjusting volume levels and 
mixing tracks. As you embark on your 
journey through this book and your 
own projects, keep your eye on the 
big picture. That is, a project’s visual 
and audio components are of equal 
importance, and it takes only a few 
seconds of audio—good or bad—for 
someone to form an opinion of your 
entire production. And here’s the 
kicker: the audience doesn’t care 
how you got there; they just want 
the experience to be awesome. So 
it is up to you as the audio editor, 
sound designer, supervising sound 
editor, re-recording mixer, or all of 
the above to deliver a professional-
quality soundtrack regardless of your 
budget, format, length, deliverables, or 
distribution methods. 

Lesson 1

Building a 
Soundtrack
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Luckily, the Fairlight page in DaVinci Resolve includes all the tools you’ll need to transform 
your basic production sound into a fully realized soundtrack from start to finish. 

In this lesson, you’ll step into the role of an audio editor, where you’ll create the intro for a 
fictional scripted Sci-Fi podcast, “Post Park Normal.” Wait. This is DaVinci Resolve, a full 
video and audio post-production solution from dailies to finishing. Why start with an 
audio-only project? Because the Fairlight page in DaVinci Resolve is an incredibly powerful 
digital audio workstation (DAW). Since many audio professionals are accustomed to 
working with audio-specific software for creating radio spots, music mixing, podcasts, and 
shows, this is a great time to dive into Fairlight’s audio toolset to quickly edit together a 
soundtrack from scratch. Let’s get started.

NOTE  This project assumes you have downloaded the media for this book. 
If you are unsure, return to the “Getting Started” section of this book and follow 
the download instructions in “Acquiring the Lesson Files.”

Building a Sci-Fi Podcast Intro
In this scenario, the original audio editor has called in sick, and it’s up to you to create a 
draft of the podcast intro on your own to play for the clients, who will be there within the 
hour. No need to panic. You’re still an unpaid intern, and this experience can only improve 
your employment situation. Where to start? The clients met with your predecessor, and 
you have their brief notes. 

Clients have a Sci-Fi podcast featuring six people who survived the ground-zero events that 
changed the world. Each storyline starts the same, in the morning at the park, when 
everything is still normal. The intro begins with the “normal” morning at the park. 

In this first set of exercises, you’ll create a new project, import audio files, and edit them 
into a timeline to create a narrative podcast intro. This lesson introduces you to the 
primary interface elements and tools you need as you go. Once you are comfortable with 
importing and editing the timeline, navigation, and playback, you’ll use additional interface 
panels and tools to finish the basic podcast intro. Keep in mind that lessons in this book 
build on each other as you learn new skills and more advanced tools and workflows. 
This lesson may start with building a basic podcast intro; however, over time, you will 
develop it into an exciting, fully immersive audio experience for the audience. 

Let’s start by locating the files you’ll need on your system, opening DaVinci Resolve, and 
creating a new project. 
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Creating a New Empty Project
In this exercise, you’ll create a new project that will be used to build and mix the Post Park 
Normal podcast intro. The media for this lesson is located in Part 1 of the R20 Fairlight 
Book Media folder on your system. 

1	 Locate the R20 Fairlight Book Media folder on your desktop or Finder.

2	 Through your computer’s Finder, open the R20 Fairlight Book Media > 
R20 Fairlight Part 1 > Podcast Intro Audio folder to see the contents. 

As you can see, the Podcast Intro Audio folder includes seven .wav audio files. 
Now that you have located the audio files that you’ll work with, let’s start a new project 
where you’ll import and edit those files to create the podcast intro. 

3	 Open DaVinci Resolve.

4	 In the Project Manager, click New Project. 
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5	 In the New Project dialog, type Post Park Normal Intro in the name field and then 
click Create. 

6	 If necessary, double-click the new Post Park Normal Intro project to open it.

The new project opens in the Fairlight page, where you’ll see three primary areas of 
the Fairlight interface, including the monitoring panel across the top, the mixer on the 
right side, and the empty workspace in the middle of the page that will display the 
timeline once you create one. 

NOTE  If your project does not open to the Fairlight page or additional panels are 
visible, click the Fairlight button at the bottom of the screen to go to that page.  
To reset your user interface, choose Workspace > Reset UI Layout at the top of 
the page. 
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Importing Audio Files and 
Creating a Timeline 
In this exercise, you’ll import the Podcast Intro Audio files in the media pool and utilize 
some built-in Fairlight page features to quickly create a timeline from an audio file. First, 
let’s show the media pool so you’ll see the audio files once they are imported. 

1	 Click the Media Pool button in the upper left of the window to show the media pool. 

The empty media pool opens on the left side of the window. Here, you can import, 
organize, and preview media. There are many methods for importing files into the 
media pool. For this exercise, you’ll use either the File menu or a keyboard shortcut. 

2	 Choose File > Import > Media or press Command-I (macOS) or Ctrl-I (Windows) to open 
the Import Media dialog.



6Lesson 1  Building a Soundtrack

3	 In the Import Media dialog, navigate to the R20 Fairlight Book Media > R20 Fairlight 
Part 1 > Podcast Intro Audio folder. Select all the media files. Click Open. 

The media files appear in the media pool library. At a glance, you’ll see a variety of clips 
ranging from Ext City Ambience to Lawn Mower… and Dangerous Music. 

Next, you’ll create a timeline where you can edit, arrange, and build the Post Park 
Normal podcast intro. Once again, there are many options for creating a new timeline. 
Luckily, in DaVinci Resolve, you can instantly create the first timeline in a new project 
by simply dragging a clip from the media pool to the empty space in the timeline area. 

Which clip should you use? Any of the clips would work. However, since you are 
creating a soundscape, starting with an ambient sound effect is a great way to 
transform silence to “somewhere” in seconds. Let’s try it. 



7Lesson 1  Building a Soundtrack

4	 In the media pool, locate the Ext City Ambience.wav audio clip.

NOTE  When dragging a clip to create the first timeline of a project, the clip 
will initially appear transparent green over the tracks of the newly created 
timeline. Dragging the clip to the top of the timeline below the ruler will place 
it in the first track when you release it. Dragging lower in the empty space will 
add a second track where you can release the clip while creating the timeline. 

5	 Drag the Ext City Ambience.wav audio clip from the media pool to the empty timeline 
space. When the timeline appears, drag the transparent green clip to the upper left 
corner of the timeline so it will start at the beginning of the first track. Release the clip. 

If the clip is not at the beginning of the first track in the newly created timeline, drag 
the clip toward the left of the track until it starts at the beginning of the track.
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Playing and Resizing Tracks in the Timeline
Now that the first clip is in the timeline, it’s a good opportunity to play it and familiarize 
yourself with the basic transport and zoom controls in the toolbar. 

The toolbar includes 
zoom sliders, commands, 

and mode buttons.

The transport controls 
include standard and audio-
specific transport functions.

The interface toolbar shows and 
hides various palettes, such as the 

media pool, mixer, and meters.

monitoring panel

The current project in the Fairlight page shows the media pool, audio timeline, monitoring 
panel, and mixer. The timeline includes one audio track and one stereo bus for output. 
Each element reflects the default names for new timelines, tracks, and busses: Timeline 1, 
Audio 1, and Bus 1, respectively. 

Timecode display PlayheadTimeline ruler

1	 Press the Home key or click the Timecode ruler at the beginning of the timeline to 
move the playhead to that position (00:00:00:00).
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TIP  Pressing the Home and End keys will move you to the start or end of a 
timeline, respectively. Some Mac keyboards do not have Home and End keys. 
When using one of those keyboards, press fn-Left Arrow to move to the start 
of the timeline and fn-Right Arrow to move to the end.

The six transport controls above the timeline toolbar are the standard buttons that 
you’ll find on any professional audio recording and playback device. To the right of the 
transport controls are the two primary automation buttons. 

Fast forward Stop Loop
Automation 

controls

Rewind Play Record Toggle 
Automation

2	 In the transport controls, click the Play button or press the Spacebar to start playback 
and listen to the beginning of the clip. During playback, watch the meters in the 
monitoring panel at the top of the window and the meters in the mixer on the right 
side of the screen.

Did you notice that the clip’s volume level is low? This corresponds with the low levels in 
the meters. Let’s take a moment to adjust the track height and volume level of the clip. 
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3	 Press the Spacebar to stop playback. 

You can resize the track using the zoom sliders located in the toolbar above the 
timeline. 

4	 Drag the vertical zoom slider to the right to increase the height of the timeline tracks. 

5	 Drag the horizontal zoom slider to the right to zoom in on the waveform at the 
playhead position. 

6	 Press Shift-Z to fit the timeline clips horizontally in the visible timeline area. 

TIP  You can use the zoom sliders in the toolbar to zoom in or out of the 
timeline vertically or horizontally. Vertical zooming is based on track selection, 
whereas horizontal zooming centers on the playhead. Press Shift-Z to toggle 
between zoom to fit horizontally and the previous zoom level. 

If you’re gripping the edge of your desk with white knuckles and thinking that there are 
too many panels, meters, and buttons to keep track of, you can relax. The Fairlight 
page is as user-friendly as it is powerful. At any time, you can simplify the interface to 
show just those tools you need as you need them.

7	 In the interface toolbar at the upper right of the screen, click the Mixer button to 
hide the mixer. Then, click the Meters button to hide the monitoring panel. Finally, 
at the upper left of the screen, click the Media Pool button to hide the media pool. 

Now that you have a focused view of the clip, let’s adjust the clip volume level in 
the Inspector. 
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Changing Clip Volume 
Levels in the Inspector
The Inspector gives you easy access to controls for any selected clip. While you will use the 
Inspector in many ways throughout this book, let’s currently focus on the clip volume 
controls. One advantage of using the Inspector to adjust clip levels is that you can change 
levels during playback. Let’s try it. 

1	 To the right of the interface toolbar, click the Inspector button to show the Inspector. 

NOTE  From this point, you’ll simply be instructed to show or hide an interface 
panel during exercises.

The Inspector shows controls for the Ext City Ambience clip. 

2	 If necessary, select the Ext City Ambience clip in the timeline to see the controls in 
the Inspector. 

The audio panel in the Inspector offers a variety of controls for the selected clip. In this 
exercise, you’ll use the Volume controls to increase the level of the clip. You can see 
that the current volume level for the selected clip is 0.00. This does not mean the clip 
volume is actually at 0 decibels (dB). Instead, the Volume field indicates the amount of 
volume change (gain) applied to the original source level. In this case, there is no 
change at all. 

3	 Move the playhead to the beginning of the timeline and start playback.

You can change the clip volume in the Inspector by dragging the Volume slider, typing 
a new number in the Volume field, or dragging left or right on the field. 
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4	 While listening, drag the volume slider to the right to increase the clip level. 

Notice that the waveform in the clip increases along with the volume level.

5	 Increase the volume by around 15.00. Hold Shift while dragging over the Volume field 
for slower, “geared-down” incremental control. 

To reset an Inspector control to the default level, double-click the control name or click 
the reset button to the far right of the control. 

6	 Stop playback. Then, double-click the Volume control name to the left of the slider to 
reset the parameter. 

Now that you know how to adjust the level during playback, you can try typing a value. 

7	 Double-click the Volume field, type 12.0, and then press Enter or Return.

8	 Play the beginning of the clip to hear the new level. When you are finished, 
stop playback.

The timeline clip is louder than before and easier to hear. You’ll adjust it again later 
as needed. 

9	 Hide the Inspector.

Keep in mind that once your timeline is populated with more clips, selecting the clip you 
want to adjust is an essential part of using the Inspector. Next, you’ll explore the media 
pool to preview additional source audio clips and use the volume controls in the Inspector 
to increase their levels as needed before editing them to the timeline. 
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NOTE  If you didn’t finish the previous steps in this lesson, import the backup 
timeline 1a Ambience in A1 to catch up. Importing a timeline also imports the clips 
within the timeline if you don’t already have them in the media pool. In this case, 
importing the catch-up timeline will only include the timeline and the ambience 
clip in the A1 track. To follow along with subsequent exercises, import the audio 
clips in the R20 Fairlight Part 1 > Podcast Intro Audio folder. 

Previewing Audio Clips 
in the Media Pool
The media pool contains all the media and timelines in your current project. In this 
exercise, you’ll preview each audio clip to familiarize yourself with them before adding 
them to the timeline. Whenever you load a clip into the preview player, you can see the 
waveform for each of the clip’s channels and preview the entire clip from its first available 
frame to the last. 

1	 Show the media pool. 

The media pool opens on the left side of the Fairlight page and includes seven audio 
clips and one timeline. 

Source audio clips

Show/hide 
bin list

Master bin list

Mark In/Out buttons

Jog bar playhead

Media pool toolbar
Preview transport 

controls

Source audio 
waveforms

Waveform zoom 
dropdown menu
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You can view source clips in either metadata or thumbnail view. The default is 
thumbnail view, which displays a graphical representation of the clip’s waveform. The 
thumbnail waveform’s size and color indicate the source clip’s volume levels. Based on 
the thumbnail waveforms for the clips in this project, there is quite a difference in 
volume between the music, voiceover, and background clips. 

2	 Select the Lawn Mower Up and Away clip to load it into the preview player at the top 
of the media pool. 

The two horizontal waveforms visible in the preview player beneath the clip name 
show that it is a two-channel stereo clip. This clip came from the Fairlight Sound 
Library, which you’ll work with in a later lesson. 

3	 Press the Home key to move the playhead to the beginning of the clip in the preview 
player. Then, click the Play button or press the Spacebar to preview the clip. When you 
are finished, click Stop or press the Spacebar. 

The clip delivers on its name, Lawn Mower Up and Away, and will work nicely to 
help create the audible soundscape of a park, complete with a groundskeeper at work 
in the distance. Before moving to the next clip, let’s increase the clip volume level in 
the Inspector. 

4	 Show the Inspector. If necessary, select the Lawn Mower Up and Away clip to show 
the media pool clip’s controls in the Inspector. 
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5	 In the Inspector, set the Volume level to 6.0. Then, in the media pool, preview the clip 
again to hear it 6 dB louder.

How loud should this background sound effect be in the final mix? That all depends on the 
context of where the lawn mower is in relation to the listener and if someone is talking at 
the time. For now, it’s louder than it was, and you know that you can adjust a clip’s volume 
in the Inspector before or after you add it to the timeline.

Before previewing the remaining clips, you should know how to control the master 
monitoring levels while listening to louder source clips and timeline playback. 

Controlling the Playback Volume Level
Whether you are recording, building tracks, or mixing your final project, it’s always a good 
idea to know how to control your master playback monitoring levels. In the upper right 
corner of the timeline, you’ll find the master playback volume controls. These controls do 
not affect the levels of your main output or individual tracks. However, they are incredibly 
useful for quickly adjusting the playback levels in your speaker system, computer speaker, 
or headphones. 

DIM buttonMute button

In this exercise, you’ll preview the remaining clips, starting with Dangerous Music R19, 
which is a professionally mixed and mastered piece of music with a much higher overall 
level than the other clips. One glimpse at the waveform in the clip thumbnail and preview 
player can tell you what you can expect from the levels before you start playback. In this 
case, you’ll lower the monitoring level rather than the clip level before you preview the clip.

1	 Click the DIM button to instantly lower the playback volume by 15 dB.

The playback volume fader turns yellow, and the DIM button turns red to indicate that 
the DIM button is on.
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2	 In the media pool, preview the Dangerous Music R19 clip. 

The music level is still much louder than the subtle ambience clips, but the dimmed 
playback should keep it at a comfortable level for listening. You should be able to 
preview the other clips without dimming the monitoring levels. You can always raise or 
lower the monitoring volume control if needed. Once clips are in the timeline and the 
levels are balanced, you won’t need to adjust the monitoring level other than to mute 
or dim playback. 

NOTE  Thumbnail waveform colors correspond to metering colors and 
indicate peak levels ranging from green to red. Green levels are safe with no 
chance of being too loud, and yellow peak levels are good targets to aim for 
when working with anchor sounds like dialogue. Red peak levels are getting 
close to being too loud and clipping or becoming distorted. 
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3	 Select the VO 1 Book_006 clip to show it in the preview player. Click the DIM button or 
choose Fairlight > Monitoring > Dim to turn off the DIM button. 

The VO 1 Book_006 clip is a single-channel, mono clip, as indicated by the single 
horizontal waveform in the preview player. 

4	 Preview the VO 1 Book_006 voiceover clip. There are three takes, but you only need to 
listen to one for now. 

When previewing ambience and background sound effect clips, you don’t always need 
to listen to the entire thing. In fact, previewing the middle of the clip often reveals the 
sound more effectively than starting from the beginning. Whichever part of these clips 
you decide to preview, be sure to listen to enough of the clip that you have an idea of 
the sounds you’ll have to work with in building the soundtrack. 

5	 Preview the 2024-06-20 0659 clip. Increase the Volume in the Inspector to 16.0, and 
then preview the clip again at the increased level. 

6	 Preview the remaining clips. When you’re finished, hide the Inspector. 

Done! You have listened to each of the clips, and you are ready to build the podcast intro, 
starting with the clip of the birds. Which clip mainly features the sound of birds? Hint: 
“birds” is not part of the name—yet. 
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Changing Source Clip Names 
There is a big difference between filenames and clip names. Filenames are generated 
when audio or video files are created and are used to link original media and proxies to the 
clips in DaVinci Resolve and vice versa. As a rule, filenames are never changed. Clip names, 
on the other hand, are user-defined nicknames for clips that can be useful for identifying 
them in the media pool or timeline. By default, clip names are identical to filenames until 
the user changes them. In this exercise, you’ll give the clip with bird sounds a useful 
clip name. 

1	 In the media pool toolbar, click the List View button.

In list view, the first column of the media pool library is Clip Name. 

2	 Locate the 2024-06-20 0659.wav clip. 

This clip was originally recorded on a smartphone, and the filename is the date 
plus the time.

3	 Triple-click the clip name field of the 2024-06-20 0659.wav clip to select the entire 
name. Type Birds, and then press Return or Enter.

4	 Hide the media pool. 

You have successfully given the clip a more useful name, which will make it much easier 
to find and work with later. Next, you’ll create two new tracks for additional background 
sound effects. 
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Manually Creating and 
Naming Tracks
You can create a single track or multiple tracks simultaneously from within the timeline. In 
this exercise, you’ll create two new tracks below the A1 Audio 1 track for the birds and lawn 
mower background sound effects. 

1	 Right-click the A1 Audio 1 track header and choose Add Tracks.

In the Add Tracks dialog, you can determine how many tracks you add and where they 
are placed. 

2	 Set the Number of tracks to 2, set Insert Position to Below Audio 1, and set the Audio 
Track Type to Stereo. 

3	 Click the Add Tracks button. 

Two new tracks appear below the A1 Audio 1 track. Next, you’ll rename the tracks.

4	 In the A1 track header, select the Audio 1 name field and type AMBIENCE. Do not 
press Enter or Return.

As long as the name field is selected, you can press Tab to automatically move down to 
the next track and select the name field. 
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5	 Press Tab to select the name field for the next track. Type BIRDS.

6	 Press Tab to select the name field for the next track. Type MOWER. Press Enter 
or Return. 

The tracks are ready to add clips.

NOTE  In DaVinci Resolve, using the right-click contextual menu from the track 
header to Add Track creates the new track directly below the selected track.

Adding Audio Clips to the Timeline
Once you find a clip that you want to work with and you know where you want to place it in 
the timeline, you need only drag it from the media pool to the timeline. In this exercise, 
you’ll add the birds and mower clips to their corresponding tracks. 

The preview player includes a handy dropdown menu that shows the 10 most recently 
accessed clips. 

1	 Show the media pool. 
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2	 At the top of the media pool, click the dropdown menu arrow and select Birds. 

The Birds clip is loaded into the preview player, as indicated by the clip name at the top 
of the preview player, and the single waveform represents a mono channel of sound. 

3	 Drag the Birds clip from the waveforms at the top of the preview player to the 
beginning of the A1 BIRDS track in the timeline. 
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The clip appears in the track once you release it. Now it’s time to add the mower clip. 
This time, instead of dragging from the preview player, you’ll drag from the media 
pool library. 

4	 Drag the Lawn Mower Up and Away clip from the media pool library to the beginning 
of the MOWER track in the timeline. 

The first three tracks contain clips. However, one of the clips does not match the 
track’s channel format. Notice the empty space below the Birds clip in the A2 track. 
This is because the birds clip is a single-channel mono clip, while the tracks are all 
stereo with two channels, left and right. The channel indicator in the upper right 
corner of the track header always shows the number of channels in the track. At the 
moment, all of the track channel indicators show 2.0 for two channels. No worries. To 
fix this, you can simply change the track format to mono. 
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5	 Right-click the A2 track header area and choose Change Track Type To > Mono. 

Now, the A2 track header’s channel indicator shows 1.0, which means it is a single-
channel mono track. 

NOTE  It is important that timeline tracks match the clip format and vice versa 
for playback and mixing. For example, a mono clip in a stereo track will play 
sound in only the left channel or left speaker during playback. The default 
settings for a mono clip in a mono track will produce equal sound out of both 
speakers during playback. You’ll work more with channel mapping for clips and 
tracks in Lesson 2, “Editing Dialogue Tracks.”
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There is still one more housekeeping item to change in the timeline.

6	 Look at the name of the clip in the A2 BIRDS track.

7	 Previously, you changed the clip name in the media pool. However, timelines display 
filenames by default. To display the user-defined clip names in the timeline, you need 
to enable that option in the View Clip Info Display dialog, available only in the Fairlight 
menu. Whichever settings you choose in the Clip Info Display dialog are global for 
timeline clips in all the projects on your system. 

8	 Choose Fairlight > View Clip Info Display to open the dialog. In the Clip Info Display 
dialog, click the Clip Name option to select it. Click OK. 

Clip names are now displayed in the timeline for all the clips, including Birds. Let’s listen to 
the beginning of the timeline and evaluate the tracks. 
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NOTE  If you didn’t finish the previous steps, import the backup timeline 1b Tracks 
A1 to A3 to catch up. 

Evaluating Tracks During Playback
In this exercise, you’ll listen to and evaluate the tracks during playback. First, let’s hide the 
unnecessary panels, fit the clips to the timeline horizontally, and decrease the height of the 
tracks to make room for additional tracks as needed. 

1	 Hide the media pool.

2	 Click anywhere in the timeline to make it active. Press Shift-Z to fit the clips horizontally.

To decrease track height, hold down Shift while scrolling down with your mouse wheel 
or drag the vertical zoom slider to zoom in vertically. 

3	 Decrease the track height until the current tracks fit in the upper third of the timeline. 

4	 Using the Timecode field as a guide, play the first 20 or 30 seconds of the timeline to 
see and hear how it is working so far. 

Now that you have heard the initial tracks together, what are your thoughts? Keep in 
mind that this is a work in progress. Based on a first listen, the mower sound is a bit 
jarring right at the beginning, and the first part of the bird sound clip sounds like it has 
more car noise than birds. 
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To evaluate the tracks, you can use the controls in the track headers. At the left of each 
track, the header shows each track’s name, number, and control buttons.

Track number

Track name field

Solo button

Meters 

Volume 
field

Arm 
button

Lock 
button

Mute 
button

5	 Press the Home key or fn-Left arrow to move the playhead to the beginning of the 
timeline. 

6	 Click any empty space on the A1 AMBIENCE track header to select that track. 

Notice that when a track header is selected, the name and number turn red, and the 
track brightens. Additionally, any clip beneath the playhead on a selected track 
brightens to indicate that the clip is selected.

7	 Click any empty space in the timeline to deselect the A1 track.

NOTE  Track selection is important when you are recording or editing 
using shortcuts. You can evaluate tracks without selecting them; however, 
it is always a good idea to be aware of which tracks or clips are selected 
as you work.
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Now, let’s try using the Solo and Mute buttons on several tracks. Solo isolates a track 
by temporarily muting all other tracks. Mute silences a track until it is unmuted. You 
can click these buttons to toggle each control on and off during playback. Your goal is 
to listen to the birds, the birds plus the ambience, and then the ambience alone to hear 
how they work by themselves and combined. 

8	 Solo the A2 BIRDS track, and then mute the A3 MOWER track.

9	 Start playback from the beginning of the timeline and listen to only the A2 BIRDS track. 
At around 00:00:10:00, unsolo the A2 track to hear the birds and ambience together 
until around 20 seconds. Then solo the A1 AMBIENCE track and listen to it by itself until 
around 30 seconds. When you are finished, stop playback. 

As you can hear, the Mute and Solo buttons are an easy way to listen selectively to 
specific tracks during playback. You can also swipe them on or off to quickly solo 
multiple tracks at once. 

10	 Unsolo the A1 track. Leave the A3 track muted.

Hopefully, you were able to focus on the first two tracks and how they work both 
separately and together to establish the soundscape of a park. This exercise also clarified 
the issue that the first part of the Birds clip is dominated by a passing vehicle. In the next 
exercise, you’ll clean up the beginning of the Birds clip. 
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Trimming Clips in the Timeline
DaVinci Resolve offers many options for editing and trimming audio clips, either manually 
or with keyboard shortcuts. In this exercise, you’ll start by manually trimming the 
beginning of the Birds clip, and then you will use a keyboard shortcut to trim the ends of 
multiple clips simultaneously. Your first goal is to trim the beginning of the Birds clip to 
remove the sound of the car. Once that is done, you’ll trim the clips in the A1 and A2 tracks 
so that they end at 30 seconds, since that is the duration of the podcast intro. 

To manually trim a timeline audio clip, you can drag an edge of the clip toward the right or 
left. While trimming, you’ll see a translucent waveform image of the entire audio file that 
you can use as a guide as you trim. 

1	 Solo the A2 track. Start playback and listen to the Birds clip. Stop playback when you 
no longer hear the passing car (at around 01:00:19:00). 

The playhead marks where you want to trim the head (start) of the clip. 
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2	 In the A2 BIRDS track, drag the head (left edge) of the clip to the right until it reaches 
the playhead. 

3	 Drag the trimmed Birds clip toward the left so that it starts at the beginning of 
the timeline. 

4	 Unsolo the A2 track and play the beginning of the timeline to hear the improved birds 
and ambience together. 

Finally, the birds clip lives up to its name, and you can move on to trimming the tails of 
the clips in the A1 and A2 tracks to end at exactly 30 seconds (01:00:30:00). 

When working with timecode, it is easy to navigate using the Timecode display. 
Numbers are entered from right to left as you type them. If you want to move to 30:00, 
you just type 3000 or type 30. (period). Entering a period (.) or colon (:) will 
automatically add two zeros (00) in the timecode field. In this case, you don’t have to 
type the hour and minutes if they are unchanged; the current hour and minutes will 
stay the same, so the results will be 01:00:30:00. 
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5	 Click the Timecode display in the upper left of the timeline to select it. Type 30. (thirty 
period) to set the timecode to 30:00. 

6	 Then press Enter or Return to move the playhead to 01:00:30:00 on the timeline. 

The playhead moves into position at 01:00:30:00. Next, you will trim the tail of the clips 
using the Trim End option available in the Trim menu. 

NOTE  In the Fairlight page, you can edit and trim clips using the playhead 
plus menu options or keyboard shortcuts. This type of trimming targets 
selected clips or tracks. If no clips or tracks are selected, all clips beneath the 
playhead will be affected. 

7	 If necessary, click the empty space in the timeline to deselect all clips and tracks and 
ensure that the playhead is at 01:00:30:00.
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8	 Choose Trim > Trim End or press Shift-] (right bracket) to trim the tail of the clips 
beneath the playhead to the playhead position. 

Done! The ambience and birds are now the exact duration they need to be for the podcast 
intro. While the playhead is still at 01:00:30:00, this would be a great time to set a marker in 
that position that you can see at a glance while you work.

NOTE  If you didn’t finish all the steps in this lesson, open the timeline 
1c A1 to A3 Trimmed to catch up.

Working with Markers 
Markers are often used in audio post-production as a guide to setting music cues, marking 
sound effects, or identifying elements such as dialogue takes or problems that must be 
addressed. They can also be used to aid navigation or as a guide when adding clips to the 
timeline. In this series of exercises, you’ll start by adding markers in the timeline to indicate 
the end of the podcast intro and the starting position for the voiceover. Then, you’ll move 
to the media pool, where you’ll use markers to label events in a sound effect and separate 
takes in the voiceover. 

1	 If necessary, move the playhead to 01:00:30:00 and deselect all clips and tracks.
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2	 In the timeline toolbar, click the Markers button to set a marker in the timeline ruler at 
the playhead position.

A marker appears in the timeline ruler. The default marker color is blue. You can 
change the marker color and edit the marker information in the Markers dialog. 

3	 In the timeline, double-click the blue marker beneath the playhead to open the 
Markers dialog, and change the name and color as follows: 

	— In the Name field, type END Intro Here. 

	— In the Color options, click the red marker to change the marker color accordingly.

4	 When you are finished, click Done.

Next, you’ll use the arrow keys and keyboard shortcuts to move the playhead to the 
starting position for the voiceover and set a marker there as well. 

5	 Press Home to move to the beginning of the timeline. Press Shift-Right Arrow to move 
the playhead one second to the right.
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6	 Press M to set a marker at 01:00:01:00. Press M again to open the Markers dialog. 
Then, in the Markers dialog, type START VO. When you are finished, click Done.

To navigate between markers in the timeline, you can hold down the Shift key and 
press the Up Arrow or Down Arrow keys. Pressing Shift-Down Arrow moves down the 
timeline to the next marker. Pressing Shift-Up Arrow moves the playhead to the 
previous marker. Navigating to a marker also selects it so you can easily open the 
Markers dialog by pressing M. Let’s try it. 

7	 Press Shift-Down Arrow to move to and select the red marker. Press Shift-Up Arrow to 
move to and select the blue marker. Press M to open the Markers dialog for the blue 
marker. Change the color to yellow. When you are finished, click Done. 

In the next series of exercises, you’ll return to the media pool, where you’ll apply markers 
to source clips as you review the remaining clips and edit them to the timeline. 
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Marking and Editing Select 
Portions of a Clip
So far, you have previewed and added whole audio clips. However, in audio post-
production, you’ll often work with long clips comprising multiple takes. When working with 
a clip that includes more content than you need, you can place markers on the clip to label 
specific sections. You can also mark a useful clip range by placing In and Out points. In this 
exercise, you’ll use both methods to mark clips. 

1	 Show the media pool. 

Here, you’ll see the seven audio clips and the timeline. The timeline is still named 
Timeline 1. Let’s rename the timeline before moving on to the next steps. 

2	 In the media pool library, double-click the Timeline 1 name field to select it. Type 
Podcast Intro v1 and then press Return or Enter. 

The first clip you’ll preview and mark is Drinking Coffee_001. Your goal here is to mark 
two key audible moments in the clip: the sound of coffee sloshing in the thermos and 
the sound of drinking and swallowing the coffee. 

3	 Select the Drinking Coffee_001 clip to load it in the preview player. Play the entire clip 
and listen to both takes. 
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For this intro, the director likes the first take. Fun fact: the director is the one who was 
actually drinking coffee in the recording. 

Previously, you set markers at specific timecode locations while the playhead was 
parked in position. This time, you’ll set markers while the playhead is moving, or “on 
the fly.” Don’t worry about setting these marks on exact frames; these are a general 
guide while editing the clips. 

4	 In the preview player, play the clip from the beginning and press M when you hear the 
sloshing start and again when you hear the sound of someone taking a drink. When 
you’re finished setting the two markers, click Stop or press the Spacebar. 

NOTE  When using common keyboard shortcuts in the preview player or 
timeline, you may need to first click the area of the interface you want to focus 
on to be sure you are controlling the desired playhead

5	 Press Shift-Up Arrow or Shift-Down Arrow to navigate between the two source clip 
markers and name the first marker Slosh and the second marker Slurp. Notice that 
when the playhead moves to a marker, the marker information appears in the 
preview player. 

Now that you are familiar with setting markers, let’s move on to marking In and Out points 
to select specific portions of a clip. 



36Lesson 1  Building a Soundtrack

Marking In and Out Points 
In the lower right corner of the preview player, you’ll see a set of buttons to mark In and 
Out points. The keyboard shortcuts for placing these marks are I and O. 

In this exercise, you’ll use the In and Out points to mark a specific section of the book 
turning. As with markers, you can set In and Out points with the playhead parked at a 
specific location or during playback. 

1	 Select the Book Pages Turning Flutter clip and preview it. 

For context, the narrator of the podcast intro is at the park drinking coffee and reading 
a book for book club. You’ll use this sound effect sparingly to sell the idea that the 
person talking is reading and turning a page once or twice. As is, it sounds more like 
someone is flipping through a book looking for something than actually reading. 
Luckily, the first few turns will work well for this project. 

2	 In the preview player, move the playhead to the beginning of the clip. 

3	 Click the Mark In button or press I to mark the In point at the beginning of the clip.
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4	 Play the clip from the beginning and listen for the first and second page turns. Stop 
playback after the second page turn, around 03:11:55:08 in the source clip’s timecode, 
located in the upper right corner of the preview player. 

5	 Click the Mark Out button or press O to mark the Out point after the second page turn. 

The scrubber bar in the preview player shows the marked portion of the clip. 

6	 Press Option-/ (forward slash) on macOS or Alt-/ on Windows to play the marked 
section from the In point to the Out point. Listen to the page-turn sound effect.

Excellent. That clip is marked and ready to edit to the timeline once the voiceover is in 
place, and you know where to place the sound. 

NOTE  When working with In and Out points, you can use Shift-I or Shift-O to 
navigate to the In or Out, and Option/Alt-I or Option/Alt-O to clear them. Option/
Alt-X clears both the In and Out points. These options are also available in the 
Mark Menu. 

Setting Duration Markers 
The last clip that you’ll mark is the voiceover clip containing three takes of the narrator 
describing a specific morning at the park. This time, instead of just setting a marker for 
each take or for In and Out points, you will combine both to create duration markers for 
easy access to each take. An advantage of working with duration markers is that they mark 
a specific range of the clip that can be edited to the timeline, like a subclip. To simplify this 
process, let’s use a new set of shortcuts to quickly scrub through the audio without 
using your mouse. 
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Scrubbing with the JKL Keys 
Using the JKL keys allows you to quickly scrub through clips in both the timeline and 
preview player. Pressing the L key plays forward, pressing the J key plays backward, and 
pressing the K key stops playback. Tapping the L or J keys multiple times will speed up 
playback. Holding down L or J will play one frame at a time and stop playing when you 
release the key. Holding down K while tapping L or J will play forward or backward one 
frame at a time, whereas pressing K together with L or J will play in slow motion. Let’s give 
these keys and combinations a try as you preview the Line 4 voiceover takes. 

1	 In the media pool, select the VO 1 Book_006 clip. 

The first and last frames of a source clip are the default In and Out points for the clip. 

2	 Press Shift-I to move the playhead to the beginning of the clip. 

3	 Press L to play forward until just before the first take. Press K to stop. Hold K and tap L 
or J as needed to move one frame at a time until you are clearly before the first words 
start (approx. 01:02:37:11). Press I to mark an In point. 

4	 Press L to resume playback. After the narrator says, “… and then out of nowhere they 
arrived,” press O to mark an Out point. You can do this during playback, or you can 
press K to stop before pressing O. When you are finished, stop playback if necessary.
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TIP  In and Out points update whenever you press I or O, which makes “on the 
fly” marking easy. For example, as the playhead approaches the desired Out 
point, you can continuously press O while listening to the playback and stop 
once you’ve hit the perfect mark. To save time, you can even set marks in fast 
forward, fast reverse, or slow-motion playback as needed using JKL. 
Conveniently, the I, O, and M keys are located adjacent to the JKL keys on a 
standard QWERTY keyboard. 

5	 Press Option-/ (forward slash) on macOS or Alt-/ on Windows to play the marked 
section. Feel free to expand the selection range by dragging the In or Out points in the 
scrubber bar of the preview player. 

If the entire take is within the In and Out points, you are ready to turn the selection 
into a duration marker. 

6	 In the preview player, right-click the marked range and choose Convert In and Out to 
Duration Marker from the menu.
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A blue duration marker appears above the marked range. 

7	 Double-click the blue duration marker to open the Markers dialog, and change the 
name and color as follows: 

	— In the Name field, type Take 1. 

	— In the Color options, click the yellow marker to change the marker’s color 
accordingly.

8	 Mark the second take with In and Out points. Convert the marks to a duration marker. 
Change the marker name to Take 2 and the color to yellow. 

9	 Repeat step 8 to create a duration marker for the third take.

When you are finished marking all three takes, you can clear the In and Out points. 

10	 Choose Mark > Clear In and Out or press Option/Alt-X. 

Not only do the source clip markers show in the preview player jog bar, but they also 
appear in the Clip Name list. 

11	 If necessary, set the media pool library to list view. 

12	 Click the arrow at the left side of the VO 1 Book clip’s icon to show the markers in the 
media pool list. 
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13	 Select Take 1 to load only that marked portion of the clip into the preview player. Play 
the selected take.

You’ve successfully marked three source clips in three different ways. Now, they are ready 
to be added to the timeline. 

Creating and Editing 
Additional Tracks
In this exercise, you’ll continue building the podcast intro using skills you’ve learned so far 
in this lesson. First, you’ll create and name new tracks, and then you’ll edit the 
corresponding source clips to the tracks. 

1	 In the timeline, right-click the A1 AMBIENCE track’s header and choose Add Tracks. In 
the Add Tracks dialog, set the following: 

	— Number of tracks: 3

	— Insert Position Below: AMBIENCE

	— Audio Track Type: Mono
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2	 Click Add Tracks or press Return.

3	 Name the new tracks as follows:
	— A2 track VO 1

	— A3 track COFFEE

	— A4 track BOOK

4	 In the timeline, move the playhead to the yellow marker. 

5	 In the media pool library, select Take 1 in the VO 1 Book_006 clip. Drag Take 1 from 
the preview player to the playhead position on the A2 VO 1 track.

6	 Drag the Drinking Coffee clip to the playhead position on the A3 COFFEE track.

7	 Drag the Book Pages Turning clip to the playhead position on the A4 BOOK track.

8	 Hide the media pool. 

9	 Play the timeline once from the beginning to hear how it is progressing. Keep the A6 
track muted for now. 

What did you think of the work in progress? The soundscape is starting to come together. 
You probably noticed that the Drinking Coffee clip needs trimming. Additionally, the timing 
and levels of some clips need to be adjusted. Soon! First, let’s color and rearrange the 
tracks to organize them. Then, you’ll move on to trimming, timing, and balancing levels. 

Coloring and Reordering Tracks
Descriptively naming and organizing your tracks can save you time later in your mixing 
process. In this exercise, you’ll change the color of each track based on the contents, then 
reorder them by priority, starting with the voiceover and ending with the background 
ambience. You can change the track color in the timeline track headers or the tracks index. 
Reordering tracks, on the other hand, can be accomplished by dragging the left edge of 
the track header, or dragging the track name in the mixer or tracks index. There is also a 
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shortcut (right-click) menu option for moving a track in the timeline. In this exercise, you’ll 
use the timeline and track index methods. 

1	 In the timeline, right-click the A2 VO 1 track header and choose Change Track 
Color > Yellow. 

To move a track up or down, you can use the right-click shortcut menu in the 
track header. 

2	 Right-click the A2 track header and choose Move Track Up. 
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The VO 1 track is now in the A1 position in the timeline, and the clip color within the 
track is yellow. As you can see, track numbering is based on the position in the timeline 
and will update automatically when you reposition tracks. 

You can also color multiple selected tracks at once. To select multiple consecutive 
tracks in the timeline, drag a selection up or down to the previous or next track 
headers. When selecting tracks, click and drag the empty space near the top of the 
track header to avoid clicking any controls. 

NOTE  You can use common Shift and Command/Ctrl modifier shortcuts to 
select multiple clips or tracks. For continuous clips or tracks, select the first 
track and then Shift-click the last consecutive track to select them all at once. 
For noncontiguous tracks, Command-click (macOS) or Ctrl-click (Windows) to 
select or deselect specific clips or tracks. 

3	 Drag a selection from the top of the A3 COFFEE track header to the A4 BOOK track to 
select both tracks. 

4	 Right-click within the selected track headers and choose Change Track Color > Chocolate.

5	 Change the Birds track color to Blue. 
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So far, so good with the track organization. Let’s finish coloring the tracks in the 
tracks index. 

NOTE  If you didn’t finish all the steps in this lesson, open the timeline 
1d A1 to A6 Move to catch up.

Moving and Coloring Tracks 
in the Tracks Index
The more tracks in your timeline, the more control you’ll need to manage them. The tracks 
index shares a panel with the markers index and edit index. Each index is an interactive list 
that lets you quickly select tracks, markers, or timeline edits. The track index also offers 
options to show/hide, change track color or track type, or drag and drop tracks in a 
different order. In this exercise, you’ll change the color of the A2 and A6 tracks and then 
drag them to a different position.

1	 Show the index and click the Tracks tab to show the tracks list. 

Here, you can see a row for each track that includes information such as the track 
number, name, and controls. 
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2	 In the tracks list, select the AMBIENCE track. 

The A2 AMBIENCE track is selected in both the index and timeline. You’ll find options to 
delete or change its track type or color in the shortcut menu.

3	 In the track list Name column, right-click the AMBIENCE track and choose Change 
Track Color > Beige.

You’ll leave the A6 track green for now. Next, you’ll drag and drop tracks in the tracks 
list to rearrange them. Your first move will be to drag the AMBIENCE track down to the 
position below BIRDS and above MOWER. A white positioning line appears as a guide 
while dragging and dropping tracks in the index. 

TIP  When dragging tracks in the tracks list, it’s best to grab an empty space in 
the track’s row so you don’t inadvertently select a field or control. The empty 
space in the Name column to the right of the track’s name works well. Don’t 
click the name itself, or you’ll open the Name field. 

4	 In the track list Name column, drag the A2 AMBIENCE track down to the position 
between the BIRDS and MOWER tracks. 
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5	 Drag and drop the MOWER track above the BIRDS track. 

6	 Click the empty space at the bottom of the track index to deselect all tracks.

The tracks are colored and ordered from voiceover to background ambience. 

Showing and Hiding Tracks
The Fairlight page in DaVinci Resolve offers a variety of tools at your fingertips to quickly 
customize how you view the timeline tracks and contents so you can focus on the tracks 
and clips you need while you work. In the next section, you’ll edit the clips in the A2 and A3 
tracks to improve the timing of the book and coffee-drinking sound effects against the 
voiceover. To simplify editing, you can hide the other tracks and zoom the remaining tracks 
for easy access and a better view of the waveforms within. 

To the far left of the track list, you can see visibility controls represented by eye icons. You 
can click these controls off and on to hide or show a track. Or you can click and swipe 
multiple contiguous tracks off and on at once.

NOTE  You can also swipe on or off track controls, including Track Lock, Record 
Enable, Solo, and Mute. Additionally, the improved Tracks index lets you double-
click to rename tracks and drag and drop to reorder tracks right in the tracks list!
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1	 In the tracks list, with your pointer over the visibility control (eye icon) for track A4, drag 
down over the visibility controls for tracks A4 through A6 to hide them. 

Those tracks are no longer visible in the timeline; however, their audio contents will 
continue to play normally. 

Next, you’ll simultaneously resize the A1, A2, and A3 tracks to a custom height. 
Previously, you’ve used the zoom sliders in the toolbar or shortcuts with the middle 
mouse wheel to resize track heights. This time, to demonstrate DaVinci Resolve’s 
intuitive, user-friendly timeline interface, you’ll select the tracks and drag the lower 
edge of the track header to resize them all simultaneously to a custom height. 

2	 Hide the tracks index.

3	 In the timeline, select the A1-A3 tracks. 

4	 Drag the lower edge of the A3 track header to resize all selected tracks until they are 
large enough to clearly see the clips and waveforms. 
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NOTE  Dragging the track header to resize track height will work on the 
specific track being resized as well as any selected tracks. 

5	 Press Shift-Z to zoom the clips horizontally. 

Now, you can see the clips much better and are ready to arrange and trim them. 
Remember that Shift-Z is a Zoom to Fit shortcut that fits all clips horizontally within the 
visible area of the timeline, even if they are video only or in hidden tracks. 

Editing and Arranging 
Clips in the Timeline
Now that the tracks are organized and focused on the clips that need your attention, you 
can tidy up the obvious issues—for example, if a clip is too long or has a distracting 
element in a sound effect. In this exercise, you’ll trim the head and tail (start and end) of 
the clip in the A2 COFFEE track to remove the excess sounds before and after the desired 
coffee drinking section, such as the clunking of the thermos being set down on the park 
bench. Additionally, you’ll move the clips in the A2 and A3 tracks so that their timing works 
better with the voiceover in A1. This is also a good time to introduce waveform zoom, the 
Range Selection tool, and the new Exclusive Solo option. 
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1	 Solo the A1 VO 1 track and play the clip once to remind yourself of what is said and the 
timing in the waveform.

“The last day of normal started like every morning, at the park with my coffee, reading 
my book. Then, out of nowhere, they arrived.” 

2	 Unsolo the A1 track and solo the A2 track. Play the clip in that A2 track. 

You’ll trim that clip shortly to remove the clunking thermos sections at the end of 
the clip. 

3	 Choose Fairlight > Exclusive Solo to enable that option. 

4	 Solo the A3 Book track.

Notice that clicking the Solo button on the A3 track automatically unsoloed the A2 
track. Exclusive Solo is great when you are evaluating a specific track. If you wish to 
solo multiple tracks, you’ll need to turn off Exclusive Solo the same way you 
turned it on. 

5	 Play the clip in the A3 track. 

NOTE  Feel free to zoom as needed to better see the clips and tracks you’re 
working with throughout the lessons in this book. 

6	 Solo the A2 track again. Play the clip and pay attention to the excessive sounds before 
the first drink and after the second drink. 

Your goal is to trim away the unwanted sounds to leave only the desired portion of the 
clip. You could trim the start and end of the clip or use the Range tool to select the 
range you want to keep and remove the excess. Let’s try the latter option. First, let’s 
zoom in on the waveform for the A2 track so it is easier to see the waveform without 
increasing the volume level. 
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7	 Choose View > Zoom Audio Waveform > Increase Height. 

The waveforms on all clips in the timeline increase in height. 

NOTE  If you’re working with a three-button mouse, you can hold Option-
Command (macOS) or Alt-Ctrl (Windows) and scroll the middle mouse button/
wheel to increase or decrease the waveform zoom level. Remember that changing 
the waveform zoom level does not affect the track’s volume.
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Selecting and Editing with 
the Range Selection Tool
Now that you can see the waveform a little better, it’s time to trim the clip with the Range 
tool. To select a specific range in the timeline, you’ll use the Range mode Range Selection 
tool. So far, you’ve been working in the default Pointer mode using the selection (arrow) 
tool to select, move, and trim clips in the timeline. To switch to Range mode, press the R 
key. (Incidentally, if you haven’t guessed already, the shortcut for the arrow tool in Pointer 
mode is A for arrow.) The Range tool can be used to select multiple clips, sections of clips, 
or an entire clip. The contents of the selected range can then be cut, copied, pasted, 
deleted, moved, trimmed, and so on. 

To drag a selection on a clip, you need to drag on the upper half of the clip. Clicking 
anywhere on the lower half of a clip will select the entire clip. Clicking any empty space in 
the timeline clears the current range. In this exercise, you’ll select the portion of the 
Drinking Coffee clip that you want to keep and trim the head and tail of the clip to the 
selection. 

1	 Press R, or click the Range Mode button in the toolbar.

TIP  When dragging a range, don’t worry about getting it perfect on the first 
try. You can always Shift-drag the edges of a range to trim it. 

2	 Play the clip again from the beginning and stop when you hear the thermos and liquid 
just before the first drink (around 01:00:03:10). This will be the start of the range. 
Using the Range Selection tool, click the upper half of the clip starting at the playhead 
and drag from left to right until you reach the end of the second drink and the “aah.” 
(The range ends before the loud spike in the waveform where the thermos is 
slammed onto the bench.) 
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The green bar in the ruler above the timeline indicates the In and Out points of the 
range. You can also see the range’s In and Out points in the timecode display. The 
section of the selected clip that is within the range brightens. Let’s play the selected 
range and then trim to it. 

3	 Choose Playback > Play Around/To > Play In to Out or press Option-/ (slash) in macOS 
or Alt-/ (slash) in Windows to play the range. If you need to adjust the range, Shift-drag 
the edges as needed. It doesn’t have to be perfect; you can trim the clip later. 

NOTE  If you accidentally click an empty space and clear the range or click the 
lower half of the clip to select the whole clip, simply deselect the clip and drag 
the range again. 

4	 Choose Trim > Trim to Selection or press Shift-Command-T (macOS) or Shift-Ctrl-T 
(Windows).

Only the selected portion of the clip in the A2 track remains in the track.
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5	 Click the empty space in the timeline to clear the range. 

Next, you’ll listen to the voiceover to find a good spot for the book and coffee sound 
effects, then use the Range Selection tool to select and move them into position. 

6	 Solo the A1 track and play the clip to see and hear where the narrator says, “at the park 
with my coffee reading my book.” 

That section of the voiceover is the middle section of the clip. The gaps in the 
waveform before and after that sentence will be ideal places to align the sound effects. 

7	 Unsolo the A1 track. With the Range Selection tool, click the lower half of the Book 
Pages Turning clip in the A3 track to select the whole clip. 

The entire clip brightens to indicate it is selected, and the pointer becomes a grab 
(hand) tool that you can use to drag the clip to a new position. When working with the 
Range Selection tool to move clips, the brightened area of the timeline within the 
range acts as a guide while you drag to assist with positioning the clip. In this case, by 
serendipitous coincidence, the loudest peaks in the Book Page Turning clip (the page 
flips) fit nearly perfectly before and after the middle section of the voiceover on A1. 

8	 Using the waveforms and range as a guide, drag the selected clip toward the right until 
the highest peaks in the waveform align with the beginning and end of the middle 
section of the voiceover clip. 
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9	 Play the timeline from the beginning. 

Thoughts? The sound of the pages turning is good, but there are one too many page 
flips. Luckily, you can use the Range Selection tool to trim clips as you did with the 
Arrow tool. Let’s trim the second loud flip in the Book Pages Turning clip. 

10	 With the Range Selection tool, drag the right edge of the clip toward the left until the 
loudest peak section (flip) is removed. 

11	 Play the timeline again to hear the work in progress. When you’re finished, deselect 
the current range. 

NOTE  You can always deselect a range with the shortcut Option-X (macOS) or 
Alt-X (Windows).
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Preparing the Project
Before adding the music and balancing the levels, let’s bring back the other tracks, change 
the track heights, and zoom so everything fits nicely in the timeline. 

1	 Press A to return to the standard Pointer mode. 

2	 Choose Fairlight > Exclusive Solo to disable that option so you can solo more than one 
track at a time if needed. 

3	 Move the playhead to the beginning of the timeline.

4	 Show the tracks index and turn on visibility for the A4, A5, and A6 tracks. Then, hide 
the index. 

5	 Choose View > Zoom Audio Waveform > Reset or press Option-Command-R (macOS) 
or Alt-Ctrl-R (Windows) to reset the clip waveform’s zoom level without changing the 
volume level. 

6	 Use the Vertical Zoom slider or Shift-middle mouse wheel to resize the track heights to 
clearly see all six tracks. 

NOTE  If you didn’t finish all the steps in this lesson, open the timeline 
1e A1 to A6 Add Music to catch up.
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Marking and Adding 
Music to the Timeline
The soundscape is starting to come to life; all it needs is some dramatic music for the 
podcast intro. You have already learned how to preview and mark source clips, create new 
timelines, and add clips. So this is a perfect time to practice some of your new skills to add 
music to the project. In this exercise, you’ll mark around 30 seconds of music and add it to 
a new track in the timeline. A few new features and techniques will be introduced along the 
way to keep building on what you’ve done earlier in the lesson. 

1	 Click the DIM button or choose Fairlight > Monitoring > Dim to instantly lower the 
playback volume.

2	 In the media pool, preview the Dangerous Music R19 clip. 

For a better view of the waveform in the preview player, you can change the zoom level 
in the Zoom menu located in the upper left corner of the preview player. To see the 
waveform for the entire clip from start to finish, you can set the Zoom menu to 1x. 
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3	 Click the Zoom menu in the upper left corner of the preview player and choose 1x. 

Now, you can clearly see the entire waveform for the music. Since this piece of music 
will be used as the intro theme for the podcast show, you’ll want to mark a 
definitive ending. 

4	 Play the last section of the music to hear the ending. 

Perfect! You’ve heard the ending. Let’s mark the clip.

NOTE  The preview player scrubber bar always represents the entire selected clip 
from the first frame to the last, regardless of the zoom level displayed.
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Scrubbing with In and Out Marks 
Previously, you’ve used the JKL keys to scrub audio in the preview player. In this exercise, 
you’ll also drag the In and Out points to scrub and mark the 30-second section of the 
music clip that you’ll add to the timeline. Since you already know how you want the music 
to end, that’s the first mark you’ll set.

1	 If necessary, select the Dangerous Music R19 clip in the media pool to load it in the 
preview player. 

2	 Press End or drag the jog bar to the end of the clip. 

3	 Press O or click the Mark Out button to set an Out point at the end of the clip. 

As you can see, the end of the clip is beyond the end of the waveform. No problem; 
you’ll fix that shortly. First, let’s set an In point using the timecode fields and waveform 
as a guide.

Timecode fields in the upper left and right of the preview player display duration and 
source frame, respectively. The clip duration is one minute and ten frames (01:00:10). So 
for 30 seconds of music, your In point should be somewhere near the middle of the clip. 

4	 Move the jog bar to the middle of the clip and mark an In point. 
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The duration field should now be around 30 seconds. The duration is fine, but the 
extended silence at the end of the clip means there won’t be 30 seconds of music. 
That’s easy to fix by scrubbing the Out point to find the end of the music. 

5	 Drag the Out point toward the left until you hear the end of the music. Continue 
dragging the Out point left or right as needed until the music stops. 

The Out point is set, but the duration is now too short. To change the duration, you’ll 
drag the In point while looking at the timecode duration field. 

6	 Move the jog bar out of the way if needed. Drag the In point toward the left while 
listening and watching the duration field. When the duration is around 30 
seconds, stop. 

Creating a New Track with a Source Clip
You have around 30 seconds of music ready to add to the timeline. This time, instead of 
creating a new track for the music clip, you’ll use the music clip to create the new track. The 
secret is to drag a source clip to the empty space below the other tracks in the timeline. 
This will automatically create a new track for the clip. In this exercise, you’ll use the 
Dangerous Music R19 clip to create a new track and then name and color the track. 
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1	 Drag the Dangerous Music R19 clip from the media pool to the empty space below 
the A6 track to create a new track for the incoming clip.

The music clip is in the new A7 track.

2	 If necessary, move the clip to the beginning of the A7 track. 

3	 Name the track MUSIC.

4	 Change the A7 track color to teal. 

5	 Hide the media pool and play the beginning of the timeline to hear how it works with 
the music. 
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It’s hard to say how it works with the music because the music completely dominates the 
soundtrack. This is evident not only when you listen to the tracks, but also when you glance 
at the timeline waveforms and red levels in the track meters. Luckily, it’s easy to adjust clip 
levels right in the timeline. 

Balancing Clip Levels 
in the Timeline
If you’re wondering which track is the priority, dialogue or music, this is a good time to 
mention the golden rule of audio post-production, also known as the “Dialogue Is King” 
rule. In short, spoken words such as voiceover, narration, or dialogue take priority over all 
other audio tracks. This rule also applies to a music score, when the actors’ lines take 
priority; action scenes, when characters’ shouting must be heard over helicopters and 
explosions; and even documentary films, when subjects are talking in a noisy location. 

Your goal in the next series of exercises is to balance the clip levels of all the timeline clips, 
starting with lowering the music clip. When balancing clip levels, you’ll use your ears to 
listen and your eyes on the clip gain line and meters as you go. 

Each timeline audio clip includes a clip gain line that looks like a white horizontal line across 
the upper third of the clip. To adjust the volume level of a timeline clip, you can drag the 
clip’s gain line up or down. 

1	 Choose Fairlight > Monitoring > Dim or click the DIM button for normal playback levels. 

2	 Select the A7 MUSIC track and increase the track height until you can clearly see the 
track, waveform, and white clip gain line. If the clip gain line is not visible, choose 
Fairlight > Show Clip Gain Line. 



63Lesson 1  Building a Soundtrack

3	 In the Dangerous Music R19 clip, drag down on the clip gain line to reduce the clip’s 
volume level until the tooltip reads -20 dB. 

TIP  Shift-drag the gain line for a slower response while you drag. Double-click 
the clip gain line to reset it to its original level. 

4	 Play the first half of the timeline to hear how the music and voiceover complement the 
new music levels.

Is it working? How does the music sound with the voiceover and other effects? 
Sometimes, less is more. Even at the lower levels, the music competes with the 
voiceover. In fact, the park’s soundscape worked much better without the music. 

It’s time for a decision. Either lower the music even more or trim it so it starts later, 
near the end of the voiceover. For this exercise, you’ll trim the music.

5	 Move the playhead to the start of the last section of voiceover, just before the narrator 
says, “then out of nowhere they arrived” at around 01:00:07:22. 
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6	 Select the A7 track, if necessary. Then press Shift-[ (left bracket) or choose Trim > Trim 
Start to trim the head of the music clip to the playhead. 

7	 Deselect the A7 track and then play the first half of the timeline. 

The intro is working much better, but the music needs a fade at the beginning to ease it 
into the soundtrack. 

Adding a Fade 
Although there are many ways to add fades to timeline clips, one of the easiest is to simply 
drag the fade handle located in the upper right and left corners of every audio clip. In this 
exercise, you’ll add a 2-second fade to the beginning of the music clip. 

1	 Move the playhead to the beginning of the clip in the A7 track. 

2	 Press Shift-Right Arrow two times to move the playhead 2 seconds toward the right. 

3	 Hover over the upper left edge of the clip to show the fade handle. Then, drag the fade 
handle to the playhead or select the clip and choose Trim > Fade In to Playhead. 
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4	 Listen to the last section of the voiceover with the music. 

Wow! What a difference a fade can make! 

NOTE  If you didn’t finish all the steps in this lesson, open the timeline 
1f Finish Balancing to catch up.

Finish Balancing the Clips
The clients have arrived at your audio facility and are eager to hear the first draft of the 
podcast intro—right after they finish a call and grab a cappuccino. So you have a few 
minutes to tidy up the clip levels. You’ve got this! 

Using what you have learned so far, adjust the levels on all the other clips to keep the focus 
on the voiceover and overall soundscape. You can adjust clip levels in the timeline or 
Inspector. Don’t forget to utilize the shortcuts you’ve already tried, like Shift-dragging the 
gain line or clip volume field for geared incremental adjustments and double-clicking the 
gain line or clip volume label in the Inspector to reset them. 

In this exercise, you’ll adjust clip levels in track order, starting with the voiceover in A1. 
You’ll learn much more about balancing clips and track levels in later lessons. For now, 
follow the suggested levels below while you train your ears. 

1	 Unmute the A4 MOWER track.

2	 Press Shift-Z to fit the clips to the visible timeline. 

3	 Adjust the vertical track height so you can see all the tracks.

4	 Set the clip levels as follows:

	— A1 Track, VO 1 Book clip: 2.0 dB

	— A2 Track, Drinking Coffee clip: 13 dB

	— A3 Track, Book Pages Turning clip: 3.4 dB

	— A4 Track, Lawn Mower clip: 2.3 dB

	— A5 Track, Birds clip: 14 dB

	— A6 Track, Ext City Ambience clip: 12 dB

	— A7 Track, Dangerous Music clip: -20 dB 

5	 When you are finished, hide the Inspector.
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6	 Play the timeline from the beginning to hear how it sounds with the new clip levels. 

Nice job! By the way, the clients have returned with their cappuccinos while you were 
playing back the tracks, and they like how the intro is coming together. In fact, they are 
rather impressed with how fast you worked, considering you are a newly appointed intern. 
Overall, they are happy. Almost. As expected, they have a few notes:

	— Voiceover is too tight, let it breathe. 

	— Coffee drinking is too in your face. 

	— Duck the second gulp.

	— Love the mower, but it should start when narrator says, “…started like every morning.” 

Finessing the Audio Edit
There are only a few things left for you to do to finish up the basic podcast intro. In the 
next series of exercises, you’ll take care of all the clients’ notes as you learn a few new 
tools and techniques. 

Let’s start with the first item on the list: voiceover is too tight, let it breathe. 

They are requesting that you add space between the voiceover phrases. Not only will this 
leave more space for sound effects between words, but it will also add dramatic pauses 
near the end. 
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Splitting and Nudging Clips 
DaVinci Resolve offers many methods for splitting clips. In this exercise, you’ll use the 
playhead, Razor, and Range tools to split the voiceover clip into four parts. Then, you’ll 
move the clips to create 1-second gaps between phrases.

1	 Move the playhead to the beginning of the timeline.

2	 Solo and select the A1 track. 

3	 Play the first section of the clip. After the narrator says, “The last day of normal started 
like every morning,” stop playback.

4	 Use the JKL keys or the Left and Right Arrow keys to move the playhead to the middle 
of the silent section between phrases in the waveform (around 01:00:04:13).

5	 In the timeline toolbar, click the Razor tool icon (scissors) to split the selected clip at the 
playhead position. 

NOTE  If you inadvertently split clips on all tracks, choose Edit > Undo, and 
then try again. This time, be sure to select the track first so that you split only 
the clip on the selected track. 

You’ve successfully split the first phrase from the rest of the voiceover. Now you can 
move the remaining voiceover 1 second to the right to add a pause between phrases. 

6	 Press Shift-Right Arrow to move the playhead 1 second to the right. 
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7	 Drag the second clip in the A1 track to the right so it starts at the playhead. 

For the next section, you’ll use the Range Selection tool to split and move clips. 

8	 Press R or click the Range Mode button to use the Range tool. 

9	 Play the second clip in the A1 track from the beginning and stop after the narrator 
says, “at the park with my coffee, reading my book.”

10	 With the Range tool, drag a range over the upper half of the clip from the playhead to 
the end of the clip. The range can extend beyond the end of the clip. 

Rather than dragging the selected range into position, this is a great opportunity to 
use the Nudge commands available via keyboard shortcuts and in the Trim menu. 
Unlike manually dragging, the Nudge commands allow you to precisely move a 
selected clip one frame at a time to the left or right by pressing the , (comma) and . 
(period) keys for single frame movement or the Shift-, (comma) or Shift-. (period) key 
combinations to nudge multiple frames. 

11	 Choose Trim > Nudge > Multiframe Right or press Shift-. (period). 

The selected clip moves five frames to the right but still must move another 20 
frames or so. 

12	 Press Shift-. (period) four more times to move the clip 20 frames to the right. 
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13	 Click any empty space to clear the current range.

Let’s do one more Range tool edit.

14	 Use the Range tool to select the last two words, “they arrived,” and move the selection 
around 1 second to the right.

15	 When finished, click an empty space to clear the range. Press A to switch to the Arrow 
tool in Pointer mode. 

16	 Unsolo the track. Play the timeline to hear the adjusted voiceover with the other tracks. 

The timing is better. However, the clients want another second of “air” between the 
first two clips and the last two clips. You can nudge any selection, whether a range or 
selected clips. This time, you’ll nudge selected clips while in Pointer mode. 

17	 With the Pointer tool, select the last two clips in the A1 track. Press Shift-. (period) five 
times to nudge the selected clips 25 frames to the right. 

18	 When you are finished, deselect the clips. 

One note down, three to go. 

Mind the Gaps!
Before moving on to the next note, it’s a good idea to adjust the timing of the clips in the 
A2 and A3 tracks so they align better with the newly created gaps. That way, the coffee 
drinking and page flips will be easier to hear without competing with the voiceover. For this 
brief exercise, you can use the waveforms in the Drinking Coffee and Book Page Turning 
clips as a guide to align the clips into position. 

1	 Select the Drinking Coffee clip in the A2 track and drag it toward the right until the 
second gulp and “aah” align with the second gap between clips in the A1 track. 
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2	 Drag the Book Pages Turning clip in the A3 track to the right until the waveform aligns 
between the gulps in the A2 track. 

3	 Play the timeline from the beginning and listen to the newly timed clips. 

The clients like the new timing but are asking for you to add one more second of space 
between the last two clips so that it times better with the dramatic music beat just 
before the narrator says, “they arrived.” 

4	 Select and nudge the last yellow voiceover clip 25 frames to the right. When you are 
finished, play the middle of the timeline to hear the timing of the last two voiceover 
clips with the music and sound effects. 

The improvement in the pacing and literal timing of the sound effects and music with the 
narrator’s words is noticeable. Apparently, the clients really know what they want, and their 
requests result in noticeable improvements! 

On to the next note! 

	— Voiceover is too tight, let it breathe 

	— Coffee drinking is too in your face. 

	— Duck the second gulp.

	— Love the mower, but it should start when the narrator says, “…started like every morning.” 

Changing Levels within a Clip
Balancing clip levels is a process. As you move and edit clips for context, you may need to 
adjust the levels more than once. You may also need to change the levels within a clip and 
bend the gain line with the help of keyframes. In this exercise, you’ll tackle the second and 
third notes: Coffee drinking is too in your face and Duck the second gulp. Translated, these 
notes from the clients mean that the volume level of the Coffee Drinking clip is too loud, 
especially the second gulp. To fix this, you’ll reduce the entire clip and then use the range 
tool to reduce the second gulp an additional amount. Let’s try it. 
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1	 Adjust the vertical and horizontal zoom to see the clip in the A2 track clearly. 

2	 Using the gain line on the Drinking Coffee clip, lower the clip level from 13 dB to 10 dB. 

3	 Play the timeline to hear it with the lowered drinking sounds. 

Next, drag a range that includes the second gulp and lower the level within the range. 

4	 Press R for the Range tool. Then, drag a range that includes the entire second gulp 
through the end of the clip. 

5	 In the selected range of the clip, drag the gain line downward to reduce the 
level to 7 dB. 

As you can see, two keyframes were created on the gain line to accommodate the level 
change in the selected range. 

NOTE  You can also manually add or delete keyframes as needed along the 
gain line. You’ll work extensively with keyframes in later lessons. For now, 
you’ve experienced the ease of changing levels within a range. 

6	 Clear the range and press A for the Pointer tool. 

7	 Play the timeline with the new levels in the A2 track. 

You may have noticed that the clip level in the Drinking Coffee clip header shows 10 dB. 
Whatever level is at the start of a clip will be displayed in the clip’s header. You can see 
the levels of different clip sections in the tooltip when you click the gain line in 
that section. 
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8	 Click the gain line near the end of the clip to see the level in the tooltip. 

Done! You’re ready for the last note. 

NOTE  If you didn’t finish all the steps in this lesson, open the timeline 
1g Finish Notes to catch up.

Finish the Notes
You have nearly completed the brief set of client notes for the first draft of the podcast 
intro! All you need to do is the final note—unless the clients change their minds and have 
additional notes, which is likely, so be prepared for anything. 

	— Voiceover is too tight, let it breathe 

	— Coffee drinking is too in your face 

	— Duck the second gulp

	— Love the mower, but it should start when the narrator says, “…started like every 
morning.” 

You are on your own for this task. Start by increasing the level of the Lawn Mower clip in 
the A4 track to 5.0 dB. Play the timeline to find where the narrator says, “started like every 
morning,” and move the Lawn Mower clip in the A4 track so that the sound of the mower 
starting up begins just after the spoken words “started like.” When you are finished, feel 
free to finesse levels or nudge any of the clips if needed as you wait for the clients to arrive 
and review your work—again. 
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One More Thing
Excellent news! The clients are extremely pleased with this draft! Then, out of nowhere, 
they have another tiny request. They noticed that everything sounds very stationary, and 
they are wondering if you could have the mower moving in the background. Of course, 
your answer is “Sure!” 

All the primary sound elements are in fixed positions, as you would expect for a narrator 
on a park bench, drinking coffee and reading a book. An important element of sound 
design that you will learn in this book is the importance of placing sounds to fill the 
panoramic space and, when possible, have objects moving dynamically to create interest 
and enhance the experience for the audience. Even in this “audio only” soundtrack, you can 
still move sound objects around to bring them to life. For this last-minute maneuver, you’ll 
use the simplest method possible. 

Panning an Audio Track 
from the Viewer
DaVinci Resolve is the only software that combines professional audio and video tools to 
offer audio pan tracking in the viewer. Throughout this book, you will spend time panning 
tracks for stereo, 5.1, and immersive audio projects using many different methods. For this 
first lesson, you’re working with a stereo project with two speakers, left and right. This 
doesn’t limit your creativity or require you to use advanced techniques, panning controls 
in the mixer, or even automation tools. You’ll get to all those things later in the book. At 
this time, you’ll simply point and click where you want the mower sound to start and, 
again, where you want it to finish! In this case, the client wants the mower to move, so 
that’s exactly what you’ll do in a few clicks. First, let’s listen to the mower sound to see if 
there is any movement of the sound. 

1	 Solo the A4 track. Play the mower clip and listen to the sound. 

Does it sound as if it is actually moving in any specific direction? Not really. You are 
about to change that by panning the clip from left to right. Later, you’ll use the Pan 
window to carefully pan a track to specific positions between speakers. In this lesson, 
you’ll use the viewer to accomplish this; no details are required. 

2	 Click the Meters button to show the Monitoring panel, including the viewer. 

If the timeline had a video track, the viewer is where you would see the video output. 
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3	 In the lower left corner of the viewer, click the Controls menu and choose Show 
Tracker Controls.

The clients want the mower to move. Since this is a stereo project with only two 
speakers, your options for movement are simply left to right, right to left, or back and 
forth between left and right. This makes the controls easy.

4	 In the Panning controls, click the Left to Right option. 
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5	 Press R for the Range tool and click the lower half of the mower clip to select the entire 
clip plus the track containing the clip. 

Selecting the track shows the track name in the viewer along with a pan tracker 
(crosshairs). In the viewer, you’ll see a crosshairs labeled MOWER in the center. To move 
the tracker and subsequently pan the track, you Option/Alt-click the viewer to set the 
tracking points. For this exercise, you’ll pan the mower from right to left, so you’ll use 
the first and last frames of the clip as a guide to set the tracking points. 

6	 Select the clip in the A4 track, if necessary. Press Shift-I to move the playhead to the 
clip’s In point. 

Now, you can set the starting position on the far right of the viewer. 
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7	 Option/Alt-click the right side of the viewer to set the pan tracker and a left-right 
keyframe in that position. 
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8	 Press Shift-O to move the playhead to the selected clip’s Out point. Option/Alt-click the 
far left side of the viewer to set a left-right keyframe in that position. 

NOTE  To see the Pan tracker in the viewer, be sure to show the controls and 
select the track.

9	 Play the clip from the beginning and listen to the clip while watching the tracker move 
in the viewer. 
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Fantastic! Just like that, the mower sounds like it is moving in the distance from the right to 
the left. The clients are thrilled and can’t wait to hear what you do with the helicopter and 
dragon sound effects! Choppers and dragons?... To be continued in Lesson 3, “Editing 
Sound Effects and Music.”

Congratulations! You survived and thrived in your first fictional audio assignment, built a 
basic podcast intro from scratch, and completed the first lesson in this training guide. 
You’ll work more on this project in later lessons. 

NOTE  If you didn’t finish all the steps in this lesson, import the backup timeline 1h 
Intro v1 Finished to see the finished timeline.

Lesson Review
1	 In the default layout, which Fairlight panels are displayed with the timeline? Choose all 

that apply.

a)	 Mixer

b)	 Media pool

c)	 Index

d)	 Monitoring panel (meters)

2	 True or False? The viewer in the Fairlight page shows only the selected video tracks in 
the edit page.

3	 True or False? You can only change a clip’s volume level in the timeline or Inspector 
once it has been added to the timeline.

4	 In the Fairlight page, which of the following can you do in the Tracks Index? (Choose all 
that apply.) 

a)	 Select tracks

b)	 Reorder tracks

c)	 Show or Hide tracks with visibility controls

d)	 Change a track’s name or color

e)	 Make a new timeline from a selected track or tracks
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5	 What shortcuts are used to mark the beginning and end of a section that you want to 
use for a source clip in the media pool? 

a)	 I and O

b)	 B and E

c)	 S and F

d)	 . (period) and , (comma) 

e)	 You can’t mark the beginning and end of a source clip. A clip must be in the 
timeline before you can choose the section you want to use. 

6	 What is audio scrubbing? 

a)	 Cleaning a clip’s audio to remove background noise

b)	 Searching for a clip in the media pool

c)	 Finding a clip’s fundamental frequency

d)	 Listening to a clip while moving the playhead forward, back, fast, slow, or 
anywhere in between

e)	 Erasing a clip from the project
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Answers
1	 a, d

2	 False. The viewer in the Fairlight page shows the video output of the edit page. 

3	 False. You can change the volume level of a selected media pool clip in the Inspector. 
You can also change the level of a timeline clip in either the timeline or the Inspector. 

4	 a, b, c, d 

5	 a

6	 d
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Welcome to dialogue editing, in which 
every word from every character 
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dialogue tracks, and edit multiple 
voiceover takes to build a composite 
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NOTE  The exercises in this lesson build from the tools and skills you learned in the 
previous lesson. If you skipped ahead to this lesson, you might need to look back 
at the previous lesson as a guide for skills and tools already covered. 

What Does the Dialogue Editor Do?
As the title suggests, dialogue editors are responsible for all the spoken words in the 
soundtrack, including dialogue, narration, and voiceover. In many cases, dialogue editors 
are also responsible for recording automated dialogue replacement (ADR).

However, in addition to dialogue, the dialogue editor is also responsible for all the 
production sound recorded during the shoot. When the picture editor is finished with a 
cut, they pass it to the Sound department, where the dialogue editors organize the sounds 
from the set into appropriate tracks. They also remove unwanted “production” sounds 
such as camera noise, buzzing lights, and squeaky dolly wheels. The dialogue editor also 
ensures that every syllable of dialogue is clear and present, even if it requires wading 
through outtakes to find a better-sounding take. They may also swap the sound in a wide 
shot with audio from clean close-up takes to improve clarity and presence. 

The dialogue editor’s “big picture” goal is to improve the clarity and consistency of each 
word within the context of a scene and create a seamless dialogue experience. So in 
addition to cleaning up and improving spoken words, they also fill in and smooth the gaps 
between lines to eliminate any silence or jarring changes in ambience between cuts that 
could distract from the dialogue-driven performances.

NOTE  The exercises in this book use the default DaVinci Resolve Fairlight page 
keyboard shortcuts. If you are using custom keyboard shortcuts, please set the 
Keyboard Customization layout on your system to the default DaVinci Resolve 
preset via the Keyboard Customization window available in the 
DaVinci Resolve menu. 
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Opening and Playing the Project 
In this exercise, you will restore the TML Audio Post project that contains the clips, scenes, 
timelines, and media from the film Too Much Life that you’ll use for Lessons 2 through 11. 
Then, you’ll save a copy of the project. 

1	 If necessary, open DaVinci Resolve.

2	 In the Project Manager, right-click and choose Restore Project Archive.

3	 Select R19 Fairlight Audio Guide Media > R19 Fairlight Part 2 > TML Audio Post.dra 
and click Open. Then, double-click the TML Audio Post project to open it.

The project opens in the Fairlight page with the 2 Multichannel Dialogue Start visible. 

This is a good time to reset the UI layout and save a working copy of the project so that 
you can keep the unaltered original project for later reference. 

4	 Choose Workspace > Reset UI Layout.

5	 Choose File > Save Project As.

6	 In the name field, type your initials after the project name. 

7	 Click Save. 
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Now that you’ve restored and saved a copy of the project, let’s review the project 
organization in the media pool.

Locating the Lesson Timelines in the Media Pool
You’ll work with this project for numerous exercises and lessons throughout this book. 
Before diving into dialogue editing, let’s go to the Lesson Timelines bin in the media pool 
to see the timeline organization for this project and open the first timeline.

1	 Show the media pool. In the media pool bin list, select Lesson Timelines > Lesson 02.

2	 If necessary, change the media pool to List view. 

Here, you will see all the timelines for this lesson. Each lesson includes sequential 
timelines starting with the lesson number. In this case, the first timeline is 2 
Multichannel Dialogue Start, which should already be open. You’ll work with this 
timeline shortly. For now, let’s open a different timeline that will serve as a reference 
for the finished scene. 

3	 Open the timeline 2f Ref Finished Scene. 

For subsequent exercises, you’ll simply be instructed to open a specific timeline. 

4	 Hide the media pool.



85Lesson 2  Editing Dialogue Tracks

NOTE  You can also access any of the lesson timelines for this book in the 
Timelines smart bin at the bottom of the media pool bins list if “Smart bin for 
timelines” is enabled in User Settings or in the Timeline dropdown menu. To see all 
the timelines in the Timeline dropdown menu, open the UI Settings panel of the 
User tab in the DaVinci Resolve Preferences and choose the Alphabetic option 
from the Timeline Sort Order dropdown menu. 

Monitoring Video Only
In a traditional audio-post workflow, an audio editor will need a separate reference 
video to use as a guide when building the soundtrack. In DaVinci Resolve, you do not 
need a reference video because the Fairlight page includes a handy viewer that shows the 
timeline’s video. For the purposes of this book, there will be reference movies of the film 
as needed to add context to the various exercises along the way. 

As you have already discovered, the viewer is located at the right side of the monitoring 
panel. You can easily expand the viewer as a separate floating window. 

1	 Play the first few seconds of the timeline 2f Ref Finished Scene to see the video in the 
viewer, as well as the audio levels in the mixer and monitoring panel meters. 

You may have noticed there is only one audio track, so there is no need for the mixer 
or full monitoring panel at this time. 
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2	 In the lower right corner of the viewer, click the Floating Window button or choose 
Workspace > Fairlight > Floating to convert the viewer into a floating window. 

The viewer appears in the middle of the interface. You can drag the top of the viewer to 
move it, and drag its edges or corners to resize it. 

3	 Click the Meters button to hide the monitoring panel. Then, hide the mixer.

4	 Drag the viewer down to the bottom of the empty tracks area in the timeline. Then, 
drag the upper right corner of the viewer to resize it to about twice its original size. 
When you are finished, the viewer should fit nicely in the lower half of the timeline. 

Feel free to resize or move the viewer at any time as you work through these exercises.
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To return the viewer to the monitoring panel, you can click the Dock button in the 
upper right corner of the viewer or press Return/Enter. For now, let’s leave the viewer 
open as a separate window.

TIP  If you have a second monitor connected to your system, you can choose the 
Dual Screen layout in the Workspace menu. You can also assign the video output 
to a second or third screen via the Workspace > Monitor > Clean Feed option. 

Previewing the Scene for Context
You are about to embark on a real-world audio post-production journey through several 
scenes from the feature film Too Much Life, directed by Sawyer Woods. Along the way, you’ll 
use professional tools and features in the Fairlight page to perform various audio post jobs 
as you turn raw production sound into a fully mixed stereo and 5.1 surround soundtrack. 

The film Too Much Life explores Kaua’i teenagers dealing with cyberbullying, social media, 
and online relationships. On the Hawaiian island of Kaua’i, middle schooler Harper Hudson 
campaigns for student body president. She tries to win the hearts of the students at 
Garden Island Middle School, but hijinks ensue as a colorful cast of characters must decide 
whether they will support or sabotage Harper. Will Harper Hudson become president, or 
will life become too much? 

MORE INFO  For more information about the film Too Much Life, 
click the following links:  
Trailer: www.youtube.com/watch?v=z8WS6h5mg8Y 
Kauai Film Academy: www.kauaifilmacademy.org

1	 Press Shift-Z to zoom the timeline horizontally to fit the visible timeline area. 

2	 Play the timeline to see and hear the first part of the scene for context. When finished, 
stop playback.

You just listened to an early pre-mixed version of the scene. Now, let’s go back to the 
original master clip to hear the same part of the scene with the original production 
sound. This time, instead of finding the timeline in the media pool, you’ll use the handy 
user-defined Timeline menu, which shows recent timelines or all timelines in a project. 

http://www.youtube.com/watch?v=z8WS6h5mg8Y
http://www.kauaifilmacademy.org
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3	 In the upper left corner of the timeline window, click the Timelines dropdown menu 
to see the project’s recent timelines. In the list of timelines, choose 2 Multichannel 
Dialogue Start. 

While you are focused on the upper left corner of the timeline window, let’s also 
open the Timeline Options menu and show the video track. As you may have guessed, 
the Timeline View Options menu is where you’ll find options to show or hide additional 
timeline elements such as the video tracks. 

4	 In the Timeline View Options menu, click the Display Video Tracks option. 

The 1 Video 1 track appears above the A1 Audio 1 track in the timeline. By default, 
video clips are blue.

5	 Play the timeline and listen to the production sound.
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Thoughts? It doesn’t take long to realize the many challenges ahead for the dialogue editor 
(you) in this lesson. For example, this scene was shot on location at the beach, so you hear 
the ocean waves sometimes louder than the voices themselves. You can also hear the 
director calling the shots during the take. Those issues and many more are easily identified 
and fixed in the Fairlight page. 

If you are wondering where to begin, that’s easy. Like any dialogue editor, you’ll start by 
identifying the different recorded microphone sources for the scene and choosing which 
one to play in the timeline.

Preparing Multichannel Clips 
for Dialogue Editing
When editing production dialogue recordings, one of the first things you must do is 
determine how many microphone channels you’ll work with and how you want to manage 
them to simplify the editing process. Fortunately, the Fairlight page allows you to change a 
clip’s audio format and source channels as well as track format at any time. This is 
incredibly important when dealing with multiple microphone sources and multichannel 
clips. Understanding how to manage your multichannel clips is crucial for properly setting 
up your clips and timelines for successful audio editing. In fact, about 80% of all the 
troubleshooting questions this author receives regarding audio editing in Resolve stems 
from a lack of understanding about channel mapping. The good news is that once you step 
through the following exercises, you’ll be armed with the skills needed for all future 
projects, whether you’re dealing with multichannel audio, eliminating an unwanted 
channel, or simply isolating the center channel (dialogue) from a 5.1 surround timeline clip.

Let’s start by taking a closer look at the clip in the timeline.

1	 Double-click the audio clip in the A1 track to open the Clip Attributes dialog.



90Lesson 2  Editing Dialogue Tracks

2	 In the Clip Attributes dialog, click the Audio tab. 

The Audio panel shows the format and source channel(s) for the current timeline clip. 
As you can see, the clip format is Mono, and the Source Channel is 3-Boom (Linked). 

3	 Click the Source Channel dropdown menu to see all the available channels for the clip. 
Leave the channel set to 3 – Boom (Linked).

With DaVinci Resolve 19.1 and higher, you can also see and change the clip’s source 
channel directly in the timeline or File tab of the Inspector. 
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4	 Show the Inspector and click the File tab to see that panel. 

In the Audio Configuration section of the File Inspector, you can clearly see the clip 
format and current channel. 

5	 Click the Source dropdown menu in the Audio Configurations area of the File Inspector 
to see all the channel options for the currently selected clip. Leave the clip source 
channel set to 3-Boom. Keep the Inspector open.

Now that you have seen how to identify and change the current source channel in the Clip 
Attributes and Inspector, let’s see how to set the source clip’s audio channel configuration 
before it is edited to the timeline. 

Auto Syncing and Setting Audio 
Channels in a Source Clip
In this exercise, you’ll use DaVinci Resolve’s intuitive Auto Sync feature to sync picture with 
sound and choose which audio channels you want to include in the source clip. Although 
we are only working with one set of clips for this exercise, you could easily apply this 
technique to an entire bin filled with source video and audio clips. 

1	 Show the media pool. 
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2	 In the media pool bin list, select the TML Media > Multichannel Dialogue bin. 

The Multichannel Dialogue bin includes two clips, one video and the other audio. 
These are the original versions of the source video and audio clips for the 
current timeline.

3	 In the Multichannel Dialogue bin, select the A024_C006_04047FE_001 video clip. 

When a source clip is selected, you can see the audio channels in the media pool 
preview player and the file panel in the Inspector. In this example, the video clip has 
two audio channels: stereo left and right.
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4	 Play a few seconds of the clip in the preview player to hear the stereo audio.

It sounds very similar to what is currently in the timeline. You can also play the clip in 
the Inspector to hear the current audio channels. Next, let’s listen to the audio file that 
was recorded by the location sound mixer.

5	 In the media pool, select the HarperSurf_Day1_05.wav clip. 

In the preview player, you can clearly see three separate channels of audio. To 
determine what they are, you only need to glance at the File tab of the Inspector.

The Inspector shows that the current clip format is 3 ch. – mono, and the channels 
from top to bottom are 1-MixL, 2-MixR, and 3-Boom. The channel names are part of 
the embedded audio information that was retained when using the Auto Sync dialog. 

NOTE  You can also add or change the names of audio channels in the Audio 
Tracks group in the Metadata panel. 

6	 Click the Metadata button located to the left of the Inspector button to show the 
Metadata panel.
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7	 Click the Format dropdown to see the current choices for the 3 channels. 

Whichever clip format you choose will determine how the audio will be formatted when 
edited to the timeline. For example, 3-ch Mono means the clip will be edited to the 
timeline with a different mono channel on three separate audio tracks, while 3-ch 
Adaptive places all three channels into a 3-channel adaptive clip that can be edited to 
an adaptive 3-channel track. Adaptive clips and tracks can have up to 36 channels to 
accommodate immersive audio formats. 

We aren’t quite ready to change the format of the clip. First, let’s sync it to the video 
clip. When you use the Auto Sync feature in DaVinci Resolve, you can choose how you 
want to sync the video and audio clips, as well as which channel to use and which 
information to retain. 

8	 In the Inspector, select the video and audio clips in the Multichannel Dialogue bin.

9	 Right-click the selected clips and choose Auto Sync Audio from the contextual menu.

10	 In the Automatically Sync Audio dialog, choose the following settings:

	— Synchronize using Waveform

	— Use channel number 1

	— Retain embedded audio 

	— Retain video metadata
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11	 Click Sync.

12	 In the Inspector, select the video clip in the Multichannel Dialogue bin.

The newly synced clip now includes five audio channels: the original two stereo 
channels plus the three mono channels from the audio clip. Let’s see it in a new 
timeline. 

NOTE  In DaVinci Resolve, clips can have up to 36 audio channels.

13	 Right-click the A024_C006_04047FE_001 clip in the media pool and choose Create 
New Timeline Using Selected Clips.

14	 In the Create New Timeline dialog, name the timeline Multichannel Test and 
click Create. 

As expected, the timeline opens with one stereo and three mono tracks. 
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15	 Select the audio clip in the timeline to see the Audio Configuration in the Inspector.

Now, let’s modify the source clip’s Audio Configuration before adding it to a timeline. 
Keep in mind that you can always change a clip’s format or channel configuration in the 
Clip Attributes after it is in the timeline.

Changing Source Audio in the Inspector
For this exercise, you’ll go back to the synced clip in the media pool and change the 
Audio Configuration in the Inspector so that it only includes the 3-Boom channel while 
editing to the timeline. How? The Audio Configuration controls in the Inspector offer 
options to preview, mute, or deselect channels. Don’t worry about limiting your channel 
options. DaVinci Resolve doesn’t delete unused channels; they simply aren’t exposed 
in the timeline. 

1	 In the media pool, select the A024_C006_04047FE_001 clip.
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2	 In the Inspector Audio Configurations, uncheck all the audio channels except for the 
3-Boom channel. 

3	 Right-click the A024_C006_04047FE_001 clip in the media pool and choose Create 
New Timeline Using Selected Clips.

4	 In the Create New Timeline dialog, name the timeline Multichannel Boom Only and 
click Create. 

It’s the same clip, but a completely different result this time. Mission accomplished! You 
have narrowed down the five audio channels to one mono track. 

5	 Select the audio clip in the timeline and look at the Audio Configuration in the 
Inspector. 

Here, you’ll see only the channels currently showing in the timeline. 
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6	 In the Audio Configuration controls, click the A1 channel dropdown menu to see the 
available channels. Leave the channel set to 3-Boom. 

 

That’s it! Now you know how to identify and choose audio channels for dialogue clips 
before and after they are in the timeline. It’s time to move on to dialogue editing. 

NOTE  You can also change a clip’s audio format and switch mono channels 
directly in the timeline. You’ll try that later in this lesson. 

Preparing the Timeline 
for Dialogue Editing 
The Fairlight page is loaded with settings and shortcuts designed to enhance and speed 
up your audio editing experience. Let’s set up the timeline before you dive into editing. 
This will only take a few minutes, and the time it takes to prepare the timeline for dialogue 
editing is nothing compared to the time you’ll save by using the new settings. 

First, you’ll increase the track height, waveform, and horizontal zoom to increase waveform 
visibility. Then, you’ll enable several timeline view options to keep the playhead in focus and 
simplify navigation between clips. Finally, you’ll engage sample-level scrubbing to help 
pinpoint where and when to edit the clips.
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1	 Open the 2 Multichannel Start timeline. Close any unnecessary panels so that only 
the timeline and viewer are visible.

2	 Drag the lower edge of the A1 track header to increase the height of the A1 
Harper track.

3	 Choose View > Zoom Audio Waveform > Increase Height or hold Option-Command 
(macOS) or Alt-Ctrl (Windows) while scrolling the middle mouse wheel to zoom the 
audio waveform. 

4	 Repeat step 2 as needed to increase the waveform zoom until you can clearly see the 
waveform as a guide for splitting the clip into parts. 

TIP  You’ll also find options to Zoom or Reset in the Track Waveform Zoom 
options available in the (right-click) shortcut menu. 

Next, you’ll zoom horizontally for a closer view of the waveform as the timeline scrolls 
beneath the fixed playhead.

5	 Zoom the timeline horizontally until the ruler shows only about 4 seconds. 
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Using Fixed Playhead Mode 
for Scrolling Playback
Normal page-scrolling playback is highly functional for both picture editing and audio 
editing. However, at times, you need a seamless playback experience to focus all your 
attention on the sounds and waveforms of the clips as they scroll beneath the playhead. In 
that case, you can turn on Fixed Playhead mode. This mode is terrific for listening to and 
editing clips in part because you can always see ahead to the waveform that is coming up. 
There is also a No Scrolling option for which the playhead continues moving offscreen 
without updating the visible portion of the timeline.

1	 In the Timeline View Options menu, set the Timeline Scrolling to Fixed Playhead. 
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The playhead and the first clip now start in the middle of the timeline. To move the 
fixed playhead to a different position, drag the top of the playhead where it crosses 
the ruler. Let’s drag the playhead closer to the track header. 

2	 In the timeline ruler, drag the top of the playhead toward the left as far as you can 
toward the track header. 

3	 Play the first part of the timeline to see and hear the waveform as it passes beneath 
the fixed playhead. When finished, stop playback and press Home to return the 
playhead to the beginning of the timeline. 

While admiring the Fixed Playhead mode’s scrolling playback, you probably noticed that it 
is easy to focus on the waveform as it scrolls beneath the playhead.

Setting the “Jump to” Options 
Another handy setting for dialogue editing is Jump to Clip. Once this feature is enabled, 
you can jump to the start or end of clips simply by pressing the Up Arrow or Down Arrow 
keys, respectively. The Jump to options are available in the Timeline View Options menu. 

1	 Click the Timeline View Options menu button to view the options. 
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As you can see, there are four Jump to options, including Clip, Fade, Marker, and 
Transient. You’ll work more with the other Jump to options in later lessons. For now, 
you’ll enable the Jump to Clip option, which is controlled by the Up/Down Arrow keys.

2	 Click the Jump to Clip option, if necessary, to enable it. 

3	 Press the Down Arrow key to jump the playhead to the end of the clip. Press the Up 
Arrow key to jump to the beginning of the clip. 

You’ll find this more useful once you start adding edits and need to jump from clip to clip in 
the timeline. 

Hiding the Video Track and Busses
As you learned in Lesson 1, using the Razor tool or its shortcut will only cut selected clips 
or tracks. When nothing is selected, the razor cuts all clips at the playhead. So before you 
start racing along the timeline splitting audio with the razor shortcut, you should consider 
putting away the video tracks for safekeeping. You don’t have to hide the video tracks to 
edit synced audio. In fact, sometimes it can be useful to see the edited clips in the video 
track while you edit the audio. However, in this case, while you are learning your way 
through the shortcuts and lightning-fast editing techniques, it’s a good idea to hide any 
tracks you don’t intend to split. 

1	 Show the Timeline View Options menu again. 

2	 Click the Display Video Tracks option to disable it. 

The video track is no longer visible at the top of the timeline. To streamline the timeline 
editing, let’s also hide the B1 Bus 1 track. Busses only show in the timeline when 
Automation is toggled on, which is a default setting in the Fairlight page. 
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3	 Click the Toggle Automation button (red) to turn off automation and hide the bus in 
the timeline.

The video and bus tracks no longer show in the timeline. 

Scrubbing Audio at the Sample 
Level Using Loop Jog
DaVinci Resolve offers tape-style scrubbing in the Fairlight timeline for manually 
controlling the speed and direction of the playhead over the clip. Scrubbing is the term 
used for listening to audio as you move the playhead back and forth over an audio clip in 
the timeline. Loop jog scrubbing, on the other hand, provides a sample-level preview of the 
audio while scrubbing the playhead. Both types of scrubbing are available in the Timeline 
menu. Audio scrubbing is turned on by default, and you can toggle it on and off by 
pressing Shift-S. In this exercise, you’ll enable loop jog scrubbing for precision edits and 
check the Loop Jog settings in User Preferences. 

1	 In the Timeline menu, locate the Audio Scrubbing option and make sure it is enabled. 

Let’s test-drive the audio scrubbing in the timeline. To scrub, drag the playhead back 
and forth over the clips at whatever speed you choose. Since the playhead is fixed, 
you’ll drag the ruler to scrub the audio beneath the playhead.
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2	 At the top of the timeline, grab the ruler above the first set of waveform peaks and 
drag toward the left, passing the playhead. Scrub the ruler back and forth as needed 
to locate the beginning of the first line of dialogue when Harper says, “It’s rough.” 

In addition to manual scrubbing, you can use keyboard shortcuts to scrub one frame 
at a time.

3	 Press the Right Arrow key to scrub forward one frame at a time. Then, use the Left 
Arrow to scrub one frame at a time in reverse. 

4	 Hold K and tap L to scrub forward one frame at a time. Hold K and tap J to scrub one 
frame at a time in reverse. 

5	 Press Shift-S to toggle audio scrubbing off. 

6	 Scrub the clip again manually and with keyboard shortcuts. This time, you shouldn’t 
hear anything.

NOTE  Toggling audio scrubbing off does not affect JKL standard playback, 
fast forward, reverse, or slow motion. It does prevent you from hearing 
playback when using keyboard shortcuts to play one frame at a time. 

7	 Press Shift-S to toggle audio scrubbing on.

Now that you are familiar with standard audio scrubbing, let’s enable loop jog 
scrubbing.
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8	 In the Timeline menu, choose Loop Jog to enable loop jog mode. If necessary, enable 
Audio Scrubbing before enabling Loop Jog in the Timeline menu.

9	 Drag the ruler to scrub the playhead over the beginning of the clip once again. When 
you reach Harper’s words, hold the ruler or playhead still. 

This time, you could probably hear much more detail as you scrubbed the playhead. 
The fast-looping sound you hear is an 80-ms (millisecond) sample preview of the 
sound preceding the playhead. If the Timeline Scrolling option were set to Page 
Scrolling, you would drag the playhead to scrub and engage loop jog instead of 
dragging the ruler. 

10	 Release the ruler. Press the Up Arrow key to move the playhead to the beginning of 
the clip. 

11	 Press Command-, (comma) in macOS or Ctrl-, (comma) in Windows to open the 
Preferences panel. 

12	 Click the User button to show the User Preferences panel, and in the preferences 
sidebar, click the Fairlight tab. 

In the Fairlight General Settings, you’ll see the Loop Jog Alignment dropdown menu and 
a field in which to set the Loop Jog Width. The default setting is 80 ms (milliseconds). 

13	 Click the Loop Jog Alignment dropdown menu to see the options. 
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14	 If necessary, change the Loop Jog Alignment to Pre and the Loop Jog Width to 80 ms. 
Click Save.

With this pre-playhead setting, you can scrub forward slowly over a word or phrase and 
hear exactly when a word starts or ends. This can be useful for identifying dialogue to edit 
and sounds you may want to eliminate. 

NOTE  You can set the loop jog with up to 2000 ms. Each second of video equals 
1000 ms. So by setting the loop jog amount to 2000 ms and centering it around 
the playhead, you will hear 1 second before and after the playhead. The default 80 
ms setting is good for identifying when a specific sound, such as dialogue, 
starts or stops.

That’s it. You’ve successfully zoomed the waveform and timeline, enabled fixed playhead 
scrolling, set the Jump to Clip option, hidden the video and bus tracks, and enabled loop 
jog scrubbing. The dialogue editor (you) and the timeline are prepped and ready to go.

Checkerboard Editing 
on Dialogue Tracks
Once a scene is edited and the best audio channels are chosen in the timeline, it’s time to 
split and move all the dialogue clips to separate tracks for each character. This process is 
referred to as checkerboard editing because of the way the tracks look when the process 
is completed.

The primary reason for separating the dialogue for each character is so that each 
character has an individual track when you’re adjusting volume, equalization, and 
dynamics processing, and creating the final mix. This editing technique is essential for all 
projects, whether scripted narrative, unscripted, dramatic, corporate, or documentary.

In the next series of exercises, you’ll follow a checkerboard editing workflow that starts 
with creating tracks for each character plus a production effects (PFX) track to 
accommodate any non-dialogue sound picked up by the microphones. Many of these 
steps utilize skills that you have learned in previous exercises.
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1	 Fast forward through the first part of the clip while looking at the viewer to count how 
many characters are in this scene. Stop playback at around 01:00:10:18.

Time for some quick track math. There are four characters, so you will need one track 
for each character plus two additional tracks to accommodate the director and the 
production sound between spoken words. Since there is already one track, you will 
only need to add five more tracks.

2	 Right-click the A1 track header and choose Add Tracks.

3	 In the Add tracks dialog, use the following settings:

	— Number of tracks: 5

	— Insert Position: Below Audio 1

	— Audio Track Type: Mono
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4	 Click Add Tracks.

The timeline now has six audio tracks. Next, you’ll resize and name the tracks, starting 
with track A1. 

5	 Adjust the timeline’s vertical zoom level until you can see all six tracks above 
the viewer. 

6	 Double-click the A1 track name and type Harper. Press Tab to select the track name for 
the next track.

7	 Name the other tracks as follows: A2, Raina, A3 Marley, A4 Levi, A5 Director, A6 PFX. 

While setting up the tracks, let’s color them as well. For this lesson, since you aren’t 
familiar with the script or characters, you’ll color the character’s tracks to match their 
shirt colors onscreen. They wear these colors consistently throughout the film. As you 
learned in Lesson 1, you can change track colors in the timeline or tracks index. 

8	 Right-click the A1 Harper track and choose Change Track Color > Navy. 

9	 Color the remaining tracks from top to bottom as follows: A2 Raina – Pink, A3 Marley – 
Olive, A4 Levi – Blue, A5 Director – Tan, A6 PFX – Green (no color change).
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Next, you’ll split the clip and move each section to the correct track. 

NOTE  Whether a scene is edited with many shots, angles, and clips or one long 
choreographed shot, the dialogue editor still needs to separate each character’s 
dialogue to a track for that character. 

Splitting the Clip 
In Lesson 1, you learned several methods of splitting an audio clip, including keyboard 
shortcuts and the Range tool. In this exercise, you’ll use the playhead and keyboard 
shortcuts to navigate and split the clip to separate the dialogue from the production 
sound. You’ll use the JKL keys to navigate the clip, so as a reminder: L plays forward, J plays 
backward, K stops playback, and tapping the L or J keys multiple times will speed up 
playback. Holding down L or J will play one frame at a time and stop playing when you 
release the key. Holding down K while tapping L or J will play forward or backward one 
frame at a time, whereas pressing K together with L or J will play in slow motion. 

To split the clip at the playhead position, you’ll use the Razor shortcut and press 
Command-B (macOS) or Ctrl-B (Windows). First, you’ll need to move the playhead to the 
beginning of the timeline and resize the tracks as needed.

NOTE  For the following exercises, you will continue working with the same 
timeline. If you haven’t completed all the previous exercises, feel free to open and 
continue working with the 2a Checkerboard Edit Start timeline. You may need to 
follow the steps in the section “Preparing the Timeline for Dialogue Editing” above 
to enable the necessary timeline options to follow along with the next steps. 

1	 Press the Up Arrow key to move the playhead to the beginning of the A1 track. 

2	 Right-click the A1 Harper track header and choose Lock Track Height to > Large.  
Then use the Vertical Zoom slider or Shift-scroll the middle mouse wheel to reduce the 
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vertical height of the remaining tracks until you can see them above the 
floating viewer. 

As you can see, locking the height of your primary track allows you to resize the other 
tracks as needed without affecting the locked track.

3	 If necessary, select the A1 track.

When a track is selected, clips beneath the playhead are also selected automatically. 
This is one of the secrets to fast keyboard editing in the Fairlight page. 
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4	 Using the JKL keys, play the A1 track from the beginning. Stop before the first spoken 
words, “It looks rough,” at around 1:00:00:15.

5	 Press Command-B (macOS) or Ctrl-B (Windows) to split the clip at the playhead position. 

6	 There are now two clips in the A1 track. Notice that the second clip starts at the 
playhead position and is already selected. 

Next, you’ll move the playhead to the end of the first dialogue line. You can watch the 
viewer for the character’s lip movement to assist in finding the start and end of 
dialogue. 

7	 Navigate using the JKL or Arrow keys or by scrubbing to the end of the first phrase, 
“It looks rough,” at around 1:00:1:10. 

8	 Split the clip.

Harper’s first line of dialogue has been separated from the production sound on either 
side of her first line. Next! 

The goal here is to introduce you to one possible dialogue editing workflow in the 
Fairlight page. So don’t worry about making the perfect edit. You can always trim the 
clips later as needed. 

The clip level and waveform in the next section are fairly low compared to the 
background sound. For the next line, let’s increase the clip gain on the remaining 
unedited clip so you can hear it better as you edit.

9	 Drag the gain line on the third clip upward to increase the gain to around 12 dB. 

10	 Play forward to the next dialogue. This time, it is Marley saying, “It’s just a few pictures.” 
Split the clip starting at around 01:00:01:17 and ending at 01:00:03:04.
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The next line doesn’t happen for a few seconds, so let’s decrease the horizontal zoom 
to see more of what is coming up next in the waveform. 

11	 Press Command -– (minus) (macOS) or Ctrl -– (minus) (Windows) to reduce the 
horizontal zoom. 

When working with fixed playhead timeline scrolling, changing the horizontal zoom 
level automatically centers the fixed playhead. If you prefer the playhead farther to the 
left, you’ll need to drag from the ruler area to reposition it. 

The Fairlight page is very user friendly, so from this point forward, feel free to adjust 
the clip level, track height, viewer size, viewer position, and zoom levels to suit your 
needs while you work. 

12	 Play the clip forward to the next line, around 01:00:11: 20, where Harper says, “What is 
this?” Split the clip. 

13	 Split the next clip where Raina says, “Surf Wax.”

14	 Split the next clip where Raina says, “You don’t need that.”

15	 Play forward and split the clip where the director says, “Cameras going off.”

16	 Play forward and split the clip where Harper yells, “Stop.” 
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Hopefully, by now, you have a bit of a rhythm with your navigation and editing shortcuts as 
you play, scrub, listen to, and split the different key dialogue elements in the track. You’ll 
continue splitting the track in a few minutes, but first, let’s look at the next part of the 
workflow, where you move clips to their representative tracks.

NOTE  For this exercise, you will continue working with the same timeline. If you 
didn’t complete the previous exercise, feel free to open and continue working with 
the 2b First Clips Split timeline.

Using Shortcuts to Move Clips Between Tracks 
Sure, you could manually drag clips between tracks using your mouse. But professional 
audio editing is all about precision editing and shortcut-driven efficient workflows. By 
design, the Fairlight page is a fully loaded digital audio workstation (DAW) packed with easy 
shortcuts that enable lightning-fast audio editing. For example, moving clips between 
tracks using keyboard shortcuts is similar to moving text between lines in a word-
processing program. In fact, the shortcuts to cut, copy, and paste are identical to the 
shortcuts in most word processors. 

In this exercise, you’ll use shortcuts for everything from selecting tracks to moving the 
playhead and editing the selected clip to a different track. 

The keyboard shortcuts for clip editing are identical in macOS and Windows. Their only 
differences are the modifier keys. In macOS, you’ll use the modifier keys Command and 
Option, whereas on a Windows system, you’ll use the modifier keys Ctrl and Alt. 

For the first part of this exercise, you’ll use the menu to apply a command. Then, you’ll 
use the keyboard shortcut the next time you use that command. After that, you’ll be ready 
to fly through your workflow using only shortcuts to finish the job. Don’t worry about 
memorizing the shortcuts. You likely already know them, and if not, you’ll pick them up 
after a single use. 

1	 Press Home to move the playhead to the beginning of the timeline. 
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2	 Choose Timeline > Track Destination Selection > Audio Destination A1 to select the A1 
track. While the menu is visible, look at the other Track Destination Selection options 
and shortcuts. 

Notice that the keyboard shortcut to select the A1 track is Option-Command-1 (macOS) 
or Alt-Ctrl-1 (Windows). Also, in the Track Destination Selection options, you’ll see that 
the shortcuts to Move Audio Track Destination Up or Down use the same macOS/
Windows modifier keys along with the Up Arrow or Down Arrow keys. Looking closely 
at the list of shortcuts from Audio Destination downward, you’ll see that the Audio 
shortcuts all use the same two modifier keys. So the good news is that you only need 
to remember the two modifier keys and track number or the Up and Down 
Arrows. Easy. 

You already use the JKL shortcuts for navigation, so in this exercise, you’ll use the Down 
Arrow or Up Arrow keys to move between clips because when a track is selected, the 
arrow keys move the playhead to the next clip in the track and select that clip 
automatically. Let’s try it.
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As you can see, with the A1 track already selected, the clip touching the playhead in the 
track is also selected. 

3	 Scrub the first clip. 

Clearly, this is production sound without dialogue and belongs in the A6 PFX track. So 
you’ll now use a command to cut the clip. Once cut, you can select the A6 track as the 
destination and paste the clip in the new track. Look at the Edit menu to verify which 
shortcuts you’ll need. 

4	 Click the Edit menu and look at the common edit commands and shortcuts.
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The shortcut for Cut is Command-X (macOS) or Ctrl-X (Windows). 

The shortcut for Copy is Command-C (macOS) or Ctrl-C (Windows).

The shortcut for Paste is Command-V (macOS) or Ctrl-V (Windows). 

Most likely, these are the same shortcuts you use for text editing as well. 

5	 Choose Edit > Cut or press Command-X (macOS) or Ctrl-X (Windows).

The selected clip turns semitransparent to indicate that it has been cut from its current 
position and is ready to be moved and pasted elsewhere. 

6	 Press Command-Option-6 (macOS) or Ctrl-Alt-6 (Windows) to select the A6 track. 

The semitransparent clip appears in the exact same position on the A6 track.

7	 Press Command-V (macOS) or Ctrl-V (Windows) to paste the clip into the new track.

The clip is moved. Keep in mind that cutting-and-pasting destinations are actually 
based on the playhead position. So be careful not to move the playhead after you cut a 
clip if you are simply moving it to a different track. 
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8	 Press Command-Option-1 (macOS) or Ctrl-Alt-1 (Windows) to select the A1 track.

The A1 track is selected and ready for you to select and move the next clips. Notice 
that the clip you pasted into the A6 PFX track is green to match the track color. All the 
clips you move will change to the color of their track while on that track. 

Let’s move on to the next clip. Remember, the Up Arrow and Down Arrow keys jump to 
the previous or next clip. Pressing the Down Arrow key moves down the timeline, 
stopping at the head and tail (first and last frame) of each clip as it goes. 

9	 Press the Down Arrow to move down the timeline to the head of the second clip. 

This clip has Harper saying, “It looks rough,” so it belongs right where it is in the A1 
Harper track. 

10	 Press the Down Arrow to select the third clip, which is another A6 PFX clip. Cut the clip, 
select the A6 track, paste the clip, and return to the A1 track. If you need more 
guidance, repeat steps 5 through 8.

11	 Press the Down Arrow to select the next clip. 

12	 The selected clip is Marley saying, “It’s just a few pictures” and belongs on the A3 track. 

This time, instead of using the shortcut plus track number to select a track, you’ll use 
the shortcut plus the Down Arrow. Pressing Command-Option-Down Arrow (macOS) 
or Ctrl-Alt-Down Arrow (Windows) or Command-Option-Up Arrow (macOS) or Ctrl-Alt-
Up Arrow (Windows) moves the track selection down or up, respectively, one track at a 
time. This is an easy way to cut and paste clips between nearby tracks. Let’s try it. 

13	 Cut the selected clip in the A1 track. Press Command-Option-Down Arrow (macOS) or 
Ctrl-Alt-Down Arrow (Windows) twice to move the track selection down to the A3 track. 
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14	 Paste the clip into the A3 track. Press Command-Option-Up Arrow (macOS) or Ctrl-Alt-
Up Arrow (Windows) twice to move the track selection up to the A1 track. 

You’ve got this! Keep it going. Time to get in a groove with these new shortcuts to 
navigate, select, cut, move, paste, and repeat. Best of all, you can split and move clips 
to create your checkerboard edit without touching your mouse. 

15	 Move the remaining clips as follows:

	— Clip 5 to A6 PFX

	— Clip 6 stays on A1

	— Clip 7 to A6 PFX

	— Clip 8 to A2 Raina

	— Clip 9 to A6 PFX

	— Clip 10 to A2 Raina

	— Clip 11 to A6 PFX

	— Clip 12 to A5 Director

	— Clip 13 to A6 PFX

	— Clip 14 stays on A1 

Once you finish the first 14 clips, stop and check your progress. 

16	 Press Home to move to the beginning of the timeline. 
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17	 Press Shift-Z to zoom out horizontally to see the checkerboard edit so far.

NOTE  If you are ready to move on to the next section but want to see the finished 
checkerboard edit, open the timeline 2c Checkerboard Edit Finished.

Finishing the Job
You’ve done excellent work setting up the dialogue tracks, splitting the audio, and moving 
clips to their designated tracks. You’re hired! As an intern. No money, of course, but you’ll 
gain lots of experience and infrequent compliments.

You’re now on your own to finish separating out the dialogue tracks. It’s up to you to use 
the same shortcuts to locate, split, and move the remaining dialogue elements to 
their tracks. 

If you make any mistakes, just choose Edit > Undo and try again.

You could go through and split all the clips first and then move them to their tracks in a 
second pass. Or you can split and move as you go. It’s up to you. 
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You can also select multiple clips, such as PFX sounds, and cut, move, and paste them 
simultaneously. 

There are a few things to consider when it comes to checkerboard editing. Some audio 
clips include production sounds such as breathing and rustling clothes. Breathing, sighs, 
snorts, giggles, and so on are considered part of the dialogue performance and should be 
moved to the associated character’s track. If the scene were dubbed in another language, 
the actor performing the new lines would also need to perform the breaths, sighs, and 
other vocalized sounds. 

Clothing movement, footsteps, and other naturally occurring production sounds (nat 
sound) picked up by the microphones are often replaced with Foley sound recordings. 
You’ll work more with Foley sound effects and other sound design elements in Lessons 3, 
5, and 8. 

Have fun! When you are finished, you can move on to the next section. 

Resetting the Timeline for 
Balancing Clip Levels
Before moving on to the next dialogue editing exercise, let’s take a minute to reset some of 
the timeline options that were enabled for the checkerboard editing workflow. For this 
exercise, you’ll use a premade timeline with the checkerboard edit finished.

1	 Open the timeline 2c Checkerboard Edit Finished. 

2	 In the Timeline View Options menu, set Timeline Scrolling to Page Scrolling. 

3	 Press Shift-Z to fit the clips horizontally in the visible timeline.

4	 Right-click the A1 track header and choose Lock Track Height to > None.

5	 Adjust the vertical zoom until all six tracks fit the timeline tracks area. 

To reset the clip levels, you can select all the clips at once, and then use the Remove 
Attributes feature to remove any level changes. 

6	 Click an empty space in the timeline. Choose Edit > Select All or press Command-A 
(macOS) or Ctrl-A (Windows) to select all clips in the timeline. 

Clips are outlined in red when they are selected. 

7	 Right-click any of the selected clips and choose Remove Attributes.
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8	 In the Remove Attributes dialog, select the Volume option. Click Apply. 

The clip gain for all the selected clips returns to their original levels. 

9	 Right-click the empty track space and choose Track Waveform Zoom > Reset Zoom 
All Tracks. 

Done! The timeline has been reset for whatever comes next.

NOTE  DaVinci Resolve 20 Studio includes new AI-based dialogue editing tools 
available in the timeline right-click shortcut menu, including Remove Silence and AI 
Tools > Checkerboard to New Tracks. 

Switching Mono Audio 
Channels in the Timeline
If you recall, prior to creating the checkerboard edit, you set up the channel configuration 
and source audio channel for the dialogue clip. Now that the dialogue has been edited to 
different tracks, you may want to switch some of the clips to a different audio channel. 
Perhaps the sound for one clip is better from a different source channel. Maybe you want 
to hear the wireless mic versus the boom or the production sound mixer’s version of the 
source audio. Whatever your reason, it’s important to know how to access your other audio 
channels once the clips are in the timeline. For this exercise, you’ll work with Harper’s last 
line of dialogue, which is the fourth clip in the A1 track. You’ll start by looking at the clip in 
the Inspector and showing the current audio channel’s name in the timeline clip header. 
Then, you’ll mark a clip with the Range tool and start looped playback while you switch 
between the different channels to hear them. Let’s get started. 
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1	 Press R to switch to the Range tool. 

2	 In the timeline, move the playhead to the beginning of the fourth clip in the A1 track. 

3	 Select the clip.

The clip is selected with In and Out points marking the clip.

4	 Zoom horizontally and scroll as needed until you can clearly see the entire clip, its 
waveform, and the clip header.

5	 Show the Inspector and in the File panel check the Audio Configuration for the 
selected clip. 

As expected, the clip is currently set to the 3 – Boom channel. 

Next, you’ll show the source audio channel in the timeline clip headers.
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6	 Choose Fairlight > View Clip Info Display to open that dialog.

7	 In the Clip Info Display dialog, enable the Channel Name option. Then click OK.

The channel name now appears in the timeline clip header, and just as with the 
Inspector, you can see that the mono channel in the timeline is 3 – Boom. Now you can 
turn on looped playback to repeatedly play from the In to Out points, which, in this 
case, is the selected clip.

NOTE  Looped playback is a great way to focus on a specific clip or section of 
the timeline between the In and Out points. To engage looped playback, turn 
on the Loop button and move the playhead within the selected range before 
starting playback. 

8	 Choose Playback > Loop or click the Loop button in the Transport controls to enable 
looped playback.



124Lesson 2  Editing Dialogue Tracks

9	 If necessary, move the playhead to the selected clip. Press the Spacebar to start 
looped playback. 

10	 During looped playback, right-click the selected clip and select Audio Channel > 
Embedded Channel 1. 

With DaVinci Resolve 19.1 and higher, you can also switch audio channels on mono 
clips in the timeline with a simple Command-Control click. If you have a two-button 
mouse, you can Command-right-click (macOS) or Ctrl-right-click (Windows). If you don’t 
have a two-button mouse, press Command/Ctrl and click for the same result. 

11	 Continue looped playback. Command/Ctrl-click the clip to see the audio channel 
shortcut menu. Choose the 3-Boom channel. 

12	 Stop playback. Click any empty space to clear the range. 

13	 Press Shift-Z to fit the clips horizontally. 

14	 Press A for the Pointer mode selection tool. 

15	 Hide the Inspector. 
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That’s all the tools and techniques you need to select audio channels, split clips, create 
tracks, create a checkerboard edit, and even change audio channels after they are edited. 
Not bad for a single lesson. But wait, there’s more… 

NOTE  If you did not complete the project in Lesson 1, follow the steps at the 
beginning of Lesson 1 to create and name a new project. Then open the project 
and choose File > Import > Timeline. On your system, navigate to the Lesson 1 
back timelines folder in the Part 1 media that you downloaded for the book and 
import the Podcast Intro v1.drt timeline.

Preparing the Project
For the remainder of the lesson, you’ll continue working with the Post Park Normal Intro 
project you created in Lesson 1. Before diving into the exercises, you’ll need to open the 
project and import a timeline.

1	 In the Project Manager, open the Post Park Normal Intro project. 

2	 Choose File > Save Project As.

3	 In the name field, type your initials after the project name. 

4	 Click Save. 

5	 Choose Workspace > Reset UI Layout. 

6	 Hide the mixer and meters.

7	 Show the media pool and Tracks index. Change the media pool to List view.

The project currently includes one timeline Podcast Intro v1 and eight audio clips. 
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For the next exercises, you’ll import a timeline that includes tracks and various editing 
stages of a new voiceover clip. 

8	 Choose File > Import > Timeline, and then in the Finder window, navigate to R19 
Fairlight Part 1 > Lesson Timelines > Lesson 2 > VO6 Runner to Edit.drt.

9	 Click Import. 

The VO6 Runner to Edit timeline opens with one track showing. Tracks A2–A4 have 
been muted and hidden for now. They are available in the index if needed as a 
reference showing the various editing stages. Let’s locate the hidden tracks and new 
elements in the media pool before moving on to the next exercise. 

10	 Locate the four tracks A1–A4 in the Tracks index. Hide the index.

Over in the media pool, there is a new timeline and two additional clips, RUNNER_007 
and Runner comp_bounce. 

11	 Locate the VO6 Runner to Edit timeline and the RUNNER_007 clip in the media pool. 
Then, hide the media pool. 

Let’s also hide the B1 Bus 1 track to streamline the timeline for editing. 

12	 Click the Toggle Automation button (red) to turn off automation and hide the bus in 
the timeline.

Now that the project is ready, it’s time to move on to the next method of dialogue editing. 

TIP  You can quickly open recent projects by choosing them from File > 
Open Recent Project. Here, you’ll find a list of the 10 most recent projects. 
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Editing Consecutive Voiceover 
Takes in the Timeline
Another common dialogue editing technique involves editing voiceover or narration 
recorded as consecutive takes. In this case, these audio-only files need to be edited, 
combined, and refined to create the best composite take to be added to the master 
timeline. One advantage of audio editing over video editing is that you can cut together 
the best phrases, words, or even syllables without the audience being aware of your edits. 
The methods you’ll explore in the next series of exercises apply to any voice recordings 
with consecutive takes in the same clip, such as voiceovers, audio books, podcasts, or 
offscreen wild lines. 

When editing consecutive takes in the timeline, there are three primary steps to achieve 
the final composite take, and many ways to get there. The first step is to identify the best 
takes and separate them. Once the best two or three takes have been separated, you can 
stack and align them on neighboring tracks or in track layers for easy comparison. Finally, 
you split them into words or phrases and mix and match as needed to build the best 
composite version. After you’ve built the best composite performance, you can keep it as 
edited clips or render it into a new one. 

All these steps are easy to achieve in the Fairlight page in DaVinci Resolve. Let’s try it!

Separating the Best Takes in the Timeline
In Lesson 1, you used duration markers in the media pool to mark takes and create 
separate subclips that could be edited to the timeline. In this exercise, rather than marking 
each take, you’ll use the Range tool to select and delete unwanted material. At this point, 
you are no stranger to the Range Tool. In fact, you’ve used it to perform a variety of editing 
tasks. However, one thing you haven’t tried is using a ripple delete to remove a selected 
range and the gap. For this set of exercises, you’ll work with a different character and 
voiceover recording for the Post Park Normal intro. In this case, there are three takes, and 
you’ll narrow it down to the best. 
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1	 Play the clip in the A1 track and listen to all three takes of the Runner’s voiceover.

Any favorite takes? The client notes say that they really like takes 1 and 3. So your job is 
to eliminate the middle take along with the production chatter before and after that 
take. No problem. You can do that maneuver in a few seconds using the Range tool 
and Ripple delete. 

2	 Press R for the Range tool. 

3	 Using the waveform as a guide, drag a selection that starts after the first take and 
ends before the third take. Don’t worry about making it perfect; it’s easy to trim later 
as needed.

4	 Choose Edit > Ripple Cut or press Shift-Delete (macOS) or Shift-Backspace (Windows) 
to delete the selection and remove the gap. 

Done! The unwanted material in the middle of the clip is gone, and you are left with the 
two best takes. 

5	 Press A to return to the Pointer mode Arrow tool.

6	 With the Arrow tool, trim the end of the second clip to remove the director saying, 
“That was awesome.”

NOTE  DaVinci Resolve Studio offers an AI-based speech-to-text editing toolset, 
including transcription, plus text-based search, playback, duration markers, 
timeline editing, and more. You’ll learn more about this at the end of the chapter. 
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Aligning Takes in Separate Tracks
To align takes, you can move them to separate neighboring tracks or layers within the 
same track. For this exercise, you’ll align and compare the takes on separate tracks. You’ll 
work with audio track layers next. 

1	 Right-click the A1 Runner VO6 track header and choose Add Track > Mono.

2	 With the Arrow tool, select the second clip in the A1 track. 

3	 Press Option-Down Arrow (macOS) or Alt-Down Arrow (Windows) to move the selected 
clip down to the next track. Then, drag the clip toward the left to align the waveforms 
for the first words. Do your best using the waveform as a guide.
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TIP  Zooming clips horizontally gives you a better view of the waveform to 
make visual alignment easier.

4	 Use the Horizontal Zoom slider until the two clips fit more than half of the timeline.

5	 Play the first part of the timeline to hear how well you aligned the “The last day of 
normal” part of the clips. 

Chances are, it’s close. Now, let’s try a unique Fairlight method of visual alignment 
where you move the clip in the lower track atop the clip in the upper track and align 
the waveforms while you can see them both simultaneously, and then Shift-drag the 
upper clip back down to the lower track. This only takes a few seconds but will give you 
much more accurate waveform alignment. Let’s try it.

6	 Drag the clip in the A2 track up to the A1 track until you see the transparent waveform.

7	 Continue holding the clip and move it left or right as needed to align the first part of 
the waveform. Then, hold Shift to constrain the clip movement and drag it back down 
to the A2 track. 
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8	 Play the first phrase and listen to the revised alignment of the runner character saying, 
“The last day of normal.” 

Great! The first part is aligned, but what about the rest? As you may have guessed, 
you’ll need to split the different phrases on A2 and align them with the A1 track. You 
already know how to split and nudge clips to align them, so you should be able to make 
quick work of this exercise. Let’s do the first one together. 

9	 Solo the A2 track. Then, select the clip in the A2 track and navigate to the end of the 
first phrase, “The last day of normal.” 

10	 Press Command-B (macOS) or Ctrl-B (Windows) to split the selected clip at the 
playhead position. 

11	 Select the clip in the A2 track and navigate to the end of the first phrase, “The last day 
of normal.” Press Command-B (macOS) or Ctrl-B (Windows) to split the selected clip at 
the playhead position. 

12	 Select the split clip to the right of the playhead that needs to be aligned. 

13	 Press . (period) to nudge the selected clip right as many frames as necessary to align 
the next phrase. 

You could easily repeat these steps to finish splitting and aligning the clip in the A2 track. 
Instead, let’s try a more advanced technique that doesn’t require mouse selection. 
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Using JKL and Edit Shortcuts 
to Split and Align Clips 
In this exercise, you’ll apply the skills you learned for checkerboard editing to splitting and 
aligning the clip. The primary difference is that instead of cutting and moving clips to other 
tracks, you’ll cut and move the playhead with the JKL keys to align the semitransparent 
clipboard clip into position and then paste. This technique works well with either a 
keyboard or Fairlight Console and with practice can be a very fast and effective way to 
edit audio. 

1	 Click an empty space to deselect all clips. 

2	 Press Option-Command-2 (macOS) or Alt-Ctrl-2 (Windows) to select the A2 track.

3	 Play to the end of the phrase “started like every morning.” Split the selected clip at 
the playhead. 

4	 Press Command-X (macOS) or Ctrl-X (Windows) to cut the newly split section of the clip 
to the right of the playhead. 

5	 Use JKL or nudge command combinations to align the next phrase based on the 
waveform. Once aligned, press Command-V (macOS) or Ctrl-V (Windows) to paste. 
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6	 You’ve got this! Keep it going. 

NOTE  This technique of splitting a clip and cutting the remaining section to move 
can be expedited with the Cut Head or Cut Tail option in the Edit menu. However, 
since that option does not have a pre-assigned keyboard shortcut, you’ll continue 
using the two-step split and then the cut method for this exercise. You can create 
custom keyboard shortcuts for any menu option in the Keyboard Customization 
window available in the DaVinci Resolve menu. Fairlight consoles include a full set 
of audio editing keys including Cut Head and Cut Tail.

Finish Splitting and Aligning the Clips
It’s time to put your new dialogue editing skills to work. This should only take a minute or 
so to complete. In this self-guided exercise, you’ll finish splitting and aligning the clips in 
the A1 and A2 tracks. That’s right. You also need to split the phrases in the A1 track 
because you’ll soon discover that the timing is very different between the takes, and it’s 
much easier to control the timing and alignment if you split the words and phrases in both 
tracks. Try using the JKL keys and edit shortcuts to split, cut, move, and paste the clips as 
needed so you can compare the sections as needed. For this exercise, leave the last 
phrase, “and then out of nowhere they arrived,” as a single clip in each take. 

NOTE  If you didn’t complete the previous exercises, feel free to import the backup 
timeline 2 VO6 Split 2 Tracks to catch up.
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Disabling Timeline Clips to Create 
a Multi-Track Composite
The next step is to choose the best take of each voiceover section and disable the other to 
reveal the composite’s best performance. To do this, you’ll use the Disable clip shortcut, D. 
Disabling a clip is the same as muting a clip within the timeline. You’ll also enable the 
Exclusive Solo option that you worked with in Lesson 1 so you can quickly listen to only one 
track at a time to evaluate the different sections and choose your favorite. 

First, let’s duplicate the timeline so it will be available to use in the next exercise as well. 

1	 In the media pool, select the VO6 Runner to Edit timeline, or the backup timeline 
2 VO6 Split 2 Tracks, and choose Edit > Duplicate Timeline. 

A duplicate timeline with the same name plus “copy” appears below the original 
timeline in the media pool. 

2	 Rename the duplicate timeline 2 Runner Split Stacks. 

You’ll work more with that version of the timeline. For now, you’ll continue working with 
the VO6 Runner to Edit timeline or the 2 VO6 Split 2 Tracks backup timeline. Let’s 
audition the different takes in the current timeline and disable any clip that isn’t your 
first choice. 

3	 Hide the media pool. Then, choose Fairlight > Exclusive Solo to enable that option. Solo 
the A1 track.
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4	 Press R to switch to the Range tool. With the Range tool, select the first clip in the 
A1 track. 

A range appears with the width of the first clip in the A1 track that should also include 
the aligned waveform in the A2 clip. 

5	 In the Transport controls, click the Loop button to turn on looped playback.

6	 Move the playhead to the first clip and start playback. Listen to the take in A1 and then 
Solo A2 to listen to the same phrase in the A2 track. Repeat as many times as 
necessary until you can choose which take you want to keep and which you want 
to disable. 

For this example, the clients like the more energetic take in A2 a little better, so you’ll 
disable the clip on the A1 track. 

7	 Select the first clip on the A1 track and press D to disable the clip. 

The first clip in the A1 track turns gray to indicate it has been disabled or muted within 
the track. Keep in mind that by disabling clips instead of deleting them, you can select 
and enable them again anytime with the same shortcut. You could easily go clip by clip 
and disable whichever takes you don’t choose. To finish this exercise, you’ll follow the 
client’s notes regarding their favorite takes. 

TIP  With the Range tool, you can select multiple consecutive clips by selecting 
the first clip and then Shift-selecting the last clip. You can also select 
noncontiguous clips by Command-selecting (macOS) or  
Ctrl-selecting (Windows). 
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8	 Unsolo the track and disable the following clips as requested by the clients: 

	— Clip 1, “The last day of normal,” disable A1.

	— Clip 2, “started like every morning,” disable A1. 

	— Clip 3, “I was at the park early,” disable A1. 

	— Clip 4, “running laps on the trail,” disable A2.

	— Clip 5, “training for the spring 5K,” disable A2.

	— Clip 6, “and then, out of nowhere, they arrived!” disable A1. 

9	 Press A to return to the Pointer mode arrow tool. 

10	 Play the timeline to hear the best takes all together. 

Nice. The timing between the clips can use a little tightening, but overall, it’s a good first 
composite. Rather than spend more time on this technique, let’s try a comparable 
workflow using the unique Fairlight audio track layers to build a composite within a 
single track. 

Working with Audio Track Layers
Audio track layers are a powerful device for editing multiple takes together to realize the 
best performance. You can stack multiple dialogue takes, sound effects, or music 
selections in several layers in the same track, enabling you to experiment with alternative 
versions and then store those versions in lower layers for later access. In this lesson, you’ll 
work with audio track layers to build a comp voiceover. You’ll turn on layered audio editing, 
move the clips from the A2 track to the A1 track, and show the audio track layers. Once 
you’re comfortable moving clips between layers, you’ll arrange the clips so that the best 
takes are on the top layer. Finally, you’ll tighten the edit and play the final comp. 
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Preparing the Project
To simplify the process, let’s work in the same timeline and start by naming and duplicating 
the A1 and A2 tracks. Then you’ll mute and hide the A1 and A2 tracks so they will be 
available later if needed for comparison. Finally, you’ll rename the new tracks, enable all 
clips in the timeline, and color the clips in the A4 track. This should only take a minute or so. 

1	 Name the A1 track Runner VO6 t1 and name the A2 track Runner VO6 t3. 

In this example, t1 and t3 represent the voiceover takes within the different tracks. 

2	 Select both the A1 and A2 tracks, right-click anywhere on the selected track headers, 
and choose Duplicate from the shortcut menu.

The duplicate tracks appear directly below the original tracks as A3 and A4, with the 
word “Copy” appended to the end of the track names.

You are finished with the A1 and A2 tracks, so they can be muted and hidden.

3	 Show the Tracks Index. 
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4	 In the Tracks Index, mute the A1 and A2 tracks and click the Visibility button (eye icon) 
to hide those two tracks.

These tracks are no longer visible in the timeline. 

5	 Hide the index. 

6	 In the timeline, press Command-A (macOS) or Ctrl-A (Windows) to select all clips in the 
visible timeline tracks.

7	 Press D to enable all selected clips. Click any empty space in the timeline to deselect 
the clips.

8	 Rename the A3 track Runner VO6 Layers.

You don’t need to rename A4 because you will delete it shortly. For the last step, you’ll 
change the clip color for the clips in the A4 track so you can easily identify the different 
takes as you mix and match them in track layers. 

9	 Select the A4 track and press Command-A (macOS) or Ctrl-A (Windows) to select all 
clips in the selected track.



139Lesson 2  Editing Dialogue Tracks

10	 Right-click any of the selected clips in the A4 track and choose Clip Color > Yellow.

The timeline is prepped and ready for working in audio track layers.

NOTE  If you didn’t complete the previous exercise, feel free to import the backup 
timeline 2 VO6 Runner Layers Start to catch up.

Showing Audio Track Layers
Track layers are a powerful way to record and edit multiple clips in a single track. You can 
show or hide audio track layers in the View menu. With audio track layers showing, you can 
freely move clips from one track to another and place them on a separate layer within the 
track. The most important thing to remember when working with track layers is that you 
hear only the uppermost clip at any given time. You’ll work with recording audio track 
layers in Lesson 4. For now, let’s show the track layers to see what they look like. Then, 
you’ll move the clips from the A4 track to the upper layer in the A3 track. An advantage of 
working in audio layers is that you can easily align the waveforms of clips with other clips as 
you move them up and down between layers. 

1	 Choose View > Show Audio track Layers. 
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Each track has a single layer of mono clips, and an empty, clip-sized space appears in 
the track above the clips. The height of each clip and layer is based on the track height 
and the number of clips in the track. 

When starting playback, only the uppermost clip exposed to the playhead is played. 

2	 If necessary, press A to switch to the Pointer mode arrow tool. 

3	 Select all the yellow clips in the A4 track. Drag the yellow clips up to the A3 track. 

The yellow clips appear in a layer above the green clips in the A3 track. Before 
proceeding, let’s delete the A4 track.

4	 Right-click the A4 track header and choose Delete Track. 

5	 Drag the bottom edge of the A3 track header downward to increase the vertical height 
of the track as much as needed for a clear view of each clip in the timeline. 

Now, you can clearly see the audio track layers to edit the multiple voiceover takes.
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Trimming and Moving Clips 
to Different Layers
When working with audio track layers, an empty clip-sized space will always appear at the 
top of the track so you have room to drag clips up or down to change their priority. When 
you drag a clip to the top layer, the other clips shuffle down. Your goal in this exercise is to 
trim the heads and tails of some of the clips and move the best take of each phrase to the 
uppermost layer. Let’s try it. 

1	 Start playback and listen to the first yellow clip. 

2	 Drag the first green clip atop the first yellow clip. 

The yellow clip moves down to the lower layer. 

3	 Play the first clip stack again. This time, you’ll hear only the green clip.

4	 Drag the first yellow clip atop the first green clip to move the green clip down and the 
yellow clip back to the upper layer.

Now that you’ve tried moving clips between layers, let’s try trimming a clip. Let’s also 
toggle off snapping so you can freely trim the heads and tails of the clips without them 
trying to snap to align with other clips. 

5	 Choose Timeline > Snapping or press N to toggle off snapping. 

6	 Trim the beginning of the first yellow clip so it starts closer to the beginning of the 
waveform. 

7	 Trim the beginning of the first green clip. 
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When trimming toward another clip in the same layer, the clip will automatically appear 
in a new empty layer while you trim to accommodate your edits. Moving or extending 
one clip above another in the same layer will result in the overlapping clip in a 
new layer. 

8	 Trim the beginning and end (head and tail) of the third green clip. 

This time, a new layer appeared while you trimmed to keep the other clips in view 
as a guide.

9	 Trim excess heads or tails of the other clips to tidy them up if needed to make them 
easier to swap between layers. 

Next, you’ll move the best takes to the upper track based on the client’s notes. This is 
the same thing you did in the previous exercise by disabling the unwanted take in the 
timeline. However, instead of referring to takes by track, you’ll focus on their color. In 
this case, your choices will be take 1 green or take 3 yellow. 

TIP  Holding Shift while dragging clips up and down between layers constrains 
the vertical alignment. This is helpful when you are quickly auditioning 
different takes because you don’t have to worry about accidentally moving the 
clips out of sync horizontally.

10	 Move clips as needed so the upper layer is as follows: 

	— Clip 1, “The last day of normal,” yellow.

	— Clip 2, “started like every morning,” yellow. 

	— Clip 3, “I was at the park early,” yellow. 

	— Clip 4, “running laps on the trail,” green.

	— Clip 5, “training for the spring 5K,” green.

	— Clip 6, “and then, out of nowhere, they arrived!” yellow. 
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11	 Play the timeline to hear the best takes. 

You may have noticed on the last clip stack that the words “and then, out of nowhere, 
they arrived” don’t align very well between the takes. Also, you can hear some of the 
green clip before the yellow starts. No worries. You’ll fix both issues in the next 
exercise. 

Splitting Clips in Layers
Splitting audio clips in track layers is almost the same as splitting them in separate tracks. 
The difference is when splitting clips in layers, only the uppermost clip will split. To split 
multiple clips simultaneously, you first need to select the clips. In this exercise, you’ll select 
and split the last clip stack into three separate stacks. Then, you’ll trim and align the clips in 
each stack. Finally, you’ll switch takes for the first and last section because it turns out the 
clients want take 1 for “and then” and “they arrived” and take 3 for “out of nowhere.” 

1	 Select both clips in the last clip stack.

2	 Move the playhead between the first and second phrases in the clip. Press 
Command-B (macOS) or Ctrl-B (Windows) to split the selected clips at the playhead 
position. 

3	 Select the remaining last clip stack. Move the playhead between the last two phrases. 
Split the selected clips. Deselect the clips.
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Next, you’ll trim and align the clips. As you align the clips, drag the clip in the lower 
layer to the upper clip for precision alignment of the two waveforms, and then hold 
Shift to constrain the clip’s horizontal position as you drag it back down to the 
lower layer. 

4	 Trim and align the clips. 

In the last three clip stacks, the upper layer should be green, yellow, green. 

NOTE  If you did not complete the previous exercises, feel free to import the 
backup timeline 2 VO6 Layers to Tighten to catch up.

Tightening the Edit 
Now that the best takes have been selected and moved to the upper layer, you can hide 
audio track layers and tighten the edit to remove the excess space between words. The 
goal is for the composite performance to sound natural. Remember, the audience only 
hears the results and has no idea what you’ve done to get there. Whether you’re working 
with audio track layers or clips on separate tracks, you’ll follow the same basic steps to 
tighten the gaps between words. This technique uses the range and nudge commands to 
rein in the gaps between words. You’ll also turn on the “stop and go to last position” option 
in the transport controls so the playhead will always start where you want it while you 
finesse the pauses between words. 

1	 Choose View > Show Audio Track Layers to hide the layers. 

You can show the audio track layers to edit or change clip order anytime. 
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2	 Use the Vertical Zoom slider or drag the A3 track header to decrease the track’s height. 

3	 In the transport controls, right-click the Stop button and enable the Stop and Go To 
Last Position option. 

4	 Move the playhead before the first clip stack. 

NOTE  When nudging or dragging a stack of layered clips in the timeline, it is 
important to drag a selection across the stack to include all clips in the stack. If 
you only select the visible clip from the top layer, that will be the only clip you 
will nudge or move. 

5	 Press R for the Range tool. Drag a range that selects all clips to the right of the 
first clip. 

Next, you’ll start playback and use the nudge commands to move the selected clips 
toward the first clip to tighten the first gap. Anytime you stop playback, the playhead 
will return to the starting point so you can listen from the beginning again. Let’s try it.

6	 Start playback and listen to the pause between the first and second phrases. 

7	 Press , (comma) twice to nudge all the selected clips to the left by two frames. 

8	 Play the section again. 
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9	 Press , (comma) two more times to nudge left two more frames. 

10	 Play the section. If satisfied, move on to the next section. If you want to adjust the gap 
more, use the , (comma) or . (period) to nudge left or right one frame at a time. 

11	 Select all the clips to the right of the second clip. Start playback at the beginning and 
nudge the clips to tighten the gap between the second and third clip. 

12	 Finish tightening the edit until you are satisfied with the composite voiceover. As you 
go, you can continue with the playhead at the beginning or move it to the section you 
are working on. Be careful not to tighten the edit too much since some pauses 
between words are part of the performance and necessary for a more natural sound. 

Don’t worry about getting it perfect. Also, some clips could benefit from a micro fade 
at the beginning or end of the clip. You’ll work with those in a later lesson. 

13	 When finished, play the timeline to hear your composite draft.

NOTE  If you did not complete the previous exercises, show the tracks index and 
unhide the A6 Runner comp track to see and hear a finished version of the 
composite draft. 

Bouncing a Selection to a New Layer
The composite voiceover you created from multiple clips will play back fine; however, it will 
become a bit cumbersome to move around and work with later in the podcast. Fortunately, 
you can simplify that process by bouncing the track to a new layer.

Bouncing is the audio equivalent of flattening a layered image or rendering a composite 
video. In this case, bouncing creates a new audio file in your capture location and media 
pool. In the Fairlight page, you can bounce a selected play range to a new layer or bounce 
your output to a new track in the timeline. For this exercise, you’ll set a range around the 
clips in the A3 track and bounce them to a new layer. 

Your bounced files will appear in the selected bin in the media pool. In this case, let’s make 
a bin and then bounce the composite.

1	 In the media pool, right-click the bin list and choose New Bin. 

2	 Name the bin Bounced VO Comps.
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3	 Select the Bounced VO Comps bin. 

4	 In the A3 track, drag a range that includes all the clips. 

5	 Make sure the A3 track is selected and you have marked a range. This is a necessary 
step for bouncing to a new layer in the same track.

6	 Choose Timeline > Bounce Selected Tracks to New Layer.

Voilà! A new bounced clip the length of the play range appears above the other clips in 
the selected track. The new source clip is also visible in the selected bin in the media 
pool. The bounced clip’s name starts with the track name Runner VO6 Layers and 
continues with “bounce” to indicate that it is a bounced file. 

7	 Choose View > Show Audio Track Layers to see the bounced clip in a layer above the 
original clips. 

8	 Choose View > Show Audio Track Layers to hide them. 

Before proceeding to the last dialogue editing example, let’s rename the current 
timeline to reflect its contents. 
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9	 If necessary, in the media pool, select the Master bin to see all the clips and timelines. 

10	 Locate the current timeline containing the bounced clip and comp. Change the 
timeline name to VO6 Runner Comp v1.

You can keep the original clips in the timeline beneath the bounced layer, disable them, or 
delete them from the track. For educational purposes, and to preserve any sentimental 
attachment you might have to your first layered composite voiceover track, let’s keep it as 
is. Besides, it’s good practice to keep the originals beneath the bounced clip handy in case 
the clients change their mind and want to try a different take combination.

TIP  If you plan to do a lot of work with audio track layers, you can save time by 
creating a custom keyboard shortcut to show/hide audio track layers. In fact, any 
menu option can be assigned to a custom keyboard shortcut via the Keyboard 
Customization window accessed from the DaVinci Resolve menu. 

Finishing a Patchwork Quilt Edit
As you may have guessed, dialogue editing isn’t a one-size-fits-all workflow, and the 
editing method you choose for your projects may vary as much as the projects themselves. 
Luckily, the Fairlight page editing tools, techniques, and shortcuts are extremely flexible 
and can be mixed and matched to suit your needs. In this dialogue editing example, the 
podcast clients had a brilliant, last-minute, late-night, over-caffeinated, wildly creative idea 
they wanted to try for the podcast intro. The idea is to try intercutting the intros of all six 
characters as a combo intro. “Sure! Let’s go for it.” 

Editing together a composite of many people’s voices would be more of a patchwork quilt 
than a standard checkerboard edit. The techniques are similar, with more cutting between 
words and voices along the way. This type of edit is sometimes referred to as a blender cut, 
patchwork quilt, or Franken-edit, which is an homage to Frankenstein’s monster, who was 
also patched together from different people’s parts. 
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Preparing the Project
To save time, you’ll open a project with the combo intro already built. You’ll be invited to 
create your own patchwork edit of the intro at the end of the lesson. First, you’ll need to 
import the project and reconnect the media. 

1	 Choose File > Import Project. Navigate to the R19 Fairlight Part 2 media folder and 
select the Podcast Intro Combo project. 

The Podcast Intro Combo project opens with the 2 Intro Combo Finished timeline 
open and all the media offline (red). 

2	 In the media pool, right-click the Master bin and choose Relink Clips for Selected Bin.

3	 Navigate to the R19 Fairlight Book Media > R19 Fairlight Part 2 folder and click Open.

The clips relink, and the project is ready to go.

NOTE  If you can’t relink the media, go to the “Getting Started” section at the 
beginning of this book and follow the instructions to download the media. 
Once downloaded, try steps 2 and 3 again. 

4	 The Podcast Intro Combo project opens with the 2 Intro Combo Finished 
timeline open. 

5	 Choose File > Save Project As, add your initials to the end of the project name, 
and then click Save. 

6	 Play the 2 Intro Combo Finished timeline once and listen to the experimental 
combo intro. 

Wow! It turns out the clients had a great idea, even if it was in the middle of the night. 
Now that you’ve seen the finished patchwork dialogue edit and heard the results, let’s 
go back and see how it all started. 
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7	 In the media pool, locate the timelines in the Lesson 2 bin. Then open the timeline 
2 Intro Combo Start.

8	 Click the Fairlight menu and make sure the Exclusive Solo option is enabled (checked). 

9	 Solo the A2 track and play the first few clips. 

10	 Using the Solo button one track at a time, play the beginning of each track 
sequentially, starting with A3 and ending with A6. 

Now, you have heard each character and a little about what they were doing at the park 
that fateful morning. 

Tighten the Patchwork Edit
You’ve already heard the final edit, so you know what you are aiming for. In this exercise, 
you’ll implement the range selection and nudge skills you used previously. This time, 
instead of selecting layered clips within a track, you’ll select multiple clips on numerous 
tracks. The workflow is the same, just more tracks. Your goal is to select clips to the right of 
a gap and use the nudge commands to tighten the gap as needed before moving on to the 
next gap. Just as before, you’ll listen as you go to determine whether you have nudged 
enough or too much and adjust the edit accordingly. 
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1	 Open the timeline 2 Intro Combo to Tighten. 

2	 If necessary, enable Stop and Go to Last Position in the Playback menu. (It should still 
be on from the previous exercises.) 

3	 Play the timeline to hear the unnatural-sounding gaps starting after the first set of 
skateboard clips on A4: “The last day of normal started like every other morning.” 

4	 With the Range tool, select all the clips from the third yellow clip on the A1 track, “at the 
park, with my coffee, reading my book,” to the end of the timeline.

5	 Start playback at the beginning of the timeline. 

6	 Use the nudge commands to tighten the space between the orange skateboard clips, 
“The last day of normal stared like every other morning” and the third yellow clip, “at 
the park, with my coffee, reading my book.” 

When you’re satisfied with the timing between those clips, move on to the next set 
of clips. 

7	 Continue tightening the spaces between the sections until you like the timing and flow 
of the patchwork intro. 

If you think the dialogue seems rushed at any time, select all clips to the right of the issue 
and nudge right to add a little breathing room. If the pauses seem too long and unnatural, 
select all clips to the right of the issue and nudge left to reduce the extra space between 
clips. Trust your ears and your guts. You’ve got this!
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Using Enable to Audition Stacked 
Clips in the Timeline
There are countless creative editing choices for this character combo podcast intro. One 
final dilemma is determining which character’s voice will be used for the last phrase, “they 
arrived.” In this short exercise, you’ll audition the same final phrase from each character 
and choose a favorite. To do this, you’ll use the Enable/Disable shortcut “D” to 
systematically enable only one clip in the stack at a time. 

1	 In the timeline, move the playhead to the blue marker. 

2	 Play the last series of clips and listen to how it sounds with the A2 track version of the 
“they arrived.”

3	 Stop playback. Select the last clip in the A2 track and press D to disable the clip. Select 
the last clip in the A3 track and press D to enable it. 

4	 Play the last series of clips again, this time listening to the final phrase from the 
A3 track. 

5	 Repeat the previous steps, but this time disable the last clip in the A3 track and enable 
the last clip in the A4 track.

6	 Repeat the previous steps until you have auditioned the endings from each character. 

7	 When you are finished, enable whichever version you like. 

8	 In the transport controls, right-click the Stop button and choose Stop and Go to Last 
Position to disable that option. 



153Lesson 2  Editing Dialogue Tracks

Mission accomplished. You have completed the first level of dialogue editing! But cutting 
the tracks together is only the first part of your job. Dialogue editing is complete when the 
clip levels are balanced, distracting noises are removed, and the tracks are strong enough 
to stand on their own. Don’t worry; you’ll work with balancing levels and cleaning up tracks 
in Lessons 5 and 6.

Patchwork Challenge: 
Edit Your Own Intro
If you have enjoyed the dialogue editing exercises and want to create your own multi-
character patchwork intro, here is your chance! This is optional, but it is a great way to test 
your new skills and creativity. For this self-guided exercise, open the 2 Intro Combo Start 
timeline with four stacks of clips representing each character’s rendition of the intro 
broken into sections. Duplicate the timeline and rename it to include your initials. Take it 
from here and have fun! 

Using AI Speech-to-Text 
Transcription (Studio Only)
This section requires DaVinci Resolve Studio to follow along. DaVinci Resolve Studio offers 
a full set of powerful AI-based tools, including speech-to-text transcription from audio 
clips. Once transcribed, you can search the text to mark clips, audition takes, set duration 
markers, and more. In this exercise, you’ll transcribe two voiceover clips and use search 
and selection options in the Transcription window to preview, audition, and mark the best 
takes for editing. 

1	 If necessary, open the Podcast Intro Combo project. 

2	 Open the 2 Intro Combo Finished timeline. 

3	 In the media pool, select the PPN Intro VO bin to see a list of all six voiceover clips. 

For this exercise, you’ll start with VO 6 Runner, which you are already familiar with, and 
run audio transcription to see the transcript and search takes. Then you’ll move on to a 
more challenging clip, the VO 4 Skateboard clip, which has numerous takes, ongoing 
direction between takes, and even changes in accent. 

4	 In the media pool, select the VO 6 Runner clip to see it in the preview player. 
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5	 Change the preview player Zoom menu to 1x. Then, move the playhead to the middle 
of the clip for a better view of the entire waveform. 

6	 Right-click the VO 6 Runner clip and choose Audio Transcription > Transcribe.
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A Transcribing Audio progress dialog indicates that the clip is being analyzed. Once 
analyzed, the Transcription window opens, showing all the clip’s dialogue as text in a 
single paragraph. Clips with multiple speakers or pauses between spoken words can 
be transcribed accordingly. 

7	 In the upper right corner of the Transcription window, click the Increase Font Size (A+) 
button to increase the size of the text.

8	 Click the Search button to show the Search field. In the Search field, type The last day 
of normal and then press Return or Enter. 

The Transcription window highlights four instances of “The last day of normal” in the 
clip. Not only can you see the highlighted text, but you can use it to quickly audition 
each take. Let’s try it.

9	 Click the Play button at the bottom of the Transcription window or press Spacebar to 
play the first take starting with the highlighted “The last day of normal….”
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10	 To the right of the Search button, click the Next button (>) to advance to the next 
selected text. Play the first part of the second take.

A small red arrow points down to the first word in the current selection.

11	 Continue advancing the search to the next take and play to hear each take. When 
finished, stop playback and clear the Search field. 

12	 In the transcription text, locate the beginning of the last take starting with “The last 
day of normal” and ending with “they arrived.” Drag a selection in the text field that 
includes the entire take. 

In the media pool preview player, you can see that the same portion of selected text 
has also been marked with In and Out points. 

13	 In the media pool, play the marked selection of the clip. 

Next, you’ll mark the selection with a duration marker, just as you marked takes in 
Lesson 1. 
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14	 In the lower left corner of the Transcription window, click the Marker button to mark 
the selected clip with a duration marker.

A duration marker appears in the preview player for the duration of the In and Out 
points. In the media pool, the VO 6 Runner clip includes a disclosure arrow to open the 
contents to see the duration marker. 

15	 Click the arrow to the left of the VO 6 Runner clip to see the duration marker. Name the 
marker Take 3 and then select the marker to see it in the preview player. 

As you can clearly see, using transcription can be a real timesaver when working with 
dialogue source clips. Now that you have a feel for how the speech-to-text transcription 
works in the Fairlight page, let’s transcribe a more complex example for comparison. 

16	 In the media pool, right-click the VO 4 Skateboard clip and choose Audio 
Transcription > Transcribe.

As you can see by the Transcription window, this clip has more takes accompanied by 
directions from the two companions who also recorded voiceovers for this project. 

NOTE  The three voices you hear in this recording are Jack, Vicente, and 
Kathryn, who are film students recruited by this author to record themselves 
as VO 4 Skateboard, VO 5 Photographer, and VO 3 Bike, respectively. 
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17	 In the Transcription window, search for the phrase “then out of nowhere.”

This time, there are 12 takes because the talent tried numerous performance 
intensities and accents. This example also demonstrates that DaVinci Resolve’s 
transcription is powerful enough to decipher accents as well. The only word the 
transcription missed in this example was “pot” instead of “park.”

18	 Using the Transcription window, listen to some of the selected takes and choose a 
favorite. Feel free to experiment with the transcription before closing the window.

19	 Save the project. 

In the next lesson, you’ll explore new editing tools and techniques for editing sound 
effects and music. 
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Lesson Review
1	 How do you separate the viewer from the monitoring panel so that you can use it as a 

floating window? (Choose all that apply.)

a)	 Double-click the viewer.

b)	 In the Workspace menu, choose Fairlight Viewer > Floating. 

c)	 Click the Floating Window button on the viewer.

d)	 Right-click the viewer and choose Floating. 

2	 When would you use Loop Jog? 

a)	 To get a little exercise after a long day of dialogue editing.

b)	 To hear a sample-level preview of the audio while scrubbing the playhead. 

c)	 To start looped playback of a selected range in the timeline.

d)	 To copy and paste multiple copies of the selected clip in the timeline.

3	 In audio post-production, what name is given to describe editing dialogue where you 
split each character’s dialogue to a separate one? 

a)	 Split dialogue editing

b)	 Character mapping 

c)	 Checkerboard editing

d)	 Character-layered editing

4	 True or False? During playback, the lowest audio track layer will always be audible.

5	 True or False? Changing a track from a multichannel format to a mono format 
permanently deletes any unexposed channels in the clip.

6	 Which keyboard shortcuts allow you to quickly edit clips from one track to another? 

a)	 Track number plus I or O for Insert and Overwrite edits. 

b)	 Hold D (for dialogue) while using the Up Arrow and Down Arrow keys.

c)	 Option/Alt track number plus the Up Arrow and Down Arrow keys.

d)	 Common Cut, Copy, Paste Keyboard shortcuts plus Option-Command-Up/Down 
Arrow (macOS) or Alt-Ctrl-Up/Down Arrow (Windows). 
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Answers
1	 b, c

2	 b

3	 c

4	 False. The uppermost track layer is always audible. 

5	 False. Changing a track’s format never deletes the unexposed channels of the 
timeline clips.

6	 d



Time
This lesson takes approximately 
75 minutes to complete.

Goals
Finishing a Spotting List in the Markers Index� 162

Editing with the Focus Mode Multi-Tool� 167

Using Multi-Tool Snapping to Head or Tail� 174

Working with the Sound Library� 183

Preparing the TML Project� 191

Using a Sync Point in the Sound Library� 192

Using Video and Audio Scrollers 
for Precise Synchronization� 197

Marking Sound Cues with the Video Scroller � 204

Editing Music to the Beat� 208

Editing Music in Track Layers� 215

Working with a Nested Timeline� 223

Adding Custom Crossfades in the Timeline� 231

Adding Podcast Music� 235

Working with the Music Remixer (Studio Only)� 236

Lesson Review� 244

Editing sound effects and music 
involves creativity, flexibility, and 
precision. In this lesson, you’ll explore 
additional editing tools, features, 
and timeline options as you edit 
sound effects and music in a variety 
of projects, including the Post Park 
Normal podcast intro, scenes from 
the film Too Much Life, and a 3D 
Fusion VFX clip.

Lesson 3

Editing Sound 
Effects and Music



162Lesson 3  Editing Sound Effects and Music

Finishing a Spotting List 
in the Markers Index
So far, you’ve learned how to build a soundtrack from scratch and edit dialogue using the 
basic tools and shortcuts necessary for most of your editing needs. In this exercise, you’ll 
finish a spotting list for the Podcast Intro Combo project you started in the previous 
lesson. A spotting list is like a to-do list of sound elements that need to be added, 
enhanced, or replaced by the sound team. In the Fairlight page, you can create a spotting 
list right in the timeline and Markers index. 

1	 If necessary, open the Podcast Intro Combo project with your initials added to the 
project name. 

2	 Open the timeline 3 Intro Combo FX Start. 

This is a version of the timeline you worked on at the end of Lesson 2.

3	 Hide all panels except the timeline. Adjust the vertical and horizontal zoom as needed 
to clearly see all the tracks and clips in the timeline. 

At a glance, you can see that colored markers have been added to the timeline ruler, as 
well as a set of empty tracks that correspond to the different characters. The colored 
markers correspond to production notes from a spotting session that indicate where 
sound effects or music cues should be added. You’ll find an interactive list of the 
markers and notes in the Markers index. 
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4	 In the upper left corner of the interface toolbar, click the Index button to open the 
Index panel. Then, at the top of the Index panel, click the Markers button to show 
the Markers index. 

The Markers index opens on the left side of the page. Here, you can see the current 
timeline markers and a corresponding thumbnail frame for each marker. As with the 
media pool, you can view the markers in either Thumbnail or List view. 

NOTE  Since this is an audio-only project, the thumbnail for each marker frame 
is black. 
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5	 In the Markers index toolbar, click the List View button to change the index to List view.

In List view, you can see columns that show each marker’s number, name, and other 
information. You can select a marker by clicking any empty space in a marker’s row. 
Selecting a marker in the index also moves the playhead to the selected marker. If you 
look at the markers again, you’ll notice a colored marker for each voiceover character 
except VO 6 Runner. 

6	 In the Markers index, select Marker 6, which is #7 in the # column and the only blue 
marker in the color column. 
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This marker represents the photographer’s voiceover, which comprises the two blue 
clips on the VO 5 track. As you may have noticed, Marker 6 is the only unnamed 
marker. Let’s give it a name. 

7	 In the Name column of the Markers index, select Marker 6 and type Photographer. 
Then press Return or Enter. 

Let’s take a moment to streamline the information in the Markers index columns. 

8	 Right-click the column headers and deselect Start TC, End TC, Duration, and Keyword. 
Now you can clearly see the Name, Color, and Notes for each marker in the list. 

The Notes column is useful for adding instructions to accompany a marker. In this 
example, during the spotting session, the director requested the sounds of a camera 
bag and camera clicks to accompany the photographer’s voiceover. 

9	 In the Notes column for the Photographer marker, type Add FX for bag and camera 
clicks. Press Return or Enter. 

NOTE  You can sort the marker list by any column header and move the 
columns to a different order by dragging the column header to a new position.
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If you look carefully at the markers in the middle area of the timeline, you’ll see a 
colored marker that corresponds with each character except the Runner on the 
VO 6 Runner track. In the next section, you’ll use these markers as a guide to add a 
sound effect for each character as they describe what they are doing at the park. 
First, let’s add a marker for the runner to complete the marker list. 

10	 In the timeline, if necessary, click an empty space to deselect all clips and tracks. Then, 
navigate to the beginning of the first teal clip in the VO 6 runner track. 

NOTE  If a clip is selected beneath the playhead when you press M to set a 
marker, a marker will appear on the selected clip. If you want to set a timeline 
marker, be sure to deselect all clips first. 

11	 Press M to add a timeline marker at the playhead position. Press M again to open the 
Markers panel and enter the information as follows:

	— In the Name field, type Runner. 

	— In the Notes field, type Extend head and tail by one second with fade.

	— Change the marker color to teal. 

12	 Click Done.

The new Runner marker appears in the timeline and Markers index. 

The spotting list is complete, the timeline is ready for action, and you have a road map in 
the marker index to help you navigate as you add sound FX to the different tracks. For the 
next set of exercises, you’ll work in Focus mode, which offers enhanced editing options, 
speed, and precision. 
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NOTE  The Focus mode multi-tool behavior combines many of the selection, 
editing, and playback features you’re already familiar with so that you can continue 
working as you have previously without needing to switch tools or 
selection modes. 

Editing with the Focus 
Mode Multi-Tool
There are two primary options for editing audio quickly: physical hardware or mouse and 
keyboard shortcuts. For editors who prefer physical controls with lightning-fast results, 
there are the Fairlight Audio Editor, Fairlight Studio Console, and Fairlight Desktop Console. 
Each model includes dozens of specialized controls for nearly every function on the 
Fairlight page interface. For mouse and keyboard editors who work fast and fluid with their 
mouse-du-jour, the Fairlight page Focus mode works as a multipurpose tool with a 
powerful multifunctional cursor that changes function based on where and how you click. 
Additionally, the multi-tool offers a robust array of focused, pointer-based advanced 
editing options using simple mouse clicks and the occasional modifier key or user-defined 
keyboard shortcut. As you work through the following exercises, you’ll explore new tools 
and techniques. 

NOTE  The Focus mode multi-tool includes the Selection tool (I-beam cursor), the 
Grabber tool (hand cursor), and the Trim tool (various trim arrow cursors), 
depending on the cursor position.

The secret to mastering the Focus mode multi-tool is learning how it changes based on 
where and how you click. Another consideration is whether the playhead is moving. When 
stationary, playback will always start at the new edit selection whenever you press the 
Spacebar. So you can click anywhere in the timeline and instantly preview the audio from 
that point without moving the playhead. During playback, the multi-tool is completely 
uncoupled from the playhead, so you can continue editing while listening to playback or 
even while recording. 

In the next series of exercises, you’ll explore some of the nuances of the Focus mode 
multi-tool and additional Fairlight functionality available in Focus mode while you edit 
sound effects into the timeline. 
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1	 Show the media pool. 

The media pool appears above the Markers index on the left side of the page. 

2	 In the media pool, select the Basic Sounds for PPN Intro bin to see the sound effect 
clips listed in the media pool library. 

3	 In the Markers index, select the Dog Walk marker to move the playhead to 
that position.

4	 In the toolbar, click the Focus Mode button. 

The timeline no longer extends vertically below the ruler. However, you can still see the 
top of the playhead in the ruler, and you will see the full vertical playhead 
during playback.

5	 With the multi-tool, click anywhere in the A9 FX 2 Dog track to see the flashing 
I-beam cursor. 

In Focus mode, clicking anywhere on a track selects the track, just like the Range mode 
tool. Let’s add the Dog walking clip to the corresponding track.

6	 In the media pool, drag the Dog walking.m4a clip to the beginning of the A9 track.
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7	 Increase the height of the A9 track as needed for a clear view of the clip, waveform, 
and pointer. 

The clip is clearly longer than necessary. No problem. You can scrub, select a range, 
and remove unwanted material in seconds with the Focus mode multi-tool. Let’s listen 
to the middle section of the clip. 

8	 In the A9 track, locate the loudest section of the waveform near the middle of the clip. 
Move the cursor over the lower half of the clip to see it change to a hand (grabber) 
tool. Click the lower half of the clip to select the entire clip. 

9	 Move the cursor to the upper half of the clip to change the multi-tool to the I-beam 
cursor. Click to set a single frame edit point with the I-beam cursor. 

10	 Start playback to hear a few seconds of the clip from the edit point and see the full 
playhead as it moves along the timeline. Stop playback. 
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A new edit point I-beam flashes on the clip wherever you stopped playback. Before you 
scrub and choose a section of the clip to use, let’s see the duration of the dog walker’s 
voiceover. 

11	 Scroll up to the A2 VO 2 Dog track. Click the lower half of the second clip in the A2 track 
to select the entire clip.

Selecting the clip with the multi-tool sets a range with In and Out points in the ruler to 
mark the clip. You can easily see the marked clip’s duration in the upper left corner of the 
timeline. In this case, the clip duration is 00:00:02:01, or 2 seconds and 1 frame in length. 
This gives you a clear idea of the length of the dog walking sound effect you’ll need to 
create from the full clip. 

NOTE  Many of the sound effects for this project were recorded by this author, 
including the dog-walking sounds, which I recorded while walking my dog, Lexie. 

Solo-Scrubbing a Clip with the Multi-Tool
Now that you know how long the dog-walking sound effect is, you can go about finding 
which section of the sound effect to use. Luckily, with the Focus mode multi-tool, you can 
scrub the playhead over any clip by holding Shift-Command (macOS) or Shift-Ctrl 
(Windows) while you drag the pointer over the clip. As a bonus, Shift-Command scrubbing 
the multi-tool temporarily solos the clip’s track so you can focus on the sound of that track. 
In this exercise, you’ll listen to the entire clip while the track is soloed. Then, you’ll unsolo 
the track and use the solo-scrub method to listen to a specific section of the clip. 
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1	 If necessary, scroll down to the A9 track. 

2	 Solo the A9 track. Select the entire clip. Start playback and listen for a good section to 
use for this intro. 

As a sound effects editor in training, what are your thoughts about the clip? Listening 
from the beginning, it takes a while before the dog and walker have a good cadence 
that really “sells” the idea of dog walking. You probably also figured out that the 
loudest section in the middle of the clip is where the dog shakes her head before the 
nice rhythmic walk begins. Let’s look and listen for a good 2.5-second range in the 
second half of the clip. 

It’s time to try solo-scrubbing the clip. With this technique, scrubbing forward or 
backward will play at normal playback speed. 

3	 Unsolo the A9 track. Press Shift-Command (macOS) or Shift-Ctrl (Windows) to scrub 
the cursor starting in the middle of the clip to hear only the clip and track you are 
scrubbing. As you scrub the clip, focus on the section after the dog shakes her head 
and before the next louder section in the waveform. 

Feel free to scrub other clip areas before moving on to the next section.

Working with an Edit Selection Range
You’ve used the Focus mode multi-tool to select an entire clip, set an edit point, and 
solo-scrub a clip. In this exercise, you’ll drag the I-beam cursor across the top half of a clip 
to create an edit selection range. Your goal is to drag a 2.5-second range that includes the 
portion of the dog-walking sound you want to use. Look at the duration in the upper left of 
the timeline to see the duration of your edit selection as you drag. You’ll try to keep the 
duration to around 2:10–2:15. Don’t worry about getting it perfect; you can always trim the 
clip later if needed. 

1	 In the A9 track, drag the I-beam cursor in the upper half of the dog-walking clip until 
you have an edit selection range with a duration of around 2:15. 
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The part of the clip within the edit selection range brightens. You can extend or reduce 
the range by Shift-dragging the start or end of the range in the upper half of the clip. 

2	 Shift-drag the start or end of the range as needed to clean up the selection so it starts 
and ends between peaks in the waveform. 

NOTE  If you accidentally click the lower half of the clip, you’ll clear the range. 
If that happens, you can simply draw the range again. 

3	 Choose Trim > Trim to Selection or right-click the clip and choose Edit Selection 
Editing > Trim to Selection.

All that remains in the A9 track is the clip within the edit selection range. Next, you’ll 
move the clip to the Dog Walk marker. For this, you’ll use the Markers index to locate 
the Dog Walk marker and then drag the clip to that position in the timeline. 

4	 In the Markers index, select the Dog Walk marker. 

The playhead and I-beam cursor jump to that marker in the timeline. Make a mental 
note of where that marker is in the timeline ruler. Instead of moving the clip so that it 
starts exactly at the Dog Walk marker, you’ll move it slightly before the marker. 
Remember, you only needed to fill a 2-second section with the sound effect. The extra 
half-second of sound gives you room to fade the clip in and out. 

5	 In the A9 track, drag the clip (from the lower half) toward the left until it starts before 
the beige Dog Walk marker and ends after the orange Skateboard marker. Use the 
range in the timeline ruler as a guide while you move the clip. 
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6	 Using the Dog Walk marker as a guide, drag the fade handle in the upper left corner of 
the clip to create a fade-in that starts at the beginning of the clip and ends at the Dog 
Walk marker. Then drag a Fade Out from the end of the clip to the Skateboard marker. 

7	 Click any empty space to clear the range. Zoom the timeline as needed until you can 
see all the tracks and clips in the visible timeline area. 

8	 Play the timeline from the beginning and listen to how the dog-walking sound effect 
works with the voiceover. It should sound great. 

Feel free to make any adjustments to the clip before moving on to the next section, where 
you’ll use a different technique to edit and align the next two sound effects. 
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Using Multi-Tool Snapping 
to Head or Tail
There are many methods for adding and syncing sound effects. In the previous exercises, 
you added an entire clip to the timeline, trimmed the clip, and then moved it into position. 
In this exercise, you’ll preload sound effects tracks with clips that have already been 
marked with In and Out points. This method works if you know which sound effects you 
want to use in each track. You’ll start by marking sections of source clips you want to use in 
the media pool and dragging the clips to a random area of the tracks, such as the 
beginning. When you’re ready to place the sound effect, you’ll use a modified click to 
instantly snap the clip into position. This handy editing snap-to-playhead feature requires 
the Focus mode multi-tool. In this exercise, you’ll preload three tracks with sound effects. 
Then, you’ll use markers to navigate to the location where you want the clips and move 
them into position with a single modified click. 

NOTE  When snapping to the head or tail of a clip, only one clip can be snapped at 
a time. Clips can only snap within their own track, and Range/clip selections (head) 
count as snap targets. 

1	 In the media pool, select the Basic Sounds for PPN Intro bin. Select the Running clip. 

As you can see, the clip already has In and Out points marked. 

2	 In the preview player, click the Loop button to turn on looped playback. Click the 
preview player Play button to play the marked section of the clip. 

3	 Drag the Running clip to the beginning of the A12 FX 6 Runner track. 

4	 In the media pool, select and play the Camera Click fx v3 clip. Drag the clip to the 
beginning of the A13 FX 5 Camera track.
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5	 In the media pool, select the Fairlight Sound Library bin to see a sample of sound 
effects that come with the Fairlight Sound Library. 

You’ll work with the Fairlight Sound Library later in this lesson. 

6	 Select and play the Book Pages Turning Flutter clip. 

7	 Drag the Book Pages Turning Flutter clip to the beginning of the A8 FX 1 Book track. 

The clips have been added to the timeline. Next, you’ll use a modified click to move the 
book and runner effects into position. Let’s start with the book clip. You can use the 
Markers index or Shift-Up/Down arrow to move the playhead to the corresponding 
marker in the timeline. Then, you’ll snap the head of the book clip to the playhead. 

8	 Ensure you’re in Focus mode. 

9	 Select the A8 track. 

Selecting the track isn’t necessary, but it allows you to see the I-beam cursor in the track. 
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10	 In the Markers index, select the Book marker.

11	 Hold Option-Command (macOS) or Alt-Ctrl (Windows) and click the yellow clip in the 
A8 track. 

The clip snaps to position, with the head perfectly aligned with the playhead. Let’s do it 
again. This time, you’ll snap the tail of the runner clip, and you won’t select the 
track first. 

12	 In the timeline ruler, scrub the playhead near the end of the second teal RUNNER_007 
clip to set the playhead at the end of the clip (approximately 01:00:26:09).
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13	 Hold Command-Option-Control (macOS) or Command-Alt-Ctrl (Windows) and click the 
teal clip in the A12 track.

The clip snaps into position with the tail of the clip aligned with the playhead position 
in the ruler. Let’s snap the tail of the camera clip to the Runner marker so it ends just 
as the runner clip begins. 

14	 Move the playhead to the teal Runner marker. 

15	 Hold Command-Option-Control (macOS) or Command-Alt-Ctrl (Windows) and click the 
blue clip in the A13 track.

The tail of the blue clip aligns with the teal Runner marker. 

16	 Play the timeline from the beginning to hear your progress. 

What a difference a few sound effects can make, especially in an audio-only project like 
this podcast intro, where the entire audience experience is based on sound. You probably 
noticed that the runner sound effect starts a little late and there are far too many camera 
clicks. Let’s take a moment to extend the Running clip and fix the camera clicks. 

The Focus mode multi-tool can also be used to trim clips and adjust the clip gain levels, 
just as you can with the Arrow and Range tools. The Fairlight page includes helpful 
visual guides you can use as you trim and fade clips in Focus mode—for example, the 
timecode field updates as you resize a clip, and the playhead in the ruler moves along 
with your trims and fades. 



178Lesson 3  Editing Sound Effects and Music

17	 In the A12 track, drag the left edge of the Running clip toward the left about 2 seconds 
until it starts at 01:00:20:20. Use the timecode field as a guide while you extend the 
beginning of the clip. 

18	 Drag the Fade handle at the beginning of the Runner clip to the teal runner marker to 
create a 1-second fade-in. Use the playhead in the ruler as a guide while you drag the 
fade handle to see when it reaches the teal marker.

Excellent. Now that you have some hands-on experience with the Focus mode multi-tool, 
let’s explore a new feature that is perfect for splitting up the camera-clicks clip. 

NOTE  If you did not complete the previous sound effects editing exercises, you 
can open the timeline 3a Intro Combo 3 fx added to catch up. This timeline is in 
the media pool in the Timelines > Lesson 3 bin.
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Using Transients to Split Clips Quickly
Transients are the abrupt changes in a waveform that let you quickly see where sounds 
begin. DaVinci Resolve includes transient detection, so you can easily split clips into smaller 
segments based on transients. In this exercise, you’ll combine transients, the multi-tool, 
and keyboard shortcuts to trim and dice up the camera clip on the A13 track into separate 
audible clicks.

1	 Solo the A13 FX 5 Camera track. 

2	 Zoom and scroll as much as necessary to clearly see the Camera clip and its waveform 
in the timeline. 

3	 In the A13 track, trim the head and tail of the Camera Click fx v3 clip to remove the first 
and last click sound. 

When finished, there should still be five camera click sounds.

Next, let’s check the “Jump to” navigation options in the Timeline View Options menu.

4	 In the Timeline View Options menu, deselect all the Navigation options except Jump to 
Clip and Jump to Transient.
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With the Jump to Transient option enabled, you can use the Up and Down Arrow keys 
to navigate to transients within the clip. 

5	 In the Timeline toolbar, to the left of the Vertical Zoom controls, click the Transient 
Detection button to turn it on. 

Once Transient Detection is active, a Transient Detection icon will appear on each track 
header. This icon allows you to choose which tracks will detect and display transients. 

6	 In the A13 track header, click the Transient Detection button to display the transients 
within that track.

The thin vertical lines within the clip are the detected transients. Notice that there 
is a transient before each camera-click sound. You can now use these transients to 
navigate to and split the clip into individual clicks.

TIP  Jump to Clips, Markers, Fades, and Transients looks at all the visible 
timeline clips and tracks for navigation with the Up Arrow and Down Arrow 
keys. To focus on a single track or specific tracks, you can simply hide all other 
tracks in the Tracks index while you work. 

7	 In the Index, click the Tracks button to switch from the Markers index to the 
Tracks index. 
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8	 Swipe off visibility (the eye icon) for tracks A1 through A12 so that only the A13 track 
is visible. 

9	 Select the A13 track header and move the playhead to the beginning of the track. Press 
the Down Arrow to jump the playhead to the beginning of the first clip in that track. 

10	 Press the Down Arrow again to move to the first transient before the first click 
sound. Press the Down Arrow again to move to the second transient, which is before 
the second camera sound. 

NOTE  Another advantage of hiding the other tracks is that the only clips you 
will split are those showing in the timeline. Normally, if no tracks or clips are 
selected, all visible clips beneath the playhead will be split when using the Split 
or Razor shortcuts. 
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11	 Press Command-B (macOS) or Ctrl-B (Windows) to split the clip at the playhead 
position, which is also the second transient. 

12	 Press the Down Arrow to move to the next transient and split the clip. Repeat this step 
until each marked transient in the clip has been split. When you are finished, there 
should be five clips in the A13 track. 

13	 Select and delete the first and third clips in the A13 track. Now, there are three 
independent camera clicks. 

Working with transients can be helpful in splitting clips into smaller segments. With 
the sounds split into smaller clips, you can then arrange them as needed in the track. 
Transients are also useful for detecting beats in music and words and phrases in 
dialogue. You are finished using transient detection for now.

14	 In the Timeline toolbar, click the Transient Detection button to disable that option in 
the timeline. 

15	 Unsolo the A13 track. 

16	 In the Tracks index, swipe on track visibility for the A1-A12 tracks.

17	 In the Timeline View Options menu, disable Jump to Transient. If necessary, enable 
Jump to Clip. 

18	 Zoom to see all the clips and tracks in the timeline again.

19	 Play the timeline starting at the pink Bike marker to hear the edited camera sound 
in context.

Great job! Just one more thing. The extended runner clip sounds so good, let’s do the 
same thing at the end of the clip.

20	 Extend the end of the Running clip in the A13 track by about 1 second and add a 
fade-out. 
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Mission accomplished! The sound effects are working great, and your clients are happy and 
eager for you to finish the soundtrack. In the next exercise, you’ll work with the Fairlight 
Sound Library, where you can search for and audition sound effects to use in your project. 

Working with the Sound Library
Many editors and audio professionals have vast libraries of project-ready sound effects 
and music, often stored on servers or separate hard drives. You can access your own 
sound collections in the Fairlight page within the Sound Library panel. The Sound Library 
hosts a user-defined collection of sounds that reside elsewhere on your system and are 
indexed to be searched, marked, and edited to the timeline, just like clips in the media 
pool. Additionally, Sound Library files can be auditioned or marked with a sync point that 
aligns with the timeline playhead. Sound library files are only added to the project media 
pool when confirmed in the timeline. 

NOTE  This exercise assumes that you have followed along with the “Getting 
Started” section of this book to download and install the Fairlight Sound Library on 
your system. The Fairlight Sound Library includes over 500 royalty-free Foley 
sound effects you can use in your projects. 

In this exercise, you’ll continue adding sound effects to the current timeline. This time, 
instead of working with clips from the media pool, you’ll use clips from the Fairlight Sound 
Library. For this example, you’ll use the sounds installed with the Fairlight Sound library to 
search for and edit three different sound effects to be added for the camera bag, bike, and 
skateboard. Let’s start with the camera bag.

1	 In the interface toolbar, click the Sound Library button to show the Sound Library. 

2	 Click the Project Library button to the right of the search field to show the Project 
Library menu. In the Project Library dropdown menu, choose Fairlight Sound Library. 
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NOTE  If you don’t have the Fairlight Sound Library installed, install it now. If 
you cannot download at this time, you can find the sound effects you need in 
the media pool Fairlight Sound Library bin. 

Now, you can find a sound effect to audition in the Sound Library. Let’s start with the 
sound of a backpack representing the camera bag when the photographer says, “I 
grabbed my camera, and I was taking pictures.”

3	 In the Sound Library search field, type backpack.

There are three results listed. 
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4	 Select each sound, one at a time, and play it in the Sound Library preview player. 

Any of the sounds could work. For this exercise, the Backpack Movement 2 clip should 
work nicely. 

5	 Select the Backpack Movement 2 clip in the list and play it again.

There is a lot of bag movement in this clip, and you’re looking for something that could 
sound like someone quickly grabbing a camera bag. Keep in mind that you only need 
about 1 second of sound. The end of the clip seems promising. Let’s mark the last 
second and a half of the clip. 

6	 Using the source timecode in the lower right corner of the preview player as a guide, 
move the playhead to 01:48:28:06, which is about a second and a half from the end of 
the clip. Mark an In point. The duration to the end of the clip should be around 01:16. 
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7	 Play the marked section of the clip. 

It’s perfect! You can add a sound to the timeline from the Sound Library just as you do 
a source clip in the media pool. 

8	 Zoom the A13 track and clips as needed for a clear view of the track and clips. 

NOTE  From this point forward, feel free to zoom in as needed while you work. 
Zoom instructions will only be given when necessary for a specific exercise. 

9	 Drag the Backpack Movement 2 clip from the waveform in the preview player to the 
A13 FX 5 Camera track. Once in the track, move the new clip so it starts before the 
camera clicks.

10	 Play the timeline from the pink marker again. 

The new clip works but has two movement sounds. Let’s trim off the second waveform 
at the end of the clip and move the remaining clip to the right, closer to the 
camera clicks. 

11	 Trim the tail of the backpack sound to remove the second waveform. Then select the 
clip and nudge it toward the right about 10 frames. 

12	 Play that section of the timeline again. 

Auditioning Sound Effects in the Timeline
One of the great things about working with the Sound Library is that you can access 
thousands of sounds in multiple libraries and audition them directly in the timeline, 
thereby hearing them in the context of the other tracks without committing to their use 
until you are sure they work. All you need to do is select a track and move the playhead to 
the position where you want the sound to start. 

In the following exercise, you’ll audition bike sounds in the A10 track to choose which you 
want to commit to using. To keep the process simple, the Fairlight Sound library includes 
an Audition button to temporarily place a clip into the selected track in the timeline and a 
set of buttons to cancel or commit, all without the need to drag and drop the clip. 
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1	 In the timeline, select the A10 FX 3 Bike track. 

2	 Press Shift-Up Arrow or Shift-Down Arrow to move the playhead to the pink 
Bike marker. 

Before auditioning sound effects, it’s a good idea to turn on the Stop and Go to Last 
Position option so you can continue to play back each clip you audition without 
needing to move the playhead into position each time. 

3	 Choose Playback > Stop and Go to Last Position. 

NOTE  You can right-click the Stop button in the transport controls in both the 
Sound Library and timeline to enable or disable the Stop and Go to Last 
Position option. 

4	 In the Sound Library search field, type bike.

The search results include a list of seven clips ranging from Bike Bells 1 to 
Bike Chain 2. 

5	 Listen to the first three clips in the list; each is a different recording of bike bells. 



188Lesson 3  Editing Sound Effects and Music

Thoughts? You could try using bells for the scene. However, the character is a college 
student on her way to class. My guess is that she is running late for class on a fast bike 
with no bell. Let’s keep looking. 

Now that you’ve heard the bike bell sound effects, let’s listen to the last four sounds, 
which focus more on bikes in motion. 

6	 In the Sound Library, select Bike By 1 and preview the clip.

Now, this sounds like someone on a bike hurrying to get somewhere. Let’s audition the 
clip in the timeline. To audition a clip, you need to select the track where you want the 
clip and move the playhead to the point where you want the clip to start. 

7	 Select the A10 FX 3 Bike track. Then move the playhead to the pink Bike marker. 

8	 In the Sound Library, click the Audition button.

The sound effect appears in the timeline, ready to play.

9	 Choose Workspace > Active Panel > Timeline or press Command-4 (macOS) or Ctrl-4 
(Windows) to change the focus from the Sound Library to the Timeline. 

10	 Press the Spacebar to start playback in the timeline from the pink marker. 

The sound effect works well and complements the VO 3 Bike voiceover. Let’s audition 
the Bike By 2 sound effect. 

NOTE  Clicking the Cancel button removes the previous sound effect and 
allows you to audition another audio clip in the same place. You can also 
cancel the audition by selecting a different sound in the Sound Library.
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11	 In the Sound Library, select Bike By 2 in the results list. 

The previous clip that you auditioned disappears from the timeline. 

12	 Click the Audition button. Then, select the timeline and play the clip to hear it in 
context with the voiceover. 

The second bike sound is good, but the first is better. 

13	 Audition the other two bike sounds and choose a favorite for the timeline. If you can’t 
decide, select Bike By 1. Click Audition to place one of the bike sounds in the timeline. 
Then, click Confirm to add the clip to the media pool and timeline as a source clip. 

Success! Two sound effects are done, and one to go. At this rate, you’ll be done with this 
assignment before your clients arrive with their next big idea. 

Audition and Confirm the Skateboard SFX
Now that you are familiar with the search, audition, and confirm functions in the Sound 
Library, it’s your turn to fill in a skateboard sound on the A11 track at the orange 
Skateboard marker (01:00:13:08). Your mission, if you choose to accept it, is to search for 
Skateboard sound effects, audition the available sounds, and choose a favorite to confirm 
in the timeline. Good luck!
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Playing the Podcast Intro with Sound Effects
Before moving on to the next section, where you’ll use tools to sync sound effects to 
pictures, let’s take a moment to listen to a version of the PPN Podcast Intro Combo with all 
the sound effect tracks. You will work with this project again in Lesson 5 to balance and 
pan the tracks. For now, you’ll open a version of the timeline with all the sound effects 
in place. 

1	 Show the media pool. 

2	 Open the timeline 3b Intro Combo FX added. 

The timeline opens with 21 tracks. The lower tracks are all muted. These tracks have 
been in the timeline you have been working with all along; they were just muted and 
hidden in the Tracks index.

You can use the “Apply to all” modified click to quickly unmute all the tracks. Holding 
Command-Option (macOS) or Ctrl-Alt (Windows) while clicking the Mute button to 
unmute a track will unmute all tracks in the timeline. Let’s try it. 

3	 Hold Command-Option (macOS) or Ctrl-Alt (Windows) and click a red Mute button on 
one of the muted tracks. 

All the tracks should now be unmuted. The “Apply to all” modified click can be used for 
many purposes while you work, and you’ll have the opportunity to use it again in 
later lessons. 

4	 Play the timeline from the beginning to hear the full, unmixed podcast combo intro 
with the sound effects, dragons and all. 

Although unmixed, the intro shows promise for an exciting narrative podcast series. You’ll 
return to this project at the end of the lesson to add music. For now, it’s time to move on to 
the TML Project. 
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Preparing the TML Project
Time to reopen the Too Much Life project you worked on in Lesson 2. Let’s take a minute for 
some minor Fairlight housekeeping to prepare the timeline for the next set of exercises. 

1	 Choose Playback > Stop and Go to Last Position or right-click the Stop button in the 
transport controls to turn off that option. 

2	 Choose File > Open Recent Project and choose your TML Audio Post project from the 
list. If the project is not in the Recent Projects list, go to the Project Manager to open 
the project.

3	 In the media pool Lesson 3 bin, open the timeline 3 Sync Sound to Picture. 

4	 Show the meters. In the viewer, click the Floating Window button or choose 
Workspace > Fairlight Viewer > Floating. 

5	 Hide the meters and hide the media pool. 

6	 Show the Sound Library. Clear the search field. 

7	 In the Sound Library search field, type wood door.

There are two results. You’ll work with these in the next exercise. 

8	 Resize the floating viewer so you can clearly see the picture and place it in the lower 
right corner of the screen. 

NOTE  Feel free to move and resize the floating viewer as needed while you work 
on the remaining exercises. 
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Using a Sync Point in 
the Sound Library
One of the daily challenges for sound designers and the sound effects editors on their 
team is to sync audio clips to video cues precisely. In this exercise, you’ll use the Sound 
Library to search for and audition sound effects. This time, instead of dropping a clip in the 
timeline based on the In point, you’ll use a sync point. A sync point is a specific frame on 
the sound effect that aligns with the timeline playhead when you click the Audition button. 

The 3 Sync Sound to Picture timeline includes three different clips featuring doors. The 
first two clips are of a wooden bedroom door. The third clip includes a truck with doors 
that are opened and closed throughout the scene. 

1	 In the timeline, play the first clip. 

As you can see, Harper’s dad knocks on the door and then opens the door from the 
hallway. The scene cuts to a matched action angle from inside the room to complete 
the action of the door opening into the room. 

Your goal is to set the playhead on the frame where the door starts to open, and 
then set a sync point on a door-opening sound effect at the peak of the door 
opening waveform. 
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2	 In the Sound Library, preview each wood door sound in the list. 

In both clips, you can hear multiple versions of wooden doors opening and closing. For 
this example, the INT Hollow Wood Door sound effect should work well with the 
door onscreen.

Let’s set the sync point on the first instance of the door opening. The sync point will be 
the loudest peak in the door-opening waveform at the beginning of the clip. First, you’ll 
mark In and Out points at the beginning and end of the effect. Then, set a sync point 
on the frame you want to align to the playhead in the timeline. To set a sync point at 
the playhead position, click the Sync Point button to the left of the Mark In and Mark 
Out buttons in the Sound Library preview player.

NOTE  It is not necessary to mark an In and Out point on a sound to set a sync 
point. The advantage of marking an In and Out point is to limit the duration of 
the clip that is added to the timeline. You can always trim a clip after it has 
been added to the timeline.

3	 Select the INT Hollow Wood Door sound in the list. 

4	 In the Sound Library preview player, move the playhead to the beginning of the clip 
and mark an In point. Move the playhead to the end of the first instance of the door 
opening and squeaky hinge and mark an Out point (00:00:04:12). 

To view a different area of the waveform in the preview player, you can click the 
horizontal waveform mini map above the preview player. Let’s try it. 
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5	 Locate the rectangle in the waveform mini map above the preview player. Click the 
beginning of the waveform in the map to jump the rectangle and waveform view in the 
preview player to the beginning of the audio file’s waveform. 

6	 Move the playhead to the loudest peak in the first instance of the door opening sound 
(00:00:00:05). Click the Sync Point button. 

The audio sync point is the loudest peak of the door opening. In other words, it’s in the 
process of opening, not before it opens. So you’ll use the same logic in finding a sync 
frame in the viewer. You will look for the slightest crack of the door opening and sync 
to that. Remember that you can always nudge the sound effect later if needed. 

7	 In the timeline, move the playhead to the first frame where you see a crack of light in 
the door where it starts to open, then back up by one frame (01:00:12:01). 
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8	 Select the A2 FX 1 Door track.

9	 In the Sound Library, click Audition.

The clip appears in the A2 track with the playhead aligned to the highest peak in the 
waveform. Let’s solo the A2 track and play back the video at full screen to check 
the sync. 

10	 Solo the A2 track. Then, move the playhead to the blue marker at the beginning of 
the video clip. 

11	 Choose Workspace > Viewer Mode > Cinema Viewer or press Command-F (macOS) 
or Ctrl-F (Windows). Play the timeline from the beginning of the video clip. 

The sound effect should be in sync with the door opening. After you confirm the clip, 
feel free to nudge the sound effect a frame or two in either direction to fix the sync 
if necessary.

12	 In the Sound Library, click Confirm. 

One door down, one to go. The best way to hone your new skills is to use them,  
so let’s do it again! This time, with less direction. 

13	 In the timeline, move the playhead to the second blue marker. Play the second video 
clip to see the door opening. 

This time, the door is farther away, so the sound may not be as pronounced. Choose 
whichever door sound effect you like. 

14	 In the Sound Library, mark In and Out points around one of the door opening sound 
instances and set a sync point. 

15	 Move the playhead to the first frame where you see a crack of light in the door’s 
opening, then back up a frame until the light crack is gone. 
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16	 Audition the sound effect. Play the clip in the timeline and check the sync. Lower the 
clip gain level on the door sound. Confirm the clip. Nudge if needed. 

TIP  A great way to check the sync on a clip is to scrub the clip in slow motion 
in reverse using the JKL keys or a jog wheel on a hardware controller. 

Well done! You’ve used the Sound Library to sync sound effects to picture using a sync point. 

Sync the Truck Doors
If you are enjoying these exercises and would like to try something more challenging, the 
third shot includes a truck with doors that open and close during the scene. For this 
self-guided exercise, you’ll solo the A3 FX 2 Truck Doors track and sync car door sound 
effects to the clip. The Sound Library includes a variety of car door sounds to choose from. 
If the car door sounds aren’t a perfect match, don’t worry; you’ll learn how to lower pitch 
and stretch waveforms to modify sound effects in Lesson 7, “Using Fairlight FX and 
Processing for Creative Sound Design.”
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NOTE  The Fairlight Sound Library includes a limited number of sounds to work 
with. If you have your own sound effects collections, you can always index your 
sound effects into a new project library that you create in the Project Manager and 
use your own sounds. 

MORE INFO  You can find more information about indexing other sound 
collections into the Sound Library in the DaVinci Resolve User Manual available via 
the DaVinci Resolve Help menu. 

Using Video and Audio Scrollers 
for Precise Synchronization
The Fairlight audio timeline includes a set of scrollers that let you compare a frame-
accurate filmstrip of the video track with any track’s audio waveform. You’ll find the 
controls to show and hide these scrollers in the Timeline View Options menu. In this 
exercise, you’ll work with a scene from the film Hyperlight, where you will combine the 
scrollers with some skills you already have to sync a sound effect to a picture. 

1	 Open the timeline 3 HL Pod Sync with scrollers. 

2	 Hide all panels except the timeline and floating viewer. Resize the viewer and move it to 
the upper right of the screen.

3	 Play the timeline once from the beginning. 
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4	 Go to the blue marker, just after Emiliana’s line “Positive, do it.” 

Your goal in this exercise is to sync the sound of the pod engines to the visual of the 
pod engines. Unlike the doors opening and closing, which have an easy-to-identify 
sync point, the pod engines take four frames to ignite from off to full engine fire. 

Whether you are working with single frame sync or a sequence of frames, the video 
and audio scrollers available only on the Fairlight page are a powerful visual tool for 
syncing sound effects to picture. 

5	 Click the timeline options menu to show all the timeline options. Select the Display 
Video Scroller option. 
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At the bottom of the timeline, you’ll see the video scroller. Each filmstrip frame in the 
video scroller corresponds to a single video frame.

NOTE  If you don’t see every frame, right-click and change the filmstrip Zoom 
Level to Low.

The red vertical line on the video scroller represents the timeline playhead.

6	 Play the timeline until the space pod engines are fully ignited with blue flames. Stop 
playback and look at the video scroller. 

As you can see by looking at the video scroller, this is not actually the first frame of the 
engine ignition. In fact, depending on your reaction time when you stopped playback, 
the first frame of ignition may not even be visible in the video scroller filmstrip. 

7	 If necessary, use the JKL keys to reverse the playback until you can see both the pod 
engines off and ignited in the filmstrip. 

The video scroller can be dragged left or right to move the playhead to the desired 
position. 

8	 Drag the video scroller to the right or left until the playhead is on the frame before the 
engine ignites. Watch the viewer as you drag the scroller to confirm when you are on 
the correct frame. 

You can also click any frame on the filmstrip to jump the playhead to that frame. 



200Lesson 3  Editing Sound Effects and Music

9	 In the video scroller filmstrip, click a frame where the engine is fully ignited with four 
blue flames. 

Now, you’ll return the playhead to the first frame before ignition with a single click. 

10	 In the video scroller filmstrip, click the last frame before ignition, just before the first 
sign of blue flame.

Next, you’ll enable the audio scroller so you can see the waveform of the pod jets 
sound effect in the A4 FX 1 track. 

11	 In the A4 FX 1 track, select the Pod Jets 2 clip and press D to enable the clip. 

This is the sound effect that you will sync to the pod engine ignition.

12	 In the Timeline View Options menu, enable the Display Audio Scroller 1 option. 

At the bottom of the timeline, you’ll see the video scroller and audio scroller 1, which 
shows the selected track A4 – FX 1. 

13	 If another audio track is showing, click the Audio Scroller 1 Display dropdown menu 
and choose A4 – FX 1.

14	 Solo the A4 track and play the clip from the beginning to hear the sound effect. 

Now that you’ve heard the sound effect, it’s time to sync it to the picture. You could 
nudge or drag the clip into position, but instead, let’s use cut and paste to pick up the 
clip and place it exactly where you want it. This is also a good time to increase the size 
of the A4 track for a better view of the clip’s waveform.

15	 Increase the height of the A4 track. 
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16	 Move the playhead to the beginning of the timeline and select the A4 track. If 
necessary, set the edit selection point at the beginning of the clip in the A4 track. 

17	 Choose Edit > Cut or press Command-X (macOS) or Ctrl-X (Windows) to cut the clip in 
the A4 track. 

A semitransparent version of the clip remains synced to the playhead until you paste it.

18	 Press Shift-Down Arrow to move the playhead and clipboard version of the clip to the 
blue marker. 

19	 Start playback and stop as soon as you see blue flames in the filmstrip. Then, click the 
filmstrip frame before the blue flame first ignites. 

20	 Choose Edit > Paste or press Command-V (macOS) or Ctrl-V (Windows) to paste the 
sound effect. 

Once the clip is pasted, you can see its waveform in the audio scroller. 
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21	 Click the A4 FX 1 track header to deselect the track. 

22	 Play the timeline from the blue marker to see and hear the pod engine sound along 
with the video. Play that section of the timeline forward and backward to check the 
sync. It should sync perfectly with the video. If not, you can nudge the sound effect as 
needed until you are satisfied with the result. 

23	 Unsolo the A4 track and play the entire timeline to see and hear the results. 

As you just discovered, the video and audio scrollers are a great way to locate, navigate, 
and sync audio to video in the Fairlight timeline. In the next section, you’ll use the video 
scroller as a guide for setting markers for a visual effects clip. 

Preparing the VFX Project
You are about to embark on a whole new project composed of a VFX clip created in the 
Fusion page, aptly named Fusion VFX v1. The clip in this project is silent, and you’ll add 
music shortly. Meanwhile, let’s take a minute to restore the project archive and save a 
version with your initials. 

1	 In the Project Manager, right-click the empty space and choose Restore Project Archive 
from the shortcut menu. In the Finder, navigate to R19 Fairlight book media > R19 
Fairlight Part 2 > Fusion VFX v1.dra. 

2	 Click Open.
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The Fusion VFX v1 project opens with the 3 Fusion VFX Video Start timeline open and 
the video and audio scrollers still showing. The viewer will be in the same position and 
size as you had it in the previous exercise. 

3	 In the Timeline View Options menu, uncheck the Display Audio Scroller 1 option to hide 
the audio scroller. 

4	 Choose File > Save Project As and add your initials to the end of the project name.

5	 Click Save. 

6	 Show the media pool and select the Lesson 3 bin to see the timelines for this series 
of exercises. 

Here you’ll see three sets of Start and Finished timelines as well as backup timelines if 
needed along the way. 

7	 Hide the media pool. 

8	 Play the 3 Fusion VFX Video Start timeline once from start to finish to see the full 
VFX clip. 

Now that you’ve seen the clip, let’s get busy setting a few markers and adding music to 
accompany the visuals. 
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Marking Sound Cues 
with the Video Scroller 
This Fusion VFX video includes a wide range of moving elements in 3D space, offering 
exciting possibilities for the sound. Currently, the clients are “sure” that they want a 
music-only soundtrack. So in this lesson, you’ll focus on editing the music the clients 
selected for this video. However, as a sound editor in training, it’s a good idea to also mark 
some prime areas of the video that are perfect for interesting sound design effects. Since 
you already have the video scroller showing, let’s take a minute and add a few markers 
based on the action on screen. 

For this exercise, you’ll continue working with the Focus mode multi-tool, which is the only 
tool that provides live updates in the viewer as you drag an edit selection or range. First, 
you’ll take a look at the current markers in the index, and then set two new duration 
markers using the Focus mode multi-tool. 

1	 Show the Markers index. 

Currently, three markers in the index correspond with the three markers in the timeline. 

2	 In the index, select the thumbnail frame for the green marker to move the playhead to 
that position in the timeline.
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3	 Play the section of the timeline with the green duration marker. Watch the green oval 
draw in and eventually disappear in the distance onscreen in the viewer and video 
scroller filmstrip. 

Next, you’ll use the scroller and multi-tool to locate when the logo flies into frame.

4	 Start playback from the beginning and stop when the multi-color DaVinci Resolve logo 
is visible in the middle of the viewer. 

5	 Use the JKL keys or Left-Arrow and Right-Arrow to navigate one frame at a time while 
watching the viewer and video scroller to locate where the logo starts to fly into the 
picture (approximately 01:00:08:22). 

As you draw an edit selection range with the multi-tool, the viewer updates live. 

6	 In the A1 MX track, drag an edit selection range from left to right, starting just as the 
logo begins to fly onscreen and ending when the logo fades out (approximately 
01:00:08:22 – 01:00:13:18).

NOTE  You can hold Shift and drag the edges if needed to resize the 
selection range. 
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7	 Choose Mark > Convert In and Out to Duration Marker.

A blue marker appears in the timeline. 

8	 Double-click the new duration marker to open the Markers dialog and edit the marker 
as follows:

	— Name: Logo Fly In and Glow Out

	— Notes: Foreground to Background

	— Color: Orange

9	 Click Done. 

One more marker. This time, you’ll drag the selection range from right to left because 
the end of the marker is also the end of the clip. 

10	 Move the playhead to the end of the timeline 
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11	 While using the viewer and video scroller as a guide, drag an edit selection from the 
end of the video clip where the logo disappears offscreen to the point just before the 
logo starts to move. While watching the viewer, you can drag the beginning of the 
range back and forth without releasing it until you’ve found the best starting frame 
(01:00:53:00–01:00:55:00).

12	 Choose Mark > Convert In and Out to Duration Marker. Change the new marker’s color 
to orange.

13	 In the Markers index, name the new marker Logo Fly Out and type Center to 
Foreground in the Notes field.
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You’ll work with these markers later in Lesson 7. For now, you are finished with the 
video scroller and Markers index. 

14	 Hide the viewer and video scroller. 

That concludes your work with sound effects in this lesson. Time to move on to 
music editing. 

Editing Music to the Beat
Editing music is like editing dialogue and sound effects, and you can use any of the 
Fairlight tools you’ve learned so far to edit and trim music in your projects. One challenge 
when editing music is maintaining musical time to hide the edits, which means editing to 
the beat rather than the frame. The Fairlight page in DaVinci Resolve offers features for 
editing music, including a user-defined tempo grid and floating Timecode window that can 
display musical time. In the next series of exercises, you’ll utilize these features to set the 
timeline tempo to match a song. Then, you’ll intercut an instrumental version of the song 
to finish the track. You’ll also use audio track layers and fades to simplify the editing and 
draw custom crossfades from one musical phrase to another. Once the music is edited, 
you’ll add that timeline to the Fusion VFX v1 timeline as a nest and play the soundtrack with 
the picture. 

Showing and Setting the Tempo Grid
In previous exercises, you relied on the timecode display, timeline ruler, and grid as a guide 
for everything from setting markers to editing clips and keeping track of duration and 
program running time. In this exercise, you’ll change the timeline’s time scale from 
timecode to tempo in the Grid View Options menu. Then, you’ll set the grid to the tempo 
of the song.

Let’s start by opening the timeline containing the song you’ll work with for the Fusion VFX 
soundtrack. The song for this project is “Circles,” written and performed by singer-
songwriter Esbie Fonte.

1	 In the media pool, open the timeline 3b Music Edit Start. Hide the media pool. 
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The timeline shows one track, A1 Song Edit, and a clip with the first part of the song 
“Circles.” There are also some timeline markers that you’ll use as a guide while editing 
the song. 

2	 Choose Workspace > Timecode Window to show the floating timecode window. 

As you can see, the timecode window shows a larger version of the current playhead 
position, which is also visible in the timecode display. You can resize and move this 
window anywhere on the screen. Let’s resize the window and move it to the center of 
the screen.

3	 Drag any corner of the timecode window to resize it for a clear view of the timecode. 
Drag the timecode window header to move the window to the center of the screen, 
where you can see it while you work. 

4	 Play the clip to hear the beginning of the song that will be used for the Fusion VFX 
soundtrack.

5	 Use the Focus mode multi-tool to click the lower half of the clip to select the entire clip 
and its duration (35:01). 

Next, you’ll show the tempo grid and customize the settings. Grid settings are located 
in the Grid View Options menu, which is located to the right of the Timeline View 
Options menu. 
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6	 Click the Grid View Options menu to show the different Grid options.

You can use this menu to customize the grid line visibility, snapping, time scale of 
either timecode or tempo, and the resolution. 

NOTE  Tempo is the heartbeat of a song and determines how quickly the beats 
within a measure are played. The Fairlight page tempo grid doesn’t change the 
speed of your music—rather, you change the grid as needed to match the 
song’s tempo. Changing the grid time scale from timecode to tempo changes 
the ruler and timecode displays to musical time: Bar|Beat|Note. 

7	 In the Grid View Options menu, set the options as follows:

	— Time Scale: Tempo

	— Resolution: Bar (measure)

	— Time Signature: 4/4 (four beats per measure) 

	— Tempo: 120 BPM (beats per minute - default)

	— Song Start: 01:00:00:00 (start of timeline default)
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Let’s zoom in on the clip for a better view of the waveform.

8	 Zoom horizontally and vertically as needed for a clear view of the clip’s waveform.

9	 Move the playhead to the beginning of the clip. Notice that the musical time in the 
timecode window shows 003|03|01.

Let’s change the grid starting time to align with the beginning of the clip and the green 
“Start” marker. 

10	 Right-click the timeline ruler above the clip and choose “Set Tempo Grid start” from the 
shortcut menu.
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The ruler and timecode window now show 001|01|01 starting at the beginning 
of the clip. 

Great. The grid aligns with the beginning of the clip, but how do you know if the grid 
tempo matches the music? One method to check the tempo against the music is to 
listen to the music while watching the timecode window. If the tempo of the music 
aligns with the bars, beats, and notes as they change in the display, then the tempo is 
correct. If the numbers in the timecode window don’t follow the beat of the music, it’s 
time to set the grid to match the song. (Hint: the tempo of this song is not 120 BPM.) 

11	 Play the clip from the beginning and watch the timecode window while listening to 
the music. 

Nope. Not even close. Now you know. If you are a musician, you are probably guessing 
that the tempo is about twice the speed it should be for this song. The good news is 
that you can easily change the tempo to match the song. All you’ll need to do is count 
to 4 four times, or 4 consecutive bars with 4 beats each. Even better, this song offers a 
very easy-to-recognize bass beat at the beginning of each bar. 

Your goal is to mark a range starting at the first beat of the first bar and ending after 
the fourth beat of the fourth bar, which is actually the first beat of the fifth bar. If this 
sounds confusing, don’t worry; it won’t be when you try it. 

12	 Play the beginning of the clip and listen to the bass guitar note that starts the 
instrumental intro. Listen for the second bass guitar note  and stop playback.

Don’t worry if you think yourself rhythmically challenged; you should be able to count 
the beats in this song. Each bar starts with a bass note that you can hear and see in 
the waveform as the highest peak at the beginning of each bar. All you’ll need to do is 
count to four, starting with the bass note as “one.” When you get to four, it’s time for 
the next bar and bass note, which will be “one” for the next bar. As you count, you’ll 
replace “one” at the beginning of the bar with the incoming bar number. Using 
numbers, your count will be 1, 2, 3, 4 | 2, 2, 3, 4 | 3, 2, 3, 4 | 4, 2, 3, 4. 

One last thing: you’ll need to mark an In point at the beginning of the clip before the 
first beat and an Out point right after you count the fourth beat in the fourth bar. Press 
O to set an Out point where the next “one” count would have been if you had kept 
counting. For this song, the vocal starts at the beginning of the fifth bar, so you’ll set 
the Out just before the vocal starts. Let’s try it.
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13	 Set an In point at the beginning of the clip since the first note is the first beat of the 
first bar. Play the clip and count 1, 2, 3, 4 | 2, 2, 3, 4 | 3, 2, 3, 4 | 4, 2, 3, 4 | Out. Mark an 
Out point after the fourth beat of the fourth bar. Ignore the timecode window while 
you count because it will be incorrect until you set the tempo. 

Once you have set a range containing a specific number of bars and beats, you can 
change the grid accordingly.

14	 Right-click the timeline ruler above the In and Out points and choose Set Tempo Grid 
BPM (beats per minute). 
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15	 In the Tempo Grid Setup dialog, set the Number of Bars to 4 if necessary. Then click 
Set Tempo From Range. 

NOTE  You can set the tempo grid with fewer than four bars; however, to be as 
accurate as possible with your beat count, it’s a good idea to use at least two 
or three bars to set the grid BPM.

16	 Clear the range and move the playhead to the beginning of the clip. 

The grid lines mark each bar of music to match the timecode window’s musical time 
display. Before editing the music, let’s play the beginning of the song again and check 
the music against the revised musical time. 
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17	 Play the entire clip and watch the timecode window. 

The bars and beats should align with the music, with a bass guitar note on the first 
beat of each of the first four bars. 

18	 Close the timecode window. 

Congratulations! You’ve successfully set up the tempo grid to match a song, and you’re 
ready to move on to editing the music. 

Editing Music in Track Layers
You can edit music clips on separate tracks or in track layers within the same track. In this 
exercise, you’ll work in track layers since they offer several advantages for editing music. 
One advantage is that in layers, you can easily compare waveforms to align musical parts 
based on timing in the waveform. Audio track layers are also great for drawing custom 
fades between layers. Let’s try it. 

1	 In the Tracks index, enable visibility on the A2 Inst track. 

The A2 Inst track appears below the A1 Song Edit track in the timeline. The A2 track 
contains an instrumental version of the song. 
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2	 Show the Markers Index.

3	 In the timeline, unmute the A2 track and play the beginning to hear both tracks together. 

Clearly, the instrumental clip is not aligned with the song clip in the A1 track; they are 
out of sync. No problem. You can quickly align them in track layers. First, you’ll need to 
enable Layered Audio Editing so you can move clips into the same track in layers rather 
than overwriting the existing clip with the incoming clip. 

4	 Choose Timeline > Layered Audio Editing to enable that option if necessary. 

5	 In the timeline, increase the vertical height of the A1 Song Edit track. 

6	 In the Timeline toolbar, turn off Snapping (magnet) if necessary. 

7	 Drag the green clip in the A2 track up to the A1 track and use the transparent 
waveforms to align the clips. 

8	 Choose View > Show Audio Track Layers to see both clips in the track. 

These music clips are two-channel stereo clips, so you will see both channels in the 
track layers. 
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Trimming and Fading Music in Track Layers
Now that the clips are aligned, you can trim any unnecessary clip handles and transition 
from the vocal song to the instrumental version with custom fade. Since you have the tempo 
grid showing, let’s turn on the Snap to Grid option so the edits will align with the grid. 

1	 Show the Grid View Options menu. Enable the Snap to Grid option.

Snap to Grid works even if timeline snapping is turned off. 

2	 In the timeline, drag the beginning of the green clip toward the right to trim the head 
of the clip to the nearest grid line. 

The edge you are trimming snaps to the nearest grid line and aligns with the 
beginning of the yellow clip. Next, you’ll trim the end of the yellow clip to the grid line 
nearest to the orange marker. 

3	 Drag the end of the yellow clip toward the left until it snaps to the grid line near the 
orange marker. 

Next, you’ll move the yellow clip above the green clip. If the yellow clip is already above 
the green clip, you can skip to step 5. 

4	 Drag the yellow clip up above the green clip in the A1 track. Deselect the clip. 

5	 Play the last two bars of the yellow clip and listen to how it cuts to the instrumental clip.

Thoughts? The edit sounds abrupt and definitely needs a fade.
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6	 Using the grid as a guide, drag a two-bar fade out at the end of the yellow clip. 

7	 Play the music from the beginning to hear the smooth transition from the vocal version 
of the song to the instrumental version.

Bravo! The transition is flawless and will go completely unnoticed by the audience. You 
know a music edit works when you don’t hear it, and the music continues without skipping 
a beat, literally. Next, you’ll add a different section of the instrumental music to finish off 
the Fusion VFX soundtrack.

NOTE  If you didn’t complete the previous music exercises, you can open the 
3c Music Edit Layers add 3rd clip to catch up. 

Finishing the Song Edit
Based on your performance in the previous exercise, you should have no trouble adding 
the last clip to finish the music edit. This exercise will serve as an opportunity to practice 
some of the new skills that you’ve learned so far. To finish off the soundtrack, you’ll add a 
section of the song’s bridge (a change in music to add interest). 

1	 In the Tracks Inspector, show the A3 track. 

2	 In the timeline, unmute the A3 Inst Bridge track. 

3	 Play the timeline from the orange marker and listen to the edit from the green 
instrumental clip in A1 to the teal instrumental bridge clip in A3. 

Not bad. In fact, you could possibly leave it as is. However, as a music editor in training, 
“not bad” isn’t “awesome” or “inspiring,” which should be your new standard. How do 
you elevate the music edit to the next level? Let’s extend the beginning of the clip to 
fade in some of that percussive beat into the bridge. This is also a good time to change 
the grid from bars to quarter notes and show the grid for more visibility as you finish 
the edit. First, let’s use keyboard shortcuts to move the clip from the A3 track to the A1 
track without changing its horizontal position. 
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4	 Select the clip in the A3 track. Press Option/Alt-Up Arrow twice to move the selected 
clip from the A3 track to the A1 track. 

The teal clip appears in the lowest layer of the A1 track. Before proceeding, let’s tidy up 
the timeline. 

5	 In the Tracks index, hide the empty A2 and A3 tracks. Increase the vertical height of 
the A1 track so you can easily see the grid, clips, and waveforms. 

6	 In the Grid View Options menu, change the Resolution to 1/4 note. Then select the 
Display Grid option at the top of the menu.
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The tempo grid now shows four quarter-note sections between each set of brighter 
bar lines. 

7	 Move the playhead to the beginning of the teal clip and zoom horizontally for a clear 
view that includes the overlapping green and teal clips (bar 013 – bar 016) in the ruler. 

Your goal is to fade from the upper clip to the lower clip to hear four bass drumbeats 
before the instrumental bridge kicks in at the teal marker. Luckily, the tempo grid 
offers exactly what is needed to simplify this musical edit. 

8	 Drag the head of the teal clip to the middle of bar 013 (013|03|01). Then, on the 
green clip, drag a fade from the tail to the middle of bar 013 (013|03|01). 

9	 Play the timeline from the beginning of bar 13 to the end of bar 14. 

Nice work. The two musical sections blend nicely with the basic linear fade. The client loves 
the music; however, they had a comment about the transition: “Great, but… can you be 
more subtle fading into the beats with a slow bleed before you drop into the bridge?” Your 
response, as always, is “Sure!” 
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Customizing a Fade in the Timeline
Once you’ve created a fade transition, you can adjust the curve of the fade by dragging the 
handle that appears on the fade curve. Dragging the handle up and down affects the angle 
of the fade curve, and dragging the handle left and right affects the shape of the curve. 
Using the handle, you can create a variety of custom fades. As you change the shape of the 
fade, bright and shaded areas on the clip indicate the power levels of the fade over time. 
Now, let’s shape the fade for a more interesting transition from the green clip to the teal 
clip. In this exercise, you’ll change the curve of the fade to maintain the level of the green 
clip longer with a more subtle transition to the incoming bass drumbeats in the teal clip. 

1	 Hover over the fade-out on the green clip to see the handle in the middle of the 
fade curve. 

2	 Drag the fade handle down as far as possible to change the curve. Then, drag the 
handle toward the left to create a steep and quick fade.
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The bright and shaded area on the clip indicates the level changes during the fade. In 
this case, the sound of the green instrumental clip drops away quickly with an equally 
quick entrance of the drumbeat in the teal clip. 

3	 Play the transition to hear how it sounds. 

Ouch. That didn’t work for this musical edit and is the opposite of what the client 
requested. Then again, what a great way to test-drive custom fade curves. Now, let’s 
try that again, this time changing the curve so the green clip remains dominant with a 
subtle bleed-through of the drumbeats until a fast drop to the teal clip at the end of 
the transition. 

4	 Drag the fade curve handle toward the right to the last grid line before the end of the 
clip, then up or down to about the middle of the clip. 

 

5	 Play the transition. 

Awesome! Notice how the drumbeats subtly bleed in seamlessly to blend two music 
sections together, even though the first section has no bass drum and the second 
section is driven by the bass drum. Sweet! 

Time for a little housekeeping before you move this timeline into the Fusion VFX 
timeline to play the music with the video.

6	 Press Shift-Z to fit the clips to the visible timeline. 

7	 Decrease the height of the A1 track. 

8	 Hide the index. 

9	 In the Grid View Options menu, set the Time Scale to Timecode and deselect the 
Display Grid option. 

10	 Choose View > Show Audio Track Layers to hide the layers. 
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11	 Drag a fade-out from the end of the teal clip to the red marker. 

NOTE  You can modify fades and fade curves on layered audio clips even when 
the audio track layers are not showing. 

12	 Play the timeline once from start to finish to hear the first version of your music edit. 

Applause. Now let’s see how it works with the video! To move these clips to the Fusion VFX 
timeline, you could either copy and paste the clips or drag one timeline into the other as a 
nested timeline. For this exercise, let’s try the second option.

Working with a Nested Timeline
DaVinci Resolve includes powerful workflow options for nesting and decomposing 
timelines within timelines in the Fairlight page. 

Nested audio timelines look and play back just like a clip. The difference is that nested 
timelines can be opened and edited, and the results update in the nested version. 
Additionally, you can decompose the nested timeline to add tracks and clips as well as 
preserve all the bussing, processing effects, and mixing from the nested timeline. You’ll 
work more with nested timelines during the mixing lessons later in this book. 

In this exercise, you will add the timeline with the finished music edit to an empty track 
in the Fusion VFX timeline, play the nested timeline, open the nested timeline, add a clip, 
and then decompose the nested timeline in place to instantly add all the clips and layers to 
the primary video timeline. You’ll start by setting In and Out points around the edited 
music. Then, you’ll drag the music timeline into an empty MX (music) track in the 
Fusion VFX timeline. 

NOTE  If you didn’t complete the previous music editing exercises, you can use the 
3d Music Layers Finished V1 timeline instead of the 3b Music Edit Start timeline.
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1	 In the Timeline View Options menu, deselect Display Video Tracks if necessary.

2	 In the 3b Music Edit Start timeline, mark an In point at the green marker. Mark an 
Out point at the end of the teal clip.

Setting In and Out points on the timeline before you add it to another timeline will 
define the duration of the nested timeline.

3	 In the media pool, open the timeline 3a Fusion VFX add Music. 

As you can see, this timeline includes two empty tracks, A1 MX for music and A2 FX for 
sound effects. Next, you’ll add the 3b Music Edit Start timeline to the A1 MX track.

4	 Drag the 3b Music Edit Start timeline from the media pool to the beginning of the A1 
MX track. 
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Notice that the nested timeline looks like a clip except for the badge in the lower left 
corner that indicates it is a nested timeline. The clients are eager to see the Fusion VFX 
video with the music edit. 

NOTE  The nested timeline should show a waveform representing the current 
audio output. This waveform is a cache file and may take a minute to appear. If 
you don’t see the waveform, try opening a different timeline and then 
returning to the timeline containing the nested timeline clip. 

5	 Show the floating viewer. Resize the viewer as needed and move it to the lower center 
of the screen. 

6	 Play the timeline and listen to the music while watching the video. 

Pretty cool, right? The song really works with the visuals, and the clients are excited. 
They have two minor notes for you to fix while they step out of the room to take a call. 

Client notes: 

	— Check the levels on the middle instrumental section; it seems too low.

	— The music needs a definitive ending.

Looking at the waveform in the nested timeline, you can see that the waveform in the 
middle section seems lower in level. That’s easy to fix. As for adding a definitive 
ending, that will be easy to fix as well in the music timeline. 

Editing a Nested Timeline 
Nested timelines work great for collaborative projects because the editor, VFX artist, or 
colorist could be working on the timeline with your nested music while you make changes 
or finish mixing in the master music timeline. Now is your chance to edit a timeline nested 
within another timeline. Any changes you make to the music timeline will update in the 
Fusion VFX timeline. For this exercise, you’ll open the 3b Music Edit Start timeline and 
make the requested changes for the clients. 

1	 In the 3a Fusion VFX add Music timeline, right-click the nested clip and choose Find in 
Media Pool from the shortcut menu.

The timeline that is nested is selected in the media pool. 

2	 In the media pool, open the selected timeline. 

3	 Hide the viewer. 

4	 Show audio track layers. 
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5	 Increase the height of the A1 Song Edit track. 

Déjà vu. Welcome back to the timeline you were just working on. Time to make a few 
quick improvements. 

6	 Clear the In and Out points. 

7	 Drag the clip gain line on the green clip upward to increase the clip level by around 
3 or 4 dB. 

8	 In the Tracks index, show the A4 Outro track. Enable the clip in the A4 track.

9	 Solo the A4 Outro track and play the clip to hear it. When finished, unsolo the track.

Now that is a definitive ending. All you need to do is add it to the end of the song so 
that it sounds good.

Fix the Song Outro 
It’s time to put your new music editing skills to the test. Give yourself a 5-minute time limit 
to get the job done. With practice, you could do it in about a minute. Feel free to dive in 
and follow your musical instincts to fix it without guidance. If you would like a few 
breadcrumbs to follow, here is a basic to-do list. There are many ways to achieve a great 
result. Here is one possibility:

	— Drag the navy clip up to the A1 track and place it below the teal clip.

	— In the Grid Option View menu, turn off Snap to Grid so you can freely align the 
Outro clip.
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	— Remove the long fade at the end of the teal clip.

	— Trim the teal clip so that it ends at 01:00:58:09. 

	— Add a short 2-frame fade-out to the teal clip to smooth the edit.

	— Reduce the clip gain level of the navy outro clip by about 2–3 dB.

	— Listen to the edit. When satisfied, hide the audio track layers. 

NOTE  If you didn’t finish the music edit and want to see and hear the new ending, 
open and play back the timeline 3f Music Edit Finished V2. 
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Playing the Updated Nested Timeline
All the improvements you made to the 3b Music Edit Start timeline updated automatically 
in the nested version of the timeline in the 3a Fusion VFX add Music timeline. As long as a 
timeline remains nested, any changes to the original timeline update as you progress in 
the nested timeline. Hearing is believing, so let’s verify that the changes have 
been updated.

1	 In the 3b Music Edit Start timeline, set an In point at the green marker. 

2	 Open the 3a Fusion VFX add Music timeline. 

3	 Show the viewer and play the clip in the A1 MX track to hear if it has been updated with 
the recent changes to the nested timeline.

The changes are all there, and the clients are thrilled! At this point, you could leave the 
nested timeline in case the clients change their minds or have a new idea they want you to 
try. Keeping the timeline nested gives you the freedom to modify its contents without 
having to bother the clients with new versions, timelines, or mixes. 
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Decomposing a Nested Timeline 
You can decompose a nested timeline via the right-click contextual menu in the timeline. 
Remember, once you decompose a timeline, there will no longer be a live connection 
between the clips and the formerly nested timeline in the media pool. In this case, 
decomposing the timeline will complete the music edit now that the clients have signed 
off on it. 

1	 In the 3a Fusion VFX add Music timeline, right-click the 3b Music Edit Start clip and 
choose Decompose in Place > Preserving Audio Data.

The Decompose Preserving Audio Data dialog offers three routing options: New 
Matching Busses, “Preserve existing paths,” and “Leave unassigned.” These choices 
affect how the tracks and busses in the nested timeline are routed to busses in the 
master timeline. The New Matching Busses option creates new busses for each bus 
that was in the nested timeline. “Preserve existing paths” will route tracks to existing 
busses in the master timeline with the same name and channel format and will only 
make new busses if they don’t match busses in the master timeline. The last option, 
“Leave unassigned,” does exactly what it says and doesn’t route any of the incoming 
tracks or busses. Don’t worry if this seems confusing. You’ll work more extensively 
with busses in a later lesson. 

For this exercise, both timelines contain only one output bus (Bus 1), so you’ll use the 
second option to “Preserve existing paths” and seamlessly route the tracks from the 
nested Bus 1 to the Bus 1 in the master timeline. 
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2	 In the Decompose Preserving Audio Data dialog, choose “Preserve existing paths” 
from the dropdown menu.

3	 Click Decompose. 

Voilà! Just like that, all the clips and tracks from the music edit timeline are now in the 
Fusion VFX timeline as if they have been there all along. If the clients want any last-minute 
changes before delivery, you can make them right in this timeline. You’ll come back to this 
project again in later lessons. 

NOTE  DaVinci Resolve 20 Studio includes new AI-based music tools in the cut and 
edit pages including Show Music Beats in the right-click shortcut menu and the 
AI Music Editor in the Inspector. You can learn more about these features in the 
DaVinci Resolve Reference Manual.
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Adding Custom Crossfades 
in the Timeline
In the previous lesson, you edited music in audio track layers and created custom fades 
using the fade handles. You can also use the right-click shortcut menu to add crossfades 
between clips or draw them with a range. In this set of exercises, you’ll try both methods. 
Crossfades do not require layered audio editing and work well as long as the clips have 
enough handles to accommodate the transition. 

1	 Open the timeline 3h Fusion VFX add crossfades Start. Then hide the media pool. 

This is a version of the Fusion VFX timeline where the music clips were edited with cuts 
only within the same track. 

2	 Play the timeline once to hear the cuts-only music edit. 

It sounds pretty good with cuts only. Some music editors prefer to edit music with cuts 
only to ensure every edit works and then add crossfades where needed. 

For the first crossfade, you’ll use the right-click method between the yellow and green 
clips in the A1 track. To do this, you’ll also use the Pointer mode arrow tool. Although 
you can add crossfades via the right-click shortcut with the Range tool or multi-tool, 
it’s easiest to work with the good ol’ arrow tool. 

3	 Press A to switch to the Pointer mode arrow tool. 

4	 Move the playhead to the first blue marker. 

5	 Zoom horizontally until you see only the yellow and green clips and one musical 
gridline in the ruler. 
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6	 Right-click the edit point where the last frame of the yellow clip meets the first frame of 
the green clip. Choose “Add 12 frame Crossfade 0 dB” from the shortcut menu. Click 
any empty timeline space to deselect all clips. 

The crossfade appears between the two clips. Let’s set a playback range for looped 
playback so you can hear the transition changes as you make them.

7	 Press R to switch to the Range tool. 

8	 At the current zoom level, using only the visible portions of the yellow and green clips, 
drag a range that includes the last half of the yellow clip and the first half of the green 
clip. Press A to return to the arrow tool to maintain the playback range while you work.

9	 In the transport controls, click to turn on the Loop button if necessary.

10	 Play the marked range to hear the transition. 
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It sounds great. However, while you are here, you might as well see and hear what 
happens if you modify the crossfade.

Once a crossfade is in the timeline, you can select, move, resize, change the curve, and 
even delete it. Let’s start by selecting and moving the transition so the edit point aligns 
with the blue marker. This is like a Roll edit on the edit page. 

11	 With the arrow tool, click any empty space in the crossfade to select it. Move the 
pointer over the lower half of the clip for the Grabber tool. Drag the crossfade toward 
the left until the edit point between the yellow and green clips is directly beneath the 
blue marker. 

12	 Start looped playback. 

13	 Experiment with the crossfade by dragging the edges to extend or reduce the length. 

14	 Drag the handle in the center of the crossfade vertically and horizontally to change the 
fade curve. 

15	 When you have explored the different variations of the crossfade and are satisfied with 
the results, stop playback. 

Congratulations! You can now quickly add a crossfade between clips and manipulate it as 
needed. In the next section, you’ll add a crossfade to the second blue marker. 
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NOTE  Audio transitions added to the timeline in the edit page appear as 
crossfades in the Fairlight page. Once in the timeline, you can select a crossfade 
and change the transition type in the Transition tab of the Inspector. 

Converting a Range Selection into a Crossfade 
Another method for adding a custom crossfade is to simply draw a range with either the 
Range tool or multi-tool. For this exercise, you’ll use the Focus mode multi-tool to draw a 
range, convert the range to a crossfade, and modify the crossfade to taste. 

1	 Move the playhead to the second blue marker. 

2	 In the timeline toolbar, click the Focus mode button to switch to the multi-tool. 

3	 If necessary, zoom in horizontally for a clear view of the edit point between the green 
and teal clips. 

4	 Drag an edit selection range across the edit point. Choose Trim > Crossfade Selection 
or right-click the timeline and choose Edit Selection Editing > Crossfade Selection from 
the shortcut menu. 

This time, you can either keep working with the multi-tool, which automatically sets a 
playback range over the selected crossfade so you can hear it loop while you work, or 
drag a playback range longer than the transition and switch to the Arrow tool to adjust 
the crossfade without clearing the playback range. 
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5	 Set a playback range if you plan to use the Arrow tool or continue working with the 
multi-tool and only loop the crossfade. 

6	 Move the crossfade toward the left so the edit point aligns with the blue marker. 
Customize the crossfade however you’d like until you are satisfied with the results. 

7	 When you are finished, press Shift-Z to fit the clips horizontally to the timeline. Play the 
finished timeline to hear it all in context. 

Fantastic! The clients are so happy that they are humming the song on their way to lunch. 
When it comes to sound editing, the clients don’t care about the details of how you do it; 
they just want it to be great. Congratulations. 

NOTE  Converting a selected range to a crossfade also works across gaps 
between the clips as long as there are enough clip handles to accommodate 
the transition. 

Adding Podcast Music
Your last music editing assignment is to add a bit of the “Dangerous” music piece to the 
end of the Podcast intro. 

1	 Open your Podcast Intro Combo project. 

2	 Hide the viewer if needed. 

3	 Open the timeline 3d Intro Combo FX and Music v1, if necessary.

4	 Play the timeline once to hear all the dialogue, sound effects, and music clip together. 

This timeline version includes some track panning automation but still needs balancing 
between the clip and track levels. You’ll work with balancing and panning clips in 
Lesson 5. For now, your goal is to open an earlier music-free version of the timeline 
and edit the music clip yourself.
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5	 Open the timeline 3c Intro Combo FX and Pan. 

6	 Resize the Music track as needed.

7	 Locate the Dangerous Music M19.wav clip in the Music bin. 

8	 Use your Fairlight editing skills to edit, nudge, trim, and fade in and out the music in 
this timeline. 

This is your self-guided assignment, so it’s up to you to determine which part of the music 
you want to use. The timeline has a green Music marker if you want to use it as a guide. 
However, it’s entirely up to you to decide where you want the music to start and end, the 
clip gain level, and finally, the duration and type of fades you want to use to bring the 
music in and out of the soundtrack. Good luck and have fun.

Working with the Music 
Remixer (Studio Only)
The Fairlight page in DaVinci Resolve Studio includes an AI-based Track FX that can change 
a vocal song into an instrumental piece with a single click. The Music Remixer is an AI 
plug-in that lets you remix music tracks to fit your show. The controls split music into 
individual basic stems, including Vocals, Drums, Bass, Guitar, and “Other,” which means 
everything else from keyboard to strings and other instruments. You can apply the Music 
Remixer to any track or clip containing music. In this exercise, you’ll apply the Music 
Remixer to the music track of the Too Much Life trailer to remove vocals from the 
soundtrack song. Once again, you’ll work with an original song by singer-songwriter Esbie 
Fonte. Then, you’ll apply the Music Remixer to a finished scene and apply the music mixer 
to automate the music mix. 

1	 Open your TML Audio Post project. 

2	 In the media pool, open the timeline 3 TML Trailer Music Start. Then hide the media pool. 
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3	 Show the floating Fairlight viewer. Resize and move the viewer to a location where it is 
easy to see while you play the timeline. 

For this exercise, you won’t be editing clips or adjusting levels, so there is no need for 
oversized clips or tracks. Your goal is to reduce or remove the vocals in the soundtrack 
music using a track FX plug-in. 

4	 Play the timeline from the beginning and stop when you get to around 20 seconds 
(01:00:20:00). 

Chances are, you recognized the issue with the music as soon as the voiceover started. 
The music vocals are stepping all over the trailer voiceover, so the listener can’t really 
focus on either one. How did this happen? Anything can happen in the wonderful 
world of post-production. As a sound editor, your job is to know which tool to reach for 
when the unexpected happens. Perhaps there was a short-notice opportunity to show 
the movie trailer before the actual music was secured and cleared, and the production 
team really wanted to use this song. Perhaps they just wanted it for the screening 
audience. The only issue with the song is the vocals. This would be great in any other 
circumstance, but it doesn’t work with the voiceover. No problem. This is a perfect 
opportunity to use the Music Remixer Track FX. 

5	 Select the A5 MX track and show the Inspector.
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The track name, MX, at the top of the Inspector indicates which track is selected. 
DaVinci Resolve Studio 19 includes five Track FX that are available in the Inspector and 
mixer. You can also apply some Track FX to individual clips in the timeline. For this 
lesson, you’ll apply the Music Remixer to a track and use the controls available in the 
Inspector. You’ll work more with plug-ins and Track FX in later lessons. 

NOTE  If the Inspector header is the clip name, Please_2444.wav, then your 
Inspector is showing the clip rather than the MX track. To switch the Inspector 
controls from a selected clip to a selected track, click the Track button to the 
immediate left of the Inspector header. There are two buttons at the top left of 
the Inspector to switch between the selected clip and selected track 
as needed. 

6	 In the Inspector, click the switch to the left of the Music Remixer to enable it and show 
the controls. 
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The Music Remixer controls include volume sliders for different music elements, 
including Voice, Drums, Bass, Other instruments, and Guitar. There are also Mute 
options to quickly mute any of those music elements from the selected track. 
Let’s try it. 

7	 In the Inspector Music Remixer controls, click the Mute checkboxes for all the options 
except Drums. 

8	 Play the first half of the timeline from the beginning to hear the remixed drum-only 
music in the soundtrack.

Amazing, right? The music is instantly percussion only. The downside is that it gets a 
little boring and redundant quickly. No problem. Let’s bring back the other 
instruments except the vocals. 

9	 In the Music Remixer controls, unmute all the instrument parts except the vocals. 

10	 Play the trailer from the beginning. 

Done!

NOTE  If you are working with a song with heavy vocal effects and background 
vocals, the Music Remixer may not remove the entire voice with a single click. 
You may need to adjust the levels on the vocals and other categories rather 
than simply muting them. 
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Automating the Music Remixer 
During Playback 
All effects plug-ins, including the Music Remixer, include a handy floating window with 
easy-to-use controls that you can adjust during playback. In this exercise, you’ll apply the 
Music Remixer to the stereo mix of a scene and use the floating controls window to adjust 
the percussion and bass levels over time. You’ll also enable the plug-in automation controls 
to record the changes over time. When finished, you’ll look at the automation curves in 
the timeline.

1	 Open the timeline 3 TML Music Remix Scene.

As you can see, the timeline consists of a single clip in the A1 track.

2	 Play the timeline once.

As you may have guessed, this scene follows the surf scene you worked with in the 
dialogue editing exercise. Although this is only the first half of the scene, it makes for a 
great example of using the Music Remixer on a finished mix. 

3	 Select the A1 track header and show the Inspector for the track. 

4	 In the Inspector, turn on the Music Remixer. Then, click the Controls button to open 
the floating Music Remixer window.
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The Music Remixer window offers easy dial controls and Mute buttons. Let’s test the 
controls during playback.

5	 Play the scene from the beginning. During playback, adjust the Drum level to decrease 
the percussion, and then bring it back up. Feel free to experiment with muting and 
adjusting the different levels to hear the outcome. 

Now that you’ve had time to experiment, let’s try to reset the controls and record some 
changes over time with the automation controls. 

6	 In the top right of the Music Remixer window, click the Reset All button to reset 
all controls. 

NOTE  You can reset individual control dials by double-clicking the dial or the 
control name within the window. 

To record changes to the plug-in during playback, you’ll first need to turn on the 
automation controls at the top of the screen and enable plug-in automation. You’ll find 
the buttons to toggle automation and show automation controls to the right of the 
transport controls above the timeline. Fairlight’s automation toolset includes 
independent controls to enable automation and expose global automation controls. 
You can show or hide the automation control toolbar as needed, without affecting 
whether automation is on or off. 

You’ll find the Toggle Automation and Automation Controls buttons at the top of the 
Fairlight page, next to the transport controls. 
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7	 Click the Toggle Automation button to turn on automation. Click the Automation 
Controls button to open the automation toolbar. 

The automation toolbar includes buttons that control every available option for setting 
up and recording automation for your mix. The buttons are organized in groups from 
left to right. You’ll work with automation more in later lessons. For now, you’ll focus on 
recording the plug-in automation for this exercise. You can identify which automation 
controls are turned on because they will appear red. 

8	 In the automation toolbar, click the following buttons from left to right to enable them: 
Write, Latch, Hold, Plugins. 

What do those settings mean? In a nutshell, during playback, you will record (write) any 
changes you make to the plug-in controls until playback stops and then hold (maintain) 
the most recently recorded automation value, overwriting previous levels for that 
parameter for the rest of the track. Any control you click or change will turn red to 
show it is recording that data, and green once you stop playback to indicate the control 
is automated. Let’s try it. 

9	 Start playback and adjust any of the controls in the Music Remixer including the dials 
and mute buttons. When finished stop playback. 
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10	 Play the track from the beginning to see and hear the changes and see the controls 
move automatically according to your recorded automation. Feel free to grab a control 
and modify the settings during playback. As long as the automation is in Latch mode, 
you will write new data during playback. 

11	 Once you are finished experimenting with the automation, change the Touch 
mode to Off. 

Once in off mode, no new automation will be recorded unless you change the Touch 
mode or manually edit the automation curve. 

Each track includes automation curves to show a graphical view of the changes for 
each parameter. To quickly see the curve in the track, just right-click the automated 
parameter. 

12	 Right-click the Drums knob to see the automated Drums level curve. Right-click the 
Bass knob to see that curve. 

Automation curves can be trimmed, edited, moved, cut, copied, pasted, deleted, and 
drawn. You’ll spend more time with them in another lesson. For now, you’ll delete all 
automation and turn off automation recording until you are ready to try it again. If you 
enjoyed automating parameters, you are in luck because in the Fairlight page, you can 
automate nearly everything. Just take a closer look at the list of automation Enables 
buttons in the automation controls. 

To clear track automation, you simply right-click the track header and choose Clear 
Track Automation. 
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13	 Right-click the A1 track header and choose Clear Track Automation. In the dialog, 
click Reset. 

14	 Turn off the Automation Toggle and Automation Controls buttons.

Wow! Who knew automating a powerful AI-based plug-in, could be this much fun? This 
type of musical surgery on a clip containing dialogue and sound effects would have been 
impossible not long ago. 

This concludes the lesson on editing sound effects and music. You’ve covered many 
different techniques and tools that you can apply to your own projects. In the next lesson, 
you’ll learn about recording in the Fairlight page. 

Lesson Review
1	 Where can you find and edit the Markers list in the Fairlight page? (Choose all 

that apply.)

a)	 Mark menu

b)	 Media pool

c)	 Markers index

d)	 Inspector

2	 Which modifier functions are unique to the Focus mode multi-tool? (Choose all 
that apply.)

a)	 You can solo-scrub clips in the timeline.

b)	 You can snap the head or tail of a clip to the edit point.

c)	 Dragging a selection range updates live in the viewer.

d)	 Right-clicking the lower half of the clip duplicates the clip. 
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3	 True or False? When using the Focus mode multi-tool, clicking the upper half of a clip 
activates an I-beam cursor, while clicking the lower half of a clip selects the entire clip. 

4	 Where in the Fairlight interface can you choose the Jump To options that use the 
Up-Arrow and Down-Arrow keys for navigation?

a)	 Timeline View Options menu

b)	 Timeline toolbar

c)	 Timeline menu

d)	 Timeline right-click contextual menu 

5	 When using a sync point in the Sound Library, what happens to the selected clip in the 
Sound Library when you click Audition?

a)	 The beginning of the clip syncs to the nearest clip in the selected timeline track.

b)	 The sync point on the sound library clip aligns to the playhead in the selected 
timeline track. 

c)	 The beginning of the clip aligns with the playhead in the selected timeline track.

d)	 Sync point is a media pool function and is not available in the Sound Library.

6	 Where do you change the timeline grid from timecode to musical time? 

a)	 In the Timeline View Options menu

b)	 In the Sound Library preferences

c)	 In the Inspector

d)	 In the Grid View Options menu
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Answers
1	 a

2	 a, b, c

3	 True

4	 a

5	 b

6	 d
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In this lesson, you’ll set up and perform four types of audio recordings. First, you’ll 
manually record a simple voiceover track for the Post Park Normal podcast. Then, you’ll use 
the ADR tools to set up and record automatic dialogue replacement for a scene from the 
film Too Much Life. Next, you’ll patch and record noise and tones from Resolve’s built-in 
tone generator for sound effects. Finally, you’ll set up and record footsteps to picture using 
the Foley Sampler plug-in. 

NOTE  The exercises in this lesson build from the tools and skills you learned in the 
previous lesson. If you skipped ahead to this lesson, you might need to look back 
at the previous lesson as a guide for skills already covered.

Setting Up Your Microphone
Before you can start recording, you must set up your microphone. If you don’t have a 
separate microphone, you can use a built-in microphone in your computer. When setting 
up new audio hardware with your system, it’s a good idea to first close DaVinci Resolve; 
otherwise, the newly attached hardware might not be recognized. Once your audio 
interface and microphone have been connected and recognized by your computer, they 
should also be available when you open Resolve. 

MORE INFO  For more specific information on compatible audio interfaces, 
including Fairlight, MIDI, and MADI interfaces, a Fairlight Accelerator card, and 
additional monitors, please refer to the DaVinci Resolve Reference Manual.

1	 Close DaVinci Resolve. 

2	 Attach a microphone to your computer or audio interface. 

3	 In your computer’s sound settings, configure your microphone (or the built-in mic) as 
the audio input device. 
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For this example, a Rode NT1-A microphone is connected to the computer via a 
Scarlett Solo USB audio interface.

Once the microphone is set up, you can use it in Resolve. Next, you’ll open the project that 
you will use for the recording exercises. 

NOTE  DaVinci Resolve 20 includes all new voiceover recording tools in the cut and 
edit pages. This is the first version of DaVinci Resolve to offer audio recording 
options outside of the Fairlight page. You can learn more about these features in 
the DaVinci Resolve Reference Manual. In this lesson, you’ll focus on the recording 
options in the Fairlight page. 

Preparing the Project
Remember the Runner voiceover that you edited in Lesson 2? Let’s go back in time and 
look at the original timeline for that recording session, including the script. This will give 
you a glimpse of what you will create for a new character shortly. What new character? 
Apparently, while the clients celebrated how much they loved the podcast intro combo 
you’ve been working on, one of them had an epiphany. The sound effects and voiceover 
are great, but who is driving the mower? And just like that, the role of the groundskeeper 
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was born. That’s right! In a few minutes, you will have the opportunity to record the part 
of the park groundskeeper. For now, let’s open the project and take a quick look at the 
timeline with the Runner voiceover. 

1	 Open DaVinci Resolve. 

2	 In the Project Manager, open your Podcast Intro Combo project. 

This is a good time to reset the UI layout. 

3	 Choose Workspace > Reset UI Layout.

4	 In the Media Pool > Timelines bin, open the timeline 4 Runner Voiceover.

The timeline opens in the Fairlight page with one track of recorded voiceover and the 
voiceover script showing in the viewer. Although this timeline is audio only, it may be 
useful to show the video tracks so you can see the text clip containing the script in 
a timeline track. 

5	 In the Timeline View Options menu, select Display Video Track, if necessary, to show 
the video tracks in the timeline. 

6	 In the Playback menu, choose Stop and Go To Last Position to turn on that 
playback mode.

7	 Play the beginning of the timeline to hear some of the recording and see the script in 
the viewer. 

Sound familiar? It should. You edited this voiceover recording in Lesson 2. Now that 
you’ve seen an example of a voiceover recording timeline, it’s time to set up a new 
recording and timeline on your own system. 

Next, you will create a new timeline for the Groundskeeper recording. There are many 
options for creating a new timeline, including using the File menu, right-click 
contextual menu, and keyboard shortcut. In this exercise, you’ll use the right-click 
option to create the timeline. First, let’s go to the media pool to locate the text clip that 
will serve as the voiceover script and then create a new timeline for recording.
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8	 In the media pool, locate the PPN Intro Scripts bin. Select the bin. 

The bin includes a text file script for each character, including the Groundskeeper. 

NOTE  If you do not see the text files in this bin, click the media pool 
Options menu (…) in the upper right corner of the media pool and enable 
the Show All Clips option. 

9	 Right-click the 7 Groundskeeper text file and choose Create New Timeline Using 
Selected Clips. In the Create New Timeline dialog, type 4 Groundskeeper VO in the 
Timeline Name field and click Create. 
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The new 4 Groundskeeper VO timeline opens with three tracks, including the Text clip 
in the V1 track, an empty A1 stereo track, and a B1 stereo bus track. 

TIP  You can edit the script text right in the Fairlight page Inspector. Just select 
the text clip in the timeline and use the Title controls in the Video panel. 

If you look at the media pool, you’ll see the new 4 Groundskeeper VO timeline among 
the text files in the PPN Intro Scripts bin. Let’s move it to the Lesson 4 bin. 

10	 In the media pool, drag the 4 Groundskeeper VO timeline to the Lesson 4 bin. 

One more thing: There is no reason at this time to show the Bus 1 track or have 
automation turned on, so to simplify the timeline, let’s also turn off automation. 

11	 Click the Toggle Automation button to the right of the transport controls to turn off 
automation and hide bus tracks in the timeline.

A1 is now the only audio track showing in the timeline. The new timeline is set up and ready 
for the next exercise. 
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NOTE  You can also access any of the lesson timelines for this book in the 
Timelines smart bin at the bottom of the media pool bins list if “Smart bin for 
timelines” is enabled in User Settings or in the Timeline dropdown menu. To see all 
the timelines in the Timeline dropdown menu, open the UI Settings panel of the 
User tab in the DaVinci Resolve Preferences and choose the Alphabetic option 
from the Timeline Sort Order dropdown menu. 

Choosing a Location for 
New Audio Recordings
When you record audio files in the Fairlight page, you create new clips in the timeline and 
media pool and store new media on your hard disk. Files are stored in the Capture location 
on your system, while the corresponding clips will appear in the selected bin in the media 
pool. In DaVinci Resolve 20, you can easily set the media location for each new project right 
in the New Project dialog. You can also change the location for project media in the Project 
Settings window.

In this exercise, you’ll create a new bin for the recorded clips and locate where the new files 
will be stored on your storage disk. 

1	 If necessary, show the media pool.

2	 In the Master bin list, right-click the Master bin and choose New Bin.

The new bin appears in the bin list with the name field selected, ready for you to type 
in a new name. 

3	 In the new bin’s Name field, type Recordings and press Return/Enter.



254Lesson 4  Recording Voiceover, ADR, and the Foley Sampler

You’ve created a bin for the recorded clips in your project, and now you’ll choose 
a location to store the new files. For this project, you can use the default Project media 
location; however, it’s a good idea to know where the default project media location is 
and how to change it. You can specify the location of your project media capture files, 
which include recorded audio files, in the Master Settings panel of the Project Settings.

4	 Choose File > Project Settings or press Shift-9 to open the Project Settings window. 

5	 In the Project Settings sidebar, click Master Settings to show the Working 
Folders panel.

At the top of the Working Folders, you’ll see that the current Project media location is 
set to the default location in the Documents folder or another user-defined location. 
This location is where newly recorded files will be stored. For this project, you can keep 
the current settings. 

If you want to save the recording to a different location, click Browse and choose that 
new location now. The new location will apply to all newly captured video and audio 
media. Here, in Working Folders, you can also see the locations for proxy generation, 
cache files, and gallery stills. 

6	 In the Project Settings sidebar, click Capture and Playback and ensure that the Project 
media location dropdown menu is set for “Video and audio.” If necessary, change the 
Capture dropdown menu from “Video only” to “Video and audio.”

TIP  It’s always a good idea to check the project media location before recording 
audio or capturing video files. Also, if you share a workstation and change the 
media location, be sure to either change it back or coordinate with the other users 
so that you can all keep track of your media as you go.
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Setting the Audio Metering for Recording
Before closing the Project Settings window, let’s look at the Fairlight settings, where you 
can set the Audio Metering to “Pre fader metering on tracks” for recording. 

1	 In the Project Settings sidebar, click Fairlight to see the Fairlight settings. 

2	 In the Audio Metering settings, click the “Pre fader metering on tracks” option to select 
it, if necessary.

The “Pre fader metering on tracks” option controls whether the position of the faders 
affects the meters in the mixer. By default, the “Pre fader metering on tracks” option is 
unchecked, so the meters display each clip’s signal level after whatever fader 
adjustments have taken place. This is often referred to as post-fader metering because 
the meters in the mixer show the post-fader results of all signal processing and level 
changes applied to the clips and track. In this mode, whatever change you apply to a 
fader is reflected in the meters. Selecting the “Pre fader metering on tracks” option, on 
the other hand, shows the actual levels of each clip in the track, regardless of the fader 
position. This includes the track source signal if you’re recording or routing signal from 
another track or bus. This is an important distinction because when you are recording, 
you usually want to see the levels coming in from your source. Otherwise, a signal 
could be too hot (loud), and you might not realize it because the faders have 
been lowered.

3	 Click Save to save and close the Project Settings window.

Before recording to a track, you must first set the input. This is referred to as patching a 
track. Next, you’ll patch the track to your microphone source for recording. 
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Patching a Track for Recording
To patch a track’s input, you can choose Fairlight > Patch Input/Output or click the Input 
settings in the mixer. Let’s use the latter method for this recording. First, it’s a good idea to 
consider whether you want to record in stereo or mono. Stereo files consist of two audio 
channels, left and right, while mono tracks have only one audio channel. In most cases, the 
preferred track format for dialogue recordings is mono, especially when working with 
voiceover or narration.

For this exercise, you’ll change the A1 track format from Stereo to Mono. Then, you’ll use 
the Input settings in the mixer to patch the microphone to the mono track. To see the 
current number of channels in a track, you might need to increase the track height. 

1	 Drag the bottom of the A1 track header downward to increase the height of the track 
until you see the text “No Clip” in the lower left and the 2.0 channel indicator in the 
upper right.

The 2.0 channel indicator on the A1 track header shows that the empty track is stereo 
with two channels, left and right. You can change a track’s channel format anytime via 
the right-click contextual menu. 

2	 Right-click the A1 track header area and choose Change Track Type To > Mono. 

Now, the A1 track header’s channel indicator shows 1.0, which means it is a single-
channel mono track. 

TIP  You can change the track type for new timelines in the Editing panel of the 
User Preferences. The default track type for new timelines is stereo. 
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3	 Name the A1 track Groundskeeper.

4	 If necessary, show the mixer.

Input settings are displayed at the top of each channel strip just below the track 
number assignment. Tracks without an assigned input will display No Input.

5	 At the top of the A1 channel strip, in the Input pop-up menu, choose Input.

The Patch Input/Output window opens. This window displays the source inputs to the 
left and the destination tracks to the right.

6	 Select the first channel for your microphone as the source and select the 
Groundskeeper track as the destination. 

NOTE  If you were recording with a stereo microphone or recording multiple 
microphone sources to multiple tracks, you would patch each track’s audio 
input channels accordingly.
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7	 Click Patch to set your input patch.

The Patch Input/Output window and the A1 channel strip in the mixer update to show 
that the microphone channel you selected is patched to the A1 track. 

8	 Close the Patch Input/Output window.

Your track is created and patched, so now you can arm it for recording. The Arm 
button, labeled “R” for “Arm for Record,” is available in the track header, tracks index, 
and the track’s channel strip in the mixer. 

9	 In the A1 track header, click the Arm button (R).

The Arm buttons in the track header and channel strip turn red to indicate that the 
track is armed for recording. 

NOTE  If your hardware supports multitrack recording, you can patch and arm 
multiple tracks accordingly.

Now that the track is patched and armed, it’s a good idea to take a moment to check your 
monitoring style. 
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Monitoring the Track Input
DaVinci Resolve 20 offers a variety of user-defined input monitoring styles with which you 
can hear the microphone signal before, during, and after you record. The Fairlight menu 
includes five Input Monitor Style options, including Input, Auto, Record, Mute, and Repro. 

The Input style lets you hear only the live signal on input, whereas the Record style limits 
you to monitoring the input signal to active recording when the Record button is on. The 
Repro style monitors only the audio already recorded to the track; instead of hearing the 
live input, you can review what was just recorded during recording.

As you might have guessed, when you choose the Mute style, you’ll hear nothing. If you 
think you’d never need to use the Mute style, imagine trying to record a scratch voiceover 
in the same room as the speakers/monitors without using headphones.

Fortunately, the default input monitoring style, Auto, is perfect for this recording exercise 
because it lets you hear the live input signal from armed tracks during recording and the 
contents of each track during playback.

1	 In the Fairlight menu, choose Input Monitor Style > Auto. 

2	 Speak into the microphone. You should be able to hear the input signal through your 
headphones and/or speakers. 

TIP  If the microphone and monitoring speakers are in the same room, you’ll 
need to use headphones to monitor your input during recording. If you don’t 
have headphones, you can mute playback during recording or use the Mute 
input monitoring style.
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Finally, if you’re using an external microphone and audio input/output interface, you 
might need to increase the microphone input level. You can do so in the Path Settings 
window in the Input pop-up menu.

3	 In the mixer, in the A1 channel strip’s Input pop-up menu, choose Path Settings.

The Path Settings window opens with standard controls for adjusting the input level of 
audio signals for each track. Here, you can use the Mic/Instr control to adjust the 
microphone/instrument level for the source patched to the A1 track. 

NOTE  If you’re using an audio interface to connect your microphone, you 
might not see the Mic/Inst controls in the Path Settings window. In that case, 
use the controls on your audio interface to adjust input levels and 
phantom power. 

4	 If your microphone input level is low and you’re using an external microphone and 
audio interface, you can increase the Record Level. 

5	 When you’re finished, press Esc (Escape) to close the Path Settings window. 

6	 Hide the mixer.

MORE INFO  You can find detailed information about all the Input Monitoring 
styles and Path Settings controls in the DaVinci Resolve Reference Manual, 
available in the Help menu. 

7	 Move the playhead over the beginning of the text clip in the V1 Video 1 track so you 
can read the text in the viewer.

You are ready to record.
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Recording Consecutive 
Takes in the Timeline
You have completed all the necessary steps to prepare your project for recording. Before 
you start recording, it’s a good idea to practice your lines and double-check that the 
Recordings bin is still selected. Remember, you’re creating a voiceover track for a new 
character in a fictional podcast intro. However, the podcast intro was created entirely for 
this training guide to help you explore the Fairlight page, so there is no pressure on your 
part for expensive recording equipment or delivering award-winning performances. 

1	 If necessary, in the media pool, select the Recordings bin to designate it as the storage 
location for your new recordings. 

2	 Make the viewer a floating window. Hide the meters. 

3	 Resize the viewer as needed for a clear view of the script. 

For the purposes of this voiceover recording session, you’ll need to read through the 
lines sequentially, one after another, and then read the entire voiceover script again. 

If you’d like a little motivation for your script reading, you’ll find the director’s notes for 
the voiceover talent in the project notes. What are project notes? Every DaVinci Resolve 
project includes a handy text notepad where you can store notes for anyone working 
on the project. 
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4	 Choose File > Project Notes to see the text window containing the director’s project 
notes. If you’d like, read the notes before proceeding to recording. When finished, 
close the project notes. 

NOTE  Each DaVinci Resolve project provides access to project notes, a simple 
“scratch pad” for keeping track of text notes associated with each project. 
There’s also a Project Notes command in the contextual menu for project 
icons in the Project Manager, which makes these notes accessible to everyone 
who’s connected to that project library. 

5	 Practice reading your voiceover lines once.

6	 Make sure that the A1 track’s Arm button is on (red).

Recording starts at the playhead position on the armed track. 

7	 Move the playhead to the beginning of the timeline. 

The Record button is in the transport controls at the top of the screen. When the playhead 
starts moving and drawing a red region within the armed track, you are recording.
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8	 In the transport controls, click the Record button. Read the script into the microphone 
all the way through two or three times. When you’re finished, press the Spacebar to 
stop recording. 

The new audio clip appears in the A1 Groundskeeper track and in the Recordings bin 
as a .wav file. Notice that the clip name starts with the track name Groundskeeper, 
followed by the take number 001. Also, the playhead automatically returns to the 
starting position because you have the Stop and Go To Last Position option selected in 
the transport controls.

TIP  In the Keyboard Customization window, you can assign a keyboard 
shortcut such as Option-R or Alt-R for Playback > Record. Keep in mind that 
interface buttons are also available via the menu, and you can create 
customized keyboard shortcuts for menu options. 

9	 Disarm the A1 track. Play some of the clip to hear the results of your recording. 

Don’t worry if your recording was rough. This lesson aims to give you the skills to record 
audio in the Fairlight page, not perfect your talent as a voiceover artist. Once recorded, you 
have many options for editing the voiceover, which you’ve already explored in Lesson 2. 
Next, you’ll repeat this recording, only this time as multiple takes in track layers. 

Recording Takes in Track Layers
Let’s record a few more takes, this time as track layers. The only difference between 
recording consecutive takes and multiple takes in layers is that you will stop between takes 
when recording in layers. There is no special setup required because in the Fairlight page, 
new recordings do not overwrite existing material in the same track. 
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Instead of creating a new track and patching it to the microphone for the layered 
recordings, let’s simply duplicate the A1 track. Duplicating the track retains the track name, 
contents, and input patching. Let’s also set a custom record name for the new recordings 
instead of the track name. 

1	 Right-click the A1 track header and choose Duplicate Track. 

A new A2 Groundskeeper Copy track appears below the A1 Groundskeeper track. 

2	 Delete the clip in the A2 track. Change the name of the track to Groundskeeper 2.

3	 Right-click the A2 track header and choose Set Track Record Name.

4	 In the Record Seed Name dialog, type VO 7 Groundskeeper. 

5	 Click OK.

6	 Mute the A1 track. 

7	 In the A2 track header, click the Arm button (R).

8	 Move the playhead to the beginning of the timeline if necessary.
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9	 In the transport controls, click the Record button. Read the script into the microphone 
all the way through once. When you’re finished, press the Spacebar to stop recording. 

The first take in the A2 track is named VO 7 Groundskeeper. Let’s record a second take. 
Doing so will not overwrite the first recording; instead, the new take will be saved as a 
separate layer in the same track. To keep track of your takes, color code them 
as you go.

10	 Right-click the clip in the A2 track and choose Clip Color > Yellow.

11	 Record another take. When you’re finished, stop playback and change the color of the 
second take to orange. Listen to the second recorded take. 

NOTE  If your second take is shorter than the first, you’ll see where the second 
recording overlaps the first take in the track.

Now that you’ve recorded several full takes, you can try recording a partial take of just 
the last section, “Then, out of nowhere, they arrived.” 

12	 In the Playback menu, choose Stop and Go To Last Position to turn off the 
playback mode. 
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13	 Press the JKL keys, using the waveform as a guide, to move the playhead to the last 
section of the second take, just before “Then, out of nowhere….”

This time, when you record the third take, vary the performance of the last section. 

14	 Click the Record button and record the entire section “Then, out of nowhere, 
they arrived.” Click the Stop button or press the Spacebar to stop recording. 

15	 Change the partial take color to apricot. 

16	 Disarm the A2 track. Notice that the A2 track header shows that it contains three clips.

17	 Save your project.
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Now that you’ve recorded several takes in the same track, let’s show the audio track 
layers so you can see all your takes at once.

18	 Choose View > Show Audio Track Layers. Increase the track height and zoom as 
needed to see the layered clips in the A2 track.

Each clip has its own layer, and an empty, clip-sized space appears in the track above 
the clips. Once again, you already have experience editing clips in track layers, and now 
you know how to record them!

19	 Choose View > Show Audio Track Layers to deselect that option. 

You have successfully set up, patched, armed, and recorded a scratch voiceover track in 
the Fairlight timeline. In the next lesson, you’ll explore the Fairlight ADR toolset. 

NOTE  If you’re using a Fairlight Desktop Console, Fairlight Desktop Audio Editor, 
or Fairlight Audio Editor panel in a Fairlight console, you’ll have additional options 
for manually recording in the timeline. These options include Record Here, Record 
Range, Record Clip, Record Again, Punch In Again, and Record Head. 

What Is ADR?
If a dialogue recording can’t be used because it is damaged, noisy, or unclear, it 
must be replaced with audio from other takes or be re-recorded. The process of 
re-recording production dialogue is called automated dialogue replacement (ADR), 
or looping. ADR sessions usually require the original actor to re-record the 
dialogue to improve the sound quality or reflect script changes. ADR sessions are 
also commonly used for dubbing films in other languages, recording dialogue for 
animated films, and performing Foley sound effects. The term looping refers to the 
mechanics of recording dialogue replacement that involves playing, rehearsing, 
and recording the same dialogue cue over and over again. 
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Setting Up an ADR Session
DaVinci Resolve includes a full ADR toolset in the Fairlight page. In this exercise, you’ll open 
a new timeline for ADR recording and use the ADR Setup panel to customize your session. 

1	 Open your TML Audio Post project. In the media pool Lesson 4 bin, open the 
4b ADR Session Start timeline.

This is a scene with Harper and her dad filmed on the beach. Like the previous surf 
scene you worked with, this original production dialogue needs replacing. As you can 
see, each character’s dialogue clips have been separated into different tracks. This is 
part of the dialogue editing process, even if the dialogue will be replaced. Also, the 
A13 ADR track was created for your replacement dialogue recordings.

All the visible tracks should be muted except the reference sound on A1 and A2, 
as well as A13. 

2	 Play the scene while listening to tracks A1 and A2 to hear the stereo reference track 
from the scene. When you’re finished, stop playback and move the playhead to the 
beginning of the timeline.

Now that you’ve listened to the finished scene, let’s mute the reference tracks and 
listen to the original production sound in A3. 

NOTE  Tracks A1 and A2 are mono tracks linked as a stereo group, so they play 
back as stereo left and right. This also means there is a single stereo fader for 
both tracks in the mixer, and any changes you make to the track header in one 
track will apply to both. You’ll learn more about linked track groups in a 
later lesson. 
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3	 Mute the A1 ref L track to mute both A1 and A2 linked tracks. 

4	 Unmute the A3 Production track. 

5	 Play the timeline from the first clip in the A3 track to hear the production sound as it 
was recorded on location.

Let’s listen to the checkerboard edit. The difference with the checkerboard edit is that 
some of the clip gain levels were increased to make it easier to hear the spoken words. 

6	 Mute the A3 track and unmute the A4, A5, and A10 tracks. Listen to the 
checkerboard edit. 

The acting is good, but the dialogue recordings could definitely use a do-over. Blue 
markers in the timeline show where the spoken words are located. Let’s use the 
markers for navigation and locate the first line that needs to be replaced. 

NOTE  In the previous lesson, you used the Focus mode multi-tool for the 
entire lesson. From this point forward, you can use whichever mode and tool 
you prefer. Feel free to switch between the Arrow tool, Range tool, or multi-
tool at any time. If a specific tool is needed for an exercise, it will be called out 
in the steps. 

7	 Press Shift-Down Arrow to move the playhead to the first marker. Then, zoom in 
horizontally so the timeline markers are near the center of the ruler and the clips in 
that section are easy to see. 

You will soon record replacement dialogue for either Dad or Harper. Let’s go to the 
ADR tools to set up your recording session.



270Lesson 4  Recording Voiceover, ADR, and the Foley Sampler

8	 In the interface toolbar, click the ADR button to display the ADR tools. Then, click the 
Setup tab at the top of the ADR tools to display the ADR Setup panel. 

The ADR Setup panel is self-explanatory, so let’s just walk through the setup for this 
session, starting at the top with the Record and Playback Setup controls. 

The Pre Roll and Post Roll controls let you determine how much time you have before 
and after a cue is recorded. Think of pre-roll as allowing time for a count-in before 
recording begins. 
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9	 Set the Pre Roll to 6 Seconds and the Post Roll to 2 Seconds. 

Notice that the Record Source menu is empty. To choose a source, you must first 
choose the Record Track. DaVinci Resolve now includes two record tracks and two 
sources so that you can have two people recording simultaneously if needed. You’ll 
only use the first record track and source for this exercise. 

10	 Choose 1st Record Track > ADR. Then, from the 1st Record Source dropdown menu, 
choose your microphone.

NOTE  The ADR track can now be armed for recording. This will happen 
automatically when you rehearse or record a cue. 

You will focus on the Guide Track as you record the replacement dialogue. While 
recording, you can listen to the reference sound in A1, the production sound in A3, or 
the character’s dialogue track. You can change this in settings anytime as needed. To 
keep things simple for this example, let’s use the A3 production sound as the guide. 

11	 Choose Guide Track > Production.

The 1st Record File Name field lets you set a seed name for the ADR recordings. For 
this exercise, you’ll leave this field blank so the naming is automatic based on the 
character name and cue. 

12	 If necessary, delete any text in the 1st Record File Name field.

Next, let’s move down to the Character Setup area in the center of the ADR Setup 
panel and add the character names.
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13	 Click the Add New button. In the selected character Name field, type Harper. When 
you’re finished, press Return/Enter.

14	 Repeat step 13, but type Dad in the Name field this time. 

When working with professional talent in an ADR session, you’ll find that each actor 
has unique personal preferences for working with cues. Some like to hear a series of 
beeps before they speak. Some prefer a visual count-in or a colorful streamer that 
moves across the onscreen text cue during recording, with no beeps. Others want no 
visuals and only a single beep just before they speak. Fortunately, the Fairlight ADR 
Setup panel includes a variety of audio and visual cues that you can mix and match to 
suit your sessions and your talent. In addition to switching the different audio and 
visual cues on or off, you can double-click the setting name to reveal the full controls 
for that element.

15	 Click the switch to the left of the controls to turn them on: Beep to In Point, Beep at In 
Point, Count In, Video Streamer, and Smart Timeline, as shown. 
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16	 Click setting titles for the Beep to In Point and Beep at In Point settings to show the 
controls for those settings.

These Beep settings offer two audio cues to help the talent prepare to record their 
replacement dialogue lines. If you look closely at the settings for each, you’ll see that 
the Beep to In Point is set to emit a 15 dB, 1000 Hz beep three times before the In 
Point for the recorded ADR Cue, while the Beep at In Point will emit a single 2000 Hz 
beep at -12 dB at the In Point where the recording begins. The slight difference in 
frequency and volume level between the two types of beeps gives the actor an 
easy-to-follow “one, two, three, go!” during rehearsal and recording.

To utilize the audible beep cues, you must create a track and assign the input to the 
Beeps in the built-in System Generator available via the Test Tones Settings in the 
Patch Input/Output window and Fairlight menu. You’ll work more with the Test Tones 
Settings later in this lesson. For this exercise, the Test Tones Settings Beeps have 
already been assigned to the A12 ADR BEEP track, which is currently hidden from the 
timeline in the Tracks index. You’ll take a closer look at this track later. 

17	 Click setting titles for the Beep to In Point and Beep at In Point settings to hide the 
controls for those settings.

18	 Click the Count-In header to reveal the Count-In settings. Then, change the Count 
From field to 5. Leave the “to” field set to 1. 
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19	 Click the On Screen Cue Text Style header to reveal the settings.

Here, you can change the Font, Size, and other style elements for the onscreen 
text cues.

You can enable the Preview button to see a live text preview while you adjust the text 
controls. Let’s try it.

20	 Click the Preview button in the lower left corner of the On Screen Text Style controls to 
enable preview. 

21	 Type This is a live text preview in the Text Sample field. 

The sample text appears in the viewer. 

22	 Change the Font to Arial Black and the Size to 60. 

23	 Feel free to experiment with other text style changes. When you’re finished, reset the 
Size to 60 and turn off the Preview button.

24	 Option-click (macOS) or Alt-click (Windows) any setup headers to hide all the opened 
Setup settings panels.

The ADR session is set up. Next, you’ll set up the cues in the List panel.

NOTE  You can return to the ADR Setup panel at any time to modify your 
settings while you work. 
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Manually Creating ADR Cues 
You can import an entire ADR cue list or manually create new cues as you go. Each cue has 
a unique Cue ID number that can be changed anytime. Cue ID numbers offer greater 
flexibility for importing and merging cue lists in collaborative workflows. In this exercise, 
you’ll create four new cues in the timeline. To manually create cues, you simply mark an In 
point and Out point for the cue in the timeline and click the New Cue button in the ADR List 
panel. You can also drag a range to set the In and Out points. Once a cue is created, you’ll 
add the text and character to the cue. Let’s start with the first marker where Dad says, “Hey.” 

1	 Check the Playback menu to make sure the Stop and Go to Last Position option is off. 

2	 Click the List tab to show the ADR List panel. 

3	 Select the A5 DX 2 Dad track so you can easily identify the original dialogue. 

4	 Move the playhead to the first marker. Press I to set an In point. 

5	 Play the clip in the A5 track and press O when dad finishes saying “Hey.” 

NOTE  Don’t worry about setting the Out point on the exact frame where the 
line is finished. Your reaction time in setting the Out point will be similar to the 
reaction time of the talent when they need to record. 
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6	 In the ADR list panel, click New Cue. 

Cue 1 appears in the list. When a cue is selected in this list, you can modify its information 
in the cue editing controls above the list. Let’s set the character for the selected cue. 

7	 Select the cue in the list, if necessary. Then, in the cue editing controls, in the 
Character dropdown menu, choose Dad. 

The only element missing now is the dialogue. 

8	 In the dialogue field above the cue list, type Hey.
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The text appears in the dialogue field in the cue list as you type. Now that you have 
created one cue, you can create the next one. Instead of marking In and Out points, 
you’ll drag a range using the Range tool. Also, to keep things interesting, you’ll type the 
dialogue before making the new cue.

9	 Press R to switch to the Range tool, if necessary.

10	 Click the empty space below Cue 1 in the list to deselect the cue. 

The Cue ID for the next cue is automatically set to the next sequential number, 2. You 
could change the cue number at this time or leave it. For this exercise, you’ll create 
four sequential cues. 

11	 In the timeline, navigate to the next marker. Drag a range in the A5 track from the 
marker to the end of the clip after Dad says, “We’re going to be okay.” You do not need 
to clear the current In and Out points before marking new ones. 

This time, you’ll type the text in the dialogue field for Cue 2 before you click New Cue. 

12	 In the Cue 2 Dialogue field, type We’re going to be okay. 

13	 Click New Cue to create Cue 2. 

You’ve finished setting the cues for Dad’s dialogue. Next, you’ll set the cues for 
Harper’s dialogue. 

Finish Setting the Cues
You know what to do! Create cues for Harper’s dialogue as follows: Cue 3 “Well” and Cue 4 
“Will you teach me how to surf?” Be sure to set Harper as the Character. You can also select 
the A4 DX 1 Harper track to make it easier to see her dialogue clips. When finished, clear 
any In and Out points if necessary. Your ADR session is ready for recording. 

NOTE  If you didn’t finish the previous ADR exercises, feel free to open the timeline 
4a ADR Setup to catch up.
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Recording ADR Cues 
in the Timeline
Once you’ve set up your ADR session, you can simply go to the ADR Record panel to record. 
However, your talent will probably need to rehearse a few times before recording. In that 
case, you’ll use the Rehearse button to the far left of the Record panel controls. In this 
exercise, you will open the ADR Record panel and select a cue to record. Then, after 
rehearsing the cue, you’ll record three takes. 

As with all recordings, you must also select a bin for them in the media pool; otherwise, 
they will appear only in the Master bin. Since this project doesn’t have a Recordings bin, 
you can make one. 

1	 Show the media pool. Create a new bin and name it Recordings. Select the Recordings 
bin. Then, reopen the ADR panel. 

2	 Click the Record tab to go to the ADR Record panel. 
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3	 In the Record panel cue list, select one of the cues to record. 

Notice that the playhead moves to the In point of the selected cue.

4	 Move and resize the viewer as needed to clearly see the talent speaking onscreen. As 
you resize the viewer, remember that the only tracks you need to see during recording 
are A4, A5, and A13. 

Also, keep in mind that once you click Rehearse or Record in the Record panel, the 
designated recording track will be armed automatically, and the mic will be live until 
you disarm the track manually. 

5	 In the Record panel, click the Rehearse button.

During the rehearsal, you will hear the audible cues in your headphones and see the 
visual cues in the viewer.

Chances are that your first rehearsal was a little rough. No worries; you can rehearse 
again. Just remember that when recording replacement dialogue in sync with the 
picture, you will need patience and many takes to get it right. 

TIP  If you’d like to change the color of the Streamer and Cross, you can go to 
the ADR Setup panel, Video Streamer settings, and choose colors there from 
the color picker.
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6	 Rehearse the cue again as many times as you need. Don’t worry about getting it 
perfect. When you’re ready to record, move on to the next step.

7	 Click the Record button and record the cue. 

A newly recorded region, the exact length as your cued In and Out points, appears in 
the A12 ADR track. 

8	 In the Record panel, select Take 1 in the list and click the Play button to audition the 
recorded cue. 

9	 Rate your performance by clicking the stars to the right of the take in the list. 

NOTE  If you look carefully at the recording’s name in the list, you’ll see that it 
starts with the character name, followed by the cue number, take, and the first 
words of the cue text. The number at the end of the record name identifies 
how many ADR recordings have been made in this timeline, including the 
current recording. 

10	 Repeat step 7 so that you have at least three takes. When finished, disarm the 
ADR track.

The takes are recorded in different layers in the same track and listed in the Record 
panel. You can play back any of the takes by selecting the take in the list and clicking 
the Play button on the ADR Record panel. 

NOTE  The take list will remain active during the current recording session. 
Once you close the project, the take list will clear automatically. However, all 
the takes will remain in the timeline.

To see the clips for all the takes in your timeline, you need to show the audio 
track layers.
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11	 Choose View > Show Audio Track Layers. Adjust the track zoom as necessary to clearly 
see the multiple takes in the A13 track.

All your ADR takes are in the timeline and ready to use in your soundtrack. This 
exercise was just an opportunity to see your takes in the track. You already know how 
to edit audio track layers. 

12	 Hide the audio track layers.

13	 When finished, select the box in the rightmost column to mark the cue as done. Then, 
deselect the Arm button on the A1 track. 

NOTE  If you enjoyed recording ADR and want another go at it, feel free to 
practice by recording the other cue or additional takes.
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Exploring the ADR Timeline
This timeline includes hidden tracks that contain actual ADR recordings for this scene. If 
you want to see and hear some of the actual recorded takes, go to the tracks index and 
show the hidden tracks, including DX ADR 1, DX ADR 1 Edit, DX ADR 2, and so on. There are 
at least two takes for each line of dialogue, which you can see by showing the audio track 
layers. Feel free to explore the takes and timeline as long as you’d like. When finished, 
move on to the next exercise. 

NOTE  The A9 DX ADR 2 Elastic track will be the same as the DX ADR 2 track. You’ll 
use DaVinci Resolve’s Elastic Wave feature to better align that clip’s waveform 
in Lesson 6.

Importing an ADR Cue List
DaVinci Resolve includes options for exporting and importing ADR cue lists. Not only can 
you create your own cues in the timeline, but you can also import a comma-separated 
values (CSV) file containing an ADR cue list and either merge or clear the current list during 
import. In this exercise, you’ll import a CSV file with the dialogue cues for an entire scene. 
Rather than using the scene you were just recording, you’ll import the cue list for a 
different surf scene with more characters and dialogue. 

1	 In the media pool, open the timeline 4b Harper Surfs Scene ADR Cues. 

This is the surf scene checkerboard edit you worked on in Lesson 2 with the addition of 
A1 ADR 1 and A2 Beeps tracks. 

2	 Move the viewer to the bottom of the tracks area in the timeline.

3	 Show the ADR panel for this timeline.

4	 Click the List tab to go to the ADR List panel. 

As you can see, this timeline does not yet have any ADR cues. 

You’ll find the options to import and export cue lists in the ADR panel Options menu in 
the upper right corner of the ADR panel. 
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5	 In the ADR panel Options menu (…), choose Import Cue List. Navigate to R19 Fairlight 
Part 1 > Additional Media > ADRCues_TML Harper Surfs Scene v2.csv and click Open.

The .csv list opens into the ADR Setup window. Here, you can verify that the columns 
are in the correct order for ADR recording: Cue ID, In Point, Out Point, Character, 
Dialog, and Done. 

NOTE  If the column contents do not match the column header in the ADR 
Setup dialog, you can use the menu at the top of the column to choose the 
correct header. There are also new columns for Cue ID, Done, and Ignore. 
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You could clear all existing cues or update the Cue ID on the existing cues to match the 
incoming list and preserve them without duplicating them. In this case, there are no 
cues in the ADR list, so either option will give the same result. 

6	 Click Clear Import. 

The ADR cue list has a full set of ADR cues for the entire scene. You can create, edit, 
and export CSV files in most spreadsheet programs. This list was created in the 
Fairlight ADR List panel and then exported for use in this exercise. 

Sorting ADR Cues
Chances are, you will be recording your cues one character at a time, based on the 
availability of the talent. To simplify the sessions, you can use the Cue Sort menu at the top 
of the ADR panel to choose which cues are shown in the list. In this exercise, you’ll use the 
Cue Sort menu to streamline the list to show only Harper’s cues.

1	 In the upper right corner of the ADR panel, click the Cue Sort menu icon to show the 
dropdown menu. 

Here, you will see the option to Show All Characters, a list of characters, and the option 
to Hide Cues Marked as Done.
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2	 In the Cue Sort menu, click Marley to deselect her cues and hide them from the list. 

3	 In the Cue Sort menu, click Raina to deselect her cues and hide them from the list. 

The list has narrowed to show only Harper’s cues. You can use the Cue Sort menu to 
show or hide cues anytime. To show all the character cues again, you simply click that 
option in the Cue Sort menu.

4	 In the Cue Sort menu, click the Show All Characters option.

You never know when you might need to record some ADR for your own projects. As you 
have just seen, DaVinci Resolve makes this process easy to set up and use at any time. 
ADR recording techniques also work great for recording Foley sound effects to match 
onscreen action. 

NOTE  The AI tools in DaVinci Resolve 20 Studio include Create ADR Cues options 
in the right-click shortcut menu. Simply right-click an audio clip containing 
dialogue from one or more characters and choose AI Tools > Create ADR Cues or 
Create ADR Cues with Speakers. You can try this for yourself at the end of 
this lesson.
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Revealing the Beep Track Patching
Now that you have firsthand experience with the DaVinci Resolve ADR tools, you probably 
recognize the value of the beeps for cueing talent during a session. For this lesson, the 
beep track was set up for you. However, in the real world, on your own projects, you’ll need 
to be able to set up your own beep track. Luckily, this is an easy process, which can be 
saved as a preset that you can use on future ADR projects on the same system. In this 
exercise, you’ll find the A2 ADR Beeps track in the mixer and then show the Input and Path 
Settings to see how to patch the built-in system generator for ADR beeps. 

1	 Hide the ADR panel. 

2	 Select the A2 ADR Beeps track.

3	 Show the mixer. 

At the top of the A2 channel strip in the mixer, you can see that the Input is Beeps. 

The Beeps input source comes from the built-in System Generator. You’ll patch and 
record sounds from the System Generator in the next exercise. 

4	 Click the A2 Input pop-up and choose Path Settings. 
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5	 The Path Settings window opens and shows the Record Level set to Thru. 

NOTE  Patched tracks can be set to Record (Rec) or Through (Thru). If a track is 
set to Thru mode, it has an open input that can be triggered by talkback or, in 
this case, the ADR Beeps. In DaVinci Resolve 20, you can click the Record Arm 
button to arm the track for recording. You can also Command-click (macOS) or 
Ctrl-click (Windows) the (R) Record Arm button on the track header to set the 
track to (T) Thru mode. The Record Arm button turns red with an (R) when in 
Record mode and green with a (T) when in Thru mode. 

6	 Close the Path Settings window. 

For future ADR timelines you create in your own projects, be sure to create a track for the 
Beeps and patch it to the System Generator Beeps. 

TIP  You can save global track settings for tracks, such as the ADR Beeps track, in 
the Preset Library via the Fairlight menu. Once saved as a preset, you can easily 
apply the global track preset to a track in another timeline or project to instantly 
turn it into an ADR Beeps track. 

Recording the Built-In 
System Generator
Fairlight includes a System Generator that you can use to generate sounds such as white 
noise, beeps for ADR audible cues, or tones that you can transform into sound effects. In 
this recording exercise, you will create a new timeline, patch the System Generator, and 
record different sounds that you can use later for sound design. 
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For this exercise, you’ll continue working with your TML Audio Post project. First, let’s clean 
up the workspace and then create a new timeline and track.

1	 Hide the mixer and viewer. 

2	 Show the media pool, if necessary. Select the Lesson 4 bin. 

3	 Press Command-N (macOS) or Ctrl-N (Windows) to create a new timeline. 

4	 In the Create New Timeline dialog, in the Timeline Name field, type Sound Design FX. 
Leave the default settings as they are and click Create.

A new, empty timeline opens with one stereo audio track.

5	 Name the A1 track GEN FX. Also, toggle off automation so you don’t see the bus tracks 
in the timeline. 

Now that the timeline is created, let’s select the Recordings bin in the media pool. If 
you ever forget to select a specific bin for your recordings and no bin is selected, they 
will appear in the selected bin or under the Master bin. You can move them to another 
bin after you’ve finished recording. 
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6	 In the media pool, select the Recordings bin. Hide the media pool. 

You can use the Patch Input/Output window to patch the built-in System Generator to 
the track just as you would a microphone or other external audio device. Previously, 
you opened the Patch Input/Output panel from the mixer. This time, you’ll do so from 
within the Fairlight page.

7	 Choose Fairlight > Patch Input/Output.

The Source Audio Inputs menu offers numerous options from which to choose, so you 
might need to scroll down in the Audio Inputs menu to find the System Generator. 

8	 Choose Source > System Generator.

The System Generator can generate three types of sound that you can patch and 
record. Let’s start with the Noise generator. 

9	 Click Noise as the System Generator Source. Then, choose Destination > Track Input. 
Because this is a stereo track, select both channels of the GEN FX track for the destination. 
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10	 Click Patch and close the Patch Input/Output window. 

WARNING!  Do not arm the A1 track yet. You just patched a noise generator to 
the track, so if you armed the track, you would immediately hear it just as 
though it were a live microphone. Let’s first take a moment to find and use the 
master playback volume controls. 

11	 In the playback volume controls, click the DIM button to instantly lower the playback 
volume by 15 dB.

The playback volume fader turns yellow to indicate that the DIM button is on.

12	 Arm the A1 track. 

As promised, you can really hear that noise generator through your headphones 
or speakers, even with the playback dimmed by 15 dB. So how loud is the System 
Generator source? The System Generator generates sound at -15 dB. This is also 
the dialogue target level when you start editing dialogue and mixing. 

13	 In the playback volume controls, click the Mute button to mute playback.

You can combine the playback controls to go from DIM to mute and back 
whenever necessary. 
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Changing the Test Tone Generator Settings
Resolve’s built-in System Generator settings are available in the Fairlight menu. In this 
exercise, you’ll open the Test Tone Settings for the System Generator and experiment with 
some of its controls. 

1	 Choose Fairlight > Test Tone Settings to open the Test Tone Settings window.

2	 Unmute the playback volume controls. Leave the DIM button turned on. 

Feel free to mute or unmute the playback volume at any time.

In the Noise controls (located in the middle of the Test Tones Settings window), you 
can change the noise type from White to Pink.

3	 If necessary, lower the Tone Level until it reads -15. Click the Pink button to change 
from white noise to pink noise. Click back and forth between the two types of noise to 
compare them. When you’re finished, leave the Noise set to Pink. 

NOTE  Both white and pink noise include all the frequencies that the human 
ear can hear. The difference is that white noise has equal energy per 
frequency, similar to white light that contains all wavelengths of the visible 
spectrum at equal intensity. Pink noise is filtered white noise that has equal 
energy per octave. With pink noise, the intensity decreases as the frequency 
increases, which is how humans perceive sound; therefore, it’s easier on 
the ears. 

Now, let’s record a bit of that noise. 
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4	 Click the Record button to record about 10 seconds of pink noise. When you’re 
finished, click the Stop button or press the Spacebar. 

Now, let’s record a tone that you can control using the oscillator. To do so, you’ll need 
to change the patch input setting. This time, let’s open the Patch Input/Output window 
from the Test Tones Settings window.

5	 Click the Options menu (...) in the Test Tones Settings window and choose Patch 
Input/Output.
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6	 In the Patch Input/Output window, click Noise in the Source controls, and then click the 
Un-Patch button to unpatch the Noise generator.

7	 In the Source controls, click the Osc button. Then, in the Destination controls, select 
both channels of the GEN FX track. When you’re finished, click Patch. 

NOTE  When you unpatch a track in the Patch Input/Output window, the 
corresponding track is automatically disarmed. Likewise, whenever you open 
the Patch Input/Output window, you must first select the source or 
destination before the option to Patch or Unpatch is available at the bottom of 
the window. 

8	 Close the Patch Input/Output window. Then, arm the A1 track.

The default oscillator tone is a 1.5-kHz tone. 

9	 In the Oscillator Settings, drag the Frequency knob counterclockwise to lower the 
frequency, and drag clockwise to raise the frequency. 

10	 Click the buttons to the right of the Frequency knob to switch the Oscillator to that 
frequency preset. 

TIP  You can double-click the knobs in the Test Tones Settings to reset them to 
the default settings. 

11	 Disarm the A1 track and save your project. 

Although you might not need to record an oscillator sound every day, it’s useful to know 
where it is and how to record it for your projects. 
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Practicing More FX
Because your oscillator is patched and handy, and the track is set up, let’s record a few 
more sounds. In the following list, you’ll see several sounds you can record using the 
oscillator. When you’re finished, be sure to disarm the track and save your project. Also, as 
you go, it’s a good idea to create markers over each type of sound that you record in the 
timeline so you can easily identify them later. While you’re at it, change the clip colors as 
well. If your ears are sensitive to some frequencies, you can always record the oscillator 
with the timeline playback dimmed or even muted. 

Record approximately 10 seconds of each of the following oscillator sounds. Leave at least 
1 second between recordings in the track. 

	— 100 Hz

	— 200 Hz

	— 440 Hz

	— 1000 Hz (or 1 kHz)

	— 2000 Hz (or 2 kHz)

	— Ascending frequencies from 20 Hz to 10 kHz (by dragging the knob while recording)

	— Descending frequencies from 10 kHz to 20 Hz

	— Droid – Quickly change the frequency while recording. 

	— White noise (This requires you to return to the Patch Input/Output window.)

When finished, disarm the track, close the Test Tone Settings window, turn off the DIM 
button, and save your project. 

NOTE  If you’d like to see a finished version of the recorded frequencies, open the 
timeline 4 Sound Design FX Recorded.
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Exploring the Foley Sampler
In this lesson, you’ll continue working with the TML Audio Post project as you explore the 
fourth and final recording technique. The Foley Sampler plug-in is a built-in sampler 
FairlightFX plug-in that makes it easy to add sound effects that you want to play using a 
keyboard, pad, or other MIDI performance device connected to your computer to sync 
with onscreen visuals. This powerful plug-in has also been designed to simplify the process 
of recording performed audio cues on the current track to which the sampler has 
been added.

In this exercise, you’ll start by adding a clothing Foley sound effect to the Foley Sampler to 
see how it works as a sampled sound effect that can be performed with a MIDI keyboard 
or mouse. Then, you’ll add Foley footsteps to the Foley Sampler to demonstrate how to 
map additional sounds to the sampler. Finally, you’ll learn how to record Foley Sampler 
sound effects into a track in time to the footfalls onscreen.

The overall goal is to map Foley footstep sounds to the Foley Sampler so you can record 
them in sync with the video and then apply sound design so the recorded Foley Sampler 
footsteps sound as though they are happening within the context of the scene.

1	 In the TML Audio Post project, open the 4c Foley Sampler timeline.

2	 If necessary, open the viewer as a separate window and hide the meters at the top of 
the interface. 

3	 Hide all other panels. Move the viewer below the tracks so you can see all five tracks 
plus the viewer. 

4	 Move the playhead to the blue marker. 

5	 Start playback and watch the viewer as Harper’s dad walks across the sand toward her 
and then sits. 

In the next series of exercises, you will set up the Foley Sampler and record Dad’s 
footsteps and the sound of him sitting next to Harper directly into the timeline. First, 
you’ll add the Foley Sampler plug-in to the A4 FX Foley 1 track. 

6	 Show the mixer and the Effects Library.

7	 Select the A4 track header so you can clearly see it in the timeline and mixer. 
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8	 Drag the Foley Sampler plug-in to the A4 FX Foley 1 track header. Hide the 
Effects Library.

When you dragged the Foley Sampler to the A4 track, not only did the Foley Sampler 
window open, but it was also automatically patched as an input instrument ready for 
recording to the A4 track. 

At this point, the Foley Sampler is ready to use, but by default, it has no samples loaded 
to play. Next, you’ll add a sound effect from the media pool. 

NOTE  If you have a MIDI controller connected to your computer and properly 
configured, it will appear in the MIDI pop-up menu at the upper right corner of the 
Foley Sampler window (next to the Keyboard button). Choose your device from this 
menu, and the Keyboard button will highlight to show that it’s enabled.

Adding Sound Effects to the Foley Sampler
There are three ways to add prerecorded sound effects to the Foley Sampler. You can drag 
and drop a sound effect from the Sound Library or media pool onto the Foley Sampler 
window. Another method is to click the Foley Sampler window’s Option menu and choose 
one of the Add or Import sample options. Or, if the file you want to use is in the file system 
on your computer, you can locate it and drag it to the media pool. For this exercise, you’ll 
drag a sound effect from the Sound FX bin in the media pool. 

1	 Open the media pool. Locate the TML Media > Sound FX bin. 

2	 In the Sound FX bin, select the Taking Clothes Off clip. 
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3	 Drag the Taking Clothes Off clip to the Foley Sampler window. 

Once you add a sound effect to the Foley Sampler, it is automatically assigned to the 
keyboard keys, starting at the C2 keys. If you look above the keyboard keys, you’ll see a 
red bar indicating which keys the sound effect is currently assigned to. The first key 
plays the sound effect at its native pitch and speed. Subsequent keys to the right of 
the first key will play the effect incrementally faster and at a higher pitch.

4	 Click and hold the first keyboard key (C2) at the far left of the Foley Sampler keyboard 
to play the sound effect in its native pitch and speed. 

5	 Click additional keyboard keys toward the middle and the far right to hear the 
differences in speed and pitch. 

6	 Right-click the C2 key to play the full sample automatically. Click the key again to 
deselect it. 

Now that you know how to add and play a sample using the keyboard keys, let’s modify the 
sample and mapping. 



298Lesson 4  Recording Voiceover, ADR, and the Foley Sampler

Modifying Sample Mapping 
Although the default mapping works, it’s important to be able to map the samples to the 
keys of your choosing. In this case, the clothes sound effect works well at its native pitch 
and speed and may also work a few keys higher for variety. However, it is unlikely that the 
very high and fast versions of this sample will be useful in the Too Much Life soundtrack. To 
modify the key mapping, you simply go to the Keys controls at the top of the 
Mapping panel. 

At the top of the Foley Sampler, you’ll find four panel buttons that can be used to show 
different panels of controls: Mapping, Sample, Level, and Filter. In this exercise, you’ll work 
with the Mapping and Sample controls to remap the sample to the first 12 keys and 
change which part of the sample is played when you press a key.

The Low, High, and Centre control knobs determine which keyboard keys are assigned to 
the sample. 

1	 In the Keys controls, drag the High knob toward the left to a value of 47. The red bar 
over the keyboard keys stops after one octave (12 keys), which is just before the C3 key.
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2	 Change the Centre knob value to 41, which is the key in the middle of the mapped keys 
between the lowest key, 36, and the highest key, 47. 

3	 Right-click the fourth white keyboard key from the left (beneath the name of the 
sample) to play the sample at its native pitch and speed. Feel free to click any of the 
other keys within the mapped area to hear how the sample has been remapped, with 
subsequent keys to the left playing lower pitch and slower, and keys to the right 
playing higher pitch and faster. 

Next, you’ll look at the sample and change which part of the sample is played when 
you press a key.

4	 At the top of the Foley Sampler, click the Sample button to show that panel.

The Sample panel controls show the sample waveform and include controls for 
determining which part of the sample is played and whether it is played once or 
looped. White vertical lines on the far left and right side of the waveform indicate the 
Start and End points of the sample that are included when you play a key. Your goal for 
this exercise is to change the Start and End points of the sample so that it includes 
only the loudest section. 

5	 Right-click one of the keyboard keys beneath the red line to play the sample. As the 
sample plays, you can see the blue playhead move across the sample’s waveform.
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6	 In the Range controls, drag the Start knob toward the right until the white vertical line 
is just before the loudest part of the waveform (around 68.75). You can leave the End in 
the default position.

7	 Click one of the mapped keyboard keys to play the modified sample.

As you have just demonstrated, it is easy to add and modify a sound effect sample in the 
Foley Sampler.

NOTE  The Foley sound effects you are working with for this scene may not be the 
exact sounds you would choose if you had a vast sound library to work with. 
However, they are perfect for learning how to use the Foley Sampler in the 
Fairlight page.

Manually Mapping and 
Splitting Additional Sounds
The Foley Sampler can accommodate additional sounds that can be mapped to different 
parts of the keyboard so they can be played and recorded in sync to the picture. For 
example, in the current scene with Dad walking across the beach to join Harper, you could 
map sound effects for waves, seagulls, and the surf crashing on the shore in addition to 
Dad’s footsteps. To keep it simple, let’s just add some footsteps. First, you’ll need to set the 
Foley Sampler Keys controls to Manual mode. Otherwise, the sample mapping will override 
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your previous mapping and automatically split the keyboard evenly between the previous 
sample and the new sample. 

1	 At the top of the Foley Sampler, click the Mapping button to show the Mapping panel. 

2	 In the Keys controls, click the Manual button. 

3	 In the media pool Sound FX bin, locate the Boots on Rocky Dirt Footsteps clip.

This professional Foley sound effect is literally named and comes from the Fairlight 
Sound library.

4	 Drag the Boots on Rocky Dirt Footsteps sound effect from the media pool to the 
keyboard area of the Foley Sampler. The new sample is mapped to all the keys to the 
right of the first sample in the keyboard. 

5	 Click a few keys mapped to the footsteps sample to hear what it sounds like.

Once again, each key incrementally plays the footsteps faster and at a higher pitch, 
which isn’t really useful if you are recording footsteps to picture. What you really need 
is for footsteps to be mapped so that you can play them individually or in sets. You can 
do this by splitting the sample from the Options menu. When you split a sample, the 
sampler will automatically map the original full-length sample to the first set of keys, 
followed by a spacer without sound, and then the split sound effects are assigned to 
keys based on how many keys remain on the keyboard. That way, the operator has the 
option to play the full sample or split parts of the sample.
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6	 At the top of the Foley Sampler, click the Sample button to show the sample waveform.

Here, you can clearly see the waveform and footstep sets that include picking up the 
foot and putting it down within the sample. You can also see that some footsteps are 
louder than others. 

7	 Click the Options menu in the upper right corner of the Foley Sampler. This is where 
you’ll find additional options to do things like Add, Rename, and Delete samples. In the 
Options menu, choose Split Sample. 
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The split footstep groups are now mapped to keys in order from left to right. Let’s look 
at the split samples to see the resulting waveforms.

8	 In the keyboard, click the line above each of the Boots on Rocky Dirt samples from left 
to right to see the respective waveform in the sample waveform area. 

As expected, the last three split samples vary from two steps to an individual step to a step 
and lift of the other foot. Knowing the difference between the different split samples will 
make it easier to perform the steps to picture when the time comes. 
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NOTE  The Foley Sampler splits samples by looking at transients and silence 
between waveforms. A recording of individual footsteps clip-clopping along a floor 
might split into individual steps, while a recording of footsteps stomping through 
dried leaves and brush might not split much at all if there is a lot of continual 
sound between steps.

Recording Foley Sampler Footsteps to Picture
With the keyboard mapped, it’s time to move on to recording the Foley samples to picture. 
Keep in mind that this takes some skill to master, so for the purposes of these exercises, 
just do the best you can. In this final Foley Sampler exercise, you’ll start by setting a looped 
playback range so that you can practice performing footsteps via the keyboard to picture. 
Then, you’ll record a take in the timeline. To simplify the process, a blue marker indicates 
where Dad lifts his foot to take the first step, and a tan marker indicates where Dad sits. 
Feel free to add more markers for each step if that helps you. 

1	 Hide the media pool and mixer if necessary to streamline your interface. 

2	 Use the zoom controls so you can clearly see the timeline between the blue and tan 
markers. You’ll also need to position the viewer window and Foley sampler so that you 
can see the video and click the keys on the keyboard. 

3	 Set a range in the timeline that starts before the blue marker and ends around 
00:58:9:00 after Dad has had time to sit. Once the range is set, press A for the Arrow 
tool to maintain the range while you work. 
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4	 Turn on the Loop button in the transport controls to enable looped playback.

5	 Press Shift-I to move the playhead to the beginning of the range. Start looped playback 
in the timeline and practice playing the samples using the viewer guide. If you are 
feeling ambitious, you can also try clicking a key in the first sample area of the 
keyboard to add a sound for Dad sitting. 

You probably noticed that the third sample in the middle of the keyboard is blank. 
Selecting it will make it show up as red, which is a good reminder not to click those 
keys while you record.

6	 In the Foley Sampler, click the horizontal line above the third sample in the middle of 
the keyboard to select it. 

Instead of recording right at the blue marker, let’s move the playhead earlier to add a 
little pre-roll time before you have to perform. 

7	 Move to the beginning of the range. Press Shift-Left-Arrow three times to move the 
playhead 3 seconds before the blue marker. Press-I to set the new In point for 
the range. 

8	 Click the Arm button (R) on the A4 track header to arm the track for recording. 
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9	 When you are ready to record a take, click the Record button in the transport controls 
above the timeline. Press the Spacebar to stop recording when you are finished. 

NOTE  If you want to try another take, you can undo the previous recording or 
simply record another take on top of the first. Each take will be stored in the 
track in audio track layers with the most recent take on top. 

You can record additional takes later. For now, let’s move on to the last part of the 
exercise. Once you have recorded a take, you can easily split the clip to adjust the 
timing of the footfalls or adjust the clip level as needed. 

10	 Close the Foley Sampler window and disarm the A4 track. 

Finishing the Foley Footsteps 
The last step for finishing the footsteps for this scene is to change the clip gain level with 
keyframes so it sounds like the footsteps are moving closer.

1	 In the timeline, increase the height of the A4 FX Foley 1 track. Zoom as needed for a 
clear view of the newly recorded clip in the A4 track. 
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2	 Move the playhead to the beginning of the range, or before the blue marker.

In Lesson 1, you worked with the clip gain line to increase or decrease the volume level 
of a clip. Adding keyframes to the clip gain line allows you to bend the line as needed 
to accommodate different levels within the clip. You’ll work more with clip levels in the 
next lesson. For now, your goal is to add two keyframes and lower the first to create a 
gradual volume increase in the footsteps as Dad approaches Harper. To set a keyframe 
on the clip gain line, you Option/Alt-click the line. 

3	 Option/Alt-click the gain line beneath the blue marker, before the first footfall starts. 

4	 Set another keyframe at the tan marker position, before Dad sits. 

NOTE  To delete a keyframe, Command-Option-click (macOS) or Ctrl-Alt-click 
(Windows). 

5	 Using the tooltip as a guide, drag the first keyframe downward to decrease the level by 
about -18 to -20 dB.

6	 Play the clip to hear the level changes. Adjust the keyframes as needed to taste. 

There you have it. You have successfully executed four different types of recording in the 
Fairlight page. Don’t worry if your Foley Sampler recording isn’t perfect. As long as 
you know how to perform these operations, you can use the Foley Sampler on your 
own soundtracks. 
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TIP  You can save a Foley Sampler instrument with all the samples and mapping to 
the Preset Manager so you can use it again in other timeline tacks or even other 
projects on the same system. This is incredibly useful if you are working on a 
project with a lot of repetitive Foley sounds, such as football tackles, helmets 
crashing, and crowd cheers for a football-themed movie.

Creating ADR Cues 
with AI Tools (Studio Only)
Earlier in this lesson, you worked with the Fairlight ADR tools, created new cues, and 
imported a cue list. If you are working with DaVinci Resolve 20 Studio, you can 
automatically create ADR cues from a dialogue clip in the timeline. In this exercise, you’ll 
continue working with the TML Audio Post project as you open the ADR timeline and use 
the AI Tools to create cues for the scene. The cues you make automatically will be added to 
the existing cue list. To simplify this exercise, you’ll create cues from the finished reference 
mix in the A1 and A2 tracks. 

1	 Open the 4a ADR Setup timeline. 

2	 Unmute tracks A1 and A2, then solo A1 and A2.

3	 Right-click the clip in the A1 track and choose AI Tools > Create ADR Cues 
with Speakers.
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4	 Open the ADR panel. 

5	 Click the List tab to see the updated ADR list. 
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Cues 1-4 are still at the top of the list, just as you created them earlier in the lesson. 
Cues 5-9 are the new cues created by the AI tools. As you can see, the text is the same; 
the primary difference is that the speaker names need to be updated to character 
names, and there is a cue labeled Music. 

Lesson Review
1	 After connecting a microphone to your computer, what two steps are necessary before 

you can record to a specific track? 

a)	 Patch the audio source to the track and select the track.

b)	 Select the track and Shift-click the Record button.

c)	 Patch the audio source to the track and arm the track.

d)	 Select the track and click the Record button in the track header or mixer.

2	 What happens to a recorded clip in the timeline when you record another take in the 
same track?

a)	 The new take overwrites the previous take.

b)	 You create a punch-in recording.

c)	 The new take is recorded in an audio track layer above the previous take.

d)	 The new take is recorded in an audio track layer below the previous take.

e)	 The new take temporarily replaces the previous take, but all takes can be 
recovered by choosing the Restore Takes option in the right-click menu.

3	 Where do you set up an ADR session?

a)	 In the media pool Preview player

b)	 In the Setup tab on the ADR panel

c)	 In the Cue Index tab on the ADR panel

d)	 In the Sound Library, ADR Cue tab

4	 True or False? To record beeps, noise, or tones, you must first open the Test Tones 
Settings bin in the media pool.
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5	 Identify the two types of noise available in the Test Tones Settings window. 
(Select two.)

a)	 White noise

b)	 Brown noise

c)	 Pink noise

d)	 Noise print

e)	 Ambient noise

6	 What file format can you use to import and set up an ADR Cue list?

a)	 .TXT

b)	 .XML

c)	 .CSV

d)	 .CUE

7	 What creates the beeps, noise, and tones that you can generate on the Fairlight page?

a)	 Velociraptor

b)	 Noiseinator

c)	 Noise FX plug-in

d)	 Oscillator 

e)	 Beep generator

8	 Which Fairlight FX plug-in is a built-in sampler that makes it easy to add sound effects 
you want to play using a mouse, keyboard, pad, or other MIDI performance device 
connected to your computer to add timed sound effects to sync with onscreen visuals?

a)	 FX Sampler

b)	 Foley Sampler 

c)	 Foley Tracker

d)	 Sound Library Sampler 
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Answers
1	 c. To record a connected microphone to a specific track, you must patch the audio 

source to the track in the Patch Input/Output window and arm the track.

2	 c

3	 b

4	 False. To record beeps, noise, and tones, you must first patch the Test Tone Settings as 
the audio source in the Patch Input/Output window. The Test Tones Settings window is 
in the Fairlight menu.

5	 a and c

6	 c

7	 d

8	 b
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Balancing your soundtrack starts with 
adjusting clip levels. Whether you’re 
working on a podcast, radio spot, 
documentary, interview, or feature film, 
the first step after editing is to ensure 
consistent clip levels. You can adjust them 
as you go or wait until editing is complete, 
but either way, it’s crucial to balance the 
levels within each track before moving 
on to mixing.

In this lesson, you’ll focus on balancing 
dialogue clips, sound effects, and music 
beds. Once the clips are properly balanced, 
you’ll explore panning sound effects tracks 
to match the scene’s context and 
onscreen positioning.

Lesson 5

Balancing Clips and 
Panning Tracks
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NOTE  The exercises in this lesson build on the tools and skills you learned in the 
previous lessons. If you skipped ahead to this lesson, you might need to look back 
at the previous lessons as a guide for skills and tools already covered. 

Previewing the Scene for Context
In this lesson, you’ll work with the “Learn to Surf” scene from the film Too Much Life. The 
dialogue edit has come a long way since you worked on it. If you recall, this is the scene 
where you performed a checkerboard edit in Lesson 2 and determined that the dialogue 
needed to be replaced. Let’s start by opening the project and previewing the beginning 
of the scene. 

1	 If necessary, open the TML Audio Post project. 

2	 Choose Workspace > Reset UI Layout. 

3	 In the media pool, select the Lesson 5 bin. Then, change the media pool to List view. 

4	 Open the 5 Balance Dialogue Clips timeline. Undock the viewer as a floating window. 
Hide the media pool and meters.

The timeline is a simplified version of the scene from your checkerboard edit. The 
original production dialogue has been replaced with ADR recordings and is ready for 
balancing. The A5 FX Amb and A6 Music tracks have been added, and the A6 Music 
track is muted. 

5	 Move the playhead to the blue marker. 

6	 Right-click the Stop button and choose Stop and Go to Last Position to turn on 
that option. 
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7	 Play the timeline and listen to it once with only dialogue and the ocean waves sounds. 

Now, let’s listen once more with the music and without the sound effects. This time, 
you’ll watch the timeline in the full-screen Cinema viewer. 

8	 Mute the A5 track and unmute the A6 track.

9	 Press Command-F (macOS) or Ctrl-F (Windows) or choose Workspace > Viewer Mode > 
Cinema Viewer. 

10	 Press the Spacebar to start playback. Watch and listen to the dialogue with only the 
music. When finished, press Esc to exit Cinema view. 

What are your thoughts? Did you notice how the scene felt serious with only the sound 
of waves crashing? Then, when paired with just the music, it became more comical. This 
shows the power of audio in a soundtrack. As you just experienced, a simple music choice 
or ambient sound effect can completely change the mood of a scene. Now that you’re 
familiar with this scene and have heard it with music and sound effects, let’s balance the 
dialogue clips.

Resetting Clip Levels 
Because these exercises are based on real-world workflows, this is a good time to learn 
how to reset volume levels to their default settings. Why would you do this? Because, in the 
real world, most dialogue editors and audio professionals prefer to start with “clean” 
unaltered audio so they can personally determine which tools and processing are 
necessary to prepare the best-sounding dialogue tracks for mixing—just as colorists clear 
all editor-applied grades and plug-ins before they begin grading, and makeup artists start 
with a clean makeup-free face instead of adding makeup on top of performer-
applied makeup.

So please remember that if you are an assistant editor who spends tireless hours 
normalizing, keyframing, and tweaking dialogue levels on your scenes before passing 
them along to the audio department, your efforts are appreciated by the picture editor 
and anyone who screens the edit. 

Meanwhile, seasoned dialogue editors will likely begin each new scene with clean dialogue 
by resetting all the levels and removing any plug-ins or EQ applied to the timeline clips. 
This is quite easy to accomplish in the Inspector or the Remove Attributes dialog. For this 
exercise, you’ll use the Remove Attributes dialog to reset all the clips in the timeline. 

1	 If necessary, click any empty timeline space below the last timeline track to deselect all 
clips and tracks. 
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2	 Press Command-A (macOS) or Ctrl-A (Windows) to select all clips in the timeline. 

As expected, the clips are all selected. Notice that the tracker controls are also showing 
in the viewer. You just discovered a secret shortcut for showing and hiding the tracker 
controls in the viewer. You’ll work more with those later in this lesson. 

3	 Right-click the selected clips and choose Remove Attributes. 

4	 In the Remove Attributes dialog, check the Audio Attributes option to automatically 
select all three options: Volume, Plugins, and Equalizer.

5	 Click Apply. 

6	 Press Command-A (macOS) or Ctrl-A (Windows) to deselect all the clips and hide the 
tracker controls in the viewer. 

The clips have all been reset. 

7	 Mute the A6 Music track.

Let’s also double-check that the pre-fader metering is unchecked in the project settings. 

8	 Press Shift-9 to show project settings. 

9	 In the Project Settings, click Fairlight in the sidebar. In the Audio Metering settings, 
uncheck “Pre fader metering on tracks.” 

Now, the meters in the timeline, track header, monitoring panel, and mixer all reflect 
the clip gain levels in the track as well as any changes made to the faders in the mixer. 
You are ready to evaluate the dialogue clips. 
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Balancing Dialogue Clip Levels
Finally, you have reached the last major step of dialogue editing. You need to balance the 
dialogue levels for the entire scene so they are consistent throughout. To do so, you’ll 
check the levels of each audio clip while watching the track meters in the mixer and adjust 
the clip gain as needed. During this process, you’ll also apply keyframes to the clip gain line 
when necessary and apply clip normalization to automatically set the peak levels on some 
clips. Once clip levels are set within a track, you can evaluate how the different dialogue 
tracks sound together. 

To further understand the task, let’s look closer at the Fairlight mixer and the target levels 
for dialogue.

1	 Show the mixer, if necessary. Drag the inner-left edge of the mixer to the left to extend 
it until you see all six tracks (A1 through A6) plus the Bus 1 output (B1).

The Fairlight mixer opens to the right of the timeline. You can easily identify each track 
by the color bar at the top and the track name in the middle. 

2	 If necessary, move the playhead to the blue marker. 

3	 Select the A1 Harper track. 

As you can see, the corresponding channel strip is also selected in the mixer.

4	 In the mixer, in the A1 channel strip, click the Solo button to solo the A1 track. 

The Solo button in the A1 track header is also in the on position. 

5	 Press R for Range mode. 

6	 Select the first clip in the A1 track to set a range. Press A to switch to Pointer mode.

NOTE  From this point forward, selecting a clip with the Range tool to set a 
range and then switching to the Arrow tool to maintain the range while 
working will be referred to as “marking the clip.” 
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7	 Zoom as needed until you can clearly see the selected clip and its waveform. 

You’ll work more extensively with the mixer later. For now, focus on the meters at the 
bottom of each channel strip. 

Reading the Meters for Dialogue
Not only are the meters in the Fairlight mixer easy to read, but they are also color coded so 
you can watch numerous tracks at once and quickly see if they are within the target range. 

Loudest peak

Dialogue range

The solid color in the meter shows the current volume level on a decibel scale. These peak 
meters are “sticky,” meaning they have a thin horizontal line that sticks to the loudest peak 
level, even when the current level is lower than the recent peak. Peaks within the green 
level are safe and cannot be too loud. Yellow peak levels are good targets to aim for when 
working with dialogue. Red peak levels are getting close to being too loud and clipping, or 
becoming distorted. When you get to the final mix, it is OK to let some of your peaks go 
into the red as long as they don’t go too far into the red and don’t remain there too long. 
However, your dialogue levels should be well within the yellow range at this point in the 
process. Exceptions might be a loud scream or whisper, but neither is in this scene. 



319Lesson 5  Balancing Clips and Panning Tracks

Establishing Target Dialogue Levels
Whether your scene is narrative, voiceover, or a talking-head interview, you manage the 
dialogue level on each clip in the same way. 

-3 dB Loudest scream

-20 dB Quietest whisper

-12 dB Average dialogue level
-10 dB Louder voice

-15 dB Softer voice

Dialogue dynamic range

Record
Solo

Mute

Volume fader

The average level should be around -12 dB on this peak meter. However, context is also 
important. If you have bigger and louder characters, their levels might be closer to -10 dB. 
A quieter voice might sound better around -15 dB because it is a speaking voice. Shouting 
might reach -8 dB to -6 dB. Bloodcurdling screams could be as high as -3 dB, while hushed 
whispers might be as low as -20 dB. 

NOTE  The dialogue clips in this scene are composed of ADR recordings created in 
the Fairlight ADR tools. The best takes were edited and bounced as a new file. 

Let’s see where Harper’s dialogue falls on the meters in her first clip.

1	 Turn on looped playback if necessary.

2	 Start looped playback. 
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3	 In the mixer, look at the meter in the A1 channel strip to determine the current 
dialogue level. During playback, watch the solid bar in the meter to see the average 
level. Also, look for the highest peak, based on the horizontal peak mark in the meter. 

4	 Stop playback. 

Depending on the actor’s voice and inflection, some fluctuation will occur between the 
peaks and the average. In this clip, the average (solid bar) is around -12 dB, while the 
peak is near -8 dB. The average level in the first dialogue clip is from around -10 dB to 
-12 dB, while the peak is near -8 dB. These are strong levels, but in context, they may 
be a bit too loud since Harper is just making a statement. Lowering it by a few decibels 
may give you more room for other more energetic clips to be louder if needed. 

You have enough information to go ahead and start adjusting the clip’s level. 
However, the Fairlight page includes two additional tools that you can employ to 
make evaluating and adjusting clip levels even easier, including the Clip Volume 
display and the Meter plug-in. You worked with the Clip Names and the Volume 
display once before in Lesson 1. 
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5	 Choose Fairlight > View Clip Info Display and click the Clip Name and Volume options to 
select them. Click OK. 

The clip gain level now appears in the header at the bottom of each clip after the clip 
name. In this case, since you reset the clip levels, the dialogue clips are all at the 
default level of 0.0dB, indicating that no change has been applied to the clip levels. 

6	 Show the Effects Library. In the Fairlight FX list, drag the Meter plug-in to the A1 track 
header. Hide the Effects Library.

A floating Meter window named after its corresponding track, Harper, appears in the 
middle of the timeline. 
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7	 Drag the Harper meter to the A1 track and place it near the clip that you’re evaluating. 

NOTE  The Meter plug-in is an SPPM (Sample Peak Program Meter) that shows 
the Sample Peak Level during playback. You can apply this plug-in to any track 
for an easy readout of the current sample peak levels. You can also apply the 
plug-in to your main output and busses. To resize the floating meter, drag the 
lower right corner. If you close the floating meter, you can reopen it any time 
by clicking the Customize button for the meter plug-in in the mixer or 
Inspector. You can also delete the Meter plug-in when you no longer need it. 

8	 Start looped playback and watch the floating Meter window to see the peak and 
average levels. 

With the help of the floating meter, you should easily be able to see the levels of the 
clips during playback. 

You can also manually scrub the playhead across the clip to see the levels of specific 
parts of a clip. 

9	 Stop playback. Choose Reset to Default from the Options menu (...) at the top or the 
Meter window to reset the meter.
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10	 Move the playhead to the last half of the clip, and then drag the playhead back and 
forth over the last part of the waveform to scrub the clip and see the levels in 
the meter. 

Scrubbing the clip allows you to focus the meter on specific areas of the waveform to 
check the levels. 

11	 Scrub the first part of the clip to see the levels.

Using this technique, you can see that the first part of the clip is louder and peaks 
at -8.3 dB.

Now that you’ve seen how the meter works and know what to look for, let’s check the 
other two clips in the Harper track.

12	 Mark the second clip in the A1 Harper track. Start looped playback and check the levels. 

13	 Repeat step 12 to check the levels on the third clip. 

The last two clips are pushing the boundaries of being too loud. The second clip, 
where Harper shouts “Stop,” should be louder than normal conversational dialogue. 
However, it’s peaking at -3 dB, which is the loudest any soundtrack element should 
ever get, including a scream—and she isn’t screaming. If you watch her delivery, you’ll 
notice she barely shouts. She is being assertive, yes, but definitely not screaming. In 
the third clip, she also breaks the sound barrier with -3.7 peaks for a simple question. 
Sure, they are a few feet away, so she must raise her voice, and she may be nervous 
but, once again, not to the level of screaming. If conversation and slightly raised voices 
are at -3 dB, what is left if she actually screams at some point? Context and consistency 
matter. Luckily, adjusting levels is easy. 

NOTE  You do not need to balance dialogue clips that have been disabled. 
The director no longer wants to include them in the scene. However, as a good 
dialogue editor, you’ll leave the clips in place (disabled) in case the director or 
anyone else changes their mind. 
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Adjusting Clip Levels 
Now that you know the levels of Harper’s first three dialogue clips and the level you’re 
aiming for in the meters, you can start adjusting each clip’s gain line overlay to lower that 
clip’s level. Later, when you start pre-mixing tracks, you can use the volume fader in the 
mixer to raise or lower the overall level of each track. You’ve already worked with clip levels 
in Lesson 1. This time, you’ll use several different methods to adjust clip levels, including 
manual and keyboard shortcuts. 

1	 Mark the first clip in the A1 Harper track.

Feel free to move the floating meter and viewer as needed.

2	 Play the clip once again to see the current levels. 

Your goal for this first clip is to lower the clip gain by 2 dB. Then, check the meters to 
see the results. 

3	 In the timeline, drag the Clip Gain line downward until the tooltip reads -2.0. Hold Shift 
while dragging for finer incremental level control.

Notice the clip gain level in the clip display.
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4	 Play the marked clip and watch the meter to see the new levels. 

The average is still right on target; it’s just a bit lower, and the peak is near -10.0. 

Now you can move on to the next clip. This time, you will adjust it on-the-fly during 
playback using keyboard shortcuts from the Clip menu.

5	 Mark the second dialogue clip in the A1 Harper track. Then, select the clip with the 
Pointer tool. 

6	 Start looped playback. During playback, press Option-Command-= (equals) (macOS) or 
Alt-Ctrl-= (equals) (Windows) and Option-Command-–(minus) (macOS) or Alt-Ctrl--
(minus) (Windows) to increase or decrease the level of the selected clip. Continue 
adjusting the level until the peak is between -8.0 and -9.0. 

7	 When you are finished, stop playback. 

The clip gain level in the clip display should be near -5.0 dB. Remember, the numbers in 
the clip display represent the percentage of change (gain) applied to the original level 
of the source material. They do not specify the actual volume level of the output. 

Don’t worry about finding the perfect number. As long as Harper’s dialogue levels are 
consistent and those levels reflect the context of the scene, it should be fine. Later, you 
can finesse the levels of the entire track when you start mixing. 

8	 Scroll down to the last clip in the A1 track. 

9	 Mark the clip. 

This time, just by looking at the waveform, you can see that there is quite a difference 
in levels between the beginning and the end of the clip. You’ll need to use keyframes to 
balance the clip. 
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Using Keyframes to Change Clip Levels
In Lesson 1, you used keyframes to lower part of the drinking coffee sound effect in the 
podcast intro soundtrack. In this exercise, you’ll use keyframes to change the volume levels 
within a dialogue clip. When making these kinds of changes, it’s a good idea to first find an 
average level that works for most of the clip’s dialogue and then apply keyframes to raise 
or lower only those sections that need further adjustment. 

For this exercise, you’ll set the level for the first part of Harper’s clip where she says, “Am I 
the only one?” Then, you’ll add two keyframes before the louder section of the waveform 
so you can lower the level of the last part of the clip. 

1	 Start looped playback and watch the levels. When finished, stop playback.

Looking at the waveform in the third clip, you can clearly see that the beginning of the 
clip is much quieter than the end. Let’s start setting the level for the first section. Then 
you’ll need to lower the level of the last word, “one,” without changing the 
earlier section. 

2	 Reset the meter. 

3	 Scrub the playhead over the clip or press the JK or KL keys in combination to see the 
levels of the first section. 

These levels are good, but the middle part is on the low side for dialogue, and she is 
talking to people behind her. So her voice could be a little louder in the beginning. 
Let’s increase the level between 1.0 dB and 2.0 dB. 

4	 Drag the gain line upward to increase the clip level by 1.0 dB to 2.0 dB. 

5	 Play the clip. 

The first part of the clip should still be solid yellow in the meters, peaking near -10.0 dB.
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6	 Locate the part of the clip waveform just before the waveform increases dramatically. 

This is where you will set a pair of keyframes one at a time by Option/Alt-
clicking the line.

7	 Option/Alt-click the gain line to add the first keyframe. Repeat to add a second 
keyframe to the left of the first. 

Now that you have a pair of keyframes, you can lower the gain line to the right of them 
as needed. Better still, lower the levels during playback so you can see the meter while 
listening to the results. Remember, yellow is a healthy dialogue volume level in the 
meters. Red is loud. If the levels are red, they need to be motivated by the context 
onscreen and controlled if necessary. 

8	 Start looped playback and watch the meter as you lower the level of the last part of the 
clip. When you’ve finished, the gain level for the last section should be somewhere 
between -5.00 dB and -6.00 dB. 

9	 Stop playback and clear the range. Press A to return to Pointer mode. 
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How do you know the clip gain levels once there are changes within the clip? Simply 
select a keyframe or the gain line to view a tooltip. 

Excellent work. Hopefully, by the third clip, you were more comfortable with the 
workflow and confident in your clip level settings. One of the wonderful things about 
audio post work is that it is fairly straightforward once you understand what you need 
to do and why. 

NOTE  You can also adjust clip volume, set and delete keyframes, and even 
navigate between keyframes in the Inspector. Working with keyframes in the 
Inspector is based on the current playhead position and the selected clip.

Here are some basic guidelines for setting and deleting audio keyframes: 

	— As the name suggests, keyframes set values on specific frames. So you can create 
and move them based on full frames, regardless of your zoom level. 

	— Pairs of keyframes between sections of dialogue make it easier to raise or lower 
each section as you go.

	— To set keyframes one at a time, Option-click (macOS) or Alt-click (Windows) the 
volume gain line.

	— After creating a keyframe, you can move it or select and delete it. 

	— Command-Option-click (macOS) or Ctrl-Alt-click (Windows) a keyframe with the 
pointer to delete it. 

	— To clear all the keyframes on a clip, click the Clip Volume Reset button in the Inspector. 

Balancing a Range of Clips 
You can balance the levels of an active range of clips as if they were a single clip. Simply 
drag a range with either the Focus mode multi-tool or the Range tool, and then adjust the 
gain line on any of the clips to adjust them all relative to the one you are changing. 

Let’s balance the clips for a different character, Levi, who is seen in the background with 
Raina trying to manage the comically heavy camera. Since he is farther from the camera, 
his lines should be audible but quieter than Harper’s, who is both louder as a character 
and closer to the camera in the scene. 
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Levi’s dialogue levels need to be on the lower end of the dialogue range, closer to -15 dB 
with peaks around -12 dB to -13 dB and possibly dipping into the green on the meters. 
To keep things interesting and continue adding new skills, you’ll use the Range tool to 
select and balance two clips at the same time. 

First, you’ll add a Meter plug-in to the A4 Levi track. However, instead of adding a new plug-in, 
you can simply drag the meter plug-in from the A1 track to the A4 track in the mixer. That’s 
right: you can drag and drop or Option-drag to copy plug-ins from track to track. Let’s try it. 

1	 In the mixer, unsolo the Harper track. Solo and select the Levi track.

2	 At the top of the mixer, locate the Meter plug-in on the A1 channel strip. 

Notice that the Insert button (In) on the A1 channel strip is yellow, indicating that a 
plug-in effect has been applied to the track. 

3	 In the mixer, drag the Meter plug-in from the effects list in the A1 channel strip to the 
effects list in the A4 track. 

The Insert button on A4 shows that there is now a plug-in on that track, and the 
floating meter is named Levi, just like the A4 track. If you don’t see the floating meter 
or closed the meter by mistake, no worries. Just hover over the Meter plug-in on the 
mixer channel strip and click the Controls button to open the plug-in window. 

NOTE  Besides indicating that a track has plug-ins applied, the Insert button 
can also be used to toggle all of a track’s plug-ins on and off with a single click. 
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4	 In the timeline, play the three clips on the A4 track. 

The first two clips are dialogue of Levi saying, “Here, I’ve got it” and “I’ve got it.” The 
third clip is Levi grunting under the weight of the camera. Nonverbal noises still 
constitute dialogue; you just don’t have to be as concerned about clarity and 
intelligibility. 

5	 With the Range tool, drag a range that includes the first two clips in the A4 track. 

6	 Zoom as needed for a clear view of the range, meter, and viewer. 
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7	 Start looped playback. Drag the gain line on the second clip downward to lower the 
level of both clips at the same time. Lower the level between 6.0 dB and 7.0 dB. 

You probably noticed the first time he says, “I’ve got it” is louder than the second time. 
Normally, this would be fine. However, since it is essentially a background line, and he 
isn’t even in focus at the time, we might as well lower the level of that phrase. Instead 
of manually adding keyframes, let’s just drag a range around the phrase and lower the 
level within the range. Adjusting clip gain levels of a range automatically sets bounding 
keyframes to maintain levels outside of the range. 

8	 Click the empty space near the first to clip in the A4 track to clear the range. 

For this exercise, try using the waveform in the neighboring sections outside the range 
as a guide. 

9	 Drag a range over the waveform in the second half of the first clip. Lower the gain level 
of the range, using the waveform as a guide. 
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10	 When finished, click any empty timeline space to clear the range. 

11	 Play the first two clips in the A4 track to hear how they sound and check the levels. Feel 
free to finesse the levels if needed.

More Clip Level Balancing
Let’s test your skills on the last clip in Levi’s track, where he grunts under the weight of the 
massive camera lens. Play the clip a few times while watching the video. Lower the clip level 
during playback and use keyframes to reduce the second part of the clip as needed. Keep 
in mind that these sounds have the potential to be either funny or distracting, depending 
on the full mix with the other sounds. Have fun. 

Now that you’ve got the hang of clip balancing, go ahead and balance the A2 Raina track as 
well. Start by adding a Meter plug-in to the A2 track. You can add a new one, take the one 
from the A4 track, or Option/Alt-drag the meter from Levi’s track to make a copy and add 
the copy to the A2 track. 

The A2 track has two clips to balance. Raina’s line “Oh, it’s heavy” is in the background with 
Levi, so the levels should be lower. Her second clip, where she enthusiastically says, “I’ll go!” 
is delivered as she bounds toward Harper (and the camera) but is stopped midway by 
Marley. That means her levels need to be set based on the context of where she is and her 
delivery. To balance Raina’s first clip, it’s a good idea to unsolo Levi’s track so you can hear 
how they sound together since it is an exchange between them. 

Don’t do anything with the A3 Marley track. You’ll work with that in the next exercise. 

NOTE  If you did not complete all the balancing exercises up to this point, open the 
5a Normalize Dialogue timeline to catch up.
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Applying Auto-Leveling 
to Balance Clips 
If you think balancing dialogue levels is agonizing and tedious, DaVinci Resolve offers two 
“cheats.” Resolve includes automatic clip volume normalization and an AI-based track 
effect: the Dialogue Leveler. Let’s start with normalization. 

Clip normalization is available in both the edit and Fairlight pages for quickly setting the 
peak levels in a clip without considering the scene’s context or performance. Auto clip-
normalization is like using the Auto-White Balance tool in the color page. It’s an easy way to 
set a starting point for an editor who must quickly set levels on audio clips. 

Of course, now that you’re a seasoned dialogue editor, you probably have no interest in 
using auto-normalization. However, it’s still worth knowing about, and in fact, one 
circumstance in which auto-normalization is effective is when you are working with a 
voiceover track, interview, or character who speaks with little inflection or dramatic change 
in emotion. And it just so happens this timeline has such a track—you’re in luck. In this 
scene, the Marley character on A3 plays the comic deadpan role where she tries to keep 
herself in control, even when surrounded by highly energetic people and circumstances. 

In this exercise, you’ll apply normalization to the clips in the A3 Marley track. 

1	 Clear the range if necessary. Select the A3 track and mark the first clip. 

2	 In the mixer, drag the Meter plug-in from the A2 channel strip to the A3 channel strip. 

3	 Show the Meter window, if necessary. Hide any open panels. 

4	 Adjust the zoom levels in the track until you can clearly see the clips in the A3 track. 

5	 Play the clip and look at the meters. 
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At a glance, you can see that her levels are on the high end of the dialogue range. Plus, 
she is off-camera, so we don’t know proximity or context. In situations like this, it’s good 
to aim for the middle of the dialogue range, with an average around -12 dB or less. 

6	 Right-click the first clip in the A3 track and choose Normalize Audio Levels to open the 
Normalize Audio Level panel for that clip.

In the Normalize Audio Level dialog, you can select a peak Target Level in dBFS 
(decibels full scale). If the average level should be around -12, then the peaks might be 
closer to -9. Let’s try it.

7	 Set the Target Level to -9 dBFS, the default level, and click Normalize. 

In this case, the clip gain line and waveform in the clip are increased slightly. So what 
actually happened? Normalization sets the volume gain so that the highest peak in the 
clip is at the volume level you designated (-9 dBFS). This would be perfect if the clip levels 
were low or if there was a wider dynamic range between the average and peaks. The 
dynamic range of this clip is only a few decibels, so you’ll need to set the normalization 
to a lower target if you want this dialogue to ride in the middle around -12 dB. 

8	 Right-click the clip again and choose Normalize Audio Levels. 

9	 In the Normalize Audio Level dialog, set the Target level to -12 dBFS. Click Normalize, 
and then start playback to check the new levels in the meter.

The levels for the first clip are good. Remember that you can always change the levels 
later if needed. 
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10	 Clear the range. 

One added benefit of using Resolve’s auto-normalization is that you can apply it to 
multiple clips at once. 

11	 Select all the remaining clips in the A3 track, including the disabled clips. 

12	 Right-click one of the selected clips and choose Normalize Audio Levels.

This time, the Normalize Audio Level pane includes two Set Level options: Relative 
and Independent. The Relative option treats the group of selected clips as if they 
were one clip, so the highest peak among the clips determines all their relative levels. 
Independent, on the other hand, normalizes each clip separately based on each 
clip’s peaks.

13	 Leave the Target Level at -12 dBFS and select Independent for the Set Level. 
Click Normalize. 

The selected clips have all been normalized independently. 

14	 Solo the A3 track and play all Marley’s clips to hear her levels. 

As you can see and hear, all Marley’s clip levels are balanced. You might have noticed 
that one of the clips seems louder than the others. Specifically, the last clip where she 
says, “surf.” If your instinct while listening was to stop and investigate or manually 
adjust that clip’s levels to improve it, you have the makings of a dialogue editor! 

In case you didn’t notice, the last clip “surf” sounds a little too prominent. Sometimes, 
even when the levels are good the sound can be perceived as too loud or too quiet. 
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15	 Lower the level of the last clip in the A3 track by 2 dB. 

16	 Close the Meter. Unsolo any tracks if necessary.

Let’s play all the dialogue clips together, along with the A5 FX Amb track. If you recall, 
the ocean wave sounds are too loud for this scene, so this is a good time to normalize 
that clip to -20 dB. Setting the peak level for background sound beds is one way to 
ensure that the loudest peak in the ocean waves is lower than the quietest dialogue. 

17	 Unmute the A5 track. Right-click the Ocean Waves Night clip and choose Normalize 
Audio Level. Set the Target Level to -20 dBFS. 

18	 Zoom as needed and move the viewer where you can see it along with the other tracks. 

NOTE  If you did not complete all the previous clip balancing exercises, open 
the 5b Dialogue Balanced timeline. 

19	 Play the timeline from the blue marker, watch the viewer, and listen to the balanced 
dialogue tracks with the ocean sound bed. 

Nice! Now, it just needs the music that drives the scene. 

20	 Unmute the A6 track. Normalize the music clip to a -18.0 dBFS target level. 

21	 Turn off Stop and Go to Last Position.

22	 Play the scene. Enjoy. 
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Wow! What a difference a little balancing makes in improving the soundtrack. Although 
balancing clips is only the beginning, you are off to a good start! Now, let’s move to an 
entirely different scene and employ the powerful DaVinci Neural Engine AI to process and 
level dialogue automatically. 

Working with the Dialogue Leveler 
DaVinci Resolve includes a built-in Track FX called the Dialogue Leveler. This effect is 
available in the cut, edit, and Fairlight pages. The Dialogue Leveler recognizes the human 
voice and balances the levels for natural-sounding results using three different processes 
to reduce loud dialogue, lift soft dialogue, and reduce background noise. In this exercise, 
you’ll play a clip that was balanced with keyframes to see the levels in the meter. Then, 
you’ll duplicate the track, remove keyframes and level changes from the copy, and apply 
the Dialogue Leveler instead to see and hear the results. 

1	 Open the 5c Dialogue Leveler timeline. Show the mixer and viewer. Hide the 
media pool. 

The timeline opens with one track showing that contains one balanced clip complete 
with keyframes. 

NOTE  This clip is from a scene shortly after Harper and Raina crash a golf cart 
into the centennial palm tree. Vice Principal Garret is making an announcement 
over his portable PA system. In Lesson 7, you’ll apply creative plug-ins to this 
dialogue to make it sound like it is coming through a portable speaker. 
For now, you’ll focus on balancing the clip levels using the Dialogue Leveler. 

2	 In the mixer, click the Custom button on the Meter plug-in to show the meter. 

3	 Zoom and arrange the clip, meter, and viewer so they are all easy to see. 

4	 Mark the clip in the A1 track. Play the clip in the timeline to see meters and video. 
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As you can see and hear, the clip is balanced. Let’s duplicate the track and clear the 
level changes and keyframes from the copy. 

5	 In the timeline, right-click the A1 DX 1 track header and choose Duplicate Track. 

There is now an A2 DX 1 Copy track. Next, you’ll remove the level changes on the clip. 

6	 Right-click the clip in the A2 track and choose Remove Attributes. In the Remove 
Attributes dialog, select the Volume option and click Apply. 

All the keyframes and level changes have been removed.

7	 Click any empty space to deselect the clip in the A2 track. 
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8	 Mute the A1 track. Show the meter for the A2 track and start looped playback to see 
and hear the clip without level changes. 

Principal Garret’s levels are mostly green in the meters and well below optimal 
dialogue levels. Let’s start by normalizing the clip to increase the overall level and then 
use the Dialogue Leveler to balance the levels within the clip.

9	 Right-click the clip in the A2 track and choose Normalize Audio Levels. Set the Sample 
Peak Program Target Level to the default -9.0 dBFS.

10	 Play the clip to see and hear the normalization results.

The beginning of the clip is now -9.0 dBFS; however, most of the clips’ levels are low. 
Now, let’s add the Dialogue Leveler. 

NOTE  When working with a processing effect like the Dialogue Leveler, it’s 
important to distinguish between applying the effect to a clip and applying it 
to a track. One effect applied to an entire track requires less processing than 
individual effects on every single clip within the track. In this case, since we are 
balancing an entire track, it is logical to enable the effect at the track level. 
You’ll work more with clip and track effects later in this book.

You can choose which Track FX are showing in the Mixer options menu.

11	 In the Mixer options menu, choose Visible Track FX to see the list of available Track FX. 
Select Dialogue Leveler, if necessary, to show it in the mixer Track FX area. 

You should now see the Dialogue Leveler at the top of each channel strip in the 
Track FX area. 

12	 Locate the Track FX area near the top of the channel strips. 

When an effect is on the track but not enabled, the name will be italicized, as shown in 
the Dialogue Leveler as Dial Lev in the Track FX list. Once enabled, a track effect can be 
toggled on or off during playback from the customization window or in the Inspector. 
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13	 Hover over the Dialogue Leveler effect in the A2 channel strip until you see the 
buttons to Enable (left) or Control (right) the effect. Click the Enable button. 

The Dial Lev text turns yellow and is no longer italic to indicate it has been enabled. 

14	 Hover over the Dialogue Leveler effect in the A2 channel strip again and click the 
Controls button (right) to open the Dialogue Leveler control window. 

Now, let’s play a section of the DX 1 track that previously required a lot of keyframes to 
balance and use a Meter plug-in to see the results.

15	 Open the Meter plug-ins on both the A1 and the A2 tracks to compare them. Arrange 
the Meters and Dialogue Leveler controls windows below the A2 track. 
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16	 Zoom to your taste. Start looped playback and watch the levels while listening to 
the playback.

It’s like magic. The levels sound nearly identical to what you achieved when 
meticulously keyframing each section. Did you notice the live waveforms in the 
Dialogue Leveler controls that show the waveform in blue and the processed level 
changes in white? The levels in this clip are all over the place, and the Dialogue Leveler 
balances the levels seamlessly. Now, let’s toggle the effect off and on during playback 
to see and hear the before and after.

17	 Start playback from the same position. This time, click the red Bypass switch in the 
upper left of the Dialogue Leveler to toggle the effect off and on during playback.

Dialogue Leveler bypassed	 Dialogue Leveler on
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18	 Feel free to experiment with the other Dialogue Leveler settings to see and hear the 
effects on this track. When finished, click the Reset button at the top of the window to 
return to the default settings. 

19	 Stop playback and close the Meters and Dialogue Leveler controls windows. 

As you can see, the Dialogue Leveler is a powerful balancing tool for your dialogue tracks. 
Next, you’ll return to the “Learn to Surf” scene, where you’ll play a more complex example 
of a dialogue scene and explore track panning. 

NOTE  To use the Dialogue Leveler on the edit or cut pages, you must access it 
through the Inspector. 

Placing Audio in the 
Panoramic Sound Field 
Pan controls place a track’s audio within a panoramic sound field. They enable you to 
compose the spatial arrangement of audio elements just as a cinematographer composes 
the visuals of a shot. You can precisely locate mono tracks to sound as if they come from 
an offscreen source or virtually anywhere within the frame. DaVinci Resolve includes 
advanced pan controls in both the edit and Fairlight pages that support 2D (stereo) audio, 
multichannel surround, and immersive (object-based) audio placement.

In this set of exercises, you’ll use the pan controls to change the perceived position of a 
camera sound effect to match the picture. Then, you’ll open a different timeline to 
experiment with various panning options to narrow the panoramic spread of airplanes 
doing a flyby. Next, you’ll use the viewer to automate the sound of the airplanes manually. 
You’ll also test-drive the auto-panning controls available in DaVinci Resolve Studio. Finally, 
you’ll edit pan automation for the dragon sound effects in the Podcast Intro project. 

1	 Open the timeline 5d Pan Track Start. Hide the media pool. Reduce the track height 
as needed to move the viewer below the tracks.
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2	 Play the timeline to see and hear the end of the “Learn to Surf” scene. 

Now that you are familiar with balancing clip levels, you probably can appreciate all the 
balancing necessary to get the levels to this point. Notice that some characters have 
multiple dialogue tracks to accommodate overlapping sound and quick fades to hide 
the edits between dialogue clips. 

Let’s solo the FX tracks to focus on how they work with the picture. First, select the 
tracks so you can solo them all at once. 

3	 In the timeline, select all eight FX tracks, starting at FX Cam 1 and ending with FX Amb, 
including four FX Cam tracks. Option/Alt-click the Solo button on one of the selected 
tracks to solo them all. 
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4	 Play the timeline once, listening only to the sound effects. 

What do you think? The sound effects work fine for a stereo mix. However, context and 
the perceived position of a sound can make a difference. For example, if someone is 
standing off to the right of the screen shooting pictures, it makes sense that the 
camera sound would also seem to be coming from that position. This is the case with 
the FX Cam 2 track. 

5	 Unsolo and deselect all tracks. 

6	 Solo and select the FX Cam 2 track. Zoom and scroll as needed to clearly see the FX 
Cam 2 track clip. 

7	 Mark the clip in the selected track. Start playback and watch where Levi is standing 
with the camera. 

8	 Stop playback. 

Now, let’s look at the panning controls for the FX Cam 2 track in the mixer. 
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In the mixer panning controls, the green dots represent the spread and positions of 
the speakers for each audio channel. The blue square is a handle that you can use 
to move the sound to a specific position in mono tracks or between speakers in 
multichannel tracks. 

The FX Cam 2 track is in the default position with the left and right channels in the 
front (upper) left and right positions, and the blue handle is equidistant between them. 
During playback, the A12 FX Cam 2 meter and Bus 1 output meters also indicate an 
equal amount of sound from the left and right channels. 

9	 Start looped playback. 

10	 Using the mixer’s pan controls, drag the blue handle for the A12 FX Cam 2 track 
to the upper left corner of the panning control in the control strip. Then, drag the 
panning handle to the upper right corner of the control to pan the sound fully to 
the right speaker.

Stereo track panned to 
the center (default)

Stereo track panned 
fully to the left speaker

Stereo track panned fully 
to the right speaker

In each example, you can hear the sound more prominently in either the left or right 
speaker or the headphone earpiece. While the track’s meter stays the same regardless 
of the panning position, the Bus 1 output meter shows twice as much sound from the 
left or right channel based on the panned position. When the sound is louder in one 
speaker, it gives the aural illusion of the sound coming from that position.

11	 Continue looped playback. Pan the track to the right so the camera sounds like it is on 
the right side of the frame. Stop playback. 



346Lesson 5  Balancing Clips and Panning Tracks

To bypass the panner, Command-click (macOS) or Ctrl-click (Windows) the pan control 
in the mixer. This works with all mixer controls. The control turns gray when bypassed. 
Let’s try it. 

Pan control bypassed (gray)Pan control on

12	 Start looped playback. During playback, Command/Ctrl-click the panner to toggle it off 
and on to hear the before and after. When finished, be sure to turn on the pan control. 

Now that you are familiar with the mixer’s pan control, you are ready to explore the full pan 
control window. 

Controlling a Track’s Stereo Spread 
In addition to panning sound between the left and right speakers, you can also narrow the 
perceived placement of the sound within the stereo field and reduce the size of the source. 
In this exercise, you’ll narrow the spread of a stereo sound effect for more precise control 
of the sound’s placement. You’ll start by listening to the sound without watching the viewer 
to understand what is happening in the stereo clip. Then you’ll play it again with the video. 

1	 Open the 5e Pan Window Start timeline.

2	 Choose Workspace > Reset UI Layout. 

3	 In the monitoring panel, drag the bottom and left edges of the viewer to enlarge the 
monitoring panel and viewer without undocking it. 

This timeline contains a single video clip of two jets flying. The sound is a stereo track 
that was recorded in the camera. 
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4	 Hide the monitoring panel, including the viewer. 

5	 Play the timeline to hear the sound and see the jets fly by. During playback, listen for 
any clues about where the planes are onscreen.

Exciting, right? The clip sounds great! You may have perceived that the planes are 
traveling left to right but have no idea specifically where they are onscreen. 

6	 Show the monitoring panel. Play the clip again; this time, listen while watching 
the video. 
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7	 In the mixer, double-click the track’s Pan controls to open the Audio Pan window. Move 
the Audio Pan window to the upper part of the screen to the left of the viewer. 

These Audio Pan controls work with standard channel-based tracks ranging from 
mono and stereo to traditional 5.1 or 7.1 surround sound configurations, depending 
on your setup and project. The center of the graph represents the audience’s 
perspective from which they can hear sounds placed in the surround sound positions 
around them. The top center position, the default position for the blue panning 
handle, is the center channel in surround formats and the phantom center in stereo 
tracks because there isn’t a center speaker, only the illusion of a center speaker in a 
stereo mix. The small letters F, R, B, and L—positioned clockwise around the space in 
the top, right, bottom, and left positions—represent the Front, Right, Back, and Left 
positions in the panoramic field, respectively.

Where you place audio tracks within this panoramic space will reflect where the 
audience will locate each audio source. The Spread control is for linked sources. 
Divergence determines the distribution of the audio signal to additional speakers in a 
stereo or surround mix, and Boom determines how much of a track’s sound is sent to 
the low-frequency effect (LFE) speaker.
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The A1 Planes track is currently panned to the front, with the left channel going to the 
far-left front speaker position, and the right channel going to the far-right front 
speaker position. 

8	 Drag the Spread control counterclockwise from the FULL position to the PNT (point) 
position. As you change the control, notice that the green dots representing the left 
and right channels move toward each other until they become a single point. 

The sound of the left and right channels is now more focused in the center.

9	 Increase the spread to around 6 to slightly separate the sound. Then, drag the 
Divergence control clockwise to around 20. 

The green line indicates the perceived size of the source sound—in this case, the jets. 

You can now position the sound using the blue pan handle, just as you would with a 
mono track.

10	 Mark the clip and start looped playback. In the Audio Pan window, drag the blue pan 
handle from the center to the left and then all the way to the right to hear the sound 
follow the position of the panner. Stop playback.
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Next, use the Left/Right control to position the panner to match the starting point of 
the planes onscreen. 

11	 Move the playhead to the beginning of the timeline. Drag the Left/Right control to 50L. 

Pan coordinates are easy to use. The Center is zero and increases left up to 100L and 
right up to 100R. On the first frame, the planes are approximately halfway between the 
left edge of the frame (100L) and the center. That makes their coordinates 
approximately 50L on the Left/Right control. The same idea applies to Front/Back and 
Up/Down panning in 3D. 

Instead of guessing the position of the planes, let’s use the pan tracker in the viewer. 

NOTE  Stereo mixes are limited to the left/right axis between the left and right 
speakers. To pan up/down or back/front, you need a multi-channel output bus 
such as 5.1 or 7.1 or an immersive format such as Dolby Atmos. 

Using the Pan Tracking 
Controls in the Viewer
At the end of Lesson 1, you used the pan tracker in the viewer to move the mower sound 
effect from right to left without ever touching the pan controls. For this exercise, you’ll use 
the tracking controls in the viewer to show the precise location of the planes. You’ll also 
use these controls to manually automate their movement. Finally, you’ll use the IntelliTrack-
powered Audio Panning to Video, which writes panning automation based on the 
movements of objects in the Fairlight viewer in DaVinci Resolve Studio. 
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1	 In the lower left corner of the viewer, click the Controls menu and choose Show Tracker 
Controls. Then, enable the Left-Right and Down-Up control buttons. 

The tracker visually represents the audio panner’s position in the viewer. 

2	 Select the A1 Planes track to see the tracker’s current position based on the current 
panner controls Left/Right 50L.

The tracker is labeled Planes based on the name of the selected track. It is close to the 
planes but not exactly on one of the planes. That is easy to fix. You can just drag the 
tracker into position. 

3	 Drag the Planes tracker to the nearest plane. Then, look at the Left/Right controls in 
the panner to see the results. 

The Left/Right pan controls are set, but what about the up/down axis? That’s right. In 
addition to moving left to right, the planes move up and down in the frame. To see 
those controls in the Panner control window, you’ll need to switch to the 3D panner. 

Exploring the 3D Pan Controls
In addition to the conventional 2D panner for standard stereo, 5.1, and 7.1 channel 
surround panning, DaVinci Resolve includes 3D audio pan controls for channel- and 
object-based spatial audio positioning. The 3D panner can be used for any project to 
visualize the panoramic field from different perspectives. Click the 3D button at the top of 
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the Audio Pan window to switch the interface to the 3D Cartesian view, offering controls for 
working with immersive audio formats such as Dolby Atmos and Ambisonics. In this 
exercise, you’ll switch to the Audio Pan window to the 3D panner view so you can visualize 
and set panning controls on the Left/Right and Up/Down axis. 

1	 Click the 3D button at the top of the Audio Pan window to switch to the 3D Panner 
control window. Resize the Monitoring panel and arrange the 3D Audio Panning 
window as needed. 

Like the standard surround panning controls, these controls include a panner viewer 
that displays a large 3D representation of the listener’s perceived sound stage, with a 
blue sphere representing the track audio positioned within that sound stage. 

To the right of the panner viewer are the 2D Front, Side, and Top panner controls for 
placing sound on specific axes. The controls at the bottom left of the 3D Panner 
include Left/Right, Front/Back, and Down/Up. Perspective buttons located in the lower 
left corner of the Panner viewer let you view the room from different preset angles. 
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2	 Click each Perspective button to see the different preset angles. When finished, click 
the first Perspective button. 
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NOTE  You can freely rotate the perspective by holding down Command-
Option-Shift (macOS) or Ctrl-Alt-Shift (Windows) while dragging. Holding the 
middle mouse button and dragging will also freely rotate the 
room’s perspective. 

Let’s manually automate the panning to match the movement of the planes left/right 
and up/down.

To move the tracker to a specific position and set an automation keyframe, simply 
Option/Alt-click the viewer where you want the track. Let’s try it. 

3	 Move the playhead to the first frame. 

4	 In the Audio Pan window, double-click the Left/Right and Up/Down controls to reset 
them to center. 
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5	 In the viewer, Option-click the nearest jet plane to set the tracker position and 
corresponding automation keyframes. 

The green under the Left/Right and Down/Up controls indicate that automation data 
has been added for that parameter. Now, let’s move forward by 1 second and move 
the tracker again. 

6	 Press Shift-Right Arrow to move the playhead 1 second forward. Option-click the same 
plane to set the tracker position. 

7	 Repeat step 6 as many times as necessary until the planes disappear from view in 
the distance.

8	 Play the clip from the beginning to see and hear the results in the viewer and 
panning viewer.

Awesome! Mission accomplished. The planes and their sound move in tandem across 
the screen in the viewer, along with the tracker, and the pan controls follow the same 
path as the planes across the panner viewer. 

You can show the automation curve for any parameter by right-clicking the parameter. 
Let’s try it.
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9	 Right-click the Left/Right control in the 3D panner to see the Left/Right automation 
curve in the A1 track. 

10	 Right-click the Down/Up control in the 3D panner to see the Down/Up automation 
curve in the A1 track. 

NOTE  To clear all the automation from a track, right-click the track header and 
choose Clear Track Automation.

Just like that, you were able to use the viewer to pan your audio to match the movement 
onscreen. Feel free to experiment with the panning controls and tracker. You’ll work more 
with automation and panning tracks in later lessons. 
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Auto-Panning to Video (Studio Only)
The DaVinci Resolve auto panning to video is unique to DaVinci Resolve Studio. It allows 
you to set an initial position for the tracker on the viewer, and the IntelliTracker will do the 
rest. The three requirements for using the auto pan controls are DaVinci Resolve Studio, a 
selected track, and a marked range. That’s it. Seeing is believing. In this exercise, you’ll clear 
the track automation and then follow the steps to automate the panning in a few clicks. 

1	 Right-click the A1 track header and choose Clear Track Automation. Click Reset in the 
Clear All Automation dialog. 

2	 Mark the clip in the A1 track, if necessary, and select the track. 

3	 Move the playhead to the beginning of the clip. 

4	 In the 3D panning controls, right-click the Left/Right control to show that curve in 
the timeline. 

5	 In the viewer, show the Tracking controls if necessary.

6	 In the tracker controls, enable the Auto, Left-Right, and Down-Up buttons.

7	 Move the tracker to the nearest plane.

8	 Click the Tracker button to start the auto tracker. 
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The Generating IntelliTrack Pan Data progress dialog indicates how long the tracking 
will take to complete. When finished, the automation curve appears in the timeline 
if showing. 

9	 Play the track to see and hear the auto-tracking results.

Voilà! Instant pan automation without touching the panner. DaVinci Resolve Studio is the 
first application to combine audio panning with video tracking. This feature alone could 
save hours panning objects. Now you can try it on your own projects. 

Viewing Multiple Pan Trackers 
For this last pan tracking exercise, you’ll return to the Post Park Normal podcast intro, 
where you’ll explore manual pan tracking applied to each sound effect right in the viewer. 
Then, you’ll look at the automation curve for one of the sounds and adjust the settings in 
the automation curve. Let’s start by opening the balanced project with all the dialogue and 
sound effects in place. The only track that has panning automation is the BGFX1 Mower 
track, which you manually panned with the tracker at the end of Lesson 1. 

1	 Open your Podcast Intro Combo project. 

2	 Open the timeline 5 Intro Combo to Pan.

3	 Show the tracker controls in the viewer if necessary.

4	 In the timeline, select the A14 BGFX1 Mower track to see the tracker in the viewer. 

5	 In the mixer, open the Audio Pan controls window for the selected track. Set the 
panner to 3D view. 

6	 Arrange the 3D Audio Pan window next to the viewer in the monitoring panel. 



359Lesson 5  Balancing Clips and Panning Tracks

7	 Play the mower clip from the beginning to see the current tracking in the panner 
and viewer. 

As you can see, the mower sound moves from right to left in the tracker and panner. 
Now, let’s look at the trackers for all the other sound effects tracks. 

8	 Select all the sound effects tracks from A8 FX 1 Book FX to A21 Wing Flaps to see 
their trackers.

Where are the trackers? They are all stacked up at the center position, where they are 
all currently panned. Trackers turn gray when no clip is currently beneath the playhead 
on their corresponding track. 
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9	 Extend the mixer to see the channel strips for the selected tracks. 

The pan controls on the channel strips clearly show that the tracks are all panned to 
the center. Notice that most of the sound effects tracks are mono, except the 
Helicopter and Wing Flaps, which are both stereo sound effects. 

Now, let’s open a different version of this timeline, with pan automation added to the 
sound effects.

10	 Open the 5a Intro Combo w Pan timeline. Move the playhead to the beginning of the 
timeline if necessary. 

11	 Select the sound effects tracks and look at the viewer. 
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The viewer shows the starting pan positions for all the selected tracks. If you are 
wondering why all the trackers are aligned from left to right, stereo mixing only allows 
for the left/right pan axis. If you want to manipulate sound up/down or front/back, 
you’ll need to work with a surround or immersive format. Don’t worry, you’ll get to do 
that soon in a later lesson! Stereo is a great starting point. 

12	 Play the timeline to see the trackers in action and listen to the clips move 
along the way.

Pretty cool. Did you happen to notice that the roar at the end sounded like it was 
coming from the far left, while the dragon flaps and other sounds were closer to the 
center? If you did, you have good ears. Let’s fix it in the automation curve on the 
timeline. 

Editing the Pan Curve in the Timeline
Automation keyframes are incredibly flexible and can be added, deleted, cut, copied, 
pasted, or manually drawn as needed. In this exercise, you’ll show the Left/Right pan curve 
on all the dragon sound effects tracks so you can compare their automation curves. Then, 
you’ll edit the curve on the Roar track to match the position of the other dragon sounds. 

1	 Deselect all tracks. Select the last four sound effects tracks from A18 Roar to A21 
Wing Flaps. 

In the tracker, you can see that the Wing Flaps and other trackers are near the center, 
while the Roar is at the far left. 

2	 Zoom the timeline as needed to clearly see the clips in the A18 to A21 tracks. 
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3	 Open the Pan window for the A18 Roar track. 

The horizontal green line running across the track is the L/R Pan curve, which is 
currently a straight line near the top of the track.

NOTE  Once the Audio Pan controls window is open, it will always show the 
controls for the most recently selected track. You don’t need to close it and 
open the pan controls for a different track.

4	 Click the curve line to see a tooltip with the current value 86L. 

Now, let’s show the pan curves for the other dragon fx tracks. To show the curves for 
multiple selected tracks at once, you’ll hold the Option/Alt key while right-clicking the 
control in the panners. You can also choose the curve you want to see using the 
Automation dropdown menu in the track headers.

5	 Select the A19 – A21 tracks. Option-right-click the Left/Right Pan control on the open 
Pan window to show that curve on the selected tracks. 

As you can see, the selected tracks have the same automation curve, so they will pan 
in unison during playback. You can move the pan keyframes up, down, left, or right. 
You can also Option/Alt-click the curve to add keyframes and Command-Option-click 
(macOS) or Ctrl-Alt-click (Windows) to remove keyframes. The Focus mode multi-tool 
also allows you to select a range of keyframes and nudge, cut, copy, paste, and delete 
as needed. 
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6	 Click the first keyframe on the A19 Dragon Vocals 1 track to see the value, 13L. 

7	 In the A18 Roar track, drag the L/R curve down to 13L. Hold Shift while dragging if 
needed to gear down the movement as you drag.

8	 Locate the first keyframe on the other dragon fx tracks. Option-click the L/R curve on 
the A18 Roar track to set a keyfame with the value of 13L.

9	 Check the value of the second keyframe on the other dragon fx tracks, 42R. 

10	 Set a second keyframe on the A18 Roar track in the same position as the other 
dragon fx. Then drag downward on the new keyframe until the value is 42R. 

Done!

11	 Select the four dragon fx tracks and play the clips to see the trackers move together in 
the viewer. 

There are slight differences in the tracker positions to emulate the scale and 
movement of the dragon. However, they all move together as if coming from the 
same flying beast. 
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More Balancing and Panning
That’s it! You’ve successfully balanced dialogue clips and panned tracks across various 
scenes and projects. No matter the timeline’s size or the project’s complexity, the goal 
remains the same: delivering great-sounding audio that both listeners and clients will enjoy. 

Your mission, if you choose to accept it, is to open the 5 Intro Combo to Pan timeline and 
add some panning to the sound effects, such as the skateboard, dog walking, bike, and 
runner. Along the way, feel free to check the dialogue levels on the tracks. If a sound effect 
seems too loud or too quiet, adjust to taste. Trust your ears and the meters as you go. 

Lesson Review
1	 Which right-click menu option allows you to reset all keyframes and volume level 

changes applied to a group of selected clips in the timeline? 

a)	 Clip Attributes

b)	 Normalize Audio 

c)	 Remove Attributes

d)	 De-Leveler

2	 What color is visible in a track’s meters when the levels are optimal for dialogue?

a)	 Yellow

b)	 Green

c)	 Red

d)	 Blue

3	 Which new built-in effect can be used to automatically balance dialogue levels in clips 
or tracks?

a)	 Dialogue Balancer

b)	 Levelinantor

c)	 Magic Meter

d)	 Dialogue Leveler 

4	 True or False? You should balance the volume levels of individual clips in the timeline 
before adjusting track levels in the mixer. 
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5	 In the Fairlight page, where can you set or adjust the left/right pan for a stereo track? 
(Choose all that apply.) 

a)	 Mixer

b)	 Pan window

c)	 Viewer when Tracker controls are showing 

d)	 Timeline track L/R pan curve 

6	 In the Pan window, how do you enable the 3D view for a stereo track? 

a)	 Click the 3D button.

b)	 Option/Alt-click the Pan Bypass button.

c)	 Hold 3 and press D.

d)	 There is not a 3D pan view for a stereo track.
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Answers
1	 c

2	 a

3	 d

4	 True

5	 a, b, c, d

6	 a
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Finding the Problem
In most cases, audio problems and their solutions fall into two categories: dynamics, which 
relate to volume issues, and equalization, which involves unwanted or missing frequencies.

The Fairlight page provides three methods for applying EQ to your soundtracks: Clip EQ, 
located in the Inspector (used for this exercise); Track EQ, accessible in the mixer (which 
affects the entire track); and the new EQ plug-in, offering custom frequency control, can 
be applied to either clips or tracks. 

First, let’s open and examine the timeline that was created for the first three examples. This 
timeline includes three clips, each placed in a separate track. Each clip presents a common 
audio issue, and the tracks are named according to the process used to reduce the problem.

	— Track A1 contains an ambient background clip recorded in a suburban neighborhood. 
This clip was chosen for the Post Park Normal podcast intro because of the audible 
bird sounds. However, the clip is dominated by a low rumble of traffic and noise.

	— Track A2 features a voiceover recording that has a distracting low-level crackle 
contaminating the audio.

	— Track A3 includes a dialogue clip that suffers from a noticeable powerline hum.

Your goal in this first set of exercises is to improve the clips quickly so you can continue 
working before the clients arrive. In real-world scenarios, you might apply a quick fix 
initially and later replace a problematic clip if necessary.

1	 Open your TML Audio Post project. 

2	 In the Lesson 6 bin, open the timeline 6 Quick Fixes Start. Close all open panels, 
including the viewer.

3	 Play a few seconds of each clip to hear each distracting issue. 

4	 Move the playhead to the beginning of the timeline. 

5	 Turn on the Loop button, if necessary. 

6	 Mark the clip in the A1 EQ Low Shelf track. 
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The first clip is ready for repair, and as the track name suggests, you’ll use EQ for this quick fix.

NOTE  If the clip name Birds is not showing on the first clip, choose Fairlight > 
View Clip Info Display and select the Clip Name option. 

What Does a Dialogue Mixer Do?
In audio post-production, a dialogue mixer focuses on delivering great-sounding dialogue 
tracks at optimal levels to add to the rest of the mix. In doing so, dialogue mixers take the 
edited dialogue tracks to the next level by introducing compression to narrow the dynamic 
range and attenuate (reduce) detracting frequencies while boosting frequencies that 
enhance the clarity of each voice. 

What Is Dynamic Range in Audio Post-Production? 
When working with audio, the dynamic range is the difference between a signal’s loudest 
and quietest levels. A track’s dynamic range is very similar to the visual contrast within a 
shot. A dialogue track with a high dynamic range has very loud and very quiet elements 
within the track, such as a character whispering and then screaming in the same scene. A 
dialogue track with a low dynamic range is fairly flat, such as in a commercial voiceover in 
which the volume level of the talent is even from start to finish. 

Dynamic range also comes into consideration when performing noise reduction because 
the range between the noise level and the dialogue levels can affect how much noise 
reduction you can apply. The signal-to-noise ratio (SNR) is a mathematical calculation 
based on the dynamic range between the noise level and the dialogue level and is 
expressed in decibels (dB). For example, if your voiceover track has an SNR value of 50 dB, 
it is 50 times louder than the noise in the same track. The higher the SNR value, the better 
sounding the signal and the less prominent the noise. 

Using Clip EQ to Reduce Low Frequencies
For this exercise, you’ll use Clip EQ to adjust the sound. Additionally, you’ll work with the 
Frequency Analyzer plug-in, a visual metering tool that shows active frequencies during 
playback. The Frequency Analyzer plug-in has already been added to the A1 track, so you 
can use it to monitor and adjust your EQ settings more accurately.

This setup will help you quickly identify and fix frequency issues in your audio.

1	 Show the mixer and the Inspector. 

2	 In the timeline, select the A1 clip to load it in the Inspector.
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3	 At the top of the A1 channel strip in the mixer, locate the Frequency Analyzer plug-in. 

4	 Click the Controls button on the Frequency Analyzer plug-in in the A1 channel strip to 
open the plug-in window. 

5	 Hide the mixer.

6	 In the Inspector, locate the Equalizer controls for the selected clip. Move the EQ 
window to the left of the Equalizer controls. 

Both the Frequency Spectrum window and the Equalizer in the Inspector show the 
same graph, which includes the frequencies within human hearing capabilities from 
about 20 Hz to 20 kHz horizontally from left to right, respectively. The numbers 
running vertically reflect the volume level, with zero in the middle representing the 
initial level of a clip. Negative numbers are attenuated (lower) than the starting point, 
while numbers above zero are raised (higher) than the starting point. 

7	 In the Inspector, turn on the Equalizer. Then, start looped playback of the clip in the A1 
track. During playback, look at the Frequency Spectrum window. 
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The large shaded blue area to the left of the Frequency Analyzer graph is the low-
frequency rumbling noise, while the peaks around 3 kHz to 6 kHz are the bird chirps. 

To quickly reduce the level of the low noise from 20 Hz to 800 Hz, you can use the Clip 
Equalizer’s low-shelf filter in Band 2. By default, Bands 2–5 are enabled when you switch 
on the Clip Equalizer in the Inspector. The default setting for Band 2 is a Low Shelf, 
which is designed to lower all frequencies within the range of the shelf in the graph. 

Numeric controls

Graphical EQ controls

Band enable button

Band filter type

In the graphical EQ controls area, you can see and manipulate the frequency graph. 
The numerical controls at the bottom of the equalizer give you more precise control 
over the frequencies and gain of each band.

8	 Click the Band Filter Type dropdown menu below the Band 2 button to see the types of 
frequency filters available for Bands 2 and 5.

High-shelf filter

Low-shelf filter
Bell-curve filter
Notch filter
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High- and low-shelf filters are similar to high- and low-pass filters, but the shelf filters 
attenuate (lower) unwanted frequencies, whereas the pass filters completely block 
unwanted frequencies. You can apply bell-curve filters to boost or attenuate frequencies 
anywhere on the graph and narrow or widen their range of influence using the Q 
control. A notch filter is used for completely removing, or cutting, specific frequencies. 

For this exercise, you’ll attenuate the low frequencies using the Band 2 low-shelf filter 
to attenuate frequencies during playback. 

NOTE  During playback, dragging the graphical controls left or right through 
the EQ graph is called sweeping and is the most effective way to hear changes 
and identify areas that need work.

9	 Start looped playback. During looped playback, drag the low-shelf Band 2 handle 
down to -70 dB and toward the right until the bottom of the shaded blue area in the 
graph reaches the 1 kHz line.

10	 Continue playback. In the Inspector, toggle the EQ control off and on to hear the 
before and after results of the low-shelf Clip EQ filter. 

Hopefully, you can hear the dramatic difference. The clip’s background noise goes from 
a low roar to a slight background noise with the built-in low-shelf filter in the clip’s EQ. 
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11	 Stop playback. 

12	 Close the Frequency Spectrum window. 

This is just one quick use of clip equalization. You’ll work more extensively with equalization 
in Lesson 9. 

NOTE  Clip equalization in the Fairlight page adjusts the tonal quality of individual 
clips, whereas track equalization in the mixer adjusts the entire track. 

Gating Low-Level Noise
Let’s look at another common mixing tool that you can use to reduce or eliminate low-level 
background noise. The noise in this exercise is very common and can be caused by poor 
connections, damaged cables, or weak microphone batteries. 

1	 Select the A2 Dynamics Gate track and mark the clip.

2	 Start looped playback and listen to the clip.

The low-level crackling noise makes this clip unusable as is. Luckily, there is a quick fix 
in the track Dynamics toolset designed specifically for reducing noise. 

3	 Stop playback. Show the mixer. 

4	 In the A2 channel strip, double-click the Dynamics controls to open the Dynamics 
controls panel.

The Fairlight mixer includes the four most common dynamics processors in one 
easy-to-use panel. The compressor narrows the dynamic range by lowering the 
loudest peaks and bringing them closer to the lowest peaks. The expander, in contrast, 
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enlarges the dynamic range to increase the difference between the loudest and 
quietest peaks. The limiter and gate work on opposite ends of the signal to avoid 
exceeding a target level (limiter) and to prevent sounds lower than a set threshold 
from being heard (gate). 

Let’s focus on using the gate to reduce or silence the part of the signal below a 
given threshold. 

Let’s turn on the gate while listening to the clip.

5	 Start looped playback to hear the clip with low-level noise. 

6	 Click the Gate button to turn on the gate dynamics processing. 

The noise is no longer audible, and the voiceover sounds pretty good. The dialogue 
sounds processed in a few places, but it’s a start. What happened? 

In the controls beneath the Gate button, you’ll see that the Threshold is set to the 
default level of -35 dB, which means the gain (volume) of any signal below -35 dB 
is reduced. 

7	 Watch the Gain Reduction meter during playback. You’ll see that the Gain Reduction is 
active between dialogue phrases whenever there is no talking and the signal falls 
below the threshold. 
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The Range control sets the maximum amount of gain reduction applied to the signal 
when it falls below the gate threshold. 

8	 Drag the Range control to the right to increase the amount of reduction by the highest 
amount, 60 dB. 

The graph and Gain Reduction meter show that the signal below the Threshold (-35 dB) 
receives the highest gain reduction (-60 dB). That’s overkill for this signal. 

9	 Double-click the Range control to reset it to the default level. 

Gating your low-level signal is very effective. However, it’s best to set the Threshold as 
close to the noise level as possible. Otherwise, you will also remove all the breath 
sounds and syllables that taper off below the Threshold. 

TIP  When adjusting audio controls, it’s often easier to start with the controls 
set to their extreme levels, either high or low, and then slowly back them off or 
add them during playback until you achieve your goal. 
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10	 During looped playback, adjust the Threshold level to lower it all the way to the left 
(-50.0 dB). You’ll hear the background noise again. Then, slowly raise the Threshold 
until you no longer hear the noise. 

11	 Drag the Range control all the way to the left and slowly increase the Range value until 
you no longer hear the background noise during playback. 

12	 When you’re finished, stop playback.

Notice that the graph in the channel strip matches the graph on the Dynamics panel.

13	 Close the Dynamics panel and hide the mixer.

Now that you have used the built-in clip EQ and Gate processing to reduce different types 
of noise in two different clips, let’s move on to repair plug-ins. 

Repairing Dialogue with 
Fairlight FX Plug-Ins
DaVinci Resolve includes a full set of built-in Fairlight FX plug-ins and supports third-party 
macOS Audio Unit plug-ins. DaVinci Resolve Studio extends support to third-party 
VST plug-ins. 

In this next series of exercises, you’ll work with two powerful Fairlight FX repair plug-ins: 
De-Hummer and Noise Reduction. Plug-ins can be applied to clips, tracks, or busses. You’ll 
work more with track- and bus-level FX and processing in Lesson 9, “Mixing and 
Sweetening the Soundtrack.” For now, you’ll focus on applying plug-ins to specific clips. 

1	 Mark the clip in the A3 track. Play the clip once.
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A clear background hum contaminates the entire clip. This problem is fairly common 
and can have several causes, including poor audio cable shielding, incorrect power 
grounding, or audio or power cables haphazardly overlapped on the set. This hum 
can’t be removed with keyframes or editing. Instead, you’ll employ one of Resolve’s 
powerful new Fairlight FX repair plug-ins. 

2	 Show the Effects Library.

The Fairlight FX plug-ins appear at the top of the Audio FX list. 

3	 In the Fairlight FX list, drag the De-Hummer plug-in onto the clip in the A3 track.
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The De-Hummer dialog opens with controls to specify the type of hum in the clip. You 
don’t have to be a hum expert to determine the frequency. Chances are, it’s a 
powerline hum. If so, it will have a 60 Hz frequency in America or 50 Hz in other parts 
of the world. 

The graph across the bottom displays low frequencies to the left and high frequencies 
to the right. The purple notches in the graph indicate which frequencies are currently 
reduced. The default De-Hummer setting is for a fundamental frequency of 50 Hz 
followed by harmonic frequencies. Harmonics are naturally occurring multiples of the 
fundamental frequency, often called overtones. These harmonic frequencies give 
sound its added color and character. However, when it comes to annoying hum 
contaminating your dialogue, you’ll probably want to eliminate the fundamental 
and harmonic frequencies. Luckily, the Fairlight FX De-Hummer does most of the 
work for you. 

Notice that the controls in the lower left of the De-Hummer include presets for 50 Hz 
and 60 Hz. 

NOTE  Power cables and audio cables can coexist when recording as long as 
they run parallel to each other and cross at perpendicular angles. 

4	 In the Frequency section, click the 60 Hz button to set the De-Hummer to notch out 
the 60 Hz frequency. 

The notch filters (purple notches) shift toward the right so that the deepest notch 
(fundamental) is now 60 Hz, and the ensuing harmonics have shifted accordingly.

NOTE  When you’re working with a hum that is not at 50 Hz or 60 Hz, you can 
click the Variable setting and adjust the Frequency dial until you reduce the 
correct frequency. 
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5	 Start looped playback. 

6	 While listening to playback, drag the Amount dial to increase the amount of the 
frequency that is removed. Drag it until you no longer hear the hum. 

You can control the slope of the harmonics, also referred to as the bias, with the Slope 
dial. Depending on the dominant overtones, you might need to use the Slope dial to 
shift the slope toward higher frequencies. You can also tweak the slope to remove the 
harmonics while retaining the fundamental frequency. 
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7	 Drag the Slope dial slightly toward the right to strengthen the different harmonic 
notch filters until you hear the least amount of hum during playback. 

Let’s use the Bypass switch to toggle the plug-in off and on to hear the before and 
after versions of the clip. The Bypass switch is red when the filter is turned on. 

8	 In the upper left corner of the De-Hummer dialog, click the red Bypass switch to turn 
off the plug-in. Continue playback, and then turn it back on. 

9	 When you’re finished removing the hum, stop playback. Close the De-Hummer dialog.

NOTE  Once you close a plug-in control window, you can access the plug-in 
controls in the Inspector Effects tab. 

You now have firsthand experience working with Resolve’s powerful De-Hummer plug-in. 
In most cases, a hum will be less pronounced. The takeaway from this exercise is that this 
plug-in is highly effective and easy to apply to your timeline clips as needed. Let’s move on 
to the Noise Reduction plug-in. 
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Reducing Noise 
Noise comes in many shapes, sizes, and intensities. Whether it’s music, background 
conversation, the roar of a sports car, or the purr of a kitten, anything may be considered 
noise when it contaminates the clarity of your dialogue tracks. 

When applying noise reduction, you can sometimes reduce the noise easily, and 
sometimes you need to reduce it incrementally with multiple plug-ins and processes. In 
this exercise, you’ll encounter a more tenacious noise than the simple hum you removed in 
the previous exercise. This time, you’ll use a new plug-in to achieve noise reduction. Why 
not noise removal? Because in many cases, noise covers a lot of territory and frequencies, 
and attempting to remove it entirely may strip your dialogue of its tone and texture. 

The clip you’ll work with in this exercise is the same clip you used to test-drive the Dialogue 
Leveler in the previous lesson. This time, instead of focusing on the clip levels, you’ll listen to 
the background noise. If you want to see the video as you work on this clip, feel free to show 
the viewer. However, the video is not necessary to reduce the background noise in the clip. 

1	 Open the 6a Noise Reduction timeline. 

This timeline includes four clips in four separate tracks. As you can see, the clips on 
tracks A2 through A4 have been disabled and are identical copies of the original 
clip in A1. 

Let’s start by listening to the clip in the A1 track to determine the type and intensity of 
the noise. 

2	 Mark the clip in the A1 track and start looped playback. 

This noise is what you might expect to be picked up by the microphone when shooting 
outdoors with extras bustling about in the background. Regardless of how the noise 
“invaded” this recording, it’s there. So you’ll deal with it using the Fairlight FX Noise 
Reduction plug-in from the Effects Library. 
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For this exercise, you’ll leave the clip unaltered in the A1 Original track. Then, you’ll 
apply the Noise Reduction plug-in to the identical clips in A2 and A3 so you can 
compare them to the original later. 

3	 Stop playback. Select the clip in the A1 track and press D to disable the clip.

4	 Select the clip in the A2 Manual NR track and press D to enable the clip. 

5	 In the Fairlight FX list, drag the Noise Reduction plug-in onto the clip in the A2 track. 

The Noise Reduction dialog opens with various controls, including a graph showing 
the spectral analysis of the signal’s frequency (Hz) and strength (dB) during playback. 
Detection, Smoothing, and Output controls are also present across the bottom of 
the dialog. 

The Fairlight FX Noise Reduction plug-in is based on spectral subtraction. It can be set 
to detect noise in selected sections of dialogue automatically or to manually learn a 
selected section of noise and then extract that noise print from the signal. 

The two mode buttons below the graph allow you to select Manual mode or Auto 
Speech mode. Manual mode learns a “noise profile” and extracts it from the overall 
signal. Auto Speech mode uses powerful algorithms and spectral analysis to detect 
and extract speech from the signal, thereby reducing the noise. 

Let’s try both methods, starting with the default Manual mode. 

For this exercise, the best section of noise to isolate for the noise profile is at the end 
of the clip. Here, you’ll notice that keyframes have already been added to the clip so 
you can easily increase the levels at the end of the clip. 
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6	 At the end of the clip on the A2 track, drag the gain line upward to around 20 dB to 
increase the noise level in that section. Then, drag a range that includes the noise 
without the louder spike near the end. 

7	 Click the Learn button to create a noise profile during playback. Start playback of the 
noise-only portion of the clip. 

In Manual mode, the purple overlay in the spectral analysis shows the noise profile 
targeted for subtraction from the signal. The noise profile updates during playback 
until you click the Learn button again.

8	 Click the Learn button again to save the current noise profile. 

The learned noise profile is subtracted from the rest of the clip’s signal 
during playback.

9	 Stop looped playback. 

10	 Select and mark the entire clip in the A2 Manual NR track.

11	 Drag the gain line at the end of the clip back down to around 13.5 dB. 
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12	 Start looped playback again to hear the clip with the noise print subtracted. Click the 
Bypass button off and on to hear the clip without and with the Noise Reduction plug-in 
applied. When finished, stop playback and close the Noise Reduction dialog. 

Just like that, the noise is gone. Let’s try it again in Auto Speech mode on the clip in 
track A3. 

NOTE  You can click the Reset button in the upper right corner of the plug-in 
dialog to return a plug-in to its default settings. You can also reset just the 
noise profile in the Noise Reduction preset menu. For this example, you’ll use 
a separate clip for comparison. 

13	 Mute the A2 track and select the clip in the A3 Auto NR track. Press D. 

14	 In the Effects Library, drag the Noise Reduction plug-in onto the clip in the A3 track. 

15	 In the Noise Reduction dialog, click the Auto Speech mode control. Start looped 
playback. 

Once again, the noise disappears while the spoken words remain. 

Set a play range around the fifth phrase in the clip. Start playback of the phrase.
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16	 Stop playback. Close the Noise Reduction dialog, clear the play range, and mute 
the A3 track.

You’ve witnessed the power of Resolve’s Noise Reduction plug-in. This plug-in can be used 
alone or combined with a second Noise Reduction plug-in to reduce a more prominent 
background noise. In the next exercise, you’ll look at a clip with multiple plug-ins applied. 

MORE INFO  You can find detailed information on each Fairlight FX plug-in and its 
specific controls in the DaVinci Resolve Reference Manual available in the 
application’s Help menu. 

Combining Multiple Plug-Ins 
In the previous examples, the De-Hummer and Noise Reduction plug-ins worked well for 
eliminating hum and mild background noise in different clips. However, sometimes you’ll 
encounter much more prominent noise issues, such as the inherent sound of a large 
professional kitchen. When that happens, rather than tackling all the noise at once at the 
potential expense of your dialogue, you may need to use multiple plug-ins to reduce noise 
incrementally. In this exercise, you’ll work with a different timeline, where the clip has both 
distracting hum and background noise. 

1	 Open the timeline 6b Combo FX to Cache.

2	 Hide the Effects panel. Show the meters.

Let’s start by listening to the original clip in the A1 track.

3	 Solo the A1 Original track, if necessary. 

4	 Mark the clip and start looped playback.

You can hear a constant hum and background noise in the clip. 
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TIP  When a dialogue clip is contaminated with both hum and noise, remove 
the hum first so the noise reduction plug-in can focus on the noise, which is 
likely in a different frequency range than the hum. 

Let’s listen to the same clip with plug-ins and processing applied. To make it easier to 
compare the two tracks, let’s switch to Exclusive Solo mode. 

5	 Choose Fairlight > Exclusive Solo to enable it.

6	 Solo the A2 track to hear only that track.

7	 Start playback and listen to some of the clip in the A2 track. 

Wait, where is the noise? If you look at the clip in the A2 MultiFX track more closely, 
you’ll see an fx icon after the clip’s name, indicating that FX plug-ins have already 
been applied. 

8	 Select the clip in the A2 MultiFX track. 

9	 Show the Inspector Effects panel. 

In the Audio Effects panel, you’ll see a De-Hummer plus two Noise Reduction plug-ins 
applied to the clip. Effects processing works from the top down, so whichever plug-in 
is highest in the list is applied first. In this example, the hum is removed first, and then 
the first Noise Reduction plug-in is applied to the results of the clip without hum. 
Finally, the second Noise Reduction plug-in is applied to the results of the first Noise 
Reduction plug-in, and so on. 

10	 In the Inspector, click the Bypass buttons on both Noise Reduction plug-ins to turn 
them off. Continue playback.

Now you can hear the noise. 
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11	 Click the Custom button for the first Noise Reduction plug-in to show the plug-in’s 
control dialog. 

Based on the settings, you can see that this Noise Reduction plug-in is using a noise 
profile in Manual mode to reduce the noise. 

12	 Turn on the plug-in and listen to the difference it makes in the noise level. 

13	 Show the controls dialog for the second plug-in and turn it on. 

The second plug-in uses Auto Speech mode to clean up the remaining noise left by the 
first plug-in. Looking at the plug-in parameters in the Inspector, you’ll see a Noise Only 
checkbox that corresponds to the “Listen to noise only” checkbox in the upper right 
corner of the Noise Reduction window. This mode is like inverting a key when you are 
compositing an image but is applied to noise reduction. It lets you monitor the part of 
the signal that is being removed. Let’s listen to the first Noise Reduction plug-in in 
Noise Only mode. 
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14	 In the Inspector, turn off the second Noise Reduction plug-in.

15	 Start playback. In the Inspector, select the Noise Only checkbox for the first Noise 
Reduction plug-in.

The corresponding “Listen to Noise Only” checkbox is automatically selected in the 
Noise Reduction window. 

You now hear only the part of the signal being removed, including some of the 
dialogue frequencies. If you can clearly distinguish vocal patterns or words in Noise 
Only mode, those same frequencies and tonal elements are being stripped from the 
dialogue. When finessing noise reduction controls, it’s always a good idea to listen to 
noise reduction in Noise Only mode to make sure you aren’t excessively diminishing 
the vocals. Remember, it may be better to stack multiple noise-reduction filters instead 
of being too heavy-handed with just one. 

16	 On the Noise Reduction window, deselect the “Listen to Noise Only” checkbox. Then, 
turn on the second noise reduction plug-in.

17	 Close both plug-in dialogs and stop playback. 

The more you work with noise reduction, the easier it gets. The goal of this lesson is to 
understand which repair plug-ins are available in DaVinci Resolve and whether they work 
alone or in combination in Manual or Auto Speech modes. 

All these methods for removing background noise are useful, and they get easier to use 
the more you work with them. Remember that you can apply unlimited plug-ins to a clip or 
combine up to six per track. While gate processing is available on the track via the mixer, 
sometimes you must combine noise reduction with a gate or other processing for the 
best results. 
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Dealing with Processor-Intensive 
Plug‑Ins
In DaVinci Resolve, there is no limit to the number of plug-ins that you can add to a clip. 
However, as your tracks get more complex and plug-ins become more processor-intensive, 
you may discover that your computer lacks the processing power to play all your audio 
tracks and effects in real time. When that happens, there are two ways to alleviate the 
burden that the processor-intensive audio effects have on your workstation.

The first option is to cache your audio clips with plug-ins, and the second option is to 
bounce audio clips with plug-ins. The first method “bakes” the plug-in effects in a cache file 
and updates the waveform accordingly. This method does not create new media and can 
easily be turned on or off while you work, and the cache file updates automatically every 
time you change any plug-in settings. Bouncing an audio clip renders a new piece of media 
with the plug-in effects baked in as part of the waveform. Let’s continue working with the 
same timeline and look at both methods. 

1	 Continue working with the timeline 6b Combo FX to Cache. 

As you discovered in the previous exercise, the clip in the A2 track is currently 
running three different repair plug-ins, including one De-Hummer and two Noise 
Reduction plug-ins.

2	 Right-click the A2 track header and choose Duplicate Track.

The newly created A3 MultiFX Copy track allows you to experiment with Cache and 
Bounce clip options without changing the A2 plug-ins and processing. 

3	 Solo the A3 track and mark the clip, if necessary. Show the Inspector. 
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4	 Right-click the clip in the A3 track and choose Cache Audio Effect.

The cached clip’s waveform updates, and a cache badge in the clip header lets you 
know that this audio clip has cached effects. You can also see the cache badge next to 
the plug-ins for the cached clip. 

You can still use the bypass switch and open the plug-in settings from the Inspector to 
change any of the parameters in the plug-in’s settings window. 

Now, let’s bounce the clip and move the bounced clip to a new track. 

5	 Right-click the clip in the A3 track and choose Bounce Audio Effect. 

6	 A new rendered clip appears in the timeline. The original clip is still there, just beneath 
the bounced clip. 

7	 Choose View > Show Audio Track Layers to see the rendered clip on the top layer and 
the original clip disabled underneath.
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Notice that the keyframes on the clip gain line were retained on the bounced clip. Why? 
Because using this bounce method only renders the clip’s plug-ins into the bounced 
clip. All other parameters can still be controlled independently. 

NOTE  You will work more extensively with bouncing clips, tracks, and busses 
in later lessons.

8	 Hide the audio track layers. 

9	 Select the bounced clip in the A3 track and press Option-Down Arrow (macOS) or 
Alt-Down Arrow (Windows) to move the selected clip down into a new track. 

10	 Enable the clip in the A3 track. Solo the A4 track, if necessary. 

11	 Play the A4 track to hear the bounced clip. 

12	 It should sound nearly identical to the clips in A2 and A3. 

Why nearly identical and not identical? Because, unknown to you, there are also some 
EQ and Dynamics presets that were applied to the track in the mixer. Track-level 
processing is not included when caching or bouncing clip effects. 

13	 Show the mixer and extend it to see all four tracks. 

Now, you can see in the EQ and Dynamics controls that some processing has been 
applied to both the Dynamics and EQ for tracks A2 and A3. Don’t worry; you’ll learn all 
about sweetening the mix with Dynamics and EQ in Lesson 9. 

14	 Hide the mixer. 

Now that you’ve seen how to cache and bounce clips with audio effects, you can apply 
these processor-saving techniques to your own projects.
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Repairing Dialogue 
with Track FX (Studio Only)
DaVinci Resolve includes two dialogue-based Track FX for quickly removing or controlling 
background noise. You’ve already worked with the Dialogue Leveler Track FX to help 
balance dialogue in Lesson 5. Now it’s time to explore the powerful new Voice Isolation 
and Dialogue Separator Track FX available for DaVinci Resolve Studio. Voice Isolation is a 
DaVinci Neural Engine AI-based effects process that recognizes and isolates the human 
voice from background sounds. Simply enable Voice Isolation for either a clip or track for 
immediate results. The Dialogue Separator uses the DaVinci Neural Engine AI to give you 
individual control over the level of dialogue, background sounds, “ambience,” the 
reverberant field, or ambient room sound. 

The Dialogue Separator and Voice Isolation are built-in Track FX, which means they are 
available on every track through the Inspector or mixer. Voice Isolation is also available for 
every clip through the Inspector. 

For this exercise, you’ll test-drive the Voice Isolation effect on several examples with 
obvious background noise issues. Then, try the Dialogue Separator on the same tracks. 
You’ll also gain a better understanding of applying Voice Isolation to a clip versus a track. 

1	 Open the 6c Track FX timeline.

2	 Show the Inspector and mixer.

3	 Make the viewer a floating window. Resize and move the top right of the timeline 
beneath the tracks. 

4	 Hide the meters and media pool.

As you can see, this timeline includes two tracks, each with a different example clip. 
Let’s start with locating the Track FX for A1 in the mixer and Inspector. 

5	 Mark the clip in the A1 track.

6	 Select the A1 track header.
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7	 In the Mixer menu Visible Track FX list, select Voice Isolation and Dialogue Separator to 
show them both in the mixer, if necessary.

8	 Find the Track FX near the top of the mixer and Inspector for the selected track. 

The Fairlight FX plug-ins appear at the top of the mixer channel strips in the 
Track FX area. 

NOTE  If the Inspector shows clip controls instead of the track controls for the 
A1 DX1 Jamie track, click the Track button at the top left to switch to the 
Track Inspector. 

9	 Play the clip in the A1 track to hear the dialogue mixed with heavy background noise 
and ambience. 

10	 Enable Voice Isolation in the Track Inspector. 
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Enabling a Track FX in the Inspector also enables it in the mixer and vice versa. The 
Track FX name in the mixer turns yellow when it is on. 

11	 Play the clip in the A1 track again.

It’s like magic! This time, you hear only the dialogue because it has been isolated from 
other non-speaking sounds (hence the name). 

Voice Isolation worked beautifully with a single click. There’s just one problem. This is 
an outdoor shot in a large space. Removing all of the non-speaking sound has also 
removed the ambient reality of this location. It’s time to back off the amount to reveal 
some of the background sound.

12	 In the mixer, click the Controls button to open the Voice Isolation controls window. 

The Voice Isolation controls window includes an Amount dial to adjust the amount of 
Isolation applied to the sound. You can reduce the amount to reveal more background 
sound as needed for a more natural result. 

13	 Play the clip and slowly reduce the Amount control until you’re happy with the 
background noise and voice levels. 

14	 Hide the viewer. Close the Voice Isolation dialog.

Now, let’s try it on the clip in the A2 track. This clip was recorded at a very low level with 
a fan near the microphone. First, you’ll need to increase the clip gain level to hear the 
clip. Then, apply Voice Isolation to clean up the background noise. 
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15	 Mark and play the clip in the A2 track. Then, increase the level of the clip gain line as 
much as necessary to hear the dialogue clearly. 

Yikes. That is one noisy clip. 

16	 In the mixer, enable Voice Isolation on the A2 track. Play the clip in the A2 track again. 

Wow, right? Even the clunking of the microphone prior to speaking is eliminated. 
Imagine how useful Voice Isolation would be for cleaning up interviews, archives, 
and documentary footage recorded in noisy locations.

NOTE  Enabling a Track FX in the mixer will always apply it to the entire track. 
To apply a Track FX to a clip, you’ll need to select the clip and enable it from the 
Inspector. The Inspector shows Track FX for both the track and the clip 
depending on which is selected. 

Next, you’ll try Voice Isolation on a familiar clip contaminated with a 60 Hz hum. This 
time, you’ll apply Voice Isolation to the individual clip in the A3 track. 

What A3 track? The one that is hidden from view in the Track Index. 

17	 Show the Track Index. Click the Visibility button (eye icon) for the A3 track to show it in 
the timeline. 

18	 Hide the Index. 

19	 Mark the clip in the A3 track. Select the clip, if necessary. 
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20	 In the Inspector, enable Voice Isolation for the selected clip.

Notice that Voice Isolation is enabled in the Inspector and not in the mixer. Also, the 
fx badge on the first clip in the A3 track indicates that an effect has been applied to 
the clip. 

21	 Play the clip to hear the results. 

The hum is completely gone. All that remains are the human voice sounds, including a 
few breaths, tongue clicks, and other natural sounds. Since Voice Isolation is an effect 
applied to a clip, it can also be cached or bounced to free up processing if you’re 
working with a slower computer.

22	 Right-click the clip in the A3 track and choose Cache Audio Effects from the 
contextual menu. 

23	 Play the cached clip. 

You can still adjust the clip’s volume level as needed while it is cached, and you can 
deselect the Cache Audio Effects option at any time. 

24	 Right-click the clip again and uncheck Cache Audio Effects.

Next, you’ll move on to the Dialogue Separator Track FX. 
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Working with the Dialogue Separator
Now that you’ve successfully used Voice Isolation on three different clips, let’s try the 
Dialogue Separator. The difference between the two Track FX is that Voice Isolation uses a 
single control to remove all non-dialogue from the clip or track. The Dialogue Separator, on 
the other hand, offers three different controls to independently control voice, background 
noise, and ambience. In this exercise, you’ll apply the Dialogue Separator to the A1 track 
and test the controls during playback. Then, you’ll switch to a different timeline and apply it 
to a different scene. 

1	 Mark the clip in the A1 track. 

2	 In the mixer, disable the Voice Isolation Track FX on the A1 track and enable the 
Dialogue Separator. 

3	 Open the Dialogue Separator controls window. 

As you can see, the Dialogue Separator controls are self-explanatory, with three 
separate knobs for Voice, Background, and Ambience. There are also Mute buttons 
beneath each control. 

4	 Start looped playback. 

5	 In the Dialogue Separator control window, adjust the Background knob to reduce the 
amount of background noise. 
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6	 Increase the Ambience amount to increase the reverberance in the clip. Then, drag the 
dial in the other direction to decrease the ambience. 

7	 Experiment with the different controls on the Dialogue Separator. When finished, stop 
playback and close the Dialogue Separator window. 

You’ve experimented with the Dialogue Separator on one clip. Now, let’s try it on a clip 
that you’ve already worked with earlier in this lesson.

8	 Open the 6a Noise Reduction timeline. Show the meters if you’d like to see the viewer. 

9	 Solo the A4 Track FX track. Enable the clip. 

This clip already has Noise Reduction applied. You can easily delete the effects in 
the Inspector. 

10	 In the Inspector, Audio Effects pane, click the Delete button (trashcan icon) to delete 
the Noise Reduction plug-in on the clip.

11	 Enable the Dialogue Separator for the A4 track and open the controls window. 

12	 Start looped playback. Reduce the Background sound as needed. Feel free to try the 
Ambience control, although you probably won’t hear any difference in this clip because 
it lacks a reverberant field.

13	 Stop playback. Close the Track FX window. 

Now that you know how to work with Track FX, you can use them on your own projects. 
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More Dialogue Repairs with Track FX
Understanding how track effects work on different types of clips comes with testing and 
experimentation across various clips and projects. Take a few minutes to try Voice Isolation 
on the A4 track. Before enabling Voice Isolation, make sure to turn off the Dialogue 
Separator. You can run multiple Track FX simultaneously, such as Voice Isolation and the 
Dialogue Leveler. However, since Voice Isolation and the Dialogue Separator serve the 
same purpose, you only need one.

After testing Voice Isolation on this timeline track, open the 6b Combo FX to Cache 
timeline. Solo the A1 Original track and test both Voice Isolation and the Dialogue 
Separator separately.

Once you’ve completed these tests, you’re ready to move on to the next section.

Removing Clicks at 
the Sample Level
So far, you’ve decreased your biggest noise issues. Now, let’s explore a common problem 
that’s much smaller in scale but equally significant. Previously, all your work has been 
performed at the frame level. But you’re ready to dive much deeper into the waveform to 
perform microsurgery at the sample level. In this set of exercises, you’ll locate and remove 
a digital click embedded in a waveform. To make things even more interesting, this 
common irritant is located right in the middle of an instrumental track, so no noise 
reduction is available to fix this issue.

Sample-level editing requires a new set of skills and patience. For starters, you must 
abandon most of the shortcuts you’ve been using for navigation. You’ll learn the rest 
as you go along. 

Let’s start by opening a different timeline containing a single music clip. 

1	 Open the timeline 6d Fix Music Cue.
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2	 Hide all open panels, leaving only the timeline. 

At a glance, the waveform appears full of diminutive spikes that may or may not be 
issues. The even spacing between the spikes usually indicates a percussion beat. 
However, the only way to be sure is to listen to the track. 

3	 Play the clip. During playback, listen to the music while you watch the playhead move 
along the waveform. 

Did you notice the digital click (glitch) near the middle of the track? 

4	 Press Shift-Down Arrow to move the playhead to the blue timeline marker. Play the clip 
from the blue marker. When you hear the distracting click, stop playback. 

Digital clicks and pops can be as aurally irritating as gnats at a picnic. However, before 
exterminating this digital annoyance, you should look at some of the navigation 
shortcuts you’ll need.

5	 Move the playhead to the red marker. Zoom in horizontally until the spike in the 
waveform (digital glitch) is no longer beneath the playhead. 

6	 Click the ruler above the glitch or drag the playhead over the peak in the waveform. 
Then, zoom in until you see the individual samples (dots) that make up the waveform. 
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Welcome to the sample level of the waveform. Just as molecules are the building blocks of 
matter, samples are their equivalent in digital audio. You can clearly see the audible glitch. 
Next, you’ll redraw the waveform to eliminate the errant sound altogether. 

Editing Samples to Correct the Waveform 
Your goal in this exercise is to redraw the waveform to eliminate the drastic peaks that 
make up the glitch. You don’t want to silence the section by dragging the waveform all the 
way down because that will also be audible. Instead, you’ll draw a smooth horizontal line to 
connect the samples at the left with the samples at the right and continue the existing 
waveform. Because this music clip is in stereo, you’ll need to redraw the waveform on the 
left (upper) and right (lower) channels. 

1	 In the upper channel, click one of the samples before the drastic change in the 
waveform. The sample turns red to indicate that it is selected. You can now drag up, 
down, right, or left to redraw the waveform.

2	 Drag the sample to the right to create a smooth horizontal waveform that connects 
with the existing samples at the tail of the clip. 

Don’t worry if your sample drawing isn’t perfect. You can drag back and forth as much 
as needed to smooth it out. The secret to editing at the sample level is to draw smooth 
lines (but not necessarily straight lines) that reconnect with the samples on either side 
of the change. 

NOTE  To reset a clip’s samples, right-click the clip and choose Reset 
Edited Samples.
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3	 Repeat steps 1 and 2 in the lower channel. 

4	 When finished, clear the play range.

5	 Press Shift-Z.

6	 Play the clip from the blue marker to hear the repaired glitch. If you hear the edit, go 
back and try to smooth it out. You’ll know it’s right when you can’t hear any indication 
that the waveform was ever edited. 

You just performed a seamless “glitch-ectomy” in the middle of a busy instrumental music 
clip. You can apply this same sample-level technique on dialogue clips to remove noises or 
even shave the “s” off a plural word. When you get used to sample-level editing, you can do 
it without first splitting the clip. For now, splitting the clip is like using training wheels for 
sample-editing newbies and can be a time-saver for seasoned editors as well. 

Retiming Audio with 
Elastic Wave Time Controls
The last audio repair tool you’ll work with is Elastic Wave audio retiming. This fast and easy 
keyframe-based method dynamically retimes audio by condensing or stretching different 
parts of a waveform without changing pitch. It is commonly used for retiming sound effects, 
commercial voiceover cues, and matching ADR recordings to the lip movement onscreen. 

In this exercise, you’ll use Elastic Wave keyframes to retime an ADR recording to match the 
original dialogue in the timeline. First, let’s set up the timeline for evaluating Dad’s 
dialogue clips during playback. 
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Preparing the Timeline
1	 Open the timeline 6e ADR Elastic Wave.

This is a version of the ADR timeline that you recorded in Lesson 4. It includes several 
takes of Harper’s lines in track layers and one best take of Dad’s line “We’re going to 
be okay.” 

TIP  If the clip you are retiming is one of many in audio track layers, disable all 
unused takes in the layers so you will not hear them while retiming the clip in 
the uppermost layer. Then, Hide Audio Track Layers. Alternatively, you can 
move the take to a new track, then mute and hide the track with the other 
takes. Either way, it’s a good idea to keep the other takes handy in case you 
need them.

2	 Close all open panels except the floating viewer. 

3	 Move the playhead to the second blue marker, if necessary.

4	 Zoom to fit all the tracks and clips within the visible timeline. 

5	 Move and resize the viewer to the open space in the timeline to the left of the 
orange clips.

Track A8 contains the best ADR take for Dad’s lines. Track A9 contains a duplicate 
version of the ADR recording that you’ll retime for this exercise.

It would be helpful if the A8 and A9 tracks were directly beneath the A5 DX 2 Dad track. 
There are two options: hide the tracks between them or move them up closer to where 
you want them. For this exercise, let’s move the tracks. 

6	 Show the mixer. Extend the mixer to show all the tracks. 
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7	 Select the A8 and A9 tracks. 

To move a track or tracks to a different position in the mixer, you drag from the track 
name area above the faders. 

8	 In the mixer, drag the selected tracks toward the left. Using the vertical line as a guide, 
release the tracks to the right of the A5 DX 2 Dad track. 
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The tracks have been reordered in the timeline and mixers. Now, all three tracks 
containing Dad’s dialogue are together in the A5, A6, and A7 tracks. Before you start 
working with the clips, let’s make them easier to see and work with. Also, this is a good 
time to turn off Exclusive Solo. 

NOTE  You can also move tracks in the Tracks Index or by dragging the left 
edge of the track header in the timeline. 

9	 Zoom as needed to clearly see the viewer and the clips to the right of the playhead in 
the A5–A7 tracks. 

10	 Choose Fairlight > Exclusive Solo to turn off that option. 

Evaluating the Original Dialogue 
with the ADR Recording
Now that you have the timeline set up, you’re ready to listen to the original and ADR 
versions of Dad’s line “We’re going to be okay” to determine whether they are in sync and 
how you may adjust the timing if needed. 

1	 Mark the clip in the A6 track. 

2	 Solo both the A5 and A6 tracks start looped playback. Listen to the clips together to 
determine how well they match. Stop playback. 

You can hear that they aren’t quite playing in perfect sync. Looking at the waveforms in 
each clip, you can see and hear that the “okay” is late in the ADR recording. Let’s use the 
Elastic Wave controls to retime the clip in the A6 track to match the clip in the A5 track. 

3	 Unsolo the A6 track. Start playback again, listening only to the original dialogue in the 
A5 track. 
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4	 Scrub through the clip forward and backward, holding JK and KL alternately to hear the 
dialogue in slow motion while watching the lip movements in the viewer. 

5	 Unsolo the A5 track and solo the A7 ADR 2 Elastic Wave track. 

This track is a copy of the A6 track except the clip color was changed to beige to make 
it easier to identify and compare to the unaltered ADR recording. 

6	 Start looped playback and listen to the ADR clip of the same line while watching the 
viewer. Feel free to scrub with the JKL keys as you evaluate the ADR recording with 
the video. 

What do you think? It’s close. Really close. In fact, you could probably leave it and move 
on. Of course, you would always know it was slightly off, and you would notice that 
every time you watched the show. Worse still, others might notice, and your reputation 
as a dialogue editor or dialogue mixer may suffer. 

This is the perfect time to turn on Elastic Wave and retime the clip waveform to match 
the original. First, let’s move the A7 track up to the position between the A5 and A6 
tracks. This time, instead of using the mixer or index, you’ll just use the right-click 
contextual menu in the track header. 

7	 Drag the left edge of the A7 track header upward to the position between the A5 and 
A6 tracks. 
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The beige A6 track is now between the orange A5 and A7 tracks. 

8	 Mute the A7 ADR 2 Dad track for comparison later. 

Next, you’ll enable Elastic Wave on the beige clip. 

9	 Right-click the beige clip in the A6 track and choose Elastic Wave > Voice to reveal the 
Elastic Wave retiming controls. 

Once Elastic Wave is enabled, the clip shows the Elastic view, where you can retime the 
entire clip or add time keyframes to stretch or condense specific areas of the 
waveform using keyframe markers.
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10	 Unsolo the A5 track. Clear the range. Solo only A6, if necessary. 

11	 Move your pointer over the right edge of the clip to see the Trim tool. Move the pointer 
slightly toward the left over the clip until it changes to the Retiming tool.

12	 With the Retiming tool showing, drag the right side of the clip toward the right to 
stretch the clip. Play the clip to hear the change. Then, drag toward the left to 
condense the entire clip. Play the clip again to hear it. 

13	 Stretch the clip back toward the right until the last waveform section, which includes 
the “kay” in “okay,” aligns with the last part of the waveform in the A5 track. You can do 
this visually or by playing the end of the clips as needed until the timing of the word 
“okay” is the same on both clips. 
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14	 Mark the clip in A7 to set a range. Solo A5 and A6 and listen to them together. 

The last section, “…be okay,” is much closer to sync now, but the first part of the clip still 
needs some work. It’s amazing how just retiming the end of the clip really helps match the 
second half of the clip. Now you’ll need to retime the first part of the clip without moving 
the part that is already fixed. To do that, you’ll need to set a few speed keyframes. 

NOTE  Elastic Wave audio retiming is a fast and easy keyframe-based way of 
dynamically retiming audio. You can stretch or condense clips to slow down or 
speed up accordingly. There are also three more options: Voice, General Purpose, 
and Varispeed. When working with dialogue, it’s best to use the Voice option, 
which is focused on human speech or singing.

Using Elastic Wave Speed Keyframes 
to Retime the Waveform 
To finesse the timing of specific areas of the waveform within the clip, you simply add 
speed keyframes. Once you add a speed keyframe, you can drag it left or right to stretch 
the wave accordingly. Speed changes based on keyframes affect only the waveform from 
that keyframe to the neighboring keyframes applied to that clip. Using an audio clip’s 
waveform as your guide, you can use multiple speed keyframes to match the waveform of 
one performance to the waveform of another to match the timing. 

In this exercise, you’ll use Elastic Wave speed keyframes to further improve the timing 
between the two clips. Let’s start by setting a speed keyframe after the last part of the 
waveform since the timing there is already good. Then, you’ll set two more keyframes in 
the empty space between the middle waveform section and the last section. You’ll use 
those keyframes to fine-tune the alignment between the sections once you adjust the 
beginning of the waveform to match the beginning of the original clip. 

DaVinci Resolve provides handy keyboard shortcuts for adding and removing speed 
keyframes: Command-click (macOS) or Ctrl-click (Windows) to add a time keyframe and 
Option-Command-click (macOS) or Alt-Ctrl-click (Windows) to delete a time keyframe. First, 
let’s set three keyframes at the end and between the longer section of the waveform 
and the last section. 
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1	 Solo only the A6 track. 

2	 Move the pointer to the empty space after the waveform and Command-click (macOS) 
or Ctrl-click (Windows) to add a time keyframe.

3	 Set two more keyframes in the gap between the first waveform section and the 
end section. 

4	 Drag the beginning of the beige clip toward the right until the beginning of the 
waveform aligns with the beginning of the original recording. 
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5	 Adjust the time keyframes in the middle of the clip as needed to align the end of the 
first part of the waveform and the beginning of the last part of the waveform to match 
the original clip. 

6	 Play the clips in the A5 and A6 tracks to hear them together. 

Wow! Way to stretch that wave! They are now in sync. 

Now that you have finished with the Elastic view, let’s hide the controls. 

7	 Right-click the beige clip in the A6 track and choose Elastic Wave > Elastic View to 
deselect that option. 

The clip looks like any other clip except for the time badge at the end of the header, which 
indicates that it has been retimed.

NOTE  All Elastic Wave retiming adjustments you make in the Fairlight page appear 
in the edit page as variable speed effects, accessible using the Retime controls. 
However, not all retiming effects created on the edit page can appear as Elastic 
Wave retime effects on the Fairlight page. 
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Applying Pitch Changes to 
a Clip in the Inspector
If you’ve followed along with all the lessons, you have already learned how to record, edit, 
and stretch to sync ADR recordings in the timeline. One last trick to keep in your dialogue 
editor’s toolkit is the ability to change a clip’s pitch. This doesn’t come up every day, but it 
can happen. Especially if you are editing different takes together where the talent’s voice 
and delivery may have been a little higher or lower in pitch. In this exercise, you’ll lower the 
pitch of the ADR clip in A6 just a bit to split the difference between the original recording 
and the dialogue replacement clips. 

1	 If necessary, solo the A6 track and unsolo all other tracks. 

Let’s compare the clips one more time. 

2	 Start looped playback and listen to the clip in A5 soloed and then A6 soloed. 

At this point, the only real difference is the character’s delivery. His voice is slightly lower 
and more serious in the original recording, while the ADR recording sounds slightly 
higher-pitched and more upbeat. This was a directorial decision during the recording. 

3	 Solo only the A6 track. Mark and select the beige clip. 

4	 Show the Inspector. 

The Pitch controls let you lower or raise a clip’s pitch by up to 24 semitones. With 
12 semitones in an octave, you can pitch a clip up or down by two full octaves. The 
Cents control manipulates the clip by hundredths of a semitone and is used for 
fine-tuning a clip’s pitch. 
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Dragging the pitch controls to the left lowers the pitch and is designated by a negative 
number. Conversely, dragging to the right raises the pitch. The best way to understand 
the power of pitch control is to hear it in action. 

5	 Start looped playback. During looped playback, drag the clip’s Semi Tones slider to 
each of the following settings: -1, -5, -10, -20, 0, 1, 5, 10, and 20. When you are finished, 
stop looped playback. 

As you just heard, subtle pitch changes can sound natural, while more radical changes 
can completely transform a voice from human to that of a demonic creature (-20) or a 
talking mouse (+20).

6	 At the far right of the controls, click the clip Pitch Reset button. 

Next, you can drag the Cents slider to introduce smaller incremental pitch changes. 

7	 Start looped playback. During looped playback, drag the Cents slider slowly to the left 
and then to the right to hear the slight changes in pitch. 

8	 Set the Cents slider to between -75 and -50. Listen and then stop playback. 

The subtle change in pitch lowers the dad’s voice just enough to feel natural. You’ll work 
more with pitch changes in the next lesson. 

NOTE  The pitch controls in the Inspector are perfect for making large and small 
pitch changes to individual clips. However, if you need to change the pitch for an 
entire track, it’s better to use the Fairlight FX pitch plug-in.
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More Audio Repairs
We’ve covered quite a few new tools and techniques in this lesson, including removing 
annoying noises between words, gating low-level noise, using the De-Hummer and Noise 
Reduction repair plug-ins, using AI-based Track FX, and, finally, performing sample-level 
repairs and waveform retiming. Whew! As a dialogue editing and mixing trainee, you rock! 

Now, you can put some of these skills to the test and choose your own audio repair 
adventure from the following list. (You might need to return to corresponding sections in 
this lesson to refresh your memory.) 

In the 6 Quick Fixes Start timeline: 

1	 Right-click each track header, choose Remove Attributes, and remove all attributes. 

2	 Right-click each clip, choose Remove Attributes, and remove all attributes on the clips.

3	 Once the clips and tracks have been reset, use what you have learned to improve or 
repair each clip.

In the 6a Reduced Noise timeline: 

1	 Clear all plug-ins and Track FX from the clips and tracks. 

2	 Use plug-ins and Track FX to improve the sound of the clip. 

In the 6b Combo FX to Cache timeline:

1	 Clear all plug-ins and Track FX from the clips and tracks. 

2	 Use whichever repair plug-ins or Track FX you need to improve the clip. 

3	 Feel free to experiment with different settings, plug-ins, and Track FX.

4	 When finished, cache or bounce the clip with effects. 

In the 6e ADR Elastic Wave timeline:

1	 Right-click the beige clip and choose Reset Speed Curve. 

2	 Move and extend the edges of the clip until it matches the recording in the A8 ADR 2 
Dad track.

3	 Use Elastic Wave to stretch and retime the clip.

4	 If you feel ambitious, show track layers and audition the different takes in Harper’s 
ADR line “Will you teach me how to surf?” 
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5	 Choose the best take, move it to the uppermost layer, disable the other clips, and hide 
the audio track layers.

6	 Retime the best take of Harper’s dialogue with the original recording. 

In the next lesson, you’ll step out of the dialogue editor’s seat and into the creative role of 
the sound designer. 

Lesson Review
1	 True or False? You can apply up to six plug-ins to a clip and apply unlimited plug-ins 

to a track. 

2	 Which Fairlight FX plug-in is designed to remove powerline hum from an audio clip?

a)	 Noise Reduction

b)	 Hum Remover

c)	 De-Hummer

d)	 Un-Hummer

3	 True or False? When using the Fairlight FX Noise Reduction plug-in, the Manual mode 
utilizes the Learn button to create a noise profile.

4	 True or False? The Fairlight FX Sample Editor plug-in lets you see and edit the audio 
waveform at the sample level.

5	 How do you enable the Elastic Wave retiming controls?

a)	 Use the Elastic FX plug-in.

b)	 Choose Elastic Wave from the right-click contextual menu.

c)	 Enable Elastic Wave in the clip Inspector.

d)	 Select the clip and click the Elastic Wave button in the toolbar.

6	 Which two DaVinci Resolve Studio built-in Track FX use AI to remove background noise 
from clips that contain a human voice? (Choose two.)

a)	 Dialogue Enhancer

b)	 Dialogue Separator

c)	 Voice Extractor

d)	 Voice Isolation

e)	 Noise Reduction
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Answers
1	 False. You can apply unlimited plug-ins to a clip and up to six plug-ins to a track.

2	 c

3	 True

4	 False. There is no Fairlight FX Sampler Editor plug-in. To edit waveforms at the sample 
level, simply zoom in to the waveform to see the samples on the Fairlight page.

5	 b

6	 b and d
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Once an audience has “been there, done that,” an onscreen soundscape (audible landscape) 
becomes part of the accepted “norm” for similar onscreen experiences. A sound designer’s 
goal is to create a rich, realistic, and emotionally compelling soundtrack that exceeds the 
audience’s expectations without drawing attention away from the story. 

In this lesson, you will become a sound designer and will be responsible for crafting, 
enhancing, and manipulating sounds—such as dialogue processing, ambience, and sound 
effects—to make scenes more immersive, emotional, and realistic. Along the way, you’ll 
also learn some powerful DaVinci Resolve tools, plug-ins, and shortcuts.

What Does a Sound Designer Do? 
The sound designer is responsible for creating sound effects and subtle sound layers to 
enhance the emotional tone and mood of a scene while also managing the post-
production sound process. In many cases, the sound designer also serves as the 
supervising sound editor. Think of the sound designer as an acoustic head chef 
responsible for the overall sound experience. Like a chef, the sound designer oversees 
every element on every track as the sounds are cumulatively blended, balanced, and mixed 
into the final soundtrack. 

Creating Keyboard Shortcuts
Whether you prefer using a mouse and menus or keyboard shortcuts for your audio tasks 
is up to you. However, some shortcuts are commonly used by nearly everyone, such as cut, 
copy, paste, the JKL keys for navigation, and Shift-Z to toggle horizontal Zoom to Fit clips on 
the timeline. As you may know, every menu feature in DaVinci Resolve can be assigned to a 
keyboard shortcut. In this lesson, you’ll use the Keyboard Customization window to assign 
two useful shortcuts. The first is for Exclusive Solo, which you’ve accessed previously 
through the Fairlight menu; assigning a shortcut will make it quicker to use. The second is 
for Smart Zoom, which isn’t available in a menu at the time of this writing, making a custom 
shortcut necessary. This simple exercise takes only a few minutes but can save significant 
time and reduce unnecessary mouse clicks as you work through this lesson. 

1	 Open DaVinci Resolve, if necessary.
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2	 Choose DaVinci Resolve > Keyboard Customization. 

The Keyboard Customization window opens, where you can create your own custom 
keyboard shortcuts, see which keyboard shortcuts are available, and choose a 
shortcut preset. At a glance, this window is self-explanatory, featuring an interactive 
keyboard at the top and a list of interactive shortcuts at the bottom, where you can 
find, select, search, and modify them. 

3	 Click the Presets dropdown menu in the upper right corner of the Keyboard 
Customization window to show the list of presets.

This list shows keyboard shortcuts for other post-production software as well as any 
custom layouts you may have saved on your system. 

4	 If necessary, set the preset menu to DaVinci Resolve. 
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NOTE  If you are already using custom keyboard shortcuts that you created on 
your own or as part of another DaVinci Resolve training course, feel free to 
continue working with that layout and just add the new keyboard shortcuts in 
this exercise. 

5	 In the Search field, located at the right side of the window, type Solo.

A list of all commands that include the word Solo appears in the search results along 
with their interface menu, such as Fairlight > Exclusive Solo. Notice in the Keystroke 
column that none of the three search results have been assigned keyboard shortcuts 
in the default DaVinci Resolve layout. 

A common letter that is easy to remember when associated with Exclusive Solo is X, so 
you’ll assign a shortcut that includes the letter X. As you know, X is already used to 
mark a clip. Let’s try Option-X (macOS) or Alt-X (Windows) to toggle the solo button to 
the Exclusive Solo option. Hint: that shortcut is already being used for the Clear Range 
function, as you will see in a moment. 

6	 In the Command list, select Exclusive Solo. Then, in the Keystroke field, press Option-X 
(macOS) or Alt-X (Windows). 
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Yep, that shortcut is already taken. No problem. Let’s try Shift-X instead to “shift” the 
solo button to Exclusive Solo mode. 

7	 Click Cancel in the warning dialog. Then, press Shift-X in the Keystroke field. 

This time, there is no warning. Let’s proceed to the next shortcut. 

8	 In the Search field, type Smart Zoom. 

As you can see, Smart Zoom is in the Fairlight Timeline > Timeline View Options menu 
list. Every modifier shortcut involving Z is already in use, so a common alternative 
shortcut for Smart Zoom uses the letter E, as in “Examine more closely.”

9	 Select Smart Zoom in the Command list and press Shift-E in the Keystroke field. 
Click Save. 

10	 In the Keyboard Mapping Preset dialog, type your initials after DaVinci Resolve to save 
your custom preset. Click OK.

11	 Close the Keyboard Customization window, if necessary. 

NOTE  Now that you know how easy it is to set keyboard shortcuts, you can assign 
them to any menu action that you use regularly, such as View > Show/Hide Audio 
Track Layers or Playback > Record. 

Altering Dialogue to Fit 
the Context of the Scene
A great place to start your sound design journey is with dialogue that you have already 
edited, repaired, or balanced. In the next set of exercises, you’ll explore two common 
real-world scenarios where the sound designer (you) must apply effects to dialogue to fit 
the diegetic context of the scene. First, you’ll experiment with the Echo Fairlight FX plug-in 
to enhance offscreen dialog in the “learn to surf” scene. Then, you’ll open a different 
timeline to apply a combination of effects to alter the voice of the assistant principal 
when he is speaking through the PA system. 
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One thing to consider before adding effects directly to dialogue clips or tracks is that, 
when it comes to dialogue editing and mixing, it is essential to keep the primary dialogue 
tracks clean. It’s OK to use effects to repair the sound for balancing, but your goal is to 
leave the dialogue otherwise unaltered and easy to hear. 

How do you change the sound of the dialogue when needed if you can’t add effects 
directly to the dialogue clips and tracks? The sound designer may duplicate a dialogue 
track, apply effects to the duplicate clips, move clips to a different track for processing, or 
send the sound to an auxiliary bus for processing. In this lesson, you’ll use the first two 
methods. You’ll work with busses in the next lesson. 

Adding Depth to Offscreen Dialogue
In motion picture storytelling, both the director of photography and the sound designer 
consider height, width, and depth when composing a scene. Just as a cinematographer 
uses light, shadows, reflections, and focus to create depth between the foreground and 
background, a sound designer uses time-based effects, such as echo and reverb, to add 
audible depth. In this exercise, you’ll use the Fairlight FX Echo plug-in to simulate depth in 
the soundtrack, positioning Raina’s dialogue as she yells surfing directions from the beach. 
Along the way, you will use the new keyboard shortcuts you created. 

1	 In your TML Audio Post project, open the 7 Offscreen Echo Start timeline. 

2	 Show only the timeline, mixer, and floating viewer. 

3	 Condense the mixer width to only show the first five or six tracks.

4	 Zoom the timeline as needed to see all the tracks and clips. 

5	 Play the timeline starting at the pink marker. During playback, focus on the story 
context of where Raina is compared to Harper. 
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There is currently no difference between Raina’s dialogue when we see her yelling to 
Harper from the beach and when we see Harper listening to Raina from the water. 
Now that you are thinking like a sound designer, the mission is clear. 

It’s time to use Smart Zoom to focus on the clips and tracks you’ll be working with. 
Smart Zoom requires the Focus mode multi-tool and a selected range in the timeline. 
Let’s try to focus on Raina’s dialogue in tracks A2–6. 

6	 With the Focus Mode multi-tool, drag a range around all the pink clips in the timeline. 
Include the empty DX r5 Echo track in your selection. 

7	 Press Shift-E to apply Smart Zoom to the selected range. 

Hello pink clips! The timeline instantly zooms to fit the selected range. Handy, right? 
Now, let’s put this to work. 
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NOTE  When working with Smart Zoom, you can use the same shortcut to 
toggle in and out of the Smart Zoom view until you deselect the range or 
perform any additional zooming. 

Now that you have a clear view of all the pink clips, you can focus on the first set of 
clips on the A3 DrX r2 track. The first clip is a duplicate clip from the A2 track where 
Raina starts her offscreen dialogue. You’ll select, copy, and paste a copy of her 
offscreen clips to the A6 DX r5 Echo track. 

8	 Drag a range that includes the first set of pink clips in the A3 track. Choose Edit > Copy 
or use the familiar keyboard shortcut to copy the clips. 

9	 Select the A6 track and then Paste. 

An identical copy of the clips appears in the A6 track. The only difference is the clip 
color because this track is not pink. 

Next, you’ll add an Echo effect to the A6 track. Instead of dragging the effect from the 
Effects library, let’s use the Add Effect pop-up menu in the mixer.

10	 At the top of the A6 channel strip, in the Add Effect pop-up menu, click the Add Effect 
button (the + symbol) and choose Delay > Fairlight FX > Echo. 
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The Echo panel opens. This classic Echo effect includes a graph showing the timing 
and intensity of the generated echoes on each channel, as well as an Output meter 
that displays the level of the resulting signal. 

Working with Plug-In Presets 
and Custom Settings
Before you rush into modifying the settings, let’s test for Echo presets to see if any of the 
presets work for this scene. 

1	 Solo the A5 Dx r5 Echo track. Mark a range around the clips if needed. 

2	 Select the first disabled clip and press D to enable the clip. 

3	 Start looped playback and listen to the default Echo plug-in settings. 

Nope. Next...

4	 Continue looped playback and try each of the Echo presets. When finished, 
stop playback.
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Did any of the presets work for this situation? Large Hall was the closest to working. In 
fact, you could probably use that preset with a few adjustments. However, in this case, 
you’ll reset the plug-in to the default settings and then modify the settings yourself. 

5	 Click the Reset button in the top right corner of the Echo panel. 

6	 On the Echo panel, set the Delay control to 0 (zero milliseconds of delay). 

TIP  When customizing a plug-in’s settings, start with extreme positions—
either the far left (no effect) or the far right (full effect). This allows you to 
clearly hear the difference between “all” and “nothing added.” Then, gradually 
adjust in the opposite direction during playback until you find the perfect 
balance for the scene. For precise control, hold Shift for fine adjustments and 
double-click the control to reset.

7	 Start looped playback and slowly increase the Delay control while listening to the 
results. Try different amounts of delay. When finished, set the delay to between 110 
and 180 milliseconds. Find the level that sounds best to you. 

8	 Stop playback.

Saving a Customized Preset
After you have customized a preset, you can save it for use in another scene in the same 
project or in another project altogether. In this exercise, you’ll save a preset for the Echo 
effect that you just modified for the “learn to surf” scene. 

1	 On the Echo panel, click the + (Add Preset) button. 

2	 In the Echo Preset dialog, type TML Surf Scene. Press Return or click OK.

The Preset pop-up menu updates to show the current preset, TML Surf Scene. 
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TIP  When naming presets and sound effects, it’s always a good idea to give 
them clear, self-explanatory names. For example, base the name on the show, 
scene, or generic situation where the plug-in preset will be most useful.

3	 Start looped playback. Choose a different preset and then choose the TML Surf Scene 
preset that you just created. When you’re finished, stop playback. 

4	 Clear the selected range. 

5	 Unsolo the A6 track and disable the first set of clips on the A3 track. 

6	 Listen to the scene in context with the Echo.

Nice work! The best part of saving presets is that you can use them in any Resolve 
project on your system. 

NOTE  You can select this preset from the list at any time, and even update it and 
resave it as a different preset.

Finishing the Offscreen Dialogue Effect
To enhance the effect of Raina yelling to Harper from the shore, consider adjusting the 
location of her sound. While dialogue is typically panned to the center, exceptions can be 
made when a character is offscreen or speaking from a specific location, such as a small 
speaker in the corner of a room. In this case, slight panning can help sell the distance and 
direction of Raina’s voice. Keep in mind that playback will vary significantly between stereo, 
5.1 surround, and Dolby Atmos immersive audio. For now, a subtle approach is best—
there’s no need for extreme panning. Adjust the track slightly to the left, between 30L and 
50L. Instead of opening the Pan window, you can fine-tune the A6 track panning directly in 
the channel strip controls. Start looped playback and gradually drag the blue pan handle 
to the left until it sounds convincingly like Raina is yelling from the beach. Once satisfied 
with the effect and placement of the offscreen dialogue, watch the scene in the full-screen 
Cinema Viewer, then stop playback.
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Futzing Dialogue to 
Simulate a PA System 
Your next dialogue-enhancing sound design exercise will be to futz a dialogue clip with 
Fairlight FX. A futz track is a processed version of dialogue or sound that mimics how it 
would sound through a specific device or environment, such as a telephone, radio, TV, PA 
system, or walkie-talkie. It is created using EQ filtering, distortion, reverb, and noise effects 
to simulate low-quality or obstructed audio. Common in films, TV, video games, and 
podcasts, futz tracks add realism by making voices sound like they’re coming from another 
room, an old speaker, or a distant communication system. 

There are four fundamental steps in creating an effective futz track, including: 

	— EQ (equalization) to cut the high and low frequencies, leaving a mid-range-
heavy sound

	— Distortion and Bit Reduction to add a grainy or lo-fi effect to simulate degraded 
audio quality

	— Reverb and Echo to mimic room reflections, such as a voice over an intercom in a 
large hall

	— Compression and noise addition to simulate static, interference, or background noise 
typical of older or low-fidelity audio systems

The number of steps and the intensity of the effects required depends entirely on the 
context of the scene and the level of immersive realism you want to achieve. For example, 
an announcement over a PA system at a major airport may be loud, clear, and easy to 
understand, while announcements at an outdoor train station or inside a moving train may 
be noisier, prone to dropouts, and harder to discern.

In this exercise, you’ll apply the first three processing steps to a futz track, including EQ 
and the Distortion and Reverb plug-ins. This may sound like a lot of effort, but these are all 
native Fairlight effects with presets to get you started. First, you’ll drag a copy of the clip to 
the next track. Then, you’ll apply EQ to limit the high and low frequencies. Next, you’ll add 
the Distortion plug-in and experiment with the presets. Finally, you’ll add a splash of 
Reverb or Echo to indicate that the sound is coming from speakers offscreen in the 
distance. 

1	 Open the timeline 7 Futz PA Start.

2	 Hide all panels except the timeline, mixer, and floating viewer. 

3	 Play the clip in the timeline, watch the video, and consider where the sound is coming 
from while Vice Principal Garrett makes his announcement.
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How do you imagine the outdoor PA sound from this location? He is speaking into a PA 
handset, but the speakers are not visible—they could be mounted on the school 
building or scattered around campus. At this close proximity, both his natural voice 
and the processed PA speaker sound would likely be audible. To maintain flexibility in 
the mix, always keep the original, clean dialogue on its own track and place a copy in 
the Futz track. This allows you to blend the processed sound with the original or adjust 
the balance as needed. 

To copy the clip, you’ll press the Option/Alt key while dragging the clip downward to 
the next track. 

4	 Option/Alt-drag a copy of the clip in the A1 track to the A2 track. You can hold Shift 
while dragging the copy to keep it aligned vertically. 

5	 Mute the A1 track. 

The A2 Futz 1 PA EXT track is set up and ready for processing. 

Applying Equalization to Limit 
High and Low Frequencies 
Equalization (EQ) controls manipulate specific frequencies to shape or enhance the overall 
sound, much like working with color, saturation, and hue in color correction. For example, 
the human voice is based on a fundamental frequency shared by millions, but additional 
frequencies add tonal qualities to “color” each voice, making it unique and recognizable. 
The primary function of equalization is to lower frequencies that detract from the voice 
and boost frequencies that enhance the overall sound clarity. 

If you recall, the Fairlight page features a four-band parametric equalizer for each clip in 
the Inspector and a six-band parametric equalizer on each track, making it the perfect tool 
for either limiting frequencies to degrade sound in a track or enhancing and “sweetening” 
audio tracks to improve dialogue during the mix.
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In the following exercise, you’ll look at limiting the high and low frequencies to simulate the 
frequency limitations of an outdoor PA system. First, you’ll use the six-band EQ on the A2 
track to diminish Vice Principal Garrett’s voice to sound as if it is coming from speakers. 

Then, you’ll apply EQ to Emiliana’s track to “sweeten” her voice. 

1	 Mark the clip in the A2 track. 

2	 Select the A2 Futz 1 PA EXT tack track to brighten it in both the mixer and timeline. 

Although selecting tracks isn’t a necessary step, it does make the tracks and clips 
easier to spot while you work. 

3	 In the mixer, on the A2 Channel strip, double-click the EQ area to open the Equalizer 
window. Move the Equalizer window to the timeline area to the left of the mixer. 

4	 In the Equalizer window, choose “General – Telephone effect” from the Equalizer 
Presets dropdown menu. Start looped playback to hear the results. 

The equalizer graph clearly shows that all the high and low frequencies have been 
filtered out, leaving only the mid-range frequencies, just like a telephone speaker. 
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Saving Alternate Settings for Quick Comparison
One of the most valuable techniques for sound design is to quickly listen to and compare 
the sound before and after applying an effect. Unlike visual comparison—where you can 
see more than one version of something at a time and compare them side by side—with 
audio, you need to listen to one version and then the other back and forth as many times 
as needed during playback. The Fairlight page in DaVinci Resolve offers several options for 
quickly comparing your plug-in effects, EQ, and dynamics while you work. One option that 
you’re already familiar with is to simply click the Bypass switch off and on in either the 
effect’s control window or the Inspector. The Fairlight page mixer also includes a bypass 
for plug-in effects, Track FX, Pan, EQ, and Dynamics by simply clicking the effect Bypass 
button or Command/Ctrl-clicking the controls area for Pan, EQ, and Dynamics, respectively, 
in the mixer channel strip. 

The A/B Comparison toolset is located at the top of the audio effect control windows and 
includes three buttons that let you compare two sets of adjustments of the same effect. 
By default, all changes applied to an effect’s controls are saved in the A bank of controls. 
Clicking the B button toggles the controls to a second bank of identical controls. The 
(arrow) button between A and B can be used to copy settings from A to B or B to A, 
depending on which button is selected at the time. The arrow changes direction based 
on which settings are showing to indicate the direction of the copied settings. 

In this exercise, you’ll use the A/B Comparison toolset first to compare the settings you 
made to the default settings. Next, you’ll copy the settings from A to B, adjust the B 
settings, and compare. Keep in mind that your overall goal is to find the best sound for the 
outdoor PA system in this scene. 

1	 Locate the A/B Comparison toolset at the top of the Equalization window.

2	 Start looped playback of Vice Principal Garret’s voice. 

3	 Continue looped playback. In the Equalizer window, click the B button to toggle on the 
B set of controls. 

The B controls are identical to the A controls. Now, you can customize the settings. 
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4	 Continue looped playback. In the Equalizer window, click the Band 2, Band 3, Band 4, 
and Band 5 buttons to turn them off. 

This widens the graph to include more of the mid-range frequencies, including 
mid-low and mid-high frequencies. The sound is still limited, like a speaker, but not as 
extreme as a small telephone speaker. 

5	 During playback, click back and forth between the A and B buttons to hear the 
different versions of the effect. 

6	 Toggle the Bypass button on and off to hear the unaffected voice, then select the A 
and B options. 

7	 Stop playback. Show the B set of controls, if necessary. Let’s continue working with the 
B controls for now. 

8	 Close the EQ window. 

Now that you have selected a favorite setting, the first step in setting up the futz effects 
for this scene is complete. Plus, you have the A set of controls as an option if needed. Just 
remember that if you are in a mixing session with clients, they will likely want to hear 
another version of the effect or suggest changes. Clients also appreciate being able to 
listen to and compare things for themselves. Fortunately, you already have a plan B (A or B) 
ready to play and compare with a click if needed.

Applying Distortion to Degrade the Sound
The Distortion plug-in offers a variety of presets to quickly simulate degraded audio. In this 
exercise, you’ll apply the Distortion plug-in to the A2 Futz 1 PA EXT track, and then test-
drive the different presets to find one that works best for this scene. 
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Once again, let’s use the Add Effect pop-up menu in the mixer. In this case, there is 
only one Fairlight FX plug-in in the Distortion category, aptly named Distortion. 

1	 At the top of the A2 channel strip, click the Add Effect button and choose  
Distortion > Distortion. 

The Distortion panel opens. This effect includes an animated graph showing the 
results of adjusting the Distortion parameters, providing a visualization of the clipping, 
wave shaping, and harmonic distortion that modify the signal as you adjust the plug-in 
settings. Input and Output meters show how the levels are affected. Warning: The 
Distortion plug-in settings can increase the levels to uncomfortable levels as you test 
out the presets. To protect your ears, this is a good time to dim the monitoring levels, 
especially if you are wearing headphones. 
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2	 In the monitoring controls in the top right corner of the Fairlight interface, click the 
DIM button. 

Now, you can safely test the Distortion presets. 

3	 Start looped playback. Try each of the Distortion presets. Notice the settings as you 
change presets to see how they affect the overall sound. 

4	 When finished, select the LoFi Radio preset. 

There are two Distortion mode buttons at the top of the Distortion settings in the 
center of the controls window. The button on the left is the Distortion button, which 
creates harmonic distortion. The button on the right is Destroy, which is an extreme 
polynomial wave shaper. 
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5	 Continue playback. In the Distortion settings, click each of the two mode buttons to 
hear the difference between Distortion on the left and Destroy on the right. Once 
you’ve compared both settings, click the Distortion button to choose that mode. 

Fairlight FX plug-in effects include a handy Dry/Wet control that determines the 
percentage of the original to the processed signal. Once you’ve selected the settings 
you prefer, you can use the Dry/Wet control to find the right balance between no 
effect (Dry) and a fully effected signal (Wet). 

6	 Start playback if needed. Set the Dry/Wet control to the Dry position. Then, slowly 
increase the Dry/Wet amount to around 80 percent.

7	 Stop playback. Close the Distortion window. Turn off the DIM button in the 
monitoring controls.

MORE INFO  You can find more information about the Distortion plug-in or 
other Fairlight FX plug-ins in the Fairlight FX chapter of the DaVinci Resolve 
Reference Manual.

Choosing Processing Order in the Mixer
Something to consider when applying effects and processing to a track is the order in 
which you want the signal to be processed. The Order dropdown menu at the top of each 
channel strip allows you to choose processing order between Effects (FX), Equalization 
(EQ), and Dynamics (DY). The default order is FX, DY, and EQ. That means plug-ins affect 
the signal first, then dynamics, and finally EQ. However, when you first started futzing 
around with the dialogue in this exercise, you started with the EQ. Currently, the Distortion 
plug-in is the first thing to alter the original signal, followed by dynamics, and then the EQ. 
Let’s start playback again and listen to the results of different processing order options on 
the signal so far. 
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1	 At the top of the A2 channel strip, click the Order dropdown menu and choose EQ, FX, 
DY from the bottom of the menu. 

2	 Start looped playback and listen to the results when starting with EQ and then FX. 

3	 Continue playback. In the Order dropdown menu, choose FX, EQ, DY. Listen again.

4	 Change the order back to the previous option, EQ, FX, DY, to match the processing 
order you are using to create the futz track.

5	 When you are finished, stop playback.

NOTE  Track FX are always processed first, followed by FX, EQ, and DY in 
whichever order the user defines per track. Keep in mind that changing the 
processing order may require you to make adjustments to the effects that 
have already been applied to the track. 

Simulating Spaces with Reverb and Echo
Resolve’s powerful Fairlight FX Reverb plug-in can instantly add a sense of scale and space 
to your tracks. This spatial simulation plug-in displays a graphical 3D cube interface, 
allowing you to control corresponding reflections and reverberations based on the size 
and shape of the “room.” Additionally, various controls let you take a “dry” recording and 
make it sound as though it’s in a live, reverberant space. In this exercise, you’ll apply the 
Reverb plug-in to the A2 track and then test the different presets to find one that best fits 
the scene. Then, you’ll add the Echo plug-in and use the Swirling Close preset in 
combination with the Reverb to combine the effects. 
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1	 Select the A2 track, if necessary. 

2	 In the mixer, click the Add Effect button and choose Reverb > Fairlight FX > Reverb to 
add it to the track. 

The Reverb dialog controls are fairly self-explanatory because they’re based on the 
size of a simulated 3D room in which you can adjust the combination of the original 
signal (Direct), early reflections (ER), and late reverberations (Reverb). 

In the upper left of the dialog, the teal-colored 3D rectangle represents the room size. 
The graph to the right roughly visualizes (from left to right) the reverb’s effect on the 
audio signal. The controls at the bottom let you fine-tune the Reverb timing as well as 
the Early Reflection tone and Reverb tone. The controls in the lower right adjust the 
levels of the Direct signal (the white vertical line), Early reflections, and Reverb levels, 
as depicted on the graph in blue. 

Let’s start by listening to the first two presets since they provide a great way to see 
and hear the extreme differences between small and large spaces. 
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3	 Start looped playback. In the Reverb dialog, choose the Bathroom preset. Toggle the 
Bypass button off and on to hear the track with and without the Bathroom preset. 

Notice that the quick, reflective sounds from the Bathroom preset give the aural 
impression of a small space with highly reflective surfaces.

4	 Choose the Cathedral preset to hear the enormous-sounding space created by 
increasing the Reverb Time, Early Reflection tone, and Reverb tone. 

Notice that the size of the room displayed to the left correlates to the length of the 
reverb tail to the right. 
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5	 Try each of the different presets to hear the differences. 

6	 When you are finished testing different presets, choose the Vocal Width preset. 

7	 Continue playback and adjust the Output Dry/Wet setting to your preferred level. If 
you aren’t sure of a setting, try somewhere between 25 and 50%.

8	 Stop playback. 

The track is really coming together. Before adding the last effect, let’s take a minute to 
compare the original dialogue in A1 to the futzed dialogue in A2. This is a great time to 
use your new Shift-X shortcut to enable Exclusive Solo. 

9	 Press Shift-X or choose Fairlight > Exclusive Solo. 

10	 Unmute the A1 track. Click the Solo button on the A1 track. 

11	 Start looped playback and listen to the original clip. During playback, click the Solo 
button on the A2 track. Exclusive Solo unsolos the A1 track and solos only the A2 track. 
Continue listening and soloing one track and then the other as needed to fully 
appreciate the impact of your futzes. When you are finished, stop playback.

Impressive, right? There is one more thing you could add to the track to emphasize 
that the speakers are a distance away. A hint of echo combined with the reverb and 
other effects might work great. 

12	 Add the Echo plug-in to the A2 track and arrange the floating windows as needed so 
you can see both the Reverb and Echo controls.
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13	 Set the Echo panel preset to the TML Surf Scene preset you made earlier. 

14	 Start looped playback. Listen to the futzed dialogue with the added echo. 

15	 Toggle the Echo Bypass off and on to hear the before and after.

16	 Try other presets to see if something works better or modify the existing preset 
setting. Then, click the Add Preset button to open a dialogue to save a new version of 
the Echo preset. 

17	 When you are finished, stop playback and close the Reverb and Echo panels. 

Now that you have completed the futz track settings, you can save the entire effects chain 
as a preset. 

Saving and Applying Track 
Presets in the Presets Library
The Fairlight page in DaVinci Resolve includes a Presets Library that you can use to save 
track settings and apply them to another track, timeline, or project. In this exercise, you’ll 
save the settings from the A2 Futz 1 PA EXT track so you can apply them to another futz 
track to modify the settings for a different variation. Then, the next time you need a futz 
track in a project, you can start with one of your presets and modify it to fit the scene. If 
you save each variation as you go, you’ll eventually have a nice preset collection to work 
with on future projects. 
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1	 Choose Fairlight > Presets Library to open the Presets Library window.

You’ll see a list of tracks in the current timeline on the right and the “Filter by” 
dropdown menu on the left. 

2	 In the upper left of the Presets Library, click the “Filter by” dropdown menu to see the 
presets options. 

In the dropdown menu, you can save Equalizer, Dynamics, Plugins, and even Global 
Track, Global Bus, and Fairlight Configuration presets. In this exercise, you’ll save a 
Global Track Preset that includes all track parameters, such as volume, panning, track 
color, processing, and plug-ins. You’ll name the preset Futz 1 PA EXT, not because that 
is the track’s name, but because it describes the cumulative effect: a futz track for an 
exterior (outdoor) PA system. 

3	 Choose Global Track Presets.

4	 In the Presets Library tracks list, select the Futz…EXT track. 
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5	 Click the Save New button to open the Global Track Preset dialog. Click Create New. 

6	 Name the preset Futz 1 PA EXT and click OK.

The Futz 1 PA EXT global preset appears in the list to the left of the Presets Library. 
Now, you can apply that preset to any other track in this or any other timeline. Let’s 
create a new track and apply the preset to it for further futzing. 

7	 In the timeline, right-click the A2 track and choose Add Track > Mono. 

8	 In the Presets Library, select the Global Track Preset named Futz 1 PA EXT. Then select 
the Audio 3 track in the list. Click Apply.

As you can see in the mixer, all the settings are applied to the new track 
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9	 Close the Presets Library. 

As you can see, the Presets Library offers a powerful way to save and apply your track 
settings throughout the post-production process.

NOTE  In addition to using presets, you can also duplicate a track to copy all its 
settings to the duplicate track. To copy, paste, or delete specific track attributes 
such as plug-ins or EQ, you can use the Copy Attributes, Paste Attributes, and 
Delete Attributes options available in the track header’s right-click 
contextual menu. 

Modify and Save another Futz Preset
Good news! The clients love the sound you created for the exterior PA system for the TML 
scene. Now that you’ve applied your Futz 1 settings to the empty A3 track, this is a perfect 
opportunity to create and save a variation. You’ll start by dragging a copy of the clip in A2 
to the empty A3 track. Name the A3 track Futz 2. Solo the A3 track. Open the control 
windows for EQ and the plug-ins and modify the effects to taste to design the cumulative 
futz effect. When finished, save your new global track preset in the Presets Library. 
Have fun! 

Using Modulation to 
Transform Noise 
For creative sound design, such as transforming sounds into robotic voices, spaceship 
engines, helicopter blades, or ocean waves, the Modulation plug-in is your go-to Fairlight 
effect. If you enjoyed working with the other plug-ins, you’re in for a treat. 

In the following exercise, you’ll start with a timeline clip that already has effects processing 
applied to a noise clip, making it sound more like an ocean surf background sound that 
could be used in the TML surf scenes.

To save time, the noise clip that you recorded in Lesson 4 is already in the timeline. Rather 
than have you create this effect from scratch, you’ll see the steps that were already taken 
to create this effect. Don’t worry; you’ll get a chance to create your own waves from the 
noise effect soon. 
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1	 Open the 7 Sound Design Waves Start timeline. Show only the timeline, mixer, 
and Inspector.

This timeline includes five tracks. Track A1 contains a pink noise clip, just like the one 
you recorded in Lesson 4. The A2 track is the pink noise clip with various processing 
already applied. 

2	 Solo the A2 Waves Build track, if necessary. 

3	 Click the DIM button to lower playback levels by 15 dB. 

4	 Select the A2 track to highlight it in the mixer. Select the first clip in the A2 track to 
show its parameters in the Inspector. 

5	 Play the clips in the A2 track.

Are you feeling the “ocean” vibe during playback? Clearly, these clips underwent 
significant sound design upgrades, including a pitch change (-7), high- and low-pass 
filters to limit the frequency range, and a Modulation plug-in. Obviously, the sound 
isn’t a recording of waves with all the inherent nuances. However, it is a usable generic 
ocean filler atmospheric sound that could be added to a scene if needed. For example, 
if characters are inside their vehicle or a building near the beach, this sound could help 
sell the location. 

6	 Solo the A1 track to hear the original sound of the pink noise. 

7	 Solo the A2 track to hear only the affected sound. 

Now that you are familiar with the sound, let’s look at the Modulation plug-in controls to 
see what is actually happening under the hood. 
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Exploring the 4-in-1 Modulation Plug-In
Fairlight’s Modulation plug-in includes many of the controls that you may have used in 
other plug-ins. Plus, as the name suggests, it also has expanded modulation controls. In 
fact, the Modulation plug-in lets you apply modulation to four elements at once, including 
the frequency, amplitude, tone, and rotation between the left, center, and right channels. 
The Modulation plug-in includes an LFO (Low-Frequency Oscillator), a tool that generates a 
slow, repeating waveform to automatically vary a sound’s properties over time. Unlike 
regular audio signals, an LFO operates at very low frequencies (usually below 20 Hz), 
making it useful for adding movement, texture, and rhythmic variation to sounds.

If you’re wondering what that means, let’s look at the plug-in settings. For this example, 
you’ll experiment with the modulation on the A1 track. To save time, you’ll use the handy 
“Copy” and “Paste to Selected” options in the mixer’s right-click contextual menu. 

1	 Solo and select the A1 track. Make sure it is the only selected track.

2	 At the top of the mixer, right-click the A2 at the top of the channel strip and choose 
Copy from the shortcut menu. Right-click the A2 again and choose Paste to Selected. 

The Modulation plug-in and all other track settings from A2 are pasted on the selected 
A1 track. In this case, the only effect applied to the track was the plug-in. Pitch and EQ 
changes were applied to the clip. 
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3	 In the A1 Channels strip, click the Controls button on the Modulation plug-in to open 
the Modulation window. Reset the plug-in.

The colorful graph shows the original sound in teal and the modulated pattern from 
the LFO in blue. The parameters below the graph affect the LFO, which in turn affects 
the sound of the signal.

4	 Mark the clip in the A1 track and start looped playback to hear the default sound. In 
the Presets pop-up menu, choose Auto-Pan.

As you can see and hear, the Rotation parameters show that the oscillator is moving 
back and forth between the left and right channels. Let’s narrow the frequency range 
on the clip.

5	 Open the EQ window for the A1 track. Choose the “General – Telephone effect” preset. 
Press the Esc key to close the EQ window.
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6	 In the Modulation window, choose the Doppler preset to hear a Doppler effect applied 
to the signal.

If you’ve ever heard an emergency vehicle pass you with sirens wailing or watched an 
airplane fly overhead, you’ve experienced a real-world Doppler effect. It’s the 
perceived upward shift in frequency as a sound source approaches you and the 
downward shift in frequency as the source moves away from you. 

Just as in the real world, the Doppler preset applies the necessary change in pitch as 
the sound travels between channels. If this reminds you of the ocean waves sound, it 
should. This is the preset used to create the waves. 

Looking at the green modulation bars in the Modulation parameters, you can see that 
the Doppler effect preset requires modulation in all four of the control areas: 
Frequency, Amplitude, Filter, and Rotation. 
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7	 Apply each of the remaining presets to hear the default modulation effects on the 
noise signal. Some of the presets work much better on an actual audio signal, such as 
a voice or animal sound. 

Tremolo is a common effect used in music recording and stage performances that 
applies an oscillator to the amplitude (volume level). As you can hear with this modified 
noise clip, the Tremolo sounds like a fast-moving distant locomotive engine. However, 
with a few adjustments to the rate, it could easily sound like rotor blades. 

8	 Choose the Doppler preset. Stop playback. Close the Modulation window.

You’ll modify this to make your own wave sounds in a few minutes. Meanwhile, let’s go 
back to the A2 track, where you’ll use new techniques to duplicate the clip and bounce 
a version of a finished sound effect. 

Bouncing the Mix to a Track 
In Lesson 6, you bounced clip effects as a clip in a new layer. In this exercise, you’ll bounce 
the mix containing all the audible clip and track processing to the A3 track in the same 
timeline. This is a common audio mixing technique used to create stems and consolidate 
multiple tracks into a single clip. In this case, you’ll first mark the clips in A2 and duplicate 
them to make a longer sound effect. Then, you’ll bounce the play range to a new track. 

1	 Solo the A2 track. Unsolo the A1 track if necessary. 

2	 In the Timeline toolbar, click the Focus Mode button. 

3	 With the multi-tool, select the first clip in the A2 track. Shift-click the second clip to 
select both. 
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4	 Choose Edit > Duplicate Selection or press Shift-Command-D (macOS) or Shift-Ctrl-D 
(Windows).

5	 Duplicate the selection again until you have six clips back-to-back in the A2 track. 

6	 Shift-select the first clip in the A2 track to select all the consecutive clips. 

7	 Play the A2 track to hear the extended effect and verify that all plug-ins and processing 
are still working. 

8	 Choose Timeline > Bounce Mix to Track to open the Bounce Mix to Track dialog.

9	 In the dialog, in the Destination Track dropdown menu, choose the A3 
Bounced Wave Mix.

10	 The Bounce Mix to Track dialog shows that the Bus 1 output bus, named Bus 1, will be 
bounced to a new destination track.

TIP  Before you bounce a mix to a track, it’s a good idea to make sure that the 
appropriate tracks are soloed or muted. In this case, you are only bouncing 
the A2 track, so you want either the A1 track to be muted or the A2 track to 
be soloed.
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11	 Click OK. 

The new bounced clip appears in the A3 track and the selected bin in the media pool. 
Notice that the bounced clip in the timeline is exactly the length of the current 
play range. 

12	 Solo the A3 track to listen to the bounced sound effect. 

13	 Clear the play range. 

Your simulated ocean wave sound effect is finished and ready to use in any of your 
other timelines. 

Congratulations! You’ve created an original sound effect from a simple pink noise 
recording. Keep in mind that plug-ins are creative tools, and the more you use them, the 
easier they are to work with. That said, look at what you’ve accomplished so far in just one 
lesson. Impressive. 

NOTE  Atmospheric sounds are background noises that help create a sense of 
place, mood, and realism in a scene. They include natural sounds such as rain, 
wind, or birds; urban noises like traffic or distant chatter; and indoor ambiences 
like air conditioning hums or office murmurs. These sounds fill the silence 
between dialogue and effects, making scenes feel more immersive and believable 
in films, TV shows, video games, and podcasts.
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Design and Bounce a Wave
It’s time to take what you have learned and make your own wave sound effect. To simplify 
your efforts, you can duplicate the 7 Sound Design Waves Start timeline. Change the name 
of the duplicate timeline to your initials plus Waves. You can add new tracks to work with, 
copy and paste clips already in this timeline, or delete everything but the clip in the A1 
track. However you choose to tackle this challenge, it’s a good idea to clear all attributes 
from the A1 clip and track. Once it’s back to standard pink noise, you’re ready to proceed. 

To get started, choose File > Project Notes. Here, you’ll find a recipe to turn pink noise into 
ocean waves in under 5 minutes!
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Using Pitch and Time to Alter Sound 
Pitch and time are fundamental tools in sound design, allowing designers to manipulate 
audio creatively for storytelling and realism. As you discovered in the previous lesson, pitch 
shifting alters the frequency of a sound, making it higher or lower, which is often used to 
create character voices (for example, deepening a monster’s roar or raising the pitch for a 
chipmunk-like effect). It can also simulate size perception: lower pitches suggest larger 
objects, while higher pitches imply smaller ones. Time manipulation, including reversing a 
clip, time-stretching, and compression, changes the speed or duration of a sound without 
affecting its pitch (or vice versa). This is crucial for synchronizing dialogue, creating 
slow-motion effects, or extending an atmospheric element without altering its tonal 
qualities. By creatively adjusting pitch and time, sound designers can transform ordinary 
recordings into fantastical, exaggerated, or hyper-realistic sounds that enhance a scene’s 
emotional and narrative impact. 

Zombies, dinosaurs, aliens, and dragons are always popular in films and television, but 
recording these creatures live is neither practical nor possible. In this series of exercises, 
you’ll explore real-world sounds—such as dragging furniture, opening umbrellas, and 
human voices—and discover how pitch and time manipulation can transform everyday 
noises into dragon roars, wing flaps, and other fantastical effects.

First, you’ll restore a new project archive created specifically for this lesson.

1	 Open the Project Manager, right-click, and choose Restore Project Archive. Select R19 
Fairlight Book Media > R19 Fairlight Part 3 > Sound Design Original SFX Builds.dra. 
Click Open.

The project opens with the “Stool dragging on Slate Roar” timeline showing. This 
timeline is an experimental workspace for testing different common pitch and time 
techniques to transform the sound of a stool dragging on a slate floor into a 
dragon roar. 

2	 Hide all panels except the timeline, mixer, and Inspector. 
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3	 If necessary, turn on Exclusive Solo. Then Solo the A1 Original track. 

A glance at the waveforms in these tracks shows that the clips are loud, so it’s a good 
idea to either turn down the listening levels or DIM the monitoring controls. 

4	 DIM the monitoring controls if needed. 

5	 Play the clip in the A1 track to hear the original sound. 

Did you notice how the waveform at the end of the clip has a Jurassic predator, 
dragonesque roar? Incidentally, it was that same roaring barstool sound erupting from 
the kitchen that inspired further investigation into the draggin’ dragon possibilities. 

Reversing a Clip in the Timeline
One of the easiest and most common time-altering techniques is to reverse a clip. In the 
Fairlight page, you can reverse a clip in the timeline or the Inspector. In this exercise, you’ll 
duplicate the A1 track and reverse the clip using the right-click contextual menu. 

1	 Right-click the A1 track header and choose Duplicate Track.

2	 Change the name of the A2 track to Reversed. 

Why use such a literal track name? When experimenting with sound design techniques, 
it’s a good idea to label as you go. This helps you keep track of the changes and 
remember what you did when you revisit the timeline later. 

3	 Right-click the clip in the A2 Reversed track and choose Reverse Clip from the menu. 

4	 Solo and play the clip in the A2 track to hear the results. 

As expected, the reversed clip sounds like the opposite of the original clip. It’s 
interesting how the first “roar” sounds as good backward as it does forward. Perhaps 
combining the two versions would be a good idea. Let’s add that to the list of 
things to try. 
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Applying Speed Changes 
to a Clip in the Inspector
Previously, you reversed a clip with the Reverse Clip option in the right-click contextual 
menu. In this exercise, you’ll use the Speed Change controls in the Inspector to manipulate 
its direction, speed, pitch, and duration. To duplicate the clip, you’ll use the Option-drag 
method (Alt-drag for Windows) to simultaneously duplicate and move the duplicate clip to 
a new position. 

1	 Duplicate the A2 track. Keep the name Reversed Copy for now.

2	 Select the clip in the A3 track to show it in the Inspector. 

3	 In the Inspector Audio panel, click the Speed Change header to expand those controls. 

The Speed Change options include controls to change the Direction, Speed, Frames 
Per Second, and Duration of the selected clip. Two additional options are important for 
sound design: Ripple Timeline and Pitch Correction.

4	 Select the Ripple Timeline option.

Doing so changes the duration of the clip in the timeline. If you leave the Ripple 
Timeline option deselected, the clip retains its current length, but the waveforms 
reflect the speed change, and any additional material is included in the visible portion 
of the clip.
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NOTE  Since you are experimenting with this sound effect in a separate 
timeline, you don’t have to worry about affecting the other clips in the scene. 

The Direction controls include three icons that indicate the current direction: 
Forward, Reverse, or Freeze. Currently, the Freeze control is only used for video 
freeze-frame control.

Forward

Reverse

Freeze

5	 Locate the Reverse button (arrows pointing left), which indicates the clip has 
been reversed. 

Notice the Speed Change (speedometer) badge in the clip header, which indicates that 
the clip has a speed change. The same badge appears when using the Elastic Wave 
tool to change a clip’s speed. 

6	 In the Inspector, locate the Change Speed dial and field. This shows the speed 
is -100.00. 

7	 Click the Forward button (arrows pointing right) to return the clip to 100.00 speed. 

Any changes you make to the speed will be indicated as either positive or negative 
numbers, depending on whether the clip is playing forward or in reverse. 

8	 Drag the Speed % dial toward the right to lower the speed and increase the duration. 
Listen to the clip. 
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9	 Drag the Speed % dial toward the left to raise the speed and decrease the duration. 
Listen to the clip.

10	 Click the Reset arrow to the right of the Speed % dial to reset the clip’s speed to 100.00. 

Reset will also change the direction to 100.00 forward. 

11	 Click the Reverse button to reverse the clip again. 

That concludes your quick tour of the speed controls. 

Applying Pitch Changes to Clips
In the previous lesson, you applied pitch changes to the dad’s dialogue to lower his voice 
slightly. In this exercise, you’ll make much more dramatic pitch changes to the reversed clip 
in the A3 track. Specifically, you’ll lower the pitch by at least a full octave or more and listen 
to the result. 

1	 Mark the clip in the A3 track, if necessary. Then select the clip to show it in the Inspector. 

2	 In the Inspector, lower the pitch of the selected clip to -24 semitones, which is two 
full octaves. 

3	 Play the clip. 

Interesting. 

4	 Change the pitch to -12, which is only one octave lower than the original sound. Play 
the clip. Feel free to try different pitch settings. When you are finished, return the 
pitch to -12. 

The clip sounds better at -12. Interestingly enough, another section of the waveform 
sounds more promising when played in reverse and pitched down to -12. 

5	 With the Focus mode multi-tool, drag a selection around the last large waveform at the 
end of the reversed clip in A3. 
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6	 Play the selection. 

The beginning of that selection sounds great. Let’s copy it and paste it to a different 
track for experimentation. 

7	 Right-click the selection and choose Copy. 

8	 Add a Mono track at the bottom of the timeline. 

9	 Select the new A10 track and paste. 

The pasted clip appears in the same position as it was in the A3 track. The clip changes 
are the same for both A3 and A10, so let’s name the tracks accordingly. 

10	 Name the A10 track Spd-100 p-12 to indicate the changes applied to the clip in 
that track. 

11	 Copy the A10 track name. 

12	 Select the A3 track name and paste. 

Before moving on to the next timeline, take a moment to listen to the clips in the A4 
and A5 tracks. Based on the track names, you can see that the clips have a -12 pitch 
with a speed of -70 and 70, respectively. 

13	 Listen to the clips in the A4 and A5 tracks. 

You are now armed with the skills to change clip speed (time) and pitch as needed for 
creative sound design. Now, let’s look at a different example of using pitch to 
transform a clip. 
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Using Pitch to Change Human 
Voices into Dragon Vocals
In this exercise, you’ll work with a timeline containing the original recordings of three 
willing college film students attempting to record dragon sounds at the request of this 
author. Kathryn, Jack, and Vicente recorded these sounds in a podcast recording room 
along with their voiceover parts for the podcast intro. Let’s open the timeline and listen to 
some of their dragon vocals. Then, you’ll apply pitch changes to hear the dramatic results.

1	 In the media pool, locate the Dragon Roar and Vocals bin. 

2	 Open the Dragon Roar and Vocals timeline. Hide the media pool. 

3	 Show the mixer and Inspector.

Let’s start with the first track, which contains a long clip of Jack’s first attempt to roar 
with a lot of coaching (and laughs) from his companions. The blue clips at the end of 
the track are the best roars copied from the original clip and pasted into the 
same track.

4	 Solo the A1 track and play some of the first clip to hear the original recording session. 

As is, there is no hint of a dragon or dinosaur in the track. The sound is completely 
human, no matter how loud the vocalization.

To transform the clip, all you need to do is lower the pitch to its full extent of -24. 
Instead of applying the pitch change to the full clip at the beginning of the track, you’ll 
select and change all the blue clips at once. 

5	 In the A1 track, drag a selection that includes all four navy blue clips. 

The Inspector indicates that multiple clips have been selected.
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6	 Set the Pitch to -24 Semi Tones. Play the selected range.

Dragon! 

Just like that, the clips sound more like they are coming from a dragon or dinosaur 
than a human. Let’s try another track. This time, you’ll listen to Vicente’s dragon vocals 
on the A4 track. The orange clip near the beginning of the A4 track is a duplicate of the 
first clip in the track with the pitch changes already applied. 

7	 Solo the A4 track. Play the first two clips to hear the original sound, followed by the 
pitched -24 Semi Tones version.

If you liked that, you will love the next clip. 

8	 Play the third clip in the A4 track. 

9	 Select the clip and lower the pitch by -24 Semi Tones. 

10	 Play the pitched clip.

Once again, these vocals sound more like they are emitted from a lion or large-winged 
fire-breathing reptile than a human. 
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Doubling a Track to 
Thicken the Sound 
Another common sound design and mixing technique is to double a track to “thicken” or 
“fatten” the sound. Doubling a track involves duplicating the contents of one track into 
another track and adding effects to one or both tracks. The combination of the two tracks 
sounds thicker and richer than the original. This technique is commonly applied to 
instrument tracks and background vocals in music production, as well as to ethereal voices 
and sound effects in audio posts. In this exercise, you’ll work with dragon vocals that have 
been duplicated to two tracks and apply pitch changes and other effects to thicken the 
sound. First, let’s listen to a finished example in the A5 and A6 tracks. Then, you’ll apply 
different pitch changes to Kathryn’s dragon vocal clips in A7 and A8.

1	 Press Shift-X or choose Fairlight > Exclusive Solo to turn off that mode.

2	 Solo that A5 track. Play the first clip to hear Jack’s original recorded sound. 

The navy blue clip in the A5 track has been stretched and pitched. 

3	 Select the navy clip in the A5 track to see the settings in the Inspector. 

In the Inspector, you can see that the pitch is -20, and the speed has been slowed 
to 33.62. 
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4	 Play the navy clip in the A4 track to hear it with the changes. 

5	 Solo the A6 track, select the navy clip, and look at the Inspector settings. 

This version of the clip has the same speed but a different pitch of -24. 

6	 Turn off the DIM button in the monitoring controls so you can hear the thickened roar 
as intended. 

7	 Make sure that both A5 and A6 are soloed. 

8	 Play the navy clips in the A5 and A6 tracks. 

Awesome! The slight variation in pitch between the two tracks gives the sound more 
character than if you simply double the identical sound. Let’s try another!

9	 Solo only the A7 track. 

10	 Play the green clip.

This is Kathryn’s unaltered dragon vocal, where she opted to make unusual 
vocalization calls instead of roars. These are the types of sounds you hear in nature 
between animals of the same species. Let’s listen to the yellow clips, which are the 
doubled and pitched versions of the original sound.

11	 Solo the A8 track. 

12	 Play the yellow clips in the A7 and A8 tracks together to hear the doubled sound. 

Hmmm. This time, the doubled clips aren’t working together as a single sound because 
the pitch difference between them is too great. In this case, the yellow clip in A7 is 
pitched to -24 while the A8 clip is pitched to -6. 

13	 Change the pitch on both yellow clips so that one is -20 and the other -16. 

14	 Play the clips together to hear how they sound. 

Much better. Feel free to experiment with the pitch settings and clip levels for the 
doubled clips. 
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Creating a Front-to-Back Extended Sound
The last technique that you’ll explore in this timeline involves editing together a clip to the 
reversed version of itself to create an extended effect. As with the other techniques, you 
can create this type of effect in a few simple steps. For this exercise, you’ll work with the 
last navy clip on the A1 track.

1	 Solo only the A1 track. 

2	 Use the Focus mode multi-tool to select the last navy clip in the A1 track. 

3	 Zoom horizontally for a clear view of the selected clip.

4	 Choose Edit > Duplicate Selection or press Shift-Command-D (macOS) or Shift-Ctrl-D 
(Windows) to duplicate the clip.

5	 Select the duplicate clip and reverse it. Then, trim the inside edge of both clips to 
remove the last part of the first clip and the first part of the second clip to the loudest 
point in the waveform. 
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6	 Drag the two clips together to remove the gap between them. 

7	 Right-click the edit point between the first and second clip and choose Add 12 frame 
Crossfade. 

8	 Adjust the crossfade to taste. Play the clip.

It sounds great, but it just needs a pitch change.

9	 Select both clips and lower their pitch to -24 Semi Tones. 

10	 Play the final extended clip. 

Nice! Now all you need to do is bounce the final effect to a new layer.

11	 Drag a range around both clips in the extended clip effect. 

12	 Choose Timeline > Bounce Selected Tracks to New Layer.

A new green clip appears in a new layer above the navy clips. 
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13	 Drag the bounced clip down to the A2 track. 

14	 Solo the A2 track and listen to the finished clip. 

Now that is a great roar! And another original sound effect that you created right in the 
Fairlight page.

NOTE  The phrase doubling a track once referred to creating two versions of a 
track in tape-based music recording. However, when using digital audio 
workstations, you can make as many tracks as you need to thicken and enhance 
your sound. 

Analyzing Multilayered Sound Effects
You now have the basic editing and sound design skills necessary to start building 
multilayered sound effects. These effects aren’t more difficult to create; they just require 
more steps. Think of making multilayered sound effects like making a multilayered dessert, 
such as a birthday cake. To achieve this, several steps are required: mixing the batter, 
baking the cake, preparing the icing, assembling the cake, and decorating the finished 
dessert. When you build multilayered effects, you must gather sounds (ingredients), build 
each section and add effects, bounce elements to create a finished (baked) clip, and add 
final effects to create a polished result. Fortunately, you’ve already learned all the skills 
needed to create dynamic, layered effects. Now, it’s time to put them into practice. In this 
exercise, you’ll first analyze a completed multilayered dragon wing flap effect and then 
create your own version.

1	 In the media pool, select the Dragon Wings bin to see the associated timelines. 
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2	 Open the Original Dragon Wings Finished timeline.

This timeline includes the elements to create the flapping sound of dragon wings for 
the Post Park Normal podcast intro. Rather than walk you through the process from 
start to finish, let’s reverse the process and start at the end, working backward from 
the bounced clip in the A27 track.

NOTE  The timeline represents the author’s experimentation to record 
and create an original dragon wing flapping sound from everyday 
household items. 

3	 Solo the A27 Bnc DWF v1 track. Play the clip. 

4	 Increase the height of the A27 track and zoom as needed for a better view of the 
bounced clip. 
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In the clip’s waveform, you can see the individual flaps. You can also see that the flaps 
gradually get closer together and quieter over time, as if the dragon is picking up 
speed as it flies away. This clip is the clean effect, meaning the focus is on the flaps 
rather than additional sound design elements such as echo, reverb, and other effects.

5	 Unsolo the A27 track.

Now, let’s focus on the group of beige clips in A21 through A26. This will be a great 
opportunity to use the Smart Zoom shortcut you created at the beginning of 
the lesson.

6	 With the multi-tool, drag a selection around the beige clips in A21–A26. Press Shift-E to 
Smart Zoom the timeline selection. 

NOTE  From this point forward, you’ll simply be asked to Smart Zoom the 
selected clips.
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7	 While the tracks are selected, Option/Alt-click the Solo button on one of the selected 
tracks to solo all the selected tracks. 

8	 Deselect the clips and solo the A25 and A26 tracks. Play the clips in the soloed tracks. 

These are a combination of the best two flaps overlapping to create a more interesting 
flap sound. These were copied and pasted into a pattern, as shown, that was then 
bounced to the A27 track as the complete v1 sound effect. 

9	 Play the clips in the A23 and A24 tracks. 

These tracks were used for experimenting with the placement of the overlapping clips 
and the timing between flaps. The winning stack of clips was copied and pasted into 
the A25 and A26 tracks, trimmed, and duplicated to make a pattern. 

10	 Play the clips in the A21 and A21 Copy tracks. 

As you may have guessed, these were the best “takes” of the multilayered sounds that 
were bounced into a single stereo clip in A21 and then edited into two individual flap 
sounds in A22. 

Next, you’ll unsolo the beige tracks and solo the brown tracks. You could simply swipe 
the Solo buttons off and on as needed. However, this is also a great time to practice 
the “do to all” and “do to all selected” modified click maneuvers. You’ve used both 
modified click combinations in earlier lessons, and they will come in handy in the 
next lesson. 

11	 Option-Command-click (macOS) or Alt-Ctrl-click (Windows) one of the active Solo 
buttons to deselect all Solo buttons. 

12	 Select the brown tracks A15–A19. Option/Alt-click the Solo button on any of the 
selected tracks to turn them all on.

13	 Smart Zoom the brown clips or zoom as needed until you can clearly see the clips in 
the brown tracks. 

14	 Play the brown clips. 
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These clips represent the two best multilayered sounds, which were copied and moved 
to lower tracks from the stacked original recordings. Next, you’ll look and listen to the 
original recordings that make up the multilayered flap sound. 

15	 Solo only the green A9–A13 tracks. 

16	 Zoom as necessary to see the track headers and clips in the soloed tracks. 

These tracks are named after the recording source in the order that they were 
recorded. Starting from top to bottom:

	— A9 Umbrella Near is a recording of a large golf umbrella opening with the 
microphone placed outside the umbrella.

	— A10 Umbrella In is a recording of the same large umbrella opening with the 
microphone placed inside the umbrella when it opens. 

	— A11 Blow on mic near is a recording of the author blowing directly on the 
microphone. This was overblown and didn’t work, so the clip was disabled. 

	— A12 Blow on mic mid – This was the author blowing at the mic from a foot away. 
Most of these takes were also overblown, but there were a few keepers where the 
breath sound works to emulate the woosh of air caused by the movement of 
massive dragon wings. 

	— A13 Smack Canvas p-12 is exactly as the name suggests. It is the sound of 
smacking a taut canvas inversion table. The clip was also pitched lower by 
one octave (-12). 
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Cumulatively, aligned and played together, these clips create a pretty good dragon 
wing flap. With some added creative sound design, you could really transform these 
into something awesome. 

Notice the stack of clips near the middle of the tracks that have been separated from 
the rest. These two clip stacks are composed of cumulative clips that aligned perfectly 
to create a “flap” sound. 

NOTE  With the luxury of time and curiosity, you could manually pick and 
choose the best of each track and create your own series of flaps from the 
same recordings. 

17	 Select and play the two stacks of clips among the A9–A13 tracks to hear the first 
incarnation of the multilayered dragon flaps. 

18	 When you are finished, unsolo the tracks and clear the selection. 

What about the upper tracks, A2–A7? These were purely experimental. Tracks A2–A4 
feature tests using Eagle Wings sound effects from the Fairlight Sound Library. The 
verdict? Eagles might be majestic, but their wing sounds didn’t quite work for dragons. 
As for tracks A6 and A7—well, let’s just sum them up in one word: fail. The first attempt 
at creating dragon wing flaps involved recording the opening of a spring-loaded 
windshield sunshade. It seemed like a great idea at the time… but let’s just say the 
results were less than legendary. 
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Another Original Dragon Wing 
Flap Sound Effect
Now it’s your time to shine! Unleash your creativity, sound design skills, and dragon wing 
expertise to craft your very own dragon wing flapping sound effect. You have two options: 
work in this timeline with all the steps laid out for you or dive into the Original Dragon 
Wings v2 timeline, where the lower experimental tracks are empty. You’ll need to figure out 
the bouncing and layering on your own.

Whichever path you choose, experiment freely. Take your time—there’s no rush since this 
step is outside the guided lessons. The key is to learn as you go, discovering what works 
and what doesn’t. Try every idea, make as many versions as you like, and if inspiration 
strikes to record your own sounds from scratch, go for it! Sound design is an art form—
embrace the mess, explore new ideas, and, most of all, have fun!

Exploring Subtle Sound Design FX 
for a Music-Based Soundtrack
In this final sound design example, you’ll revisit the Fusion VFX project from Lesson 3, 
“Editing Sound Effects and Music.” This time, you’ll open the finished timeline, where all the 
new sound design effects are already in place. But don’t worry—you’ve already learned 
every technique used in this project!

First, you’ll explore the completed version, allowing you to select clips and analyze how 
they were created from the original sounds. Then, you’ll switch to an alternate timeline, 
where you can take your time selecting, editing, and applying sound design techniques to 
craft an amazing soundtrack. Your ultimate goal? Impress the clients and bring the video 
to life with sound!

1	 In the Project Manager, open your Fusion VFX v1 project. 

2	 In the media pool, locate the Lesson 7 bin and open the 7 Fusion VFX MP v1 timeline. 

3	 Hide the media pool. 

4	 Move the playhead to the beginning of the timeline. 

5	 Move the floating viewer to the right of the timeline clips. 
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6	 Play the timeline once and listen for the subtle sound design effects that were added 
to accentuate the 3D DaVinci Resolve logo onscreen. 

NOTE  If you prefer to watch the video in full screen, press Command-F 
(macOS) or Ctrl-F (Windows) to view the timeline in the full-screen 
Cinema Viewer. 

Everything you need to create your own sound effects for the marked sections of this 
timeline is located in the A2 and A3 tracks. These tracks are currently muted. The A2 
track is composed of music swells and risers recorded using Apple Logic Pro X. The A3 
Percussion and Drums track includes a variety of percussion and drone clips used in 
previous versions of this book. Consider these tracks as a grab-and-go buffet where 
you can pick and choose whichever sounds you want to try for the marked sections of 
this timeline and add effects and sound design as needed to accomplish your goals. 

Keep in mind the primary guidelines from the client: “The audience should feel the 
logo’s presence, especially when it enters and exits the frame. But do not take away 
from the song! Also, add some low-frequency energy to the green oval as it draws on 
and off so the audience feels its presence more than they hear it.” 

If you aren’t sure what those directions imply, listen to the timeline again to hear a 
version that the clients liked, giving it two thumbs up.
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The good news? You’ve reached the end of these action-packed sound design exercises! 
Now that you’ve explored the tools, techniques, and creative workflows, you’re ready to 
apply what you’ve learned to your own projects.

The bad news? Now that you know these common sound design techniques, you won’t be 
able to unhear them. Whether it’s in music, radio ads, TV shows, films, or even live theater, 
your ears will be tuned in like never before. But hey, knowledge is power! The ability to 
craft sound and emotionally connect with an audience is what makes sound design so 
exciting—and it’s exactly why we do what we do!

Lesson Review
1	 Which Fairlight page mode in the toolbar enables Smart Zoom selections and shortcut 

actions? (Choose all that apply.) 

a)	 Pointer mode 

b)	 Range mode 

c)	 Smart Selection mode

d)	 Focus mode

2	 Where in DaVinci Resolve can you create custom keyboard shortcuts for functions 
such as Smart Zoom?

a)	 Quick Keys menu option

b)	 Right-click Customize Keyboard shortcut menu

c)	 DaVinci Resolve > Keyboard Customization

d)	 Timeline > Keyboard Shortcuts 

e)	 None of the above

3	 True or False? The difference between Solo and Exclusive Solo is that you can listen to 
multiple soloed tracks, but only one track at a time when Exclusive Solo is enabled. 

4	 Which native Fairlight plug-in could be used to add depth to off-camera dialogue? 

a)	 Perspective 

b)	 Depthinator 

c)	 Dialogue Separator

d)	 Echo

e)	 Dialogue Depth Tracker



473Lesson 7  Using Fairlight FX and Processing for Creative Sound Design

5	 Where can you change the processing order between FX, EQ, and DY (Dynamics) 
per track?

a)	 Timeline Options menu

b)	 Mixer Options menu

c)	 Mixer 

d)	 Project Settings > Fairlight panel

6	 With the default DaVinci Resolve settings and shortcuts, how can you reverse a clip in 
the timeline? (Choose all that apply.)

a)	 Right-click and choose Reverse Clip

b)	 Inspector, Speed Change settings

c)	 Reverse Clip plug-in

d)	 Shift-R 

e)	 Option/Alt-right-click the clip in the timeline
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Answers
1	 d

2	 a

3	 True. You can listen to multiple soloed tracks, but only one track at a time when 
Exclusive Solo is enabled. 

4	 d

5	 b

6	 a, b
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DaVinci Resolve features the powerful Flex Bus bussing architecture, which is completely 
user-defined and offers unlimited signal flow possibilities. Older “legacy” projects use the 
more traditional Fixed bussing format consisting of mains, submixes, and auxiliary busses. 

In this lesson, you’ll take a hands-on tour of the Fairlight interface to explore a handful of 
useful Fairlight features, panels, and menu options designed to assist you with managing 
your tracks and signal flow as you prepare your project for mixing. 

Are Other Sound Mixers Working on the Same Project?
In large-scale Hollywood films and shows, several other mixing teams often work in 
parallel before the final mixing phase. Those mixers may include a dialogue mixer, mixers 
for ensemble pieces, and sound effects mixers. Like the re-recording mixer, their job is to 
balance and sweeten (enhance) the sound and levels of their respective tracks, narrowing 
them down to a few well-balanced tracks, submixes, or bounced submixes for the re-
recording mixer to blend with the other sound elements. 

Combining Mono Tracks as 
Multichannel Link Groups 
The first stop on your “Simplifying the Mix” tour is the Link Group dialog, where you can 
link multiple mono tracks as a single multichannel-formatted channel strip in the mixer. 
Likewise, you can also convert a multichannel clip in a multichannel track into a link group 
of separate mono tracks if that suits your mixing needs. For this exercise, you’ll revisit your 
Podcast Intro Combo project, for which the sound designer doubled the Birds track to 
increase the presence of bird ambience. Then, you’ll group the two mono tracks as a single 
stereo track in the mixer. If you’re wondering, “How does this simplify my mix? It’s just bird 
ambience. Why bother?” or “Would I ever need to do this?” stay tuned; your questions will 
be answered shortly. 
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1	 Open your Podcast Intro Combo project. Then open the Lesson 8, 8 Link Group and  
Track Groups timeline.

2	 Show the timeline, mixer, and monitoring panel. 

3	 Play the timeline once to hear all the tracks playing together.

Now, let’s focus on the background tracks, including the Birds and Ambience tracks.

4	 Zoom as needed for a clear view of the A15–A17 tracks. Solo the A15–A17 tracks.

5	 Play the soloed tracks. Listen to the birds. Where do they seem to be coming from?

NOTE  The A16 Birds track is a duplicate of the A15 Birds track. Both have a 
little low-shelf filtering in the clip EQ to minimize the low-frequency 
background noise. 
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6	 Select the A15 and A16 tracks and look at them in the mixer to see how they 
are panned. 

They are both panned to the center, just like the dialogue clips. This also anchors the 
sound of the birds to the center channel in multichannel speaker formats, such as 5.1, 
and creates the “phantom center” or illusion of the center in stereo. In other words, the 
sound of the birds is centered in front of the listener. Perhaps you’ve seen a row of 
birds neatly aligned on a telephone wire or rooftop but not aligned in a neat row or 
tight group in a fixed position in front of you at a park. This may work for one bird but 
not for multiple birds. How do you instantly spread out the bird sounds to fill the 
panoramic space? Link the tracks as a stereo link group. 

7	 Choose Fairlight > Link Group to open the Link Group dialog. 

The Link Group dialog displays buttons for all timeline tracks with the mono track 
buttons active and all other tracks disabled since they can’t be linked. 
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8	 In the Link Group dialog, select both Birds tracks and click Link.

The Birds buttons are combined to indicate that the two mono-channel tracks are now 
linked as a two-channel stereo track.

9	 Close the Link Group dialog. 

10	 Look at the linked Birds tracks in the timeline. 

The white bar to the left of the A15 and A16 tracks indicates they are linked, while 
L and R in the top right corner of the tracks show their channel assignment in the 
linked group. 

11	 Select one of the Birds tracks in the timeline to select both linked tracks. 

Once linked, the tracks act as a single two-channel track.
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12	 Look for the Birds tracks in the mixer and monitoring panel.

The Birds channel strip is stereo, and only the A15 channel number is showing, with the 
A16 channel missing from both the mixer and meters in the monitoring panel. Why? 
When mono tracks are linked, they play back as a multichannel track with a single-
channel strip, fader, and meter based on the first channel in the linked group.
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13	 Unsolo the A17 Ambience track.

14	 Start playback from the beginning to hear only the soloed birds. Where are the birds 
now? When you are finished, stop playback.

This time, the birds seem to be spread more evenly between the left and right channels in 
the stereo panoramic field. But the results aren’t making that big a difference in the 
soundscape. The only thing holding these birds to mediocre sonic status is that both 
channels are playing an identical clip. 

This is a good time for a quick detour from your Fairlight tour to the sound design “gift 
shop” to pick up a quick sound design souvenir that can be yours in just five easy steps. 

Slipping Audio in the Timeline
To create variation between the two bird clips, you could replace one of the channels with 
a different clip and edit it in, although this may take some time. Alternatively, you can use a 
simple keyboard shortcut to slip the audio within the clip earlier or later. This will offset the 
bird calls, making them sound like multiple birds calling and responding to each other 
across the park.

1	 With the Arrow tool, select the clip in the A15 Birds track. 

2	 Move the playhead to around the middle of the clip and press M to set a marker on the 
selected clip.

Why set a marker? So you can see how far you have slipped the clip audio. The marker 
isn’t necessary, but it is handy when working with low-level clips that lack prominent 
waveforms to use as a guide. 

3	 Choose Trim > Slip Audio to see the Slip Audio shortcuts. 
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4	 Hold Option/Alt while pressing the comma key numerous times to slip the sound in 
reverse. Keep an eye on the marker and the playhead. The marker will move toward 
the left as you slip the contents of the clip. Stop once the marker is at least 5 to 10 
seconds before the playhead. 

5	 Play the soloed Birds tracks again and listen to the birds. 

Where are the birds now? Everywhere! With just a few clicks, the birds now seem to be 
scattered all around the park, adding scale and realistic ambience to the soundtrack. 

TIP  The Slip Audio options in the Trim menu are a great way to nudge audio into 
sync after clips are edited in the timeline. 

Unlinking a Multichannel Group 
You can unlink the group at any time in the Link Group dialog. Tracks from unlinked 
groups retain the same panning, only as independent mono tracks. Although this step is 
unnecessary for the project, it’s good to see the results firsthand since you are learning 
about link groups in DaVinci Resolve. In this exercise, you’ll revisit the Link Group dialog 
and unlink the Birds tracks to hear them as independent mono tracks that retain their 
stereo panning. Once finished, you’ll relink the group to simplify mixing with a single fader 
control for both Birds tracks. 

1	 Open the Link Group dialog. 

2	 Choose Fairlight > Link Group.
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3	 In the Link Group dialog, select the linked Birds tracks. 

4	 Click Unlink and close the Link Group dialog. 

The Birds tracks in the mixer are panned to the far left and right, even though they are 
no longer linked. 

5	 Play the tracks to hear the birds. When finished, stop playback. 

There is no audible difference between the mono tracks panned left and right and the 
stereo-linked group. 

6	 Choose Fairlight > Link Group and link the Birds tracks again. Then, close the dialog. 

7	 Unsolo the Birds tracks. 

If there is no difference, why didn’t we just pan the mono tracks in the first place? The goal 
of this lesson is to explore methods of simplifying the mix. Having a single fader and meter 
to control the cumulative level of the birds is easier than having multiple faders. This would 
be true whether it is stereo or another standard format, such as 5.1 or 7.1. 

Working with Track Groups 
Track groups allow you to switch focus from individual tracks to grouped tracks, which can 
range from small, multilayered sound effects to large, multitrack submix groups, such as 
sound effects (FX). These groups are entirely user-defined and can be created either 
directly in the timeline or in the Groups panel on the Fairlight page of DaVinci Resolve.

In this exercise, you’ll continue working in the 8 Link Group and Track Groups timeline as 
you explore a track group for the dragon sound effects. Then, you’ll create larger groups 
for dialogue, sound effects, background sound effects, and music tracks within the 
timeline. For this exercise, you’ll use the default Pointer mode selection tool.

1	 If necessary, press A for the Pointer mode Arrow tool. 

2	 Hide the mixer and monitoring panel so only the timeline is showing. 
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3	 Unsolo the Birds tracks.

4	 In the interface toolbar at the top left of the Fairlight page, click the Groups button to 
show the Groups panel. 

The Groups panel was added to the Fairlight interface in DaVinci Resolve 19, offering 
easy access to create, select, modify, and control track groups. The default group, All, is 
the only group that includes all timeline tracks. The Dragon group (G1) is a user-
defined group created specifically for this timeline to quickly control all the 
tracks containing dragon sound effects, which constitute a single dragon encounter 
in the timeline. 

5	 Zoom as needed to clearly see track names and numbers for the green tracks at the 
bottom of the timeline and all the clips within those tracks. 

Now, let’s use the Dragon group to solo, copy, and paste another instance of the 
dragon sounds. 

6	 In the Groups panel, click the G1 ID button to activate the Dragon group.

Selecting the ID button for a group makes it active, and the button turns green to 
indicate its active state. Clicking the checkbox for a group selects all tracks within the 
group, making them easy to see in the timeline and mixer and allowing for easy access 
to “selected track” based shortcuts and modifications without needing to select all 
clips or tracks within the group manually. 
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7	 In the timeline, solo the A22 Wing Flaps track near the bottom of the timeline. 

All the tracks included in the Dragon group are soloed at the same time. 

8	 Play the timeline from the beginning of the clip in the Dragon Vocals 2 track, 
01:00:31:02.

These sounds all represent one vocally diverse dragon. Let’s say you want to copy and 
paste the same dragon effects at the end so the final roar coincides with the music 
fading out. As long as the Dragon group is active, you’ll be able to copy and paste the 
dragon without needing to drag a selection around all the clips. 

NOTE  When you select a clip in an active group, be aware that all clips in that 
group that are beneath the playhead are also selected. Additional clips may 
need to be selected independently. 

9	 Move the playhead to the end of the clip in the A19 Roar track. 

You’ll use the end of that clip to align a copy of the clips at the end of the timeline. 

10	 In the Wing Flaps track, drag a selection that includes both clips. 

Notice that any clips in the group tracks that align with the selected clips will also be 
selected at the same time. 



486Lesson 8  Simplifying the Mix with Groups, Busses, and Nested Timelines

11	 Choose Edit > Copy or use keyboard shortcuts to copy the selected clips. 

12	 Press the Down Arrow key to jump the playhead to the next edit point, along with the 
transparent copied clips. The next edit point should be the end of the helicopter clip in 
the A18 track. Once the playhead and transparent clips are aligned with the end of the 
helicopter clip, choose Edit > Paste or use keyboard shortcuts to paste the clips. 

13	 Unsolo any of the dragon group tracks to unsolo them all. 

14	 Play the timeline from the beginning of the helicopter clip in the A18 track. Listen to the 
double sets of dragon clips. 

Well? It sounds like the same dragon clips were pasted near each other. Let’s disable 
some of the dragon clips selectively to mute them. To regain independent control of 
the clips, you’ll need to deactivate the Dragon group. 
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15	 In the Groups panel, click the G1 ID button to deactivate the Dragon group. 

NOTE  If you are working with an extended keyboard, you can press 
Command (macOS) or Ctrl (Windows) plus a number keypad group number to 
activate or deactivate the group. Command (macOS) or Ctrl (Windows) plus 
number keypad 0 activates or deactivates the All group. Command (macOS) or 
Ctrl (Windows) plus number keypad * toggles off or on the Groups switch.

16	 In the timeline, select the first clip in the A19 Roar track and press D to disable the clip. 

17	 In the second stack of dragon sound effects, select all but the uppermost clip in the 
A19 Roar track.

18	 Press Option/Alt-L to play the section again from the previous starting point. 

That sounds much better! There’s just one more thing to do to fix the end of the Roar 
clip. You may have already thought of it on your own. 

19	 Extend the end of the Roar clip in the A19 track and add a slight fade out to the end 
of the clip. 

20	 Press Option/Alt-L to play the section again and listen to the ending roar in context. 

Excellent! You have successfully used a track group for editing. Best of all, the clients love 
the ending and are jubilant, with high fives and fist bumps all around. Next, you’ll use track 
groups to create larger submix groups. 
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Creating Track Groups for Mixing
Track groups are useful for mixing, allowing you to control all member tracks 
simultaneously. This includes fader movements, panning, send levels, automation, and 
adjustments to the mute, solo, and record arm buttons. However, plug-ins and processing 
controls are not affected by a track group. In this exercise, you’ll create four track groups: 
dialogue, sound effects, background sound effects, and music.

1	 Condense the track heights so you can easily see and select any tracks in the timeline. 

2	 Select the first seven tracks, including VO 1 through VO 7.

3	 Right-click the selected track headers and choose Create Group. 
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The Create Group dialog opens. At the top of the dialog, you can name the group and 
select which controls will apply to it. The lower half of the Create Group dialog includes 
a list of channels (tracks) added to the group on the right and all additional channels 
on the left. Arrows between the two lists allow you to add or remove selected 
channels. 

4	 Name the group VO. Click Save. 

A new G2 VO group appears in the Groups panel. Now, let’s make the FX track group. 
This time, you’ll create the initial group with some of the FX tracks, and then add more 
tracks to the group in the Create Group dialog. 

5	 In the timeline, select the next seven tracks, starting with Book FX and ending with 
Mower FX. 

6	 Right-click the selected track headers and choose Create Group. 

7	 In the Create Group dialog, name the group FX.

8	 Click Save. 

9	 The new FX group is added to the Groups list. To edit the group, hover to the right of 
the checkbox for the group to see the action icons, including a Tools button to access 
the Modify Groups dialog and a Trash can button to delete a group. 

10	 Hover to the right of the G3 FX group checkbox to see the action buttons. Click the 
Tools button to open the Modify Group dialog. 

The Modify Group dialog is identical to the Group dialog.
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11	 In the Modify Group dialog, scroll down the Add Channels column on the left. Drag a 
selection from Helicopter down to Wing Flaps to include all those tracks. Click the Add 
button (>) to add the selected tracks to the FX group. Click Save.

To check which tracks are included in a group, you only need to click the Selected 
checkbox for the group. Let’s try it. 

12	 In the Groups panel, click the G2 and G3 buttons to deactivate those groups. 

13	 Click the Selected checkbox for the VO group to select all the member tracks.

14	 Click the VO group checkbox again to deselect the tracks. 

15	 Click the FX checkbox to select the member tracks. Deselect the tracks. 

As you can see, creating a track group only takes a few seconds. You’ll use these groups to 
create submix busses shortly. What else can you do with the track groups? Many things, 
such as controlling all their faders at once, selecting all the member tracks to assign to 
busses, automating pan controls for all member tracks simultaneously, and so on. You’ll 
have the opportunity to use some of these mixing techniques in the next lesson. 

Create More Submix Track Groups
Now that you have two submix track groups, it’s time to create two more. Select the 
appropriate tracks and create submix track groups for bgFX and music. There is only one 
music track. Does it still need a group? Why not? That way, if additional music tracks are 
added later, there is already a group for them. Set up the track groups as follows:

	— bgFX group includes Birds and Ambience tracks. 

	— Music group includes the Music track. 

When you are finished, deactivate and deselect any active groups. 
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NOTE  If you didn’t complete the previous exercises, open the 8 Link Group  
and Track Groups Finished timeline.

Simplifying Mixing Using Busses
You already know how to balance individual clip levels, but if you have numerous similar 
tracks that are already balanced—such as dialogue, sound effects, or music—you can 
combine them and assign each of their output signals to a bus to create a submix. As the 
name suggests, a submix lets you independently mix a subset of the tracks. 

Submix busses are signal paths, or vehicles, that route the signal from multiple tracks to a 
new channel strip in which the sum of the signals can be controlled as a single track.

In this exercise, you’ll create submix busses for the dialogue, FX, background FX, and music 
tracks. It’s not a coincidence that these submix busses include the same tracks as the track 
group names. These are the standard submix groups used for mixing and controlling high 
track counts. 

To create new busses, you’ll use the Bus Format dialog available in the Fairlight menu. 

1	 In the Fairlight page, choose Fairlight > Bus Format to open the Bus Format dialog.

The Bus Format dialog shows that the timeline has only one stereo bus, aptly named 
Bus 1. This is the default output bus used to monitor and output the sound from all the 
tracks in the timeline. 

NOTE  The first bus in a timeline will automatically be assigned as the output 
for all current tracks and new tracks added to the project.

Let’s add four new busses to use for the submix groups. With the Fairlight Flex bus 
format, any bus can be used as an output, submix, or auxiliary bus, depending on its 
intended use to control signal flow. 



492Lesson 8  Simplifying the Mix with Groups, Busses, and Nested Timelines

2	 Click the Add Bus button four times to add four new busses to the list. 

The four new busses appear in the Bus Format dialog below Bus 1 and are sequentially 
named Bus 2, Bus 3, Bus 4, and Bus 5. These will be the new submix busses. 

Let’s name the sub-busses and change their formats and colors based on the tracks 
they will contain.

3	 In the Name column, double-click the Bus 1 name and enter Stereo. This will identify it 
as the stereo output, also referred to as the main bus. 

TIP  When naming consecutive tracks or busses, you can press Tab after you 
finish typing a name to select the Name field for the next track or bus. 

4	 Change the name of Bus 2 to DX, Bus 3 to FX, Bus 4 to bgFX, and Bus 5 to MX. 

All the submix busses should be stereo except the DX dialogue submix, which 
will be mono. 
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5	 In the Format column, change the format of the DX bus to Mono. 

Finally, let’s change the colors of each sub-bus. 

6	 In the Color column, change the DX bus color to yellow, FX to purple, bgFX to beige, 
and MX to green. 

7	 Click OK to close the Bus Format window.

NOTE  The channel format of each bus can be changed at any time in the Bus 
Format window.

The new sub-bus names and colors also appear in the mixer, meters, and bottom of 
the timeline as bus tracks. 

NOTE  Bus tracks only appear in the timeline when automation is enabled. 
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You are all set up with submix busses. The next step is to assign the tracks to go into 
those submixes.

TIP  To reduce the height of the mixer channel strips, you can use the Mixer 
Options menu (…) to deselect mixer controls that you don’t need to display, such as 
Track FX, Pan, EQ, and Dynamics, if you are merely assigning tracks to busses. 
Additionally, if you ever notice that controls are missing from the mixer, they have 
been hidden via the Mixer Options menu. 

NOTE  If you didn’t complete the previous exercises, open the timeline 
8a Groups Finished add Submix Busses. 

Assigning Tracks to Submix Busses
Now, you need to assign tracks to their respective busses. You can do this in two areas: the 
mixer and the Bus Assign window. For this exercise, you’ll use the mixer.

The middle section of the mixer displays Bus Sends, Bus Outputs, and the signal flow of 
each track so you can see where everything is assigned. Use the bus controls in the mixer 
to assign tracks to the new submix busses you created. For now, all tracks will remain 
assigned to the Bus 1 output. 

In DaVinci Resolve, routing audio to multiple busses is lossless, meaning you can assign 
tracks to multiple busses without quality loss. This provides more flexibility for mixing, 
monitoring, and final deliverables.

To complete this exercise, select similar tracks and assign them to their designated submix 
output bus. You can do this from the timeline, Tracks Index, mixer, or Groups panel. Let’s 
use the timeline to select the first track, and then use the mixer and Track Groups panel to 
select the tracks as needed while assigning busses.

TIP  You can expand or compact the mixer at any time by dragging its left edge. 
The busses are always visible to the right of the mixer. The busses section of the 
mixer can also be expanded by dragging the lower left edge. Also, with 
DaVinci Resolve, busses can be reordered and moved to any position in the 
timeline by simply dragging them up or down in the Tracks Index or by their name 
in the mixer. 
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1	 Press Shift-Z to fit all the timeline clips horizontally in the visible timeline.

2	 In the timeline, select the first track VO 1 Book to highlight its channel strip in 
the mixer. 

3	 In the Bus Outputs area of the A1 VO Book track, click the Add (+) button and choose 
DX from the pop-up menu. 

The Bus Outputs for the A1 track now include both Stereo (Bus 1) and DX (Bus 2) 
output busses. 

One track assigned, 22 tracks to go. Don’t worry; you won’t have to continue assigning 
individual tracks to busses. Instead, you’ll use the handy Option/Alt modified click 
method to “do to all selected” when assigning tracks. 

4	 In the mixer, drag across the fader area of the A2 through A7 tracks to select all five 
remaining dialogue tracks. 

These tracks need to be assigned to the Bus 2 DX bus output. 

5	 In the Bus Outputs area of the mixer, hold Option/Alt and click the Add button on one 
of the selected tracks. Continue holding the Option/Alt key as you select DX from the 
pop-up menu. 
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That was easy! The only thing that would simplify this process even more would be if 
you could instantly select all the submix tracks that you want to assign to submixes. 
Wait a second. You already set that up in the previous exercise when you created 
submix track groups. Let’s put them to use! 

6	 In the Groups panel, click the Selected checkbox for the FX group. 

Just like that, in a single click, all the FX submix group tracks are selected in the timeline 
and mixer. 

7	 Click the Add Bus button on one of the selected tracks in the mixer and hold Option/Alt 
while you choose the FX bus from the pop-up menu.

Voilà! The FX tracks have all been assigned. 

You’ve got the hang of this now. 

8	 Select and assign the Birds and Ambience tracks to the bgFX bus.

9	 Select and assign the Music track to the MX bus. 
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10	 When you are finished, deselect any selected track groups and hide the Groups panel. 

You have successfully assigned all 23 tracks to four submix busses to greatly simplify the 
mixing process. How is the process simplified? It’s much easier to balance the levels of four 
faders between the four submix groups instead of 23 individual faders. Then again, if you 
think 23 faders is a lot, wait until you see the timeline from the TML Reel 1 mix with more 
than 350 tracks! Even with that many tracks, a handful of submix busses makes it much 
more manageable to balance levels between the primary stem groups dialogue (DX), 
sound effects (FX), and music (MX). 

How do you know if the submix busses are working? No problem; you can selectively listen 
to any bus in the Control Room Monitoring dropdown menu in the monitoring controls. 

Monitoring Multiple Busses
In the monitoring panel, the Control Room settings let you determine which bus is 
currently audible in the Control Room during your mix. The default monitoring is set to the 
first bus in the project (Bus 1). In this case, it is the stereo output bus that you aptly named 
Stereo. To monitor a different bus, you simply choose from the menu to the left of the 
Mute button in the monitoring controls. 

In this exercise, you will change the Control Room monitoring to each of the different 
submix busses to hear their signal and verify that you assigned the correct tracks. How will 
you know? If dialogue is coming from the FX submix bus, or sound effects from the MX 
music submix bus, you’ll know there is an issue with your bus assignments. If a bus is 
silent, look at the timeline to see if there are any clips from that submix group beneath the 
playhead before troubleshooting the bus. 



498Lesson 8  Simplifying the Mix with Groups, Busses, and Nested Timelines

Keep in mind that your Control Room monitoring can be changed at any time.

1	 Below the viewer, in the Control Room monitoring dropdown menu, choose DX.

2	 Play the beginning of the timeline to monitor the DX submix bus. 

If you only hear dialogue, the DX submix bus is perfect. If there is an issue, fix it. 

3	 Continue playback and change the Control Room monitoring dropdown menu to FX.

This time, you should only hear sound effects. 

4	 Continue playback and check each of the remaining submix busses, bgFX and Music. 
When finished, stop playback. 

5	 When you are finished, set the Control Room monitoring dropdown menu to Stereo so 
you can monitor the Stereo bus. 

Whether you want to monitor your full mix or select tracks in a submix group, the 
monitoring controls offer easy access to listen to whatever track combination you need 
while you work. 

NOTE  The Monitor column in the Tracks Index provides a checkbox for each 
timeline track. If selected, that track appears in the Control Room monitoring 
dropdown menu so it can be selected for monitoring during playback. This is 
useful when working with reference tracks, scratch voiceover recordings, test 
mixes, and other track elements that you may want to quickly reference and 
monitor during playback.
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Deleting Unnecessary Bus Assignments
Based on your recent tests monitoring the different busses, all are working according to 
plan. There is just one issue. If you were to render only one bus as a finished mix, which 
would it be? Naturally, you’d think the Stereo output bus would be perfect. After all, it has 
every track assigned to it; what could be better? The submix busses were created to 
carefully adjust and balance the levels of the different stem categories, dialogue, fx, and 
music. However, in the current bus assignments, the main bus never plays the output of 
any of the submix busses. So it doesn’t matter how skillfully you automate their levels in 
the mix if the audience only ever hears the unmixed track levels currently assigned to the 
Stereo bus. Do you understand the issue now? Luckily, it only takes a few modified clicks to 
quickly update the bus assignments so the tracks only go to their corresponding submix 
bus, and the submixes are the only signal going to the Stereo output bus. Let’s do this!

1	 Show the Groups panel. 

2	 In the Groups panel, click the Selected checkbox for the All group. 

All tracks are selected in the timeline and mixer. 

3	 Hold Option/Alt as you click the right side of any of the Stereo bus tiles in the mixer and 
choose Remove Bus Output from the pop-up menu. 
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So long, Stereo output bus. With that one modified click, the tracks are no longer 
assigned to the Stereo output bus. 

4	 Start playback from the beginning to hear the stereo output bus, which currently has 
nothing assigned to it, so it should be silent. 

Next, you’ll assign each of the submix busses to the Stereo bus. This can be done with 
one modified click! 

5	 Extend the bus section of the mixer until you can see all five busses. 

6	 In the mixer, select all four submix busses. Option/Alt-click the Add Bus button and 
choose Stereo from the pop-up menu.

Done! Who knew assigning busses could be this easy? Imagine the not-so-distant past 
when channels had to be manually patched with cables and hardware, and the only 
mouse in the studio was an uninvited rodent. Before you move along to the next stop 
in the “Simplifying the Mix” tour, let’s take a minute to test the bus monitoring again.

7	 Hide the Groups panel. 

8	 Start playback from the beginning of the timeline. During playback, check each of the 
different busses in the Control Room monitoring pop-up menu. You should hear all the 
tracks as intended. If not, check the signal flow and try again!

9	 When you are finished, stop playback. Set the pop-up menu to the Stereo bus. 

You have successfully assigned tracks to a submix bus, and you can see the signal flow 
easily in the mixer.
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TIP  When you’re finished, it’s a good idea to always reset the Control Room 
monitoring to the main output—in this case, the Stereo bus. Also, when 
troubleshooting the signal flow of a “silent” track, examine the track’s Bus Output 
and make sure that it has an output bus. If it has an output bus other than the 
main output bus used for playback and monitoring, make sure that the assigned 
output bus is connected to the main output bus. 

Viewing Bus Mapping in 
the Bus Assign Window
Now that you’ve assigned all the busses and confirmed that they work in playback, let’s 
look at the Bus Assign Window, which clearly displays the timeline’s tracks and bus 
assignments in both Thumbnail and List views. 

The Bus Assign window has two sections. At the top of the window, you’ll find a list of all 
available busses. The rest of the window shows the available tracks. In the Available Tracks 
area, initials under each track name indicate the current assignment for each track. 

When working with a project in the Flex Bus format, all busses can be assigned as a Send 
and/or Output. The lowercase initial “s” followed by the bus number and name indicates 
that the track or bus is assigned to a Bus Send, while a lowercase initial “o” followed by the 
bus number and name means it is assigned to an Output Bus. You’ll work with bus sends in 
the next exercise when you create an auxiliary bus. 

1	 Choose Fairlight > Bus Assign to open the Bus Assign window. 
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At a glance, the Bus Assign window tells the entire story of how the tracks and busses 
are assigned. Bus assignments are shown below each track name in the lower section. 
Let’s review the bus assignments in List view. 

2	 In the upper right corner of the Bus Assign window, click the List View button.

In List view, you can clearly see the Source, Bus Sends, and Bus Outputs. 

3	 Scroll down to the bottom of the List view to see the busses. 

Here, you can clearly see that each submix bus is assigned to the B1 (Bus 1) Stereo bus. 
However, the Stereo bus is not assigned to any other bus because it is an output bus. 
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4	 Close the Bus Assign window. 

All the tracks are assigned to a submix bus, which in turn are all assigned to the Stereo 
output bus. 

NOTE  The Bus Assign window can be used to assign and unassign tracks and 
busses. For more information about using the Bus Assign window, refer to that 
section of the DaVinci Resolve Reference Manual, available via the Help menu. 

Working with Busses in the Mixer
Now that you’ve verified that the signal flow is working for all the tracks, let’s take a minute 
to test-drive the new submix bus faders in the mixer. In this exercise, you’ll play some or all 
of the timeline and use the submix bus faders to raise or lower the levels of the dialogue 
(DX), sound effects (FX), background sound effects (bgFX), and music (MX) during playback. 
First, you’ll reset the UI layout and change the mixer to Single Mixer view so there is no 
separation between the tracks and busses in the mixer and tracks index. This makes it 
easier to scroll to see the busses in the timeline. 

NOTE  If you didn’t complete the previous exercises, open the timeline 
8b Groups and Submix Busses Finished.

1	 Choose Workspace > Reset UI Layout to reset the Fairlight page to the default layout. 

2	 In the Mixer Options menu (…), choose the Single Mixer View option.
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3	 Extend the mixer as far to the left as possible. Scroll to the end of the mixer to see the 
channel strips for the last tracks and all the busses. If you are working with dual 
monitors, the mixer and monitor will extend across the entire second monitor. 

Notice there is no longer any separation between the tracks and busses in the mixer 
and monitoring panel. 

4	 Press Shift-Z to fit all the timeline clips horizontally in the visible timeline.

5	 Play the timeline from the beginning and listen to the current mix. 

The mix should still sound pretty good. You haven’t actually changed any of the levels; 
you’ve just altered the way you will control them. Keep in mind that you can always 
adjust clip levels within a track or the levels of individual tracks if needed. 

6	 Start playback and try adjusting the levels of the FX and bgFX busses on the fly while 
you listen to the results. When you are finished, stop playback. 
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Now you know why submixes are a mixer’s best friend. It is much easier to move one 
fader that lowers multiple tracks than to manually lower multiple separate faders on 
the fly. You’ll get a chance to record mix automation as you change track levels in 
the next lesson. 

TIP  You can control multiple selected faders at the same time with the mouse 
pointer by employing the Option/Alt modifier as you drag the selected faders. 

Creating an Auxiliary Echo Bus 
Previously, you applied plug-ins to individual clips and tracks. What would you do if you had 
multiple tracks that needed the same effect at the same time? Instead of adding the same 
plug-in to every track, you can simply send the tracks to the plug-in via an auxiliary (Aux) 
bus. Doing so saves processing and time. Auxiliary busses are often used to add reverb to 
similar elements in a scene, futz effects, or in this case, Echo. 

In this exercise, you’ll create an auxiliary bus for the Fairlight FX Echo plug-in and send the 
dialogue tracks where characters are yelling from a distance to the Aux bus to add echo.

1	 Open your TML Audio Post project. Then open the 8 Surf Add Aux Echo timeline. 

This version of the timeline includes standard submix busses. Your goal will be to add 
one more bus that will be used as the auxiliary Echo bus instead of adding echo 
directly to individual tracks.



506Lesson 8  Simplifying the Mix with Groups, Busses, and Nested Timelines

Auxiliary busses have several advantages over applying effects directly to tracks, such 
as shared processing, applying effects with a wider channel format like stereo, and 
simple fader control of the effect amount as it is applied to tracks during playback. 

2	 Play the first half of the timeline until you’ve heard Raina’s yelling offscreen with the 
Echo effect. 

The Echo effect still works fairly well, but it is an echo applied to a mono track, so you 
can’t achieve the same expansive sound as you can on a stereo bus. Plus, you’ll have 
greater control to apply it to this track and others if needed by sending the track to an 
auxiliary bus with the effect instead. Let’s turn off the Echo effect on the track and 
create the new bus.

3	 In the mixer, hover over the left side of the Echo effect in the A6 channel strip to see 
the red Bypass button. Click the Bypass button to turn off the Echo effect.

4	 Choose Fairlight > Bus Format to open the Bus Format window.

The project currently contains five busses: Stereo output bus, DX, FX, bgFX, and MX 
submix busses. 

5	 Click the Add Bus button to add a new bus to the list. Bus 6 will be used as an auxiliary 
bus for the Echo effect.
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The new Bus 6 appears below MX in the Bus Format pane.

Let’s rename the bus and change its color. You’ll also want to ensure that the DX Echo 
bus format is set to Stereo. 

Wait. Why stereo if all the dialogue tracks are mono? Great question! You are applying 
an Echo effect to dialogue to create a sense of space. Stereo effects such as echo, 
delay, or reverb are intended to blend the dialogue into the environment naturally, 
making it easier to place within a stereo or surround sound mix. 

NOTE  It’s a good idea to use a different Aux bus for FX tracks to keep the 
elements separate for mixing and removing all dialogue if needed for dubbing 
and localization. 

6	 In the Name column, double-click the Bus 6 name and enter DX Echo.

7	 Set the Format to Stereo and the color to yellow. 
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8	 Click OK to close the Bus Format window. Expand and scroll the mixer as needed to 
see the new Echo Bus to the right of the MX bus. Notice that the new bus, labeled DX 
Echo, is also located to the right of the MX bus in the monitoring panel. 

You are all set up with the Aux bus. The next step is to add the Echo plug-in. 

9	 In the mixer, on the DX Echo bus, click the Add Effect button and choose Delay > 
Fairlight FX > Echo.

The Echo window opens, and the Echo plug-in appears in the Bus6 effects slot. 

10	 In the Echo window, in the Presets pop-up menu, choose the TML Surf Scene preset 
you made in Lesson 7. 

NOTE  If you did not make a preset in the previous lesson, use the Large Hall 
preset for now. 
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11	 Close the Echo window.

Don’t worry if the Echo preset is too intense for the scene; it will work fine for 
demonstrating the auxiliary Echo bus. You’ll change the Echo settings later.

Since this Aux bus is specifically for adding echo to dialogue tracks, let’s move the DX 
Echo bus to the left of the dialogue tracks in the mixer. This won’t change the sound or 
the processing order, but it will keep the bus near its constituent tracks.

12	 In the mixer, click the DX Echo bus’s name and then drag the DX Echo channel strip 
toward the left to the first track position in the mixer before the dialogue tracks. 

The DX Echo is in its new position in the mixer and monitoring panel. 

The last step is to send the signal from the tracks to the Aux bus. 

NOTE  A yellow track or bus name indicates that it is the most recently selected 
track or bus. 
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Sending Track Signals to the Auxiliary Bus 
Currently, the auxiliary DX Echo bus is configured with the Echo plug-in ready to use, but 
you still need to send the signal from the tracks to the bus. This is one of those times when 
audio mixing terms and functions are interchangeable. That’s right, you are about to 
employ the use of sends to do exactly what their name implies. If you look closely at the 
mixer, you’ll find the Bus Sends between the EQ and Pan controls. 

1	 Select the A6 DX r5 30L track to highlight it in the mixer.

2	 In the mixer, in the A6 channel strip, click the Bus Sends Add (+) button and choose DX 
Echo from the pop-up menu. 

The DX Echo bus is now in the Bus Sends list along with all busses that are not already 
assigned to the track. If you hover over the bus name, you can access the Bypass, 
Controls, and Delete buttons for the DX Echo bus. 
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3	 Hover the pointer over the DX Echo and click the Controls button to open the Bus 
Sends – DX r5 30L window. 

The Bus Send is already on. The Send Level adjusts the amount of signal sent from the 
track to the bus.

4	 Double-click the Send Level handle or drag the Send Level handle to 0.0 to send the 
full signal to the DX Echo bus. 

NOTE  The send level is also visible as a colored bar beneath the Bus name in 
the Bus Sends area of the channel strip. Bus names in the mixer match their 
user-defined color in the Bus Format window. You change the bus color in 
either the Bus Format window or Tracks Index. For this lesson, all dialogue 
busses are yellow regardless of the track colors that were used to differentiate 
between different characters. 

5	 Play the set of clips in the A6 DX r5 track with the auxiliary bus Echo effect applied. 

Hold on. There is no Echo? Why? We forgot to plug it in. That is, in terms of audio signal 
flow, the signal may be routed from track to track, track to bus, bus to track, bus to 
bus, or all these options as long as it eventually reaches an output bus if you want to 
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hear it. In this timeline, all tracks are assigned to the Stereo output bus, as you can 
clearly see in the mixer. The DX Echo bus still needs to be assigned to the output bus. 

6	 In the mixer, in the Bus Outputs area of the DX Echo bus, click the Add (+) button and 
choose Stereo from the pop-up menu.
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You should now be able to hear the A6 track with the echo effect. 

7	 Solo the A6 track and play the set of clips in that track.

Wow! That’s a whole lot of echo, and not in a good way. Why does it sound so 
different from the echo with the same settings from the previous lesson? One word: 
stereo. Time-based effects like echo, delay, and reverb are designed to create the 
illusion of space. 

Don’t worry; the settings can easily be adjusted to rein in the effect so it works better 
for this scene. 

The last step is to use the fader on the Bus 2 VERB bus in the mixer to raise or lower 
the amount of reverb applied to the sends. This is a fantastic way to control effects on 
multiple tracks over time. Keep in mind that any changes you make to the auxiliary bus 
levels will apply to all the incoming sends. If you want to vary the amount of the effect 
on a specific track, lower the Send Level on that track’s send. 

Customizing Auxiliary Bus Effects Parameters
Now that you’ve heard the over-the-top stereo TML Surf Scene Echo preset with the tracks, 
let’s make some quick changes to rein in the effect and save it as a new preset. To 
customize an effect-applied bus, you just hover your mouse pointer over the effect in the 
mixer and click the Controls button to open the corresponding plug-in window. 

1	 In the mixer, hover the mouse pointer over the Echo effect in the Bus 6 DX Echo bus 
and click the Controls button to open the plug-in controls window.

2	 In the DX Echo controls window, continue using the TML Surf Scene preset. If you don’t 
have that preset, use the Large Hall preset instead. 

3	 Locate the Input Format dropdown menu in the upper right of the window. Change 
the Input Format from Stereo to Mono since the dialogue track being sent to the 
bus is mono. 
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4	 Using the image below as a guide, make the necessary changes to the Echo controls. 
Once finished, solo the A6 DX r5 30L track and play the first set of clips to hear them 
with the new settings.

Now that is a much better echo! Let’s save it as a preset so it can be used again later 
if needed.

5	 In the upper left corner of the Echo controls window, click the Add button. In the Echo 
preset dialog, click Create New. Name the preset TML Surf Scene v2. 

6	 Close the Echo controls window. 

7	 Unsolo the A6 track. 
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8	 Play the scene from the beginning to hear how it sounds with the echo applied to 
Raina’s r5 track when she shouts from the beach to Harper. 

9	 Play the scene again, starting with the pink clips in the A2 track. This time, while Raina 
is shouting offscreen, adjust the fader level for the DX Echo Aux bus to increase or 
decrease the amount of echo during playback. When finished testing the fader-driven 
Aux bus, double-click the fader to reset it to its default position (unity). 

Nice echo! This time, it totally works with the scene. Did you notice how easy it is to use 
the fader to control the echo on the track during playback? Welcome to bussing and 
the power of the Aux bus. Let’s add another track.

Send Another Track to the DX Echo Bus
Now that you have successfully sent a track to an Aux bus and seen how well it works to 
apply a custom effect, let’s send another track. In this self-guided exercise, you’ll send 
Harper’s track to the DX Echo bus as well. In this timeline, Harper has only one brief 
exchange of dialogue at the end, and she is shouting to her friends back on shore. 
Although she is closer to the camera, her sheer volume level and the fact that she is 
surrounded by reflective water means her sound would likely have a bit of echo too. 

Your goal is to send her track to the DX Echo bus. Use the A6 track as a guide to make sure 
you are assigning it correctly. And for fun, during playback, use the fader to find a good DX 
Echo level for Raina during her yelling clips, and then find a different fader level for 
Harper’s clips when she pops up out of the water and bellows, “Did you get it?” 
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Your motivation is that once you can find levels on the DX Echo fader that you like for each 
section, you’ll realize that you could easily automate those levels to fit this scene and many 
other scenes during a mix. Trust your ears and have fun! 

Of course, increasing the Echo effect on a track may also increase the track level, so 
you’ll also need to watch the track levels along the way. You’ll focus more on mixing in 
the next lesson.

NOTE  If you didn’t complete these exercises but would like to see and hear a 
finished version of the timeline with the busses and DX Echo Aux bus applied, 
open the 8 Surf Aux Echo Finished timeline. You’ll notice that some EQ 
adjustments were made to Raina’s A6 track to simulate the loss of high frequencies 
in her vocals, reflecting her offscreen distance from the camera.
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Working with Nested Timelines
Nested timelines are a powerful tool for combining elements from different timelines. In 
the next set of exercises, you’ll explore two practical ways to use nested timelines in 
everyday workflows.

In Lesson 3, “Editing Sound Effects and Music,” you used a nested timeline to transfer an 
edited music timeline into a separate timeline containing only a picture. Now, you’ll apply 
nested timelines in two different projects.

First, in the TML Audio Post project, you’ll add an FX timeline containing all the sound 
effects elements to the master timeline, which already includes dialogue and music. Then, 
in the Fusion VFX project, you’ll move a music mix with over a hundred tracks and 
instrument parts into the Fusion VFX timeline, allowing the composer and clients to 
collaborate on finalizing the mix.

Moving an FX Timeline into a Master Timeline
This first example involves using nested timelines to move a pre-mixed sound effects 
timeline into a master timeline that already contains the dialogue and music tracks. Often, 
on large shows, there will be separate dialogue, sound effects, and music mixers working 
on separate mixes for their designated elements. These pre-mixes can include clip 
keyframes, plug-ins, track automation, and bussing specific to that timeline. To combine 
the elements of different timelines, you can use nested timelines to move the entire 
timeline into a master timeline and then decompose. This time, you’ll move a simple FX 
timeline complete with sound effects-specific busses to a master timeline and then 
decompose to add it to the mix in progress.

1	 Open the 8c FX premix timeline. 

As you can see, this timeline has one stereo bus, named FX. 
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2	 Play the timeline once to hear the sound effects for the scene without any dialogue 
or music. 

A sound effects editor worked on crafting this version of the timeline, while the 
dialogue editor performed a checkerboard edit, recorded ADR, and edited the final 
version of the dialogue edit. 

Let’s open the dialogue edit. 

3	 Open the 8 Dad and Harper Add FX timeline. 

At a glance, you can see in the timeline, mixer, and meters that this timeline has 
dialogue, music tracks, and busses but no FX busses. The only FX track is the PFX 1, 
which has been edited out of the original dialogue. Those clips have been disabled, 
and the track has no output bus. 

There are many tracks with disabled clips that don’t need to be visible. Before 
combining the timelines, let’s hide the unnecessary tracks. 

4	 In the Tracks Index, turn off visibility (eye icon) for tracks A1 through A6. Hide the A10 
track as well. 
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5	 Hide the Index. 

Now, it’s time to combine these timelines. In this exercise, you’ll add the FX premix 
timeline to the empty FX track in the master timeline. Then, you’ll decompose the 
nested FX timeline to reveal all the tracks, clips, and busses. 

6	 In the timeline, select the A11 FX track. Move the playhead to the beginning of 
the timeline.

You can drag a timeline from the media pool into another timeline or insert it using 
timecode if the two timelines have matching timecode. In this case, both timelines are 
duplicates of the same timeline from editorial, so the timecode will be the same.

7	 In the media pool, right-click the 8c FX premix timeline and choose Insert Selected 
Clips to Timeline Using Timecode. 

The nested 8c FX premix timeline appears in the A11 FX track. 

8	 Hide the media pool. Solo the A11 FX track, start playback, and listen for the sound 
effects in the nest. Feel free to unsolo the track and listen to the entire timeline with 
the nested timeline contributing to the FX during playback.
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Now, let’s decompose it and add the FX bus to the busses already in the master 
timeline. 

9	 In the A11 FX track, right-click the nested timeline and choose Decompose in Place > 
Preserving Audio Data.

10	 In the Decompose Preserving Audio Data dialog, set the Routing to New Matching 
Busses. Click Decompose. 

The FX premix timeline is added to the master timeline, including effects, processing, 
automation, and bussing. In this case, there were three busses originally named FX, 
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bgFX, and Stereo. They were incorporated into the master timeline and tagged with 
the name of the track the nest was decomposed in. Now, a new FX-FX bus has been 
added to the master timeline. Why FX-FX? When you decompose a timeline using the 
New Matching Busses option, matching busses from the nested timeline are added 
and appended with the track name the nest was opened in. This is handy for keeping 
track of busses coming in from other mixes. 

11	 Expand the mixer if necessary to see the FX-FX bus. 

The timeline is set up with busses and ready to mix!

Although this is a very simple nested timeline example, it should give you a glimpse of the 
possibilities for collaborative audio workflows and moving mixes from one timeline 
to another. 

Nesting and Decomposing a Music Mix 
Let’s look at nesting a more complex timeline with over 100 tracks. In this exercise, you’ll 
return to the Fusion VFX project, where you’ll open a mix-in-progress version of the music 
with all the instrument parts and music elements in one timeline. Then, you’ll nest it in a 
version of the VFX timeline with the video to quickly add all the tracks and processing to 
the master timeline. 

1	 Open your Fusion VFX v1 project. Then open the timeline 
8 Fusion VFX add Music Mix. 

The familiar timeline opens with the Fusion VFX video and the edited music with 
crossfades in the A1 track.
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You’ll add the timeline with the full music mix to the A2 track. First, let’s look at the 
other timeline. 

2	 Open the timeline 8 Circles for VFX v2 full. 

This timeline includes the intro and outro of the song “Circles,” which is edited from the 
full song to match the version you edited in the Fusion VFX timeline in Lesson 3. 

NOTE  The crossfade between music sections was applied to all tracks at once 
by selecting a range that included a few seconds on either side of the split 
between sections and all tracks. Then, a crossfade was applied to the selection 
range via the Batch Fades window in the Fairlight menu. 

You’ll find many of the different tools and workflows that you’ve learned throughout 
this book in this timeline. For this lesson, your goal is to edit this timeline as a nest into 
the VFX timeline and decompose it to bring the full mix into that project. However, you 
can always come back to this timeline to play (literally and figuratively) on your own. 

Let’s take a quick tour before nesting the timeline. 

In the monitoring panel across the top of the screen, you’ll see meters for 112 tracks. 
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3	 Double-click the meters in the monitoring to stack the meters in two rows. 

NOTE  You can double-click the meters to toggle between single-row and dual-
row meters. This option is also available via a right-click menu in the meters. 

4	 Show the Groups panel to see the track groups that were added for mixing. Hide the 
Groups panel.
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In the timeline, you’ll see that the tracks are colored based on types of instruments 
or effects. 

In the mixer, you’ll see that the tracks are panned front and back, as well as left and 
right, to fill the panoramic field for a 5.1 mix. There has also been EQ applied to many 
of the tracks.

Now, let’s proceed with the nesting exercise. First, you’ll need to mark an In point to 
set the start of the nested timeline so that it is in sync with the music in the 
other timeline.

5	 Move the playhead to the blue marker in the timeline and mark an In point. 

Setting an In point here will automatically set an Out point at the end of the last clip in 
the timeline. 

6	 Show the media pool. Open the 8 Fusion VFX add Music Mix timeline. 

7	 Drag the 8 Circles for VFX v2 full timeline to the empty A2 track in the timeline. Make 
sure that the nested timeline starts at the very beginning of the A2 track. Hide the 
media pool.

8	 Play a few seconds of the timeline to hear both A1 and A2 tracks together. 
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The nested timeline has a 5.1 output bus, and this timeline has a stereo output bus, so 
the nested timeline will play, but you won’t hear all the audio channels until you 
decompose the timeline and the 5.1 bus is active. 

9	 Mute the A1 track.

10	 Right-click the nested timeline in the A2 track and choose Decompose in Place > 
Preserving Audio Data. 

11	 In the Decompose dialog, choose the New Matching Busses routing and click 
Decompose. 

Well done. You can monitor Bus 1, which is stereo, or the 5.1-A2 bus for 
surround sound.

12	 Double-click the meters to see dual rows in the monitoring panel. 

Now, the music is in place and ready to be mixed with different versions for the clients if 
needed. You’ll revisit this timeline in the next lesson to explore using track groups to 
automate mutes and other mixing and sweetening tricks along the way.

Creating a Timeline Template
To finish off this multi-stop bus tour, you’ll head over to the timeline, where you’ll apply new 
skills to transform an empty timeline with 100 tracks into a usable template. 

For this exercise, you’ll import a DaVinci Resolve project (.drp) containing some sample 
timelines from different types of projects. The premade timelines in this project are also 
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available as DaVinci Resolve timeline (.drt) files that can be imported into another project. 
You’ll find this project and timelines for this exercise in the R19 Fairlight Part 2 folder in 
your R19 Fairlight book media folder on your system. 

1	 Choose File > Import Project. Then, navigate to the R19 Fairlight Part 2 folder in your 
R19 Fairlight book media folder on your system. 

2	 Locate the Sample Timeline Templates folder. 

3	 Inside the Sample Timeline Templates folder, select Fairlight Timeline Templates.drp 
and click Open. 

The project opens with an empty timeline named 100 tracks. True to its name, the 
timeline contains 100 stereo tracks. There is also one default output bus aptly named 
Bus 1. This is a perfect starter timeline for building a template. 
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The first step for building a template is naming the tracks. Track names and 
abbreviations can vary significantly between types of projects, audio post facilities, 
and the re-recording mixer’s current tracks. 

Let’s condense the vertical track heights in the timeline. 

4	 Drag the vertical zoom slider all the way to the left to reduce the vertical track height 
and see more tracks in the timeline.

This step allows you to view more tracks and their corresponding track names in the 
timeline for this exercise. 

For this example, you’ll use a basic naming structure that includes the big three sound 
categories: dialogue, sound effects, and music. You’ll find the names in an .rtf file in 
the Sample Timeline Templates folder. The track name list was also added to the 
Project Notes for easy access during this exercise. 

5	 Choose File > Project Notes to open the Project Notes window. 

The Project Notes include a vertical list of all the track names for this template, 
including 18 Dialogue tracks, 40 FX tracks, and 24 Music tracks. 
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Manually naming 100 tracks could take a while. Luckily, the Fairlight page features a 
batch track-naming function that allows you to copy all the track names from a list 
and paste them into all the tracks simultaneously. Let’s try it. 

6	 In the Project Notes window, drag a selection starting with DX 1 and continuing 
down through the entire list until you have also selected the last music track 
name, MXStem8.

Don’t worry if you select the header between track types, such as FX Tracks (40). 
Those tracks can be used as spacers between track types. 

7	 Once you’ve selected all the track names, right-click the empty space in the Project 
Notes window and choose Copy from the shortcut menu.

8	 In the timeline, double-click the Audio 1 track name to select it in the A1 track.

9	 Choose Edit > Paste or press Command-V (macOS) or Ctrl-V (Windows) to paste the 
copied track names into the A1 track name field. Press Return or Enter. 

Bam! Just like that, the tracks are renamed according to the vertical list in the Project 
Notes. Now you know that you can copy and paste a vertical track name list from any 
text file directly into a timeline track’s name field, and the renaming will begin from 
that track.

10	 Close the Project Notes.

Step 1 is complete. Next, you’ll locate the header track for the FX and Music and create 
those spacer tracks. Spacers aren’t necessary but can be useful when working with 
high track counts. Some mixers like to use Aux busses as spacers between sections. 
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11	 In the timeline, zoom vertically to increase the track heights until you can see track 
numbers in the headers. 

12	 Scroll down to the A19 track. Right-click the A19 FX Tracks (40) track header and choose 
Lock Track Height to > Micro. Change the A19 tracks color to brown.

13	 Scroll down to the A60 track. Lock the track height and change the color to make it a 
spacer track. 

Excellent! The track names are all the guides you need to build a template. You can 
select track types and make groups, change track color and format, add busses, and 
assign busses. Don’t worry, you’ll get a chance to build a template at the end of this 
lesson. First, let’s take a quick look at a finished version of one possible template based 
on these tracks. 

14	 Show the media pool and the Groups panel. Open the timeline 100 Tracks 10 Busses. 

This colorful version of the timeline includes an assortment of busses and groups and is 
ready for media and mixing! 
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Saving a Timeline Configuration 
in the Presets Library
Once a timeline template is complete, you can export the timeline as a .drt file or save the 
timeline configuration in the Presets Library, allowing you to open a new timeline using the 
saved preset configuration on your system. Timeline configurations include all bus and 
track information, including color, routing, plug-ins, panning, and processing.

In this exercise, you’ll save the 100 Tracks 10 Busses timeline as a Fairlight configuration 
preset in the Presets Library. Then, you’ll test using the preset on a new timeline. 

1	 Open the 100 Tracks 10 Busses timeline, if necessary.

2	 Choose Fairlight > Presets Library. 

3	 In the Presets Library window, change the “Filter by” dropdown menu to Fairlight 
Configuration Presets.

4	 Click Save New. Then, click Create New in the Fairlight Configuration Presets dialog. 
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5	 Name the new configuration with your initials followed by 100 Tracks 10 Busses. 
Click OK. 

Your new Fairlight configuration preset appears in the presets list on the left of the 
Presets Library. 

6	 Close the Presets Library.

Applying a Timeline Configuration 
Preset to a New Timeline
Now that you have created a timeline configuration preset, how do you use it? Timeline 
configurations are applied to new timelines as they are created. Let’s try it. 

1	 Choose File > New Timeline.

2	 In the Create New Timeline dialog, click the Use Fairlight Preset checkbox.

The Fairlight Presets dropdown menu appears. 
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3	 Select your 100 Tracks 10 Busses preset from the dropdown. Click Create.

Your new timeline opens with identical settings—including groups, tracks, busses, and 
routing—as the original timeline you used to create the preset. 

Congratulations! You have reached the end of the “Simplifying the Mix” tour in the Fairlight 
page. Along the way, you have worked with track groups, created busses, nested and 
decomposed timelines, and created a timeline configuration template. Best of all, you can 
apply these skills to your own projects. 

Create Your Own 100-Track Template
Now is your chance to return to the initial 100 Tracks timeline that started this entire 
template journey. Use your new skills to select similar tracks, beginning with the DX 
(dialogue) tracks. Create a group, color-code the tracks, change their format to mono, and 
set up a submix bus. You’ve got this!

Remember the power of working with track groups, selecting multiple tracks, and using the 
Option/Alt-modified click to apply changes to all selected elements as you build your template.

When you’re finished, save the timeline with a unique name in the Presets Library as a 
Fairlight timeline configuration.

For added inspiration and to explore the many possibilities for setting up tracks and 
busses in your projects, check out two example timelines from actual shows in the media 
pool. Here, you’ll find empty timelines from two productions: Sample Nature Doc and TML 
Stereo Mix Tracks.

Sample Nature Doc showcases the track and bus routing used in a nature documentary 
series. TML Stereo Mix Tracks represents the track and bus configuration from the Too 
Much Life feature film, which you’ve been working with throughout this book. In this 
example, you’ll see multiple tracks for each main character, each with their own set of futz 
tracks for phone, computer, and other effects. Additionally, a submix bus is assigned to 
each main character, with all character submix busses ultimately routed to a DX submix 
bus. Enjoy!
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Lesson Review 
1	 Which Fairlight feature is used to link multiple mono tracks as a single multichannel-

formatted channel strip in the mixer?

a)	 The link button in the toolbar

b)	 Track Groups in the Groups panel

c)	 Choose Link Selected Tracks in the right-click menu

d)	 The Link Group window in the Fairlight menu

2	 What types of Group Settings can you apply to a track group? (Choose all that apply.)

a)	 Editing

b)	 Fader

c)	 Mute

d)	 Solo

e)	 Channel configuration

3	 What type of bus can you use to apply one plug-in, such as Reverb, to any track in 
the timeline?

a)	 Main bus

b)	 Effects bus

c)	 Submix bus

d)	 Auxiliary bus

4	 Where do you access the Bus Format and Bus Assign windows?

a)	 Mixer

b)	 Monitoring panel

c)	 Fairlight menu

d)	 Auxiliary controls

5	 True or False? New DaVinci Resolve projects open in the default Flex Bus format.

6	 Where do you save a timeline configuration to use as a template?

a)	 Presets Library

b)	 Media pool

c)	 Timelines Smart Bin

d)	 Timeline Options menu 
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Answers
1	 d

2	 a, b, c, d

3	 d

4	 c

5	 True

6	 a
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The final step of audio post-production 
involves enhancing and mixing tracks 
to prepare them for output, assuming 
all other steps have been completed. 
This process is straightforward for 
experienced audio engineers or 
re‑recording mixers, since they know 
how to turn a timeline full of tracks into 
a professional mix. However, if you’re an 
editor or new to audio post‑production, 
this series of exercises will help you 
understand mixing by introducing the 
essential Fairlight tools and how to use 
them. Once the levels are balanced 
and tracks are panned, you’ll dive 
into primary sweetening tools like 
equalization and dynamics processing 
to improve clarity and elevate the 
overall sound.

The last step of audio post involves 
enhancing and mixing the tracks to 
prepare them for output. Assuming that 
all other steps were completed before 
the mix, this process is straightforward.

Lesson 9

Mixing and 
Sweetening the 
Soundtrack
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If you are a seasoned audio engineer or re-recording mixer, you already know how to 
transform a timeline full of tracks into a professional-sounding mix; you just need to learn 
how to do it using the tools in DaVinci Resolve. 

Mixing is an ongoing process. Every variable you change on every track can affect how 
other tracks interact. In other words, you have no “set-it-and-forget-it” in mixing. That’s 
why you start small at the clip level by balancing levels within each track. 

In this lesson, you’ll share the stage (sound stage) with a re-recording mixer as you 
explore, experiment, and experience various mixing tasks. You’ll focus your attention on 
the track levels, how they sound together, and the placement of sound within the 
panoramic field. Then, you’ll move on to sweetening the sound.

What Does a Re-Recording Mixer Do?
A re-recording mixer, also referred to as a dubbing mixer, is an audio engineer who 
specializes in post-production audio mixing. The name indicates that this mixer is 
not recording a live set, live audience, or live performance. All the sound they are 
mixing—including recorded dialogue, sound effects, and music for a soundtrack—
has already been recorded and assembled into a track (although a re-recording 
mixer may also work as the sound designer on lower-budget productions). 

To build the final mix, re-recording mixers pre-mix the tracks to enhance the sound 
and reduce the number of tracks going to the final mix. The re-recording mixer 
carefully balances those tracks to create a final mix based on the sound designer’s 
or director’s audio goals. Along the way, the mixer records the output of the mix, 
or groups of tracks, back into the timeline into a new track. Hence the name 
re-recording mixer—because they continually re-record mixed sections of the 
timeline or the entire mix back into the timeline to create finished stems or mixes. 
The mix must also comply with regulations that enforce sound mixing standards 
for broadcast or theatrical distribution.

Although you can mix projects in a home office or recording studio, full-sized mixing 
or dubbing stages are preferred when mixing feature films destined for theatrical 
release. They enable the mixer to fully hear how audiences will experience the final mix.

In audio post-production, a re-recording mixer typically begins by reviewing the 
dialogue, sound effects, and music elements, making sure they are clear and 
cohesive. This involves adjusting the volume of each track, ensuring that dialogue 
is intelligible, sound effects are prominent but not overpowering, and music 
supports the emotional tone of the scene. Once the levels are balanced, the 
re-recording mixer moves on to panning, spatial placement, and other techniques 
to create a polished and immersive mix, followed by sweetening (enhancing tonal 
qualities and dynamics) and finalizing the mix for output.
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NOTE  The exercises in this lesson build from the tools and skills you have learned 
in previous lessons. If you skipped ahead to this lesson, you may need to review 
the previous lessons as a guide for skills and tools already covered. 

Preparing the Project
In the first series of exercises, you’ll continue working with the end of the “Learn to Surf” 
scene that you’ve been editing and building since Lesson 2. Before you dive into your first 
mixing task, let’s take a moment to set up your Fairlight workspace. 

1	 Open your TML Audio Post project. Then open the timeline 
9 Mix Balance and Pan Start.

This version of the scene represents the culmination of your work throughout this book. 

2	 Choose Workspace > Rest UI Layout. 

3	 Extend the mixer to show at least 10 tracks. 

4	 Press Shift-Z to fit the timeline clips horizontally in the visible timeline area.
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Let’s resize the viewer in the monitoring panel. Because this timeline has only 21 
tracks, you don’t need to see all the empty track meters at the top of the screen. Also, 
at any time, you can increase the height of the monitoring panel while decreasing the 
height of the mixer. In this exercise, you’ll customize your interface for mixing. Then, 
you can make changes as you go to accommodate the mixing tasks at hand. 

To resize the viewer or the monitoring panel, you can simply drag the viewer’s 
boundaries.

5	 In the monitoring panel at the top of the screen, move the pointer over the left edge of 
the viewer until it becomes a resize pointer. Drag the left edge of the viewer to the left 
until the loudness meters are to the left of the track and bus meters.  

This customized layout has several advantages. First, the gray space around the viewer 
makes it easier to glance at, like a stand-alone window. Second, all the meters are 
together in the monitoring panel, making it easier to see them all at once. 

Next, you’ll resize the monitoring panel in both directions to see how easily you can 
quickly adjust the height of the panel or mixer. 

6	 Drag the lower edge of the viewer down to increase the height of the viewer and 
monitoring panel. Stop dragging when the monitoring panel fills the upper third of 
the screen. You should still be able to see the pan controls above the bus outputs in 
the mixer. 

This layout is great when you need a larger viewer, loudness meters, and overall 
track meters.
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7	 Drag the bottom edge of the viewer up as far as you can to minimize the height of the 
viewer and monitoring panel. 

Now you know how quickly you can resize the interface when needed. The trick to resizing 
your interface is to maximize the size of the elements you need as you need them.

TIP  You can save your favorite interface layouts in Workspace > Layout Presets 
options. Here, you can Save, Import, and Delete custom layouts. 
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Using Reference Tracks to 
Set Monitoring Levels 
In previous lessons, you learned some of the guidelines for balancing dialogue and sound 
effects. Those are important considerations, but—stepping away from the clips and tracks 
for a moment—everything comes down to volume. Your personal preferences for volume 
levels may be completely different from your family and friends. That’s why when you use 
the television remote control, you usually change the volume as well as the channel. 
Regardless of your personal preferences, audio levels should be consistent from scene to 
scene and from one show to the next. 

How do you achieve this? Meters are only part of the story. You still mix with your ears as 
well as the meters. So, before mixing a single track, you should set your computer output 
monitoring levels. Of course, you may be at home or in a classroom while stepping 
through this training guide, so you may not have the equipment to calibrate your listening 
environment—or even the speakers to listen to the output. And if you already have 
professional calibration gear and an awesome surround speaker setup at your mixing 
station, chances are your room is already calibrated. 

NOTE  The engineering details for calibrating your room go far beyond the scope 
of this book. Furthermore, the standards vary from region to region and are 
subject to your equipment, room size, project type, and delivery requirements. If 
you are considering a career in audio post-production, by all means, become an 
expert in the hardware, standards, and calibration. You can find reference details 
and sample wave test files online through professional organizations like the EBU, 
SMPTE, or ATSC, as well as some audio post facilities. 

Regardless of your setup, for the purposes of this lesson, how loud should your monitoring 
output be? Basically, if your room, computer output level, and speakers are properly set up, 
the levels should be comfortable to your ears while you mix. Loud sounds will sound loud, 
quiet sounds will sound quiet, and if something isn’t working, you’ll hear it. 
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One of the best ways to set your listening levels is to use a reference track that contains 
professionally mixed content similar to your current project or scene. In the real world, 
you’d need a time machine to reference a finished mix of your current project. Such is the 
power of training guides like this one. However, it is common for sound-mixers-in-training 
to use finished mixes as a guide to check levels and practice re-mixing a scene. 

For this exercise, you’ll use the finished reference mix from the “Learn to Surf” scene to set 
your listening levels. These can also be used later while mixing to check your balancing and 
sweetening skills against the stereo mix. 

1	 Open the timeline 9 Full Surf Scene Reference. Resize the layout as you see fit.

Take a moment to familiarize yourself with the various meters on the Fairlight page.  

2	 Move the playhead to the blue marker, which is just before the end of the scene that 
you’ll be working with shortly.
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3	 Start playback from the blue marker. Look at all the meters in the track header, mixer, 
and monitoring panel. 

Track header

Mixer

Monitoring panel

Seasoned audio engineers should feel right at home among these meters and 
controls. However, if you’re new to audio post, this setup may be as intimidating as a 
space shuttle cockpit. If so, relax. In the next few exercises, you’ll discover just how 
useful and user-friendly the meters and mixing controls can be.

In the meters to the right of the monitoring panel, you’ll see that each meter tells the 
same story but simply uses different scales to do so: the reference track levels peak 
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at the nominal levels between -10 and -15 dB in the mixer and correspond with the 
Control Room (mustard colored) meter and fluctuate around -23 LUFS in the blue 
loudness meters. You’ll work more with the Control Room and loudness meters in 
the next lesson.

NOTE  American loudness standards are -24 LUFS, which you can change in 
the project settings. Also, keep in mind that this is a stereo signal. 

Now that you are confident in the reference levels, you can adjust your 
monitoring levels.

4	 In the master playback monitoring controls, drag the fader to the far right position, 
0 dB. If you are monitoring through an external audio I/O device, adjust the 
monitoring levels accordingly. Press Option/Alt-L to replay that section from the 
blue marker if necessary.

5	 While listening to the reference track, adjust the output level of your computer or 
speakers so that the levels are comfortable and clear for you. You can do this whether 
you are using headphones or external speakers. If necessary, you can also adjust the 
playback monitoring level.

How did the levels sound to you? If they sounded too low, you may have set your 
computer output level a bit too low based on the reference track. Conversely, if the 
dialogue was too loud, you probably set the levels too high. Setting the best levels 
comes with practice. The important goal is to set a comfortable level for you. 

6	 Adjust your computer output level as needed. 
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Once you have set up your monitoring levels for mixing, you must abide by the number 
one rule: Don’t touch the levels again until you finish the mix. Really! Moving forward, when 
the tracks sound too loud or too quiet, they truly are. Fix them in the timeline or the mixer, 
but don’t touch the computer volume controls. Trust your ears as well as the meters. 

NOTE  If you’re working in a quiet room with a good set of stereo audio monitors, 
you should be good to go. If you have been using your built-in computer speakers 
or an inexpensive single speaker up until now, you are advised to use headphones 
when performing these mixing exercises. Stereo headphones are made for casual 
listening, while professional film mixing headphones are built for accurate, 
detailed sound to ensure a balanced mix. For this lesson, mixing with standard 
stereo headphones will suffice for learning purposes. 

Finding Useful Reference Tracks
What should you use as a reference track? Something that is as close as you can 
get to the project or scene you are mixing. Of course, no two projects or scenes 
are the same, so when looking for reference tracks for comparison, here are some 
basic guidelines: 

	— Compare apples to apples whenever possible. In other words, find a project 
that has the same delivery format. For example, if you are mixing a podcast, 
use a downloaded podcast as a reference. If you are mixing a film (even a 
short film) for theatrical release, use the highest-quality theatrical mix you can 
of the same genre. Blu-ray and 4K DVDs often use the theatrical mix or 
something close to it. You can patch a player to your system so you can hear 
the soundtrack, see the meters, and set your listening levels accordingly.

	— If you are working on an episodic show, scripted or unscripted, use mixed 
elements from previous episodes as a guide.

	— Choose reference scenes or sections that reflect the overall feel and sound 
experience (soundscape) that you’re trying to convey in your mix. 
For example, if you are mixing an intense dialogue scene that involves a 
heated exchange ranging from hushed whispers to loud shouting, use a 
scene with the same dynamic dialogue range as a reference.

	— Choose a reference soundtrack that successfully balances and mixes the 
subtle elements in the scene as well as the big moments. Pay attention to the 
background, ambience, and Foley sound effect levels, as well as the placement 
of the music and non-diegetic sound in the mix.
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Evaluating the Reference Track Levels 
It’s one thing to read about dialogue levels, loudness, and balancing tracks. It’s another 
thing entirely to mix the levels yourself. One of the best ways to understand the art of 
balancing dialogue, FX, music, and overall levels is to listen to other mixes and watch the 
meters as a guide. In the movie theater or on your television at home, you don’t have the 
luxury of meters to watch while you listen to the show. Here in the Fairlight page, you have 
meters everywhere, and even floating plug-in meters that you can watch during full-screen 
playback if you’d like. Why not?

In this exercise, you’ll dive a bit deeper into the various types of meters by changing the 
project settings from the default IEC 60268-18 Peak Program Meter (PPM) that you’ve been 
working with to the Digital VU (Volume Unit) Root Mean Square (RMS) meter for mixing. 
What is the difference between the meter types? 

In audio post-production, a PPM detects quick peaks, helping prevent distortion and 
ensuring compliance with broadcast standards. On the other hand, an RMS (Root Mean 
Square) meter measures average loudness, reflecting how audiences perceive sound, 
making it crucial for balancing dialogue, music, and effects. PPM meters are essential for 
avoiding clipping, while RMS meters help maintain consistent loudness across a mix. For 
optimal results in post, both meters should be used together to ensure that a mix is clear, 
balanced, and broadcast-ready. 

1	 Press Shift-9 to open the Project Settings. In the Fairlight settings Audio Metering 
section, choose Digital VU from the Meter Type dropdown menu. 
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2	 While you are in the Project Settings window, make sure that the “Pre fader metering 
on tracks” option is unchecked so the changes you apply to the faders will be reflected 
in the meters. 

3	 Click Save. 

Next, you’ll open the Fairlight FX Meter plug-in, which has already been added to Bus 1 
and offers additional metering to guide you while monitoring playback. 

4	 In the mixer, locate the Meter plug-in on the Bus 1 channel strip. Then click the 
Controls button to open the floating Bus 1 meter. 

You are already familiar with the Meter plug-in from previous lessons. This meter is a 
Peak Program Meter, just like the default DaVinci Resolve mixer, timeline, and 
monitoring meters have been all along. 

Now that you’ve changed the Fairlight meters in the Project Settings to Digital VU, the 
monitoring panel and mixer will display RMS meters. This gives you both types of 
meters to look at while you evaluate and mix levels. Let’s look at them in action. 

5	 Move the floating meter to the lower part of the timeline next to the mixer. 

6	 Undock the viewer as a floating window. Resize the viewer and move it to the bottom 
of the timeline near the floating meter and mixer. 

7	 Start playback from the blue marker and listen to the playback while you watch 
the meters. 

These dialogue levels are right in the dialogue sweet spot for a mix, even set against 
heavy music. Do you remember your target levels for dialogue? They’re between -15 
and -10 dB, with the average at -12dB. Also, if you recall, these target dialogue levels 
appear yellow in the track meters, mixer, and monitoring panel track meters. 
The dialogue in the reference track fits the target levels perfectly. At powerful 
moments, music and sound effects swell to the same levels when dialogue is not 
present. The loudest peaks in this scene reach around -6 dB but not above that.
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In the last step of evaluating this reference mix, you’ll watch the entire scene from 
the beginning with the floating meter showing so that you can keep an eye on the 
levels throughout. 

8	 Move the playhead to the beginning of the timeline. 

9	 Press Command-F (macOS) or Ctrl-F (Windows) for Cinema Viewer full-screen playback. 

10	 Move the floating viewer to the upper right corner of the screen. 

NOTE  If you are using dual monitors, with a full-screen clean feed to the 
second monitor, move the floating meter over the video output screen if 
possible. 

11	 Play the scene from the beginning to listen to the mix and watch the meter in action. 
Feel free to use the JKL keys during playback to fast forward or rewind to specific parts 
of the scene. 

12	 When you are finished, stop playback. Press Esc or Command-F (macOS) or Ctrl-F 
(Windows) to exit full-screen playback. 

13	 Close the floating viewer and meter. 

This scene has come a long way since the original production sound you checkerboard-
edited back in Lesson 2. You can refer to the reference timeline whenever you need a little 
mixing inspiration, to see the levels, or to listen to the balance between sound elements. 
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Setting Initial Track 
and Submix Levels
The four fundamental elements of mixing are volume level, pan, dynamics, and 
equalization. Each of these elements affects the overall sound. In many ways, mixing a 
soundtrack is like cooking a single-pot dish. Many parts influence the final dish, so you 
continually mix, add more ingredients (tracks), taste (listen), and add spices (effects and 
EQ) until it’s ready to serve.

The most apparent mixing element is the volume, so let’s start with that. You have only one 
way to find out if the starting levels are balanced. First, as a re-recording mixer, you’ll want 
all the faders in their default positions before you listen to the tracks. If a change in level is 
necessary, you’ll want to be the one to do it. 

In this exercise, you’ll work with the end of the surf scene from the previous lesson and 
reset the faders to the default position (unity). Then you’ll find starting levels for the tracks 
and busses. 

1	 Open the 9 Balance Start timeline.

2	 Expand the mixer as far to the left as it will go. 

For this first exercise, let’s change a setting in the mixer options menu to show more 
channel strips in the mixer. 

3	 In the Mixer options menu, choose Small Track Mixer. 
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The channel strips are narrower but still offer all the same controls and information. 

In the mixer, you can see that some of the faders are not in their default positions—
specifically, the aux bus and some of the submix busses. Luckily, you only need to 
double-click a fader to reset it. This is the starting position for mixing. 

4	 Double-click any fader not in the default position to reset it. 

OK, the faders are all at unity. What’s next? Assuming that all the clip levels are 
balanced within each track, you can use the individual track faders to adjust the levels, 
then use the submix busses to adjust the balance and levels between the dialogue, FX, 
and music within the mix. Remember that the faders are only in their starting 
positions; their final positions will change constantly until the final mix is bounced or 
rendered in the deliver page.

First, it’s a good idea to check the levels, rather than assuming “all is well in Levelville.” 
To do this, you’ll use tools you are already familiar with to systematically check levels of 
each submix group in order of priority, starting with dialogue (DX). If there is an issue 
with a specific clip, this is the time to fix it. As you check the levels, you can determine if 
it is something you’ll fix on the clip, on the track, or with a submix bus during the mix. 

5	 In the monitoring controls, beneath the viewer, set the monitoring dropdown menu to 
DX to monitor only the dialogue bus. 
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6	 Open the corresponding Meter plug-in for the DX submix bus and place it above the 
timeline and mixer where you can easily see it. 

Let’s play the scene, dialogue submix only, to see and hear the current dialogue levels. 
There should be some dynamic range in the dialogue levels between talking levels, 
-10 dB to -15dB, and shouting, peaking as high as -6 dB. If any track levels are obviously 
out of place, you can balance them in the track header or in the mixer.

7	 Move the playhead to 01:00:18:00, just before the first dialogue clip on the 
A8 DX m2 track. 

8	 Play the timeline from the first dialogue clip and listen to the levels in context while 
watching the viewer and floating DX meter.

The floating meter shows the peak program level, with the highest peak value at the 
top. If you glance at the track levels and the DX bus meter in the monitoring panel, you 
will see that these depict the peaks as a horizontal line. The solid-color bar in the 
meter is the RMS perceived level, which is similar to the loudness meter. 

NOTE  The track colors and subsequent clips are different for each character, 
and the initials in each track header following DX are the first letter of the 
character’s name, followed by their track number. For example, DX r1 is Raina’s 
first dialogue track, and DX m2 is Marley’s second dialogue track. 

What did you think of the dialogue levels? Objectively, they are all within the dialogue 
target levels and fit the scene’s context. Subjectively, Raina’s offscreen shouting could 
be a little lower, but it would be better to lower it when you can hear it with the music 
and sound effects. 

The DX bus has been checked, and it’s good to go. Dialogue is the most important 
element in the scene. Once the levels are good, you can add the next most important 
ingredient, which in this case is the music. If this were an action scene where sound 
effects drive the scene, the FX bus would be the next element to add to the mix. 
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Wait. Busses don’t have a Solo button, and you can only monitor one bus at a time. So 
how do you add only the music bus (MX) to the mix? No problem, just mute the busses 
you don’t want to hear and monitor the Stereo bus. 

9	 Move the playhead to the blue marker near the beginning of the timeline. 

10	 Set the monitoring dropdown menu to Stereo bus. 

11	 In the mixer, mute the FX and BG FX busses. Then open the Meter plug-ins on the 
Stereo and MX busses.

12	 In the monitoring panel, drag the right edge of the loudness meters toward the left to 
make room for the three floating meters. 

The music levels will seem loud, because they are. You’ll need to find a comfortable 
level for them during playback that works alongside the dialogue and complements 
the scene. Music without dialogue is usually around the same levels as dialogue, but 
with dialogue, it’s lowered by -6 to -10 dB. Keep in mind that you’ll be applying 
sidechain compression and EQ carving to the music to favor the dialogue later in this 
lesson. For now, your goal is just to find a level that works for music with dialogue. 

13	 In the mixer, click the MX bus fader and prepare to reduce the level. 

14	 Start playback from the beginning of the scene. Use your ears and the Stereo meter as 
a guide to drag the MX bus fader downward to lower the level of the music going to 
the Stereo bus. 

15	 Play the timeline a second time if needed. Once you’ve set the MX bus level, stop 
playback. If you aren’t sure what level to set, try moving the fader to between 
-10 dB and -15 dB.

Now that you have a strategy for balancing clip, track, and bus levels, let’s try a track FX 
designed to use the levels of one track (or tracks) to duck (lower) the levels of another. 



552Lesson 9  Mixing and Sweetening the Soundtrack

Using the Ducker to Lower  
Music or FX Tracks
The Ducker is a built-in Fairlight Track FX, like the Dialogue Leveler, that makes it easy to get 
a good mix automatically, by using the levels of one track or multiple tracks to manage the 
levels of another track, without the need for keyframes or automation. Commonly used to 
lower music or sound FX tracks based on active dialogue, the Ducker is an invaluable tool 
for quickly reducing dominant tracks to benefit dialogue levels. In this exercise, you’ll apply 
the Ducker Track FX to a dominant music track and adjust the settings as needed. 

In this exercise, you’ll revisit a scene where the music track is overpowering the dialogue. 
In just a few steps, you’ll enable the Ducker on the music track, choose the dialogue source 
tracks, and then adjust the amount that you want to lower the music. 

Let’s start by opening the timeline and playing it to hear the dominant music track. 

1	 Open the timeline 9a Ducker Start. Move the playhead to the first marker, 
if necessary.
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2	 Play the timeline from the first marker and listen to the music with the dialogue.

What are your thoughts? The music is sweet and really adds some emotional 
resolution to the scene and the film, but it is a bit overpowering for the dialogue. 

This is the perfect time to employ the powerful Ducker Track FX to the Music 1 track. 
First, let’s determine which tracks have active dialogue.

3	 Play the timeline again from the first marker. See if you can identify the active dialogue 
tracks by looking at the meters in the track headers and monitoring panel. 

As you can see, and hear, the active dialogue clips for this scene are on tracks A7 ADR 
1 Edit, A8 ADR 2 Dad, and A9 ADR 2 Elastic Wave. Now, let’s open the Inspector. 

4	 Hide the video tracks via the Timeline Options menu by deselecting the Display Video 
Tracks option. Close the Timeline View Options menu. 

5	 Hide the mixer and show the Inspector. 

6	 Zoom the timeline as needed to see all clips in visible tracks. Resize the monitoring 
panel, if necessary, until the timeline is high enough to see all visible tracks containing 
clips and the track number and name in the headers. 

7	 Select the A22 Music 2 track. 
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8	 In the Track FX list of the Inspector, enable the Ducker. 

NOTE  If you are using the free version of DaVinci Resolve 20, you’ll see two 
Track FX, including the AI Dialogue Leveler and the Ducker. The screenshot is 
of the DaVinci Resolve 20 Studio Inspector and therefore includes 
five Track FX.

The default Ducker settings include a Source 1 dropdown menu for selecting which 
track will control the ducking of the selected track. You’ve already determined that the 
dialogue for this scene is on tracks A7 ADR 1 Edit, A8 ADR 2 Dad, and A9 ADR 2 Elastic 
Wave. Now all you’ll need to do is assign them as the source tracks for the Ducker, and 
the music will automatically lower as needed for the dialogue. 
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9	 In the Ducker controls, set the Source 1 dropdown to ADR 1 Edit. 

10	 Click the Add button (+) to the right of the Source 1 dropdown twice to add Source 2 
and Source 3 dropdown menus. 

11	 Set the Source 2 dropdown menu to ADR 2 Dad. Then set the Source 3 dropdown 
menu to ADR 2 Elastic Wave.

Now that you’ve set all three source dropdown menus, you can open the Ducker 
controls window. 
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12	 Click the Custom button in the top right corner of the Ducker controls in the Inspector 
to open the Ducker window. 

13	 In the Ducker window, click the Source dropdown menu to see which source tracks are 
controlling the signal on the Music 2 track. 
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You can also select (check) or deselect (uncheck) source tracks in the Ducker Source 
dropdown menu. 

In the Ducker window, you’ll see the Ducker controls, including Duck Level, Lookahead, 
Rise Time, Hold, and Recovery Time. These controls have literal names that describe 
their function in ducking the track level based on the incoming signal from the source 
tracks. The best way to use and understand the Ducker is to see and hear what it is 
actually doing. 

NOTE  You can find more detailed information about the Ducker controls in 
the Davinci Resolve User Reference, available via the Help menu. 

14	 Start playback from the first marker, watch the Ducker Graph display to see the visual 
changes between the incoming signal (gray line) and the Duck Level (yellow) when 
there is spoken dialogue. 

The Ducker window displays the magic behind the scenes as the music is seamlessly 
lowered just enough for the dialogue to shine through. For a more dramatic example, 
you can increase the Duck Level. Keep in mind that the more you increase the Duck 
Level, the more likely the changes will be perceived by the listener. 
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15	 Increase the Duck Level control to 10.0. 

The music level will now be reduced by a full -10 dB anytime there is dialogue. You will 
hear the difference during playback. 

16	 Start playback from the first marker and listen to the scene until the end of the dialogue. 

 

Yikes! Chances are, you clearly heard the music level drop, but not in a good way. This 
is an excellent example of what not to do when applying ducking techniques, whether 
they are with keyframes or the Ducker, to a track. Unless the story or stylistic directing 
requires it, your goal should be to keep the level changes subtle. Dramatic level 
changes to any track will be heard by the untrained ears of the audience. 

As a sound designer, supervising sound editor, or re-recording mixer, your work is 
supposed to enhance the story seamlessly without the audience ever being aware 
of what you are doing. If the audience is focused on or distracted by the technical 
aspects of a show, whether it’s the cinematography, visual effects, or soundtrack, 
they aren’t focused on the story. Of course, plot holes, poor acting, and lousy 
storytelling are beyond your control. 

Let’s reset the Duck Level controls.

17	 Double-click the Duck Level control to reset it to the default level of 2.7 dB. Feel free to 
explore and experiment with the other controls before moving on to the next section. 
When you’re finished, hide the Inspector and close the Ducker window.

Now that you’ve experienced the Ducker for quickly reducing a track’s levels based on 
other sources, let’s move on to automating levels using a fader and automation controls. 
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NOTE  The Ducker is a Track FX that can be applied on any track to control the level 
based on the signal in a user-defined track or tracks. To apply ducking to a bus or 
use a bus signal, you must apply sidechain compression, which is available in the 
Fairlight Dynamics window. You’ll work with sidechain compression later in 
this lesson. 

Mixing with the Fairlight Desktop Console
The Fairlight Desktop Console is designed to work alongside your mouse and 
keyboard to give you professional mixing controls for the Fairlight page. Features 
like touch-sensitive faders and knobs, along with a full automation toolset, make it 
easier than ever to perform complex mixing and sweetening workflows. 

TIP  Re-recording mixers working with large mixing consoles typically move 
hardware faders during playback and can maneuver their hands around the 
controls like a keyboardist playing a church organ. When you’re working in a 
software-only environment, you must do the best you can using a mouse or 
trackpad. You can always record automation to your tracks or submix busses to 
help simplify the final mix. Also, numerous hardware mixing consoles, including 
the Fairlight Desktop Console and customizable Fairlight Studio Consoles, are 
compatible with DaVinci Resolve and its Fairlight page. 

Automating Fader Levels 
Adjusting faders and other controls during a mix is part of your job. You could try making 
all the changes on the fly during your final mix, or alternatively, record the parameter 
changes as automation. Recording automation data to a track curve is also called writing 
automation. In previous lessons, you applied automation techniques to pan tracks and 
dynamically change the Music Remixer controls over time. In this exercise, you’ll use 
Resolve’s automation controls on the Fairlight page to record volume changes to the 
Waves sound FX. You could record automation using either the faders for the three 
individual tracks containing Waves sounds or focus on adjusting the FX Waves submix 
bus fader. In this case, you’ll use the submix bus to automate the cumulative wave sounds 
with a single fader.



560Lesson 9  Mixing and Sweetening the Soundtrack

Automating the changes to your faders and other parameters while you work allows you to 
free up your hands and focus on each pass of the mix. In the next set of exercises, you’ll 
continue working with the beach scene with Harper and her dad. This time, you’ll use your 
own ears and instincts to adjust the fader levels over time and record your changes 
along the way. 

Preparing the Project
When automating track levels using a mouse and keyboard, it’s a good idea to adjust your 
tracks and mixer for easy access to the tracks and tools you’ll need for automation. To 
simplify the mix, an FX Waves submix bus was created so you can control the cumulative 
background wave sounds from multiple FX tracks at the same time. 

Let’s open the timeline and make a few visual changes to automate the FX Waves bus. 

1	 Open the timeline 9b FX Waves Bus Snap Start. 

2	 Zoom the timeline vertically so that all the visible tracks and busses are in the upper 
half of the timeline. 

3	 Select the FX Waves bus header located in the lowest timeline track position. 

4	 Scroll the mixer until you see the FX Waves bus and fader in the furthest right position 
in the mixer.

5	 Increase the height of the FX Waves bus at the bottom of the timeline for a clear view 
of the bus track and header.
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With the larger track height, you can more clearly see the Automation Arm button 
and Automation dropdown menu in the track header. The timeline is set up and ready 
for automation. 

Showing Per-Track Automation 
Controls in the Mixer
Fairlight’s automation toolset includes global automation controls that affect all tracks 
and busses, and independent automation mode settings on each channel strip in the 
mixer, in case you need some tracks to be in a different mode while mixing. For example, 
the global settings could be to write automation in Snap mode for fader adjustments, 
but Read mode on the auxiliary busses, and Trim mode for the busses that already have 
automation applied. By default, all tracks and busses follow the global automation settings 
as shown in the Automation Controls toolbar. You’ll find the controls to set individual track 
automation modes in the mixer options menu. 
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Show options with a click.

Setting the Automation Controls
The automation toolbar includes controls that let you automate a wide range of 
parameters in the mixer with choices to suit the type of automation you need to apply, 
whether recording all new automation data or trimming levels with a few extra decibels to 
previously recorded data. Before you dive in to recording automation, let’s open the 
automation toolbar and take a quick look at the controls and what they mean. 

1	 Click the Automation Controls button to open the automation toolbar. 

The automation toolbar includes buttons that control every available option for setting 
up and recording automation for your mix. The buttons are organized in groups from 
left to right.

You can record automation data in either Write or Trim mode. Write mode records 
absolute changes to controls, whereas Trim mode records relative changes that 
increase or decrease levels already recorded. 

The Touch mode settings determine what happens when you begin automation. 
When Touch mode is turned off, no automation is recorded. Touch mode includes 
three automation recording modes:

	— Latch mode begins recording as soon as you touch a control enabled for 
automation and continues to record automation after you release the control.
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	— Snap mode begins recording automation when you touch a control and stops 
recording when you release the control. Additionally, once you release the control 
and automation stops recording, the physical control glides back to the starting 
value or position where it was at the start of the automation recording. For 
example, if you are recording fader automation with a starting position of -12 dB in 
Snap mode, you can record new fader automation as long as you hold the fader. 
Once you release the fader, the automation recording stops, and the fader glides 
back to the -12 dB position. The default glide time is 250 ms (milliseconds) and can 
be changed in the Fairlight User Preferences tab.

	— Snap Latch offers a combination of Snap and Latch mode in that the faders work 
in Snap mode while all other controls are in Latch mode. This is an optimal mode 
when using a Fairlight control surface like the Fairlight Desktop Console or studio 
consoles because you can adjust fader levels in Snap mode while all other 
parameters are in Latch mode, so you can make simultaneous quick adjustments 
to pan, EQ, FX, or dynamics control knobs while also automating faders. 

The On Stop controls determine what happens when you release the control that you 
are recording:

	— Event maintains the most recently recorded automation value and overwrites 
previous levels for that parameter until the playhead reaches the start of the next 
recorded data on the track.

	— Hold maintains the most recently recorded value and deletes all previously 
recorded data for the rest of the track.

	— Return creates a ramp from the automation value you just recorded to the 
previous values on that track. 

The Enables buttons are self-explanatory and let you enable or disable different 
controls for recording automation.

The Preview switch toggles Preview mode on or off. Preview is an additional mix 
automation workflow that frees the faders (and other controls) from automation 
control and lets you move them while you experiment with different levels and settings 
until you are ready to write or trim new automation data. 

Now that you are familiar with what the controls do, let’s set up the automation toolbar 
so you can record fader automation to the FX Waves bus in Snap mode. Why Snap 
mode? Because that way you’ll be able to make an adjustment to the level when needed, 
and the fader will automatically glide back to the previous level when you release it. 
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Since this scene takes place at the beach near the water, it is important to always hear 
the water and waves, without them overpowering the dialogue or music. 

2	 In the Automation Toolbar’s On Stop controls, click the Return button to select 
that option. 

3	 In the Enables controls, click the Fader button. 

As you can see, active automation buttons turn red to indicate they have been 
selected. 

TIP  Before recording automation, it’s always a good idea to set the initial track 
levels and practice changing levels on the fly. 

Next, you’ll find the fader level that you wish to use most often and the level you are 
likely to use when you increase or decrease the level over time. This step gives you a 
solid starting point before automating levels. 

Let’s start by listening to only the FX Waves bus, and then switching the monitoring 
back to the Stereo mix bus.

4	 In the monitoring controls above the mixer, set the monitoring dropdown menu to 
FX Waves. 

5	 In the mixer, double-click the fader on the FX Waves track to reset the level. 

6	 Play the beginning of the timeline and listen to the FX Waves bus while watching 
the picture.

These levels work well with the visuals. Now let’s hear them with the music. 

7	 Set the monitoring dropdown menu to Stereo. Then play the beginning of the timeline 
again to hear the waves with the music. Continue playback until Dad sits down and the 
first piece of music ends. 

What do you think of the waves now? In a word, nope. There is a distracting music 
versus waves battle for attention happening in this scene’s soundtrack. When sounds 
compete, let context be the judge. The music is clearly the dominant force going into 
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this scene, and the waves sound FX are a distraction. Additionally, the musical score 
was written and recorded specifically for this moment and offers an emotional 
transition from the previous scene. In other words, the music wins. That doesn’t mean 
you need to exclude the waves; you just need to tame the levels to make them fit into 
the soundtrack’s background where they belong. 

Let’s lower the FX Waves bus level to around -6.0 dB. 

8	 Start playback from the beginning of the timeline and drag the FX Waves fader 
downward to lower the level. Hold Shift while dragging for fine-tuned incremental 
control. Set the level to around -6.0, which you will see above the fader in the mixer 
and in the upper left of the bus header in the timeline. 

What do you think of the sound of the waves in this scene now? This time, they are still 
audible, leave plenty of room for the music, and stand out nicely once the music ends. 
Let’s listen to them during the dialogue. 

9	 Play the timeline from the first marker and listen to the dialogue with the 
waves sounds.

Too much. Once again, the waves are a bit distracting. Let’s find a level that works well 
during dialogue. 

10	 Play the timeline from the first marker again and lower the level to around -10 or until 
you are satisfied with the level.

NOTE  You can adjust the fader level by dragging the fader or by dragging 
the level field in the B6 FX Waves track header. 
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11	 Stop playback. 

12	 Move the playhead to the beginning of the timeline. 

13	 Practice changing the B6 FX Waves bus level from around -6.0 dB to -10.0 dB and back 
several times to get a feel for where those levels are and the movement from one to 
the other. 

One last step. Let’s check the glide time for the automation in User Preferences to 
make sure the glide amount is around 1 second (1000 ms). 

14	 Choose DaVinci Resolve > Preferences. Click the User preferences tab, if necessary, 
and then click the Fairlight tab in the sidebar. 

Locate the Automation options. Here you will see the Glide Time and a number field. 
The Glide Time determines how long it takes for an automation parameter to return to 
the previous level once the control has been released. You can set this amount as high 
as 4 seconds (4000ms). 

15	 Set the Glide Time to 1000 ms, if needed. 

16	 Click Save. 

You are ready to automate the FX Waves bus for this scene!
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Recording Fader Automation 
To record automation data, the only thing left to do is choose which Touch mode you want 
to use for recording automation. In this exercise, you’ll use Snap mode so that the fader 
will return to the previous level when you release it. Your goal for this scene is to set the 
initial Waves FX bus level at the beginning of the timeline. Then, during playback, you’ll 
lower the level before the dialogue starts and release the fader when the dialogue ends. 
Let’s try it! 

1	 Press A for Pointer mode. In the timeline, select the B6 FX Waves bus track. 

Selecting a track is not necessary for automating the track, but it makes it easier to see 
which track you are working on. 

2	 Right-click the FX Waves bus fader to show the Fader Level curve for that bus track. 

3	 Move the playhead to the beginning of the track and set the B6 FX Waves fader to the 
starting level (around -6).

4	 In the Touch controls, click the Snap button. Also, ensure that automation is in Write 
mode and On Stop is set to Return.
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5	 In either the timeline or mixer, click the Automation Arm button for the B6 FX Waves 
bus track. 

The Automation Arm button turns red to indicate that the enabled automation curves 
for this track are being recorded at the playhead position based on the global 
automation settings. Now that the initial track level is recorded at the beginning of the 
track, you can move the playhead forward, closer to the start of the dialogue. 

6	 Move the playhead to the beginning of the music clip in the Music 2 track 
(approximately 00:59:16:08).
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The red Fader Level curve in the FX Waves track indicates that level data is being 
recorded starting at the beginning of the track. Now it’s time to move that fader during 
playback! Good luck. As you record automation during playback, you’ll see the fader 
turn red to indicate that it is recording automation data. 

7	 Start playback, and as the playhead approaches the first marker (and first dialogue 
clip), lower the FX Waves level to around -10 dB. Continue holding the fader in that 
position until you reach the end of the last dialogue clip, and then release the fader. 
Stop playback.

Nice curve! Don’t worry if it isn’t perfect. This is a learning experience. You’ll be invited 
to try it again shortly. 

The Fader and Level curve colors go from red during recording to green once you stop 
playback to indicate recorded automation data. Notice the smooth glide ramp in the 
curve from the lowered level to the initial level where you released the fader. 

8	 Set the Touch mode to off. 

TIP  When working with automation, it’s a good idea to turn off the Touch 
mode when you aren’t actively recording. Otherwise, you could accidentally 
record or overwrite automation during playback. Also, you can click the Toggle 
Automation button to the right of the transport controls to disable or enable 
all automation applied to a timeline. 
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9	 Play the timeline just before the automated section of the scene and watch the B6 FX 
Waves fader as it moves automatically to follow the recorded automation.

Editing Automation Curves with Standard Tools
Once you have recorded automation, you can write new automation over the original, trim the 
levels by a few decibels as needed in Trim mode, or edit the automation curve using standard 
tools like the Focus mode multi-tool. In this exercise, you’ll use the Focus mode multi-tool to 
select, nudge, and trim the Fader Level curve without the need to record new automation. 

1	 In the timeline toolbar, click the Focus Mode button.

2	 Using the multi-tool, drag a selection range on the B6 FX Waves track from anywhere 
after the last clip in the timeline to the beginning of the timeline. 

3	 Drag the Fader Level curve downward to decrease the level by 1 dB. View the tooltip to 
see the amount of change. 
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Now let’s select the glide ramp at the end of the lowered section of the curve and 
nudge it toward the right. 

4	 Drag a selection around the curve, including the glide ramp, after the dialogue section. 
Press period or Shift-. (period) several times to nudge the selected section of the curve 
toward the right. 

NOTE  The automation curves offer visual feedback of the curve’s previous 
position as you make changes to the levels. The actual curve remains green, 
while a gray version of the curve remains as a placeholder to indicate the 
previous position until the curve is released in its new position. You can also 
use the multi-tool to select, nudge, copy, paste, and delete a selection 
containing automation keyframes. 

Congratulations! You automated and trimmed the levels of a sound effects bus using the 
Fairlight Automation toolset.

Take Two: Automating the FX Waves Bus 
Now it’s your turn to clear the automation from this bus track and try it again using what 
you have learned. In this self-guided exercise, you’ll reset the fader level curve and re-
record the automation. This time, don’t worry about exact level numbers. Instead, once 
you set the initial levels, trust your ears and your instincts to guide your hand on the 
mouse and fader. You’ll start by moving the playhead to the beginning of the timeline. 
Right-click the FX Waves track header and choose Clear Track Automation. Once you’ve 
cleared the automation, set your initial levels, turn on Touch Snap or Latch mode, and try 
setting the FX Waves bus track levels during playback. When finished, feel free to trim, edit, 
or redo your work. Have fun! 
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Sweetening the Mix
A professional sound mixer’s process of enhancing audio is very similar to a colorist’s 
workflow for grading the picture. The colorist’s process is referred to as color grading, while 
the process for improving and embellishing sound is often called sweetening. As the name 
suggests, sweetening makes everything sound better. Now that the levels have been 
balanced and tracks are panned, it’s time to focus on the soundtrack’s dynamic range and 
tonal qualities. In the next set of exercises, you’ll explore the primary audio sweetening 
tools, dynamics processing, and equalization, to improve clarity and elevate the soundtrack. 

NOTE  A spirited debate rages among audio professionals about which comes 
first: dynamics or equalization. This is a bit of a chicken-and-egg scenario because 
both processes affect the sound and each other. For this lesson, you’ll address 
dynamics first, but only because it makes sense to modify one character’s voice 
before adjusting her offscreen dialogue. 

Compressing Dialogue Tracks
The difference between a good soundtrack and a fabulous, professional-sounding 
soundtrack often comes down to dynamics control. Well-balanced dialogue tracks with 
modest compression have more consistently strong levels and therefore stand out more in 
a mix, leading to a better experience for the audience. Keep in mind that the entire audio 
post-production process is about delivering that awesome audience experience. Viewers 
don’t care how it’s done; they just want it to be incredible. 

If you recall, the difference between a track’s loudest and quietest levels is its dynamic 
range. If you’ve ever worked with a waveform or Parade scope in the color page, controlling 
a track’s dynamics is very similar to adjusting the white and black levels of a clip. Just think 
of white as the loudest and black as the quietest. 

In this set of exercises, you’ll apply compression to a group of dialogue tracks all by the 
same character in the same scene. First, you’ll apply a compression preset to Raina’s first 
track A2 DX r1 in the “Learn to Surf” scene. Then you’ll copy and paste those compression 
settings to her other four tracks to help her voice stand out in the mix. Luckily, her tracks 
are all colored pink, so it’s easy to spot the tracks that you’ll work with. 

Let’s start by finding the high and low average levels in Raina’s first track. To do so, you can 
mark a play range around a group of clips. 
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1	 Open the timeline 9c Dynamics Start. 

2	 Zoom the timeline as needed until you clearly see tracks A2–A6 and all the pink clips 
within those tracks. 

3	 Solo the A2 DX r1 track. 

4	 In the Soloed track, drag a range with the multi-tool around the three consecutive pink 
clips from approximately 01:00:38:00 to 01:00:40:10.

5	 In the mixer, on the A2 Channel strip, double-click the Dynamics area to open the 
Dynamics window. Move the Dynamics window to the timeline area to the left of 
the mixer and the selected range. 

The Fairlight page Dynamics controls include four tools for modifying a track’s dynamic 
range. So far, you have used only the Gate to eliminate low-level noise. 

The Compressor is the most common control and is used to narrow the dynamic range 
by lowering the highest peaks and bringing them closer to the lowest peaks. It’s a 
great tool for bringing out some of the quieter spoken words while simultaneously 
lowering the level of the loudest words.
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6	 Start looped playback. In the Dynamics – DX r1 window, watch the Input meters and 
green dots on the dynamics graph to determine the average levels as well as the 
lowest and highest peaks. 

Even though Raina’s clips were balanced, her peaks dance above and below -15 dB, 
and the average levels range from around -13 to -18 dB. Most of this dialogue is within 
the desired -15 dB to -10 dB range; however, it hovers on the low end and could easily 
be lost amid the music and chaos of this part of the scene. Therefore, some light 
compression and make-up gain would be useful to narrow the dynamic range and 
increase the overall level of the track. 

NOTE  When working with the compressor, one thing to consider when 
dealing with a wide dynamic range is the compression Threshold value, which 
is the level at which the compressor kicks in. If you have strong dialogue 
tracks, you can play them a little lower to rein in more of the louder peaks. 
If the dialogue is quieter than desired, you can increase the Threshold value. 
In most cases, you’ll set your dialogue compression Threshold between 
-10 and -20 dB. 
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7	 Click the Compressor switch to enable the default compressor controls. During 
playback, look at the Output levels. 

In the Compressor controls, you can see six knobs that represent different 
compression settings, including Threshold, Ratio, Knee, and Mix. The latter two control 
the level and shape of the compression applied to a signal, while the lower three knobs 
control how aggressively the compression is used to Attack, Hold, and Release the 
signal during playback. 

The default compression settings are working on this track. However, the levels are still 
a little low for this action-packed moment of the scene. Let’s apply a dynamics preset 
to see if it improves the levels. 
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8	 Continue looped playback. In the Presets dropdown menu, choose the first option, 
Dialog – Basic. Listen to the results. 

9	 Continue looped playback and toggle the Dynamics controls off and on to hear the 
before and after results during playback. When finished, stop playback. 

The dialogue with the Dialog–Basic dynamics preset applied has a more consistent 
level and a tighter dynamic range between the peaks and average levels. 

Now that you have a Dynamics setting that works for Raina’s first dialogue track, let’s 
copy and paste the settings on her other tracks. 

10	 Close the Dynamics window. 

11	 Clear the range in the timeline. 

12	 Unsolo the A2 DX r1 track. 

13	 Select the remaining pink tracks, A3–A6. 
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14	 In the mixer, right-click the Dynamics area of the A2 DX r1 channel strip and choose 
Copy from the shortcut menu. 

15	 Right-click the A2 Dynamics area again and choose Paste to Selected. 

All the pink tracks containing Raina’s dialogue have the same dynamics settings. Let’s 
hear how they sound with the other tracks.
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16	 Play the scene and listen to the dialogue with the music and sound effects. 

Mission accomplished! What a difference a little mixing TLC can make on the dialogue 
tracks. Raina’s dialogue really stands out in the mix now. Compression can also be applied 
to an entire bus, such as the dialogue bus, for additional dynamics control of all 
dialogue levels. 

TIP  In the Fairlight page, the floating windows—such as plug-in controls, Pan, EQ, 
and Dynamics—will stay in front of the full cinema viewer if you want to watch the 
playback full-screen while making adjustments during playback. Also, pressing Esc 
will close the active floating window.

Auto-Ducking Busses with  
Sidechain Compression 
Previously, you applied keyframes, the Ducker, and fader automation in the timeline to 
dynamically control volume levels of a track or bus. You also used the compressor to 
control the dynamic range of dialogue tracks. In addition to standard compression, the 
Dynamics window also offers sidechain compression, which lets you use the signal from 
one track to control the amount of compression applied to another track. Sidechain 
compression is often referred to as auto-ducking because it automatically “ducks,” or 
attenuates, the level of one track based on the content of another. While similar to the 
Ducker, one advantage of sidechain compression in dialogue scenes is the ability to use 
either tracks or busses as the compression source. This is especially useful in scenes with 
numerous characters and dialogue tracks. 

In this exercise, you’ll explore the sidechain compression controls on the MX bus that 
control the music bus levels with the signal from the Dialogue bus. First, you’ll listen to the 
scene from the teal marker with the dynamics on the music bus (MX) disabled. Then, you’ll 
enable the dynamics on the MX bus and listen again to hear the difference. Once you’ve 
heard the power of sidechain compression in action, you’ll open the Dynamics controls to 
see what is happening under the hood in the Dynamics window. 

1	 Open the 9d Dynamics Sidechain timeline.
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2	 Scroll the mixer to the right to see the busses. Look at dynamics area for the busses.

Notice that compression has been applied to the DX bus, and the dynamics are 
enabled. The MX bus also appears to have dynamics applied, but the graph is gray, 
indicating the dynamics are disabled. 

You can enable or disable Dynamics, Pan, and EQ in the mixer with a Command-click 
(macOS) or Ctrl-click (Windows). 

3	 Play the timeline from the teal marker and listen to the competing music and 
dialogue levels.

Although the comically dominant music drives the scene like a cartoon montage, it’s 
the dialogue that tells the story and must be heard clearly over the score. There is 
room for both a heavy score and clear dialogue. All the scene needs is a little sidechain 
compression to seamlessly reduce the music just enough to let the dialogue 
shine through. 
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4	 In the mixer, Command-click (macOS) or Ctrl-click (Windows) the Dynamics area of the 
MX bus to enable the dynamics processing on that bus.

5	 Play the timeline from the teal marker again to hear the difference. 

Wow! It’s as if the focus shifts instantly from the music to the dialogue, without losing 
the comically dominant music. Now, let’s open the Dynamics controls for the MX bus to 
see how it’s done. 

6	 In the mixer, double-click the Dynamics area of the MX bus to open the 
Dynamics window. 

Notice that the Compressor controls are turned on and have been customized for this 
scene. In the lower right corner of the Compressor settings, you’ll find the Sidechain 
controls. Here, you’ll see On and Listen buttons as well as a source dropdown menu 
where you can choose the source track or bus that will trigger the compression on 
the MX bus. 

Sidechain On and Listen buttons perform exactly as their names suggest: 

	— On toggles Sidechain compression on and off.

	— Listen allows you to hear only the source track or bus driving the compression. 
This is great for verifying your compression source while you mix. 
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7	 Move the playhead to the teal marker and start playback. 

8	 When the dialogue starts, click the Listen button to hear only the source 
dialogue bus (DX).

The Listen button flashes yellow while it is toggled on. 

9	 Click the Listen button again to toggle it off. Stop playback.

10	 Click the Sidechain Source dropdown menu to see all the available tracks and busses 
that can be used as a source. 
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11	 Click the Sidechain Source dropdown menu again, or any empty timeline space to hide 
the dropdown menu. 

NOTE  For detailed information on Compression and other processing controls in 
the Dynamics window, go to the DaVinci Resolve Reference Manual available in the 
Help menu. 

Test-Driving the Sidechain 
Compression Controls
Now that you’ve seen and heard what the sidechain compression controls can do for your 
mix, it’s time to test them on your own. For this self-guided exercise, you’ll keep the 
finished version of the compression settings in the A Bank of controls and copy them to 
the B Bank of controls for experimentation. This is a great way to learn how things work 
while keeping the example settings just a click away. 

At the top of the Dynamics window, click the Copy A to B button (arrow) to copy the 
settings in the A Bank to the B Bank of controls. Then, click the B Bank button to show 
that set of controls. 

You now have a copy of the settings in the A bank that you can experiment with: toggle, 
reset, adjust, and explore the settings to hear how they affect the sidechain compression 
results during playback. 
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Adjust the Threshold and Ratio to set the amount of this gain reduction, and adjust Attack, 
Hold, and Release to set how quickly gain reduction responds to changes in the sidechain 
level (as defined by the source levels).

These controls take practice, so the more you use them, the easier it will be to set up and 
apply sidechain compression to your own projects. However, as you can hear for yourself, 
this is an awesome way to quickly “duck” your music bus levels beneath your dialogue 
bus levels. 

When you are finished, click the A Bank button to return the MX bus to the A Bank set of 
compression controls. 

The levels may be playing nicely, but they are competing in the same frequency range. No 
worries; you’ll fix that shortly with some EQ carving. 

Applying Equalization to  
Dialogue Tracks
Equalization (EQ) controls manipulate specific frequencies to shape or enhance the overall 
sound, just like working with color, saturation, and hue in color correction. For example, 
the human voice is based on a fundamental frequency range shared by millions, but 
additional frequencies add tonal qualities to “color” each voice and make it unique and 
recognizable. The primary function of equalization is to lower frequencies that detract 
from the voice and boost frequencies that clarify the overall sound. 

If you recall, the Fairlight page includes a six-band parametric equalizer for each clip in the 
Inspector, and another six-band equalizer for each track, which is the perfect tool for 
enhancing and “sweetening” audio tracks during the mix. Additionally, the Fairlight page 
mixer includes a six-band equalizer on each bus, and with DaVinci Resolve 20, there is even 
a Fairlight FX six-band equalizer that you can add to a clip, track, or bus for additional 
equalization control. 

In the following exercises, you’ll look at three EQ techniques during mixing. First, you’ll use 
the six-band EQ on Raina’s dialogue tracks to “sweeten” her voice. Then, you’ll use the 
Equalizer to reduce high frequencies in Raina’s off-screen dialogue to emulate the effects 
of off-axis, distant dialogue. Finally, you’ll apply an EQ carving technique to reduce similar 
frequencies in the music to make room for the dialogue. 
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First, let’s go over some key things to know about dialogue equalization. 

Fairlight Track EQ window showing real-time dialogue frequencies during playback

Things to Know About Dialogue Equalization
Audio frequencies are measured in Hertz (Hz) or thousands of Hertz, called kiloHertz (kHz). 

Low numbers represent low frequencies, and high numbers represent high frequencies.

When you change the amount of gain in a frequency range, you either boost (increase) or 
attenuate (reduce) the volume level of the frequencies within that range. Filtering out a 
specific frequency or a narrow range of frequencies is referred to as notching or cutting. 

The audible frequency range for the average human is between 20 Hz and 20 kHz 
(20,000 Hz). These frequencies are divided into three main categories:

	— Low 	 50–250 Hz

	— Midrange	 250–2300 Hz

	— High 	 2500–20,000 Hz
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The fundamental frequencies for human voices sit right in the low to lower-middle of the 
audible frequency range and vary between men, women, and children:

	— Men 	 80–160 Hz

	— Women 	 165–255 Hz

	— Children 	 250–300 Hz

Dialogue Frequency Level Enhancing and Troubleshooting
Frequency variations and intensities in each voice lend to that person’s 
recognizably distinctive qualities—some charming, some detracting. Below is a 
short list of some common frequency-related issues that can make the human 
voice sound harsh or unpleasant. Using this list as a guide, if you encounter a voice 
that is too boxy, nasal, or sibilant, you’ll know which frequencies are the likely 
culprit and how to reduce them.

100 Hz–300 Hz	 Too low sounds thin; too high loses clarity

200 Hz–500 Hz	 Just right sounds warm; too high can sound boxy

250 Hz–750 Hz	 Potentially muddy if too high

600 Hz–1.1 kHz	 Potentially nasal/honky if too high

1 kHz–3 kHz		 Adjust for intelligibility

3 kHz–6 kHz		 dd presence 

5 kHz–8 kHz		 Adjust sibilance (esses)

9 kHz–15 kHz	 Adjust sheen/sparkle

10 kHz–20 kHz	 Adjust breathiness/airiness

TIP  A common rule of thumb when adjusting dialogue EQ is to “cut narrow and 
boost wide.” Also, a little EQ goes a long way, so when possible, make subtle 
changes (no more than 2–3 dB), just as you would when adjusting hue on the 
color wheel.
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Sweetening Dialogue with EQ
In Lesson 7, you explored limiting high and low frequencies to make dialogue sound as if it 
is coming from a speaker. In contrast, actively listening, delicately cutting, and selectively 
boosting frequencies to improve a voice take patience and practice. In this exercise, you’ll 
apply three different EQ adjustments to Marley’s DX m2 dialogue track to find and reduce 
detracting frequencies, and then selectively boost frequencies to enhance the voice.

Every voice is different, so no single EQ setting will magically improve all your dialogue. 
However, you can tweak three key areas that will usually improve the overall sound 
of dialogue. 

First, you’ll start with a high-pass filter to roll off all the low frequencies below 85-100 Hz. 
Next, you’ll sweep the midrange frequencies around 250 Hz. This is the beefiest range of 
most voices and can often become boxy, muffled, or muddy. Attenuating a wide range of 
midrange frequencies, even by just a few decibels, can really warm up a voice and improve 
its clarity. Finally, you’ll enhance the high frequencies to add vocal presence, intelligibility, 
and sparkle by applying a nice wide boost around 3–5 kHz. 

TIP  First, find and cut (attenuate) the frequencies that detract from the dialogue, 
and then boost the frequencies that sweeten the voice.

1	 Open the timeline 9e EQ Start. 

2	 Zoom the timeline as needed until you clearly see tracks A7–A8 and all the olive-green 
clips within those tracks. 



587Lesson 9  Mixing and Sweetening the Soundtrack

3	 Solo the A8 DX m2 track. 

4	 In the soloed track, drag a range with the multi-tool around the five consecutive 
olive-green clips where Marley says, “It’s happening now. Take the picture!”

5	 In the mixer, on the A8 Channel strip, double-click the Equalization area to open the EQ 
window. Move the EQ window over the mixer, to the right of the selected range. 

The Fairlight page Equalizer controls include four tools for modifying a track’s 
frequency range. There is also a real-time analyzer (RTA) built into the EQ graph so you 
can see the tracks’ active frequencies during playback. 

6	 Start looped playback and watch the live frequency analysis of Marley’s voice.

As expected, the meatiest part of her vocal lives between 100–500 Hz. 



588Lesson 9  Mixing and Sweetening the Soundtrack

7	 In the Equalizer window, turn on Band 1. Listen to Marley’s dialogue while you drag the 
Band 1 handle right to around 85–100 Hz. You can watch the Band 1 Frequency field to 
see the current position of the handle. 

You probably won’t hear any dramatic changes to the dialogue track by rolling off 
the low frequencies, and some re-recording mixers are against the idea entirely. 
However, unless the voice you are working with is heavy on the low end, you’re unlikely 
to find any voice-enhancing frequencies below 85 Hz.

Next, you can start sweeping Band 3 around 250 Hz with a wide bell curve to hear 
what happens if you boost or attenuate around that range. As you sweep, 
exaggerating the height of the bell curve by at least +10 or -10 dB will help you 
determine how much adjusting the 250–500 Hz range affects this voice. 

8	 Start looped playback. Drag the Band 3 handle up to around +10 dB and listen to 
Marley’s voice as you sweep the frequencies between 250–500 Hz. Experiment to 
determine whether tweaking within this range improves her voice or amplifies 
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irritating vocal qualities. Drag the Band 3 handle below the 0 dB line to around -10 dB 
and sweep the same frequency range. When you are finished, stop playback.
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You probably discovered that boosting her vocal frequencies between 400 Hz–500 Hz 
sounded “boxy” and brought out the most unflattering qualities. Also, cutting those 
frequencies too much made her voice sound thin and lifeless. 

9	 Start playback and listen to Marley’s voice as you drag the Band 3 handle up to around 
-2.0 dB at 445 Hz to attenuate that frequency range.

So far, so good; her voice sounds great. Now, let’s boost the high end with a wide curve 
by 1–3 dB right around 3–5 kHz to brighten up the vocal presence and intelligibility. 

TIP  The secret to finding the sweet spot for vocal presence is to sweep for 
sibilance between 4 kHz and 8 kHz. When you find the annoying sibilant esses 
and whistles, back off toward the left by 1–2 kHz and then adjust that 
frequency amount to a slight increase above zero to accentuate just a touch of 
presence in the voice. Presence will make it sound as though someone is very 
close to the listener. This is especially important in close-up and extreme 
close-up shots. 

10	 Start looped playback, if necessary. Sweep the Band 4 bell curve between 3–8 kHz and 
listen for the sibilant esses and whistles. Sweep slightly toward the left until the 
sibilance is gone, and then lower the curve to around 1–3 dB. Trust your instincts and 
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your ears. However, if you aren’t sure, sweep around 8 kHz to find her sibilance, sweep 
left to around 6.20 kHz, and set the level to around +2 dB.

11	 During playback, toggle the Equalizer Bypass button on and off several times to hear 
the difference in Marley’s voice with and without EQ applied.

12	 Stop playback, clear the play range, and unsolo the A8 track.

Since Marley has two tracks in this timeline, let’s copy the EQ settings from this track 
and paste them into her other track. You can do this all from the EQ window’s 
Options menu. 

13	 In the EQ window, click the Options menu (…) and choose Copy.

14	 Select the A7 DXm1 track. 

The EQ window updates to show the newly selected track. 

15	 In the EQ window, click the Options menu (…) and choose Paste. 
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16	 Close the EQ window. Zoom to fit the clips to the timeline.

17	 Play the scene from the teal marker to hear Marley’s sweetened voice with the 
other tracks.

TIP  Training your ears to recognize subtle dialogue differences takes time.

Though subtle, the EQ improves Marley’s voice significantly. This is another reason to 
separate each character’s dialogue to its own track during editing so you can not only 
balance the volume levels but also apply equalization to the entire track. 

NOTE  The Equalizer Type dropdown menu offers the Native Fairlight response 
curve as well as three emulations of classic mixing console EQs: Earth—Native 
Fairlight response (Default), Air—SSL 4K, Ice—Neve V, and Fire—Focusrite. 

Applying EQ Carving to 
Improve Dialogue Clarity
The last “sweetening” technique that you’ll learn in this lesson is one of the easiest to apply 
and is as valuable a mixing staple as brown sugar on Thanksgiving. EQ carving involves 
reducing a wide curve of low-mid frequencies in the music or effects tracks to allow the 
fundamental dialogue frequencies to shine through. Competing frequencies all in the 
same range at the same time can “muddy” dialogue clarity. This is similar to having too 
much of the same color in a shot. For example, a shot of red apples and strawberries on a 
fancy red tablecloth against a red brick wall may reflect the creative vision of the director, 
but at the same time presents a challenge for the audience to discern what is important 
and where they should be looking. If the focus of the “red” scene is the fruit, a colorist may 
choose to help the fruit stand out by lowering the saturation or brightness of the other red 
elements. The same is true if music or background sound effects are dominant in the same 
frequency range as the dialogue. When this happens, and it happens often, you can 
change the pitch and volume levels of the background sounds or apply some EQ carving. 
In this exercise, you’ll carve the low-mid range frequencies on the music track.

1	 Open the 9f EQ Carving timeline. 
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2	 In the timeline, set a range in the MX bus track that includes the teal marker and the 
three blue clips in the DX h A2 track (approximately 01:00:14:15 – 01:00:49:20).

3	 Double-click the EQ area of the MX channel strip to open the EQ window.

4	 In the EQ window, drag the Band 3 bell curve upward to between +10 and +20 dB. 

5	 Start looped playback and listen to the music’s exaggerated mid-low frequencies from 
the bell curve. Sweep the curve toward the left and right between 100–500 Hz to hear 
how the different frequencies “muddy” the dialogue.  
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If you recall from earlier in this lesson, the meatiest part of human vocals usually stays 
between 100–500 Hz. Therefore, that is the same range that needs carving. First, you’ll 
need to widen the bell curve by adjusting the Q Factor control. 

6	 At the bottom of the Band 3 controls, drag the Q Factor control to the far-left position, 
0.3, to create the widest curve. 

TIP  When working with any of the Fairlight EQ graphs, you can scroll the 
middle mouse wheel to increase or decrease the Q Factor (width) of the 
bell curve.

7	 Continue playback and drag the bell curve down to -20 dB. Then, sweep the wide curve 
between 125 and 500 and listen to the simultaneous change in dialogue clarity at the 
expense of the robust musical score. Set the Band 3 Frequency to around 400.
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8	 Set the curve to between -5 dB and -10 dB. Toggle the EQ window off and on to hear 
the difference with and without the carving.

9	 Feel free to continue experimenting with your carving skills. When you’re finished, stop 
playback and close the EQ window. 

The next time you have background or music tracks competing with your dialogue tracks 
and you don’t want to lower the levels, break out your EQ and carve away!

Exploring EQ, Gain, and  
Chain FX Plug-Ins
You now have the basic skills to balance clips, tracks, and busses. Additionally, you can 
automate fader levels, pan controls, and any other parameters available in the mixer. 
Finally, you have also explored the Dynamics and EQ windows and have experienced 
setting levels using presets and applying these processing controls toward sweetening 
dialogue in your soundtracks. 

How you go about balancing and sweetening your soundtrack is up to you. However, 
this is a good time to arm you with a few additional mixing tools that are newly available 
in DaVinci Resolve 20. Let’s start with the new plug-ins that are now available in the 
Effects panel. 
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1	 Open the timeline 9g New Plugins. 

2	 Show the Effects panel on the left side of the screen.

Here, you will see all the Fairlight FX plug-ins, including three new mixing plug-ins: 
Chain FX, Fairlight EQ, and Gain. Let’s look at these in context with the scene you’ve 
been mixing in reverse order. 

3	 Hide the Effects panel. Show the mixer if necessary. 
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4	 In the timeline, set a play range using the pink duration marker for In and Out points. 
Select the A6 DX r5 30L track and locate the corresponding channel strip in the mixer.

As you can see, this track has five plug-ins in the effects slots: three are enabled 
(yellow), and two are disabled (gray). The track also has dynamics, EQ, and panning 
applied, and it is routed to both the Dialogue bus (DX) and DX Echo Auxiliary Bus. The 
built-in EQ and dynamics are the same for all of Raina’s tracks for consistency. 
However, in this case, the clips in this track are spoken offscreen, so Raina’s voice 
needs to sound as though it is coming from a distance and off-axis from the listener. 
This requires additional equalization to reduce the high frequencies. With the new 
Fairlight EQ plug-in, you can place additional EQ control anywhere in your effects chain 
at the clip, track, or bus level. 

If you look at the top of the A6 channel strip, you’ll see that the processing order 
dropdown menu has been modified to EQ DY FX, so that the built-in EQ is the first 
process applied to the track, followed by Dynamics, and finally FX plug-ins. 
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5	 In the A6 Effects area, open the FL EQ and Gain plug-ins. 

These plug-ins are self-explanatory. 

The Gain plug-in has a single dial to increase or decrease the clip, track, or bus level by 
up to 48 decibels. This gives you far more gain control at the clip level if you need to 
increase the level of a clip. At the track level, the Gain plug-in is useful for maintaining 
optimal levels at different processing stages, also called “gain staging.” In this example, 
the Gain reduces the level to complete the offscreen effect pre-fader. 

The Fairlight EQ plug-in is a fully functioning six-band parametric equalizer. In this 
example, it is being used as a high shelf filter to reduce the mid to high frequencies, 
as expected for distant off-axis dialogue. 

6	 Start looped playback and toggle the Fairlight EQ and Gain plug-in bypass switches off 
and on to hear the offscreen dialogue with and without the added EQ and Gain 
adjustments. When you are finished, make sure the plug-ins are turned on.
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7	 Close the plug-in windows.

Next, let’s open the Chain FX plug-in located below the Gain plug-in on the A6 channel 
strip. Remember, there are only six effects slots per track or bus in the Fairlight mixer. 
The A6 track has five of the six slots already filled. You can now create custom effects 
chains with your favorite plug-ins and operations with the new Chain FX plug-in. Add 
up to six effects in a chain, customize settings, and save the preset. You can even 
combine Chain FX plug-ins for longer chains in the channel effects slots.

8	 Open the Chain FX plug-in to see the Chain FX window. 

Here, you can see an empty Chain FX plug-in window. You can click the Add button (+) 
in the Plugin Chain area to add available plug-ins. Once plug-ins have been added, 
they work just like the plug-ins in the effects slots in the mixer, with controls to enable/
disable, open controls, or delete.

You can add a plug-in to a Chain FX plug-in by clicking the Add button. You can also 
add any plug-in in a channel effects slot in the mixer to a Chain FX plug-in by choosing 
the option Add to Plugin Chain from the plug-in window’s options menu. 
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9	 In the A6 channel of the mixer, open the second Chain FX plug-in window. 

This is a fully populated Chain FX plug-in with various customized Fairlight FX plug-ins 
applied. Notice that this plug-in window is disabled, so none of the processing is 
currently applied to the track. 

You can open any plug-ins in the Chain FX window and change the settings as needed. 
Enable only the plug-ins you need in the chain. The controls also let you add or remove 
plug-ins and save presets like this one. 

10	 Click the De-Esser Custom button on the Chain FX plug-in to open the window for 
that plug-in. 

As you can see, the plug-in windows are the same for plug-ins within the Chain FX 
window as they are if you use them in individual effects slots in the mixer. 
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11	 Close all the open plug-in windows.

You can create and save collections of custom plug-ins, such as effects for Dialogue 
sweetening or Mix Tools and Meters. 

12	 Scroll the mixer toward the right to see the busses. Open the Chain FX plug-in on the 
Stereo bus channel strip. 

In this Mix Tools and Meters plug-in preset, you’ll see five different plug-ins commonly 
used for mixing and mastering a soundtrack. 

13	 Close the open Chain FX window. 

Chain FX plug-ins expand your creative options by allowing you to build complex effects 
chains, create custom plug-in presets, and manage processing more efficiently, beyond 
the usual six-plug-in limit per channel strip. Each Chain FX plug-in can hold up to six 
individual plug-ins, and you can insert up to six Chain FX plug-ins on a single track or bus. 
This gives you access to up to 36 plug-ins on one track, if needed.

Working with New AI 
Processing Tools (Studio Only)
DaVinci Resolve 20 Studio introduces three new audio processing tools to make dialogue 
sound more consistent across different clips: EQ Matcher, Level Matcher, 
and Dialogue Matcher.

EQ Matcher lets you take the tone or frequency balance from one clip, like location audio 
from a set, and apply it to another, such as a studio ADR recording. You can copy the 
EQ curve from your reference clip and apply it to individual clips or entire tracks, or even 
automate it across a sequence. This helps smooth out tonal differences between 
recordings without needing to manually adjust EQ settings for each one.
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Dialogue Matcher goes even further. It not only matches the tone but also adjusts volume 
levels and the sound of the recording space—like room reverb or ambience. It creates a 
profile from a reference dialogue clip and applies that to others, even if they were recorded 
at different times or with different gear. This helps blend dialogue seamlessly, making all 
your takes feel like they were recorded in the same space.   

In this exercise, you’ll experience both AI processing tools and their results in just a few 
simple steps. 

1	 Open DaVinci Resolve 20 Studio, if necessary. 

2	 In your TML Audio Post project, open the timeline 9 Studio Additional Tools. 

Here, you’ll see two different stacks of clips duplicated to different tracks to easily 
show the progression from the original clip to the version ready for AI processing.  

3	 Use the Range tool to set a looped playback range around the orange clip in the A1 
Original track. 

4	 Press A for the default Pointer mode arrow tool. 

5	 In the Fairlight menu, ensure that Exclusive Solo is enabled (checked). 

6	 Solo the A4 Film Version ADA VO track. Play the first two clips, “Emiliana Newton. Yes.”
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This is the final processed sound of the ADA voice in the film Hyperlight. For this 
exercise, you’ll test the EQ Match and Dialogue Match AI processes in DaVinci Resolve 
Studio to match the EQ and overall sound in a recording of a different person with a 
different microphone from the final version of this computer VO character. 

7	 Solo and play the beginning of the clip in the A1 Original track to hear the clean 
(unprocessed) recording of this author saying, “Emiliana Newton. Yes.” 

Your goal is to process the sound of this author’s recording so that it sounds as though 
the microphone and effects processing are the same as the finished source sound in 
the A4 track. Let’s start with the EQ Match processing. First, you’ll need to make an EQ 
profile of the clip or clips that you want to match. 

8	 Solo the A4 track. Select the first green clip in the A4 track. Right-click the selected clip 
and choose Clip Operations > EQ Matcher > Capture EQ Profile.

Once the EQ Profile has been captured, you can apply it to any selected Clip EQ, Track 
EQ, or Automated Track EQ for changes over time. Let’s try the EQ Profile on the clip in 
the A2 Dialogue Match track.

9	 Right-click the clip in the A2 EQ Match track and choose Clip Operations > 
EQ Matcher > Apply Clip EQ. 
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10	 Show the Inspector and select the clip in the A2 track, if necessary, to see the EQ 
applied to the clip. 

11	 Solo the A2 track and play the clip to hear the difference. Feel free to click the Solo 
buttons between the A1 track and the A2 track to hear the before and after versions 
of the clip with and without the new EQ profile applied. When you are finished, 
stop playback. 

If you thought that was impressive, wait until you try the AI Dialogue Match process! 
Best of all, you’ll follow the same simple steps. Let’s try it! 

12	 Solo the A4 track. Right-click the first clip and choose AI Tools > Dialogue Matcher > 
Capture Dialogue Profile. 
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13	 Right-click the clip in the A3 Dialogue Match track and choose Apply Dialogue Profile.

14	 Solo the A3 track and listen to it. During playback, solo the A1 and A3 tracks one at a 
time to hear the before and after versions of the voiceover. 

Mind blown! The mic tone, room reverberation, and effects used to create the “computer 
voice” sound were all applied to the unprocessed clip on track A3. The only difference 
between the original and processed versions is the voice itself—in this case, the author’s 
voice. Tools like EQ Matcher, Level Matcher, and Dialogue Matcher can save you significant 
time and effort when replicating a specific sound. These AI-driven processes are especially 
useful when working with the same talent across multiple episodes in a consistent 
location, where you need to match the sound to a previous episode.

Convert One Voice to Another Without ADR, 
Dubbing, or Additional Recording
AI Voice Convert in DaVinci Resolve 20 Studio lets you take the sound of one person’s voice 
and apply it to another speaker’s recording. For example, if a line of dialogue was replaced 
by someone else during ADR or a scratch track, you can make it sound like the original 
actor’s voice using AI. The tool creates a voice profile from a reference clip and then 
transforms the target voice to match the tone, pitch, and overall vocal identity of that 
person. This helps keep voice continuity in your project, even when using different 
speakers, without re-recording. It’s especially useful for fixing mismatched dialogue or 
creating placeholder lines that sound like the real actor.

In this exercise, you’ll experiment with the four different voice models that come with 
DaVinci Resolve 20 Studio. If you have been following the lessons in this book, you’ll be 
familiar with the clips that you’ll work with in the A5–A8 tracks. 

1	 In the 9 Studio Additional Tools timeline, scroll the timeline toward the right so the 
stack of green clips on A5–A8 is closer to the track headers. 
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2	 Set a play range around the green clip in the A5 VO Test Original track. 

3	 Solo and play the green clip in each of the tracks from A5–A7, one at a time, to hear the 
progression of the same poorly recorded clip from low and noisy, to louder and noisier, 
to cleaned up with the Voice Isolation Track FX. 

Next, you’ll convert the voice in the clip on the A8 track to one of the four voice profiles. 

4	 Solo the A8 Voice Convert track. 

5	 Right-click the clip in the A8 track and choose AI Tools > Voice Convert.

The AI Voice Convert window opens with a simple set of controls. Here, you’ll use the 
default settings with a few minor adjustments. 

6	 In the AI Voice Convert window, set the controls as shown: 

	— Track: New Voice.

	— File Name: Clip Name-Model Name.

	— Voice Model: Female 2 US

	— Check the Tight Matching to Source option (this is important for lip sync if there is 
video plus audio)

	— Pitch Change: 0.0
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7	 Click Render. 

A progress dialog shows the voice analysis for the conversion. When the analysis is 
finished, the original clip is disabled, and the newly rendered clip with the Female 2 US 
voice model is in the A9 New Voice track. 

8	 Solo the A9 New Voice track and play the clip. 

Amazing! Same words and timing, but with a different voice. Let’s do it again, this time, 
with the Male 1 voice. 

9	 Solo the A8 track. Select the clip in the A8 track and press D to enable the clip. 

10	 Right-click the clip in the A8 track and choose AI Tools > Voice Convert. 

11	 In the AI Voice Convert window, make the following changes: 

	— Set the Track dropdown menu to New Track. 

	— Set the Voice Model dropdown menu to Male 1 US.
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12	 Click Render.

Once again, the clip in A8 is disabled. However, the newly rendered clip with the Male 1 
US voice model is in a new track at the bottom of the timeline. 

13	 Solo the A10 track and play the results. 

Impressive! Now let’s try the same thing on a clip with synced picture and sound. 

14	 Solo the A8 track. 

15	 Mark a new play range around the Navy clip in the A8 track. Zoom the track as needed 
to clearly see the Navy clip. 

16	 Undock the viewer from the monitoring panel and move the floating viewer to the 
timeline area above the Navy clip. 
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17	 Right-click the Navy clip in the A8 track and choose AI Tools > Voice Convert.

18	 In the AI Voice Convert window, set Track to the New Voice and choose one of the Male 
voice models. Click Render. Listen to the results. 

19	 When you are finished, close the viewer. 

As you can see, and hear, the newly converted voice is in perfect sync with the video. Feel 
free to try a different voice model before moving on to the next section.

NOTE  If you want to try creating a voice profile from a source clip or clips in the 
media pool, you simply right-click the clips and choose AI Tools > DaVinci AI Voice 
Training and follow the self-explanatory steps. You can find more detailed 
information about AI Voice Training and working with DaVinci Resolve AI tools in 
the DaVinci Resolve Reference Manual available via the Help menu. 

Mixing a Soundtrack with 
the AI Audio Assistant 
Throughout this book, you’ve learned how to record, edit, clean up, enhance, sound 
design, and mix your soundtrack. Along the way, you’ve worked with various tools, 
techniques, and plug-ins across different types of projects. Now, you’re ready to apply 
those skills to your own work. But if you’re new to audio, or if you’re a video editor or 
content creator with basic audio tracks and aren’t quite sure how to balance or mix them, 
DaVinci Resolve 20 Studio has you covered with the new AI Audio Assistant.

This powerful tool analyzes the audio in your timeline and creates a professional-sounding 
mix for you. From the Timeline menu, simply go to AI Tools and choose Audio Assistant. 
You’ll be guided through the process: the assistant organizes your tracks, evens out 
dialogue levels, balances sound effects and music under the dialogue, and delivers a final 
mastered mix, all automatically. It’s the perfect solution for editors who want a faster, 
easier way to polish their audio and feel confident about the results. 

In this exercise, you’ll open a timeline with unbalanced sound and use the AI Audio 
Assistant to organize and mix the soundtrack. 
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1	 Open the timeline 9 Studio – AI Audio Assistant.

2	 Show the monitoring panel and mixer, if necessary. 

This timeline is a scene from the film Hyperlight. 

NOTE  This example has a limited number of tracks with clips that are 
intentionally unbalanced so you can see and hear a noticeable difference with 
the AI Audio Assistant’s results.

WARNING  You may wish to lower the monitoring level on your system before 
playing the timeline, as parts of it may be too loud.

3	 Play the timeline once to hear the unmixed part of the scene.

Your trained ears are likely on high alert. No worries. You can stop cringing and get 
busy fixing this timeline. No doubt you recognized that the dialogue levels are low, the 
music is inaudible, and the drone and alarm sound effects overpower everything. Your 
instincts are probably driving you to start manually balancing the clips in the tracks 
and then tackle the mix. If you have been following along with this book, this author is 
confident you could clean up this unmixed audio chaos in minutes. Instead, let’s see 
what the DaVinci Resolve Studio AI Audio Assistant can do with it. 



611Lesson 9  Mixing and Sweetening the Soundtrack

4	 Choose Timeline > AI Tools > Audio Assistant. 

The default Delivery Standard is YouTube. 

5	 In the AI Audio Assistant dialog, choose Netflix as the Delivery Standard. Then click 
Auto Mix. 

The audio assistant will follow as a series of processes, with a dialog to indicate each 
step along the way to the finished mix. 
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The finished timeline includes organized tracks that are color-coded for dialogue, 
music, FX, and BG FX. The clip levels are balanced, and the tracks are sweetened and 
mixed as needed. 

6	 Return the monitoring level on your system to your preferred setting.  

7	 Play the timeline from the beginning. 

Well done, AI Audio Assistant! The dialogue is clear, the music is audible, and the 
background sounds are where they should be—in the background. Keep in mind, this is a 
starting point. From here, you could still adjust clip or track levels to your own liking. 

If you were impressed with the AI Audio Assistant and are now worried about your job 
security in professional audio, relax! The AI Audio Assistant is doing some basic mixing to 
produce a predictable result. The reason the example didn’t involve the surf scene from 
Too Much Life or your exciting Post Park Normal podcast intro is that the Audio Assistant 
isn’t creative. Both of these projects that you have been working on throughout this book 
include creative sound design that goes beyond basic mixing rules. The exaggerated 
sound FX levels in the podcast intro are part of the storytelling and audience experience, 
just like the louder-than-normal music in the cartoonish “Learn to Surf” scene in Too Much 
Life. Sure, all these AI tools are impressive and helpful. They can absolutely be used with 
confidence as needed, along with all your own skills, creativity, intuition, and uniquely 
human storytelling with sound abilities. 

Congratulations! You have finished this mixing and sweetening lesson and are ready for 
bouncing and delivering your soundtracks! 

Lesson Review
1	 True or False? You should balance the volume levels of individual clips in the timeline 

before adjusting track levels in the mixer. 

2	 Where do you set and balance overall track levels? 

a)	 Mixer

b)	 Track Level window

c)	 Monitoring panel

d)	 Control room

e)	 Loudness control
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3	 What is a common reason for applying a compressor to a dialogue track?

a)	 To make noise sound like a computer warble

b)	 To reduce the dynamic range between the loudest and quietest peaks in the track

c)	 To make the sound seem like it is coming from a small space

d)	 To create the aural illusion of a physical barrier

4	 What is the difference between the Ducker Track FX and side chain compression in 
the mixer? 

a)	 The Ducker is only for music tracks, while side chain compression works with 
any track. 

b)	 The Ducker can only have one source track, while side chain compression works 
with multiple tracks.

c)	 The Ducker works on tracks only, while side chain compression works with tracks 
and busses. 

d)	 The Ducker has a waveform graph and no user controls, while side chain 
compression has user controls and no waveform graph. 

5	 True or False? Applying EQ carving to a music track is the same as adding keyframes to 
the volume curve to dip the track’s sound when there is spoken dialogue.

6	 How many plug-ins can be added to the Chain FX plug-in?

a)	 2

b)	 3

c)	 4

d)	 5

e)	 6 

7	 Which controls enable you to automate faders, pan controls, and other parameters?

a)	 Automation

b)	 Animation

c)	 Auxiliary

d)	 Agnostic
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Answers
1	 True

2	 a

3	 b

4	 c

5	 False. EQ Carving reduces some frequencies shared by the dialogue to improve 
dialogue clarity. 

6	 e

7	 a
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and that the files are rendered in the 
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In this lesson, you’ll explore 
DaVinci Resolve’s built-in loudness 
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loudness analysis to ensure the final 
elements meet delivery loudness 
requirements. Then, you’ll return to 
the partial scene that you mixed in 
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effects, and the full stereo mix. 

Finally, you’ll render stereo and 5.1 
surround sound versions of the Post 
Park Normal podcast intro in the 
deliver page.
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Preparing the Project
Let’s start by opening the TML project, where you will work with the loudness metering 
and bounce versions of the “Learn to Surf” scene. First, let’s create a bin for bounced files 
in the media pool. 

1	 Open DaVinci Resolve if necessary.

2	 Open your TML Audio Post project.

3	 In the Fairlight page, open the 10 Full Surf Scene timeline.

4	 In the media pool, right-click the Master bin and choose New Bin. 

5	 Name the new bin Bounced MIX and STEMS. 

6	 Hide the media pool. 

Monitoring and Analyzing 
Loudness in Your Mix
Now that you’re ready for the final output, you need to monitor and analyze the output 
levels. In the past, broadcast standards were based on the highest peak level in a 
soundtrack. As long as audio content did not exceed that level, it would pass quality 
control. That led to commercials that applied heavy audio compression to narrow their 
dynamic range and sustain all voiceovers at the maximum allowable (and overbearing) 
level. For a brief time, there was a loudness war. Really!

The television loudness war was that awkward era when commercials felt like they were 
yelling at you during a quiet movie night. Thankfully, the CALM Act (Commercial 
Advertisement Loudness Mitigation Act) stepped in like a good roommate, telling them to 
turn it down and play nice with the rest of the show.
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To even the acoustic playing field, new loudness standards were introduced that apply to 
all broadcast programs (television and radio), regardless of the length or type of program. 
In North America and parts of Asia, an integrated target of -24 LUFS (Loudness Units Full 
Scale) is the norm for broadcast content, whereas in Europe the target is -23 LUFS. 
(Theatrical films, trailers, and streaming videos have different standards.)

DaVinci Resolve includes three types of monitoring panel meters to measure such 
standards. Peak meters are traditional Root Mean Square (RMS) meters available for 
every track and bus that uses a decibel scale, True Peak (TP) meters in the Control Room 
measure the sum of all audio channels routed to the current bus selected in the 
monitoring dropdown menu, and Loudness meters measure the loudness in your program 
based on the loudness unit scale (LUFS). Presets available in the Loudness options menu 
(...) allow you to choose the most current loudness metering, ITU BS.1770-1 and ITU 
BS.1770-4, as well as international Loudness standards for the meters. 

The Fairlight page Loudness meters include a numeric display that outputs various useful 
loudness measurements, the most important of which is the Integrated level.

	— M displays the momentary loudness unit at the playhead location.

	— The Loudness meter displays the sum of all channels for the playback duration.

	— The numeric value at the top is the max LUFS value over that range.

	— Short displays loudness over a 30-second range.

	— Short Max displays the played range’s maximum true peak level.

	— Range displays the dynamic range of loudness in the entire program.

	— Integrated displays the average loudness for the entire played range. This value 
targets either -23 LUFS or -24 LUFS, as required by broadcasters and configured in 
your Project Settings.

	— True Peak (TP) meters show the highest program peak.
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You can monitor loudness levels for an unrendered mix in real time during playback in the 
monitoring panel Loudness meters and in the timeline Loudness graph. Additionally, you 
can quickly perform an offline loudness analysis, which is much faster than playback, to 
assess the levels of your rendered mix. In the next series of exercises, you’ll explore both 
methods for measuring loudness in DaVinci Resolve. 

Analyzing and Normalizing Levels
If you are working with rendered mixes, it’s a good idea to check their loudness levels to 
see if they meet delivery standards. In this exercise, you’ll use Fairlight’s offline Loudness 
Analyzer to check the loudness levels based on a specific loudness measurement preset. 
This is a great way to quickly measure loudness in imported audio files or bounced mixes. 
If the levels are too loud, you can normalize the clip to the same loudness preset and then 
rerun the analysis. For this example, you’ll analyze the Surf Scene Reference stereo clip 
with the international standard ITU-R BS.1770-4 loudness measurement preset. 

1	 Open the 10 Full Surf Scene timeline, if necessary. 

You may have noticed that the audio waveform in the clip is quite pronounced, 
indicating that it has likely been rendered at louder levels than necessary. 

2	 In the timeline, right-click the audio clip in the A1 track and choose Clip Operations > 
Analyze Audio Levels to open that dialog.
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3	 In the Analyze Audio Levels dialog, choose ITU-R BS.1770-4. Click Analyze.

When using the ITU-R BS.1770-1 and ITU-R BS.1770-4 loudness presets, you will always 
see accurate True Peak and Loudness measurements in blue. The other loudness 
standards presets use red or yellow to show that the levels are too loud or within 
tolerance, respectively. In this case, a True Peak level of +0.5 dBFS and Loudness 
measurement of -17.2 LUFS is too loud for any broadcast delivery standards. Luckily, 
you can normalize the clip to whichever loudness requirements you need. 

4	 Right-click the audio clip in the A1 track and choose Normalize Audio Levels. 

Your goal is a maximum Target Level of -2.0 dBTP and Target Loudness of -23 LKFS. 
Setting the Normalization dialog to the ITU-R BS.1770-4 mode will reduce the clip’s 
relative loudness as much as necessary until it is below or within tolerance of both 
loudness targets.

NOTE  Keep in mind that the True Peak is a ceiling, not a desired target. 
In fact, ideally, in an entire show the levels should almost never reach the 
True Peak maximum level. This includes action, sci-fi, and war films. In a 
typical dialogue film with dynamic levels, the True Peak is somewhere between 
-6 dBTP and -3 dBTP. 
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5	 In the Normalize Audio Level dialog, set the Normalization Mode to ITU-R BS.1770-4. 
Click Normalize. Once the normalization is complete, the waveform changes to indicate 
the reduced clip level. Select the audio clip and analyze the audio levels for ITU-R 
BS.1770-4 again. 

6	 Close the Analyze Audio Levels window.

Mission accomplished! The levels of the Surf Scene clip meet the loudness standard 
and are ready for delivery. 

Showing the Loudness History 
Curves in the Timeline
If you’re working with DaVinci Resolve, you can show loudness curves in the Bus 1 track so 
that you can easily see loudness levels in context over time and spot exactly where 
loudness issues occur and fix them. In this exercise, you’ll show the Loudness History 
Curves in the timeline, then play through the timeline once to see the full loudness history 
and compare it to the loudness meters. Then, you’ll reset the meters and play only the last 
part of the timeline to see the difference in loudness levels over a shorter, dynamic part of 
a scene versus the entire scene, reel, or show. 
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1	 Move the playhead to the first frame of the 10 Full Surf Scene timeline. Then, click the 
Toggle Automation button to turn automation on and enable visibility for the bus 
tracks in the timeline. 

2	 In the timeline, increase the height of the B1 Bus 1 track until you see the Loudness 
History controls in the track header.

3	 Switch on the Loudness History controls to see the Loudness history graph in the 
timeline. Then check the Integrated, Momentary, and Short Term options to see all 
three loudness metering graphs.

To see the Loudness history in the graph, you must start the Loudness meters.

4	 In the monitoring panel, click the Loudness meters Options menu (…) and choose 
BS.1770-4. Also, make sure the “Lock Metering to transport” and Absolute Scale 
options are checked. 

5	 On the Loudness meters, click Reset and Start.
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6	 Start playback. The loudness metering colors and values are drawn in the graph as 
you play. Feel free to mute or dim playback if you don’t want to listen to the entire 
scene. The important thing is that you play through the entire scene. When you get to 
the end of the clip, stop playback.

The Loudness meter shows the same numbers as the offline loudness analysis, with a 
True Peak of -5.2 and an Integrated level of -23.0 LKFS. If the loudness levels are within 
tolerance (+/- 2 dBFS), the graph and the meters will display yellow.

These three Loudness curves follow the same color indicators as the loudness 
meters. If the program level exceeds the -23 LKFS loudness standard, that part of the 
graph is shown in red along with the meters. A little red or yellow in the graph is fine 
as long as the loudness measurement at the end of the reel (for theatrical films) or full 
show (for streaming services like Netflix) meets the loudness requirements.

NOTE  The Loudness History graph shows the visual history of the program 
loudness in the timeline. You cannot edit the loudness history curves. If there 
is an issue with the loudness levels, you must fix the volume levels in the 
tracks and busses using standard mixing and automation workflows. 
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Remember, loudness measurements are for the cumulative sound of a show or reel. 
In any given soundtrack, there will be sections that are quieter and other sections that 
get much louder. They should be balanced over time so the audience isn’t bombarded 
with nonstop loud music and sound effects for the entire show. Hence, the loudness 
requirements. 

Let’s run the loudness meter and graph again, this time starting at the blue marker, 
which only includes the last part of the scene that you were mixing in the previous lesson. 

7	 In the timeline, move the playhead to the blue marker at 01:03:04:05.

8	 On the Loudness meter, click Reset and Start. 

9	 Start playback from the blue marker. When you get to the end of the clip, stop playback 
and look at the graph and Loudness meters. 

As expected, the True Peak is the same as before because that wouldn’t have changed. 
However, the Integrated loudness level is -20.1, which is too high when measured 
without the rest of the scene. 

Now you know how to read the Loudness meter, analyze and normalize a rendered audio 
mix, and show the loudness graph in the timeline. Next, you’ll open a version of the scene 
that you mixed in the previous lesson and learn how to bounce the finished mix. 
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Bouncing Mixes in 
the Fairlight Page
Assuming your soundtrack is mixed and clients are happy with the soundtrack levels and 
overall sound, it’s time to bounce or render your mix into a finished file that can be moved, 
shared, duplicated, and played outside of DaVinci Resolve. 

In this exercise, you’ll bounce stems including dialogue (DX), music and effects (M&E), and 
the stereo mix for the “Learn to Surf” scene that you mixed in the previous lesson.

This can be accomplished by muting and soloing specific tracks or simply bouncing the 
different busses to new tracks in the timeline. 

There are four things you’ll need to do prior to bouncing tracks or busses:

	— Select a destination for the bounced files in the media pool. If you don’t have a 
bin, make one.

	— Make sure automation is toggled on so that all automation levels and changes will 
be included.

	— Set a range that includes the portion of the timeline that you want to render.

	— Determine which bus or busses you want to bounce and the format you want to 
bounce to. 

You’ve already created a bin, so all you need to do is select it. Then, check that automation 
is toggled on, set a range, and let the bouncing begin! 

1	 Open the 10 Surf Scene to Bounce timeline. 

2	 In the media pool, select the newly created Bounced MIX and STEMS bin. Then hide 
the media pool. 

3	 If necessary, toggle automation on. 

4	 Move the playhead to the first blue marker and press I to mark an In point. 
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5	 Extend the mixer. Zoom the timeline as needed to see all the clips, tracks, and busses. 

6	 In the timeline, locate tracks A22–A25. 

These tracks were created for the bounced files you will create shortly. The track 
heights were locked (via the right-click menu) to make them easy to spot and maintain 
their uniform height regardless of your screen size or resolution. 

For this exercise, you will bounce four versions of the mix, including Stereo Mix, DX 
Stem mono, DX Stem stereo, and M&E Stem stereo. Three of these will be 
straightforward bounces that can be rendered straight from the associated busses. 
Let’s start by bouncing a stereo version of the dialogue. In this case, there is no stereo 
dialogue bus, so instead, you’ll mute all other busses and render the remaining 
stereo sound. 

7	 In the timeline, mute the FX, bgFX, MX, and M&E busses. 

This leaves the Stereo, DX, and DX Echo busses unmuted. The DX and DX Echo busses 
are assigned to the Stereo bus, so when you bounce the Stereo bus, the results will be 
dialogue plus echo. Let’s try it.



626Lesson 10  Finishing and Delivering Tracks

NOTE  When bouncing a mix to an existing track, the bus format and track 
must match. For example, you can bounce a stereo bus to a stereo track. If you 
don’t have a pre-existing track to bounce to that is the correct format, you can 
choose New Track in the Destination Track dropdown menu, and a new track 
will be created for the bounced file. 

8	 In the Timeline menu, choose Audio > Bounce Mix to Track.

9	 In the Bounce Mix to Track dialog, set the Bus 1, Stereo Destination Track to DX 
STEM Stereo.

10	 Click OK. 

The bounced file appears in the A24 DX STEM Stereo track. The bounced dialogue clip 
is yellow based on the track color. Let’s see how it sounds. 
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11	 Unmute all the busses. 

12	 Solo the A24 track. Play a few seconds of the track starting at the visible waveform to 
hear the dialogue-only clip that includes the echo effect. 

Voilà! Stereo dialogue with echo. One bounce down, three to go! 

Bouncing Busses to Create Stems
In addition to using submixes for simplified mixing, another option is to bounce the stereo 
bus as a full mix, the mono DX submix bus as a stem, or the M&E bus to create a music and 
effects-only version of the mix. Not only can you create all of these using the Bounce Mix 
to Track dialogue, but you can also bounce them all at the same time. Seeing is believing. 

In this exercise, you’ll bounce three busses simultaneously to render three different 
versions of the mix. 

1	 Unsolo the A24 track. Then mute the A24 track so it is not included in the 
bounced mixes. 

2	 In the Timeline menu, choose Audio > Bounce Mix to Track.

3	 In the Bounce Mix to Track dialog, assign the Destination Track dropdown menus 
as follows: 

	— Bus 1 Stereo bus to the MIX Stereo Destination Track.

	— Bus 2 DX Mono bus to the DX STEM mono Destination Track.

	— Bus 7 M&E bus to the M&E STEM Stereo Destination Track.
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4	 Click OK.

The new bounced files are in their premade tracks and ready to play. 

5	 Unmute the A24 track. 

Before moving on to the Deliver page, this is a good opportunity to locate the rendered 
files in the media pool and give them clip names if necessary. 

Renaming and Exporting 
Stems as Multichannel Files
Bounced files are named after their source, which makes it easy to identify them in the 
media pool. In this exercise, you’ll rename and export your new rendered files to a folder 
on the Desktop.

1	 Show the media pool. Select the Bounced MIX and STEMS bin to see the contents in 
the media pool library. 

2	 Select each of the rendered files one at a time to see how many channels show in the 
Preview Player. Move the playhead in the Preview Player to the middle of the clip for a 
better view of the bounced waveform. 

Single-channel, mono bounced file	 Two-channel, stereo bounced file
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Two-channel, stereo bounced file	 Two-channel, stereo bounced file

3	 In the media pool, play a bit of each clip to confirm the contents, and then change the 
clip name for each file to match the associated track name and channel configuration 
as follows:

	— DX_Mono

	— M&E_Stereo

	— DX_Stereo

	— MIX_Stereo

Now that you’ve given the bounced clips new names, you can show them in the 
timeline. If your timeline already shows the clip names, feel free to jump ahead to 
the next section. If the timeline still shows the original filenames, you can update the 
display in step 4. 
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4	 Choose Fairlight > View Clip Info Display. Set the Name option to Clip Name. Click OK. 

The new clip names appear in the bounced files in the timeline as well. 

Preview the Bounced Files 
Now that you’ve bounced and named four different variations of the mix, it’s time to 
test-drive the clips to make sure they are in sync and the levels are good.

Take a moment to listen to and verify each of the bounced files in the timeline. Use the Solo 
and Mute buttons to play back only the bounced mixes. You can combine the M&E with 
either of the DX files to hear them together. This is a self-guided exercise, so you can take 
as long as you want. At the minimum, solo each file one at a time and play a few seconds of 
it while looking at the video and meters to verify it is in sync and the levels still sound good. 
There should be no difference in sound or levels between playing the mix or bus and 
playing the associated bounced file. 

When you are finished, proceed to the next section, where you will export the files to a 
new folder on your system.

NOTE  If you have not completed the previous exercises, open the timeline 
10 Surf Scene to Export to catch up.
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Exporting Files from the Timeline
The last step for your bounced mixes is to export them from DaVinci Resolve so they can 
be shared with others as needed. The Fairlight page includes a handy Export Audio Files 
dialog that offers all the settings you need to export your files. 

In this exercise, you’ll export all four of the bounced audio files to a new folder on the 
Desktop and add a tag representing the movie at the beginning of each filename. 

To bounce the timeline clips as new multichannel files, you’ll use the Export Audio Files 
option available in the contextual right-click menu. Also, to keep things organized, you’ll 
create a new folder called TML Deliverables on your Desktop as a location for the 
exported files.

1	 Hide the media pool.

2	 With the Pointer mode Arrow tool, select the A22–A25 tracks. 

3	 Right-click anywhere in the timeline and choose Export Audio Files from the 
contextual menu.

The Export Audio Files dialog opens. The options are self-explanatory. Let’s start 
at the top and make the necessary adjustments to export all four bounced files 
simultaneously. 

4	 In the top section of the Export Audio Files dialog, do the following: 
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	— Click Browse, create a new folder on the Desktop (or other preferred location), and 
name the folder TML Deliverables.

	— In the File Name dropdown menu, choose “Tag + track name.”

	— In the Tag field, type TML_ (with an underscore).

	— It’s important to add the underscore to separate the tag from the rest of 
the filename.

	— Uncheck the option to “Also add to Media Pool” unless you are working 
collaboratively with others in a shared project. Keep in mind that these files 
are already in the media pool, ever since you bounced them. 

5	 In the next section, choose the following options:

	— File format: BWAV

	— Check the option to “Enforce video compatibility.”

	— Sample rate: Same as project

	— Channel format: Interleaved. This means it will be a multichannel file, such as 
stereo, with panned left and right channels. 

In the middle section, you’ll use the default settings. You’ll only need to specify which 
clips or tracks will be exported. 

6	 In the middle section, use the default settings as shown. Check the option to “Only use 
selected tracks.”
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The last two sections provide options to Export with clip information such as Clip level, 
fades, EQ and FX, and iXML information. Below that, you’ll see the option to Normalize 
the clips as you export them. Assuming the levels are already good to go, there is no 
need to normalize the clips at this time. 

7	 Check the Export with Clip level option if necessary. Leave the Normalize dropdown set 
to No normalization. 

8	 Click Export. When the export is complete, check the TML Deliverables folder on the 
Desktop for your exported files.

Congratulations! Not only did you edit the dialogue tracks, but you also sweetened, mixed, 
bounced, and exported versions of the mix. Now that you’ve stepped through the process, 
you can apply these tools and techniques to your own projects. Next, you’ll open a 
different project and render stereo and 5.1 mixes in the deliver page. 
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Preparing the Project
1	 Open your Podcast Intro Combo project. 

2	 Open the timeline 10 Deliver Stereo and 5.1.

The timeline includes 23 tracks and 10 busses. Let’s monitor a few seconds of the 5.1 
and Stereo busses. 

3	 In the monitoring controls above the mixer, click the monitoring dropdown menu to 
see all the different busses that you can monitor during playback. 

4	 Set the monitoring menu to Stereo so you can monitor the Stereo bus. 

5	 Start playback from the beginning of the timeline and listen to some of the stereo mix. 
Continue playback and change the monitoring menu to the 5.1 bus. Feel free to listen 
to any of the busses during playback. When finished, stop playback. 

6	 Set the monitoring menu back to the Stereo bus.

If you are listening with headphones, did you notice that when monitoring stereo busses 
the sound was focused in the front left, right, and center? However, when monitoring the 
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5.1 busses, the sound effects and music sound as if they are coming from the front, side, 
and behind you. Hence the name 5.1 surround sound. 

Rendering Stereo and  
5.1 Mixes in the Deliver Page
It’s time to deliver your podcast intro mix. Whether it is your final mix, stems, or just an 
intermediate timeline such as your sound effects, whatever type of deliverable you need to 
output, the deliver page of DaVinci Resolve is where you can do it. 

In this exercise, you’ll go to the deliver page to render loudness-compliant stereo and 5.1 
mixes to a folder on the Desktop. Once you’ve completed rendering the mixes, you’ll be 
invited to return to the Fairlight page timeline to explore the final mix, automation, tracks, 
busses, and panning. 

1	 Mark an In point at the beginning of the timeline. 

2	 Make sure the Toggle Automation button is on (red). 

3	 In this timeline, all busses and tracks should be unsoloed and unmuted.

4	 Click the Deliver button to open the deliver page.

The toolbar buttons switch 
between file rendering 

and tape output.

The viewer shows 
images from the 

selected timeline.

The Render Queue 
contains all the jobs 
waiting to render.

The Render Settings 
configure the output format.

The timeline displays a graphical representation 
of the timeline you are outputting.
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5	 In the upper left, in the Render Settings, click Audio Only. Also, choose Single Clip 
if necessary. 

6	 In the Export Audio tab, in the Format menu, choose Wave.

You can choose whatever format you need for your projects, but you’ll export this one 
in a standard Wave format. 

7	 In the Codec menu, choose Linear PCM, if necessary.

The current Bit Depth is 24, which is fine for this lesson. You can change it to 16- or 
32-bit audio files at any time, depending on your delivery requirements.

Below the Bit Depth are two very important checkboxes that determine whether your 
mix will be rendered as a multichannel file, separate mono files for each channel, or a 
clip with discrete audio tracks.

For this example, you’ll leave both boxes unchecked so that you render one 
multichannel stereo clip and one multichannel 5.1 clip. 

8	 Deselect the “Render one track per channel” and “Render as discrete audio tracks” 
options, if necessary. 
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9	 Click the Output Track dropdown menu to see the multiple available options. 

Here you can select any busses, a timeline track, or all timeline tracks. With the All 
Timeline Tracks option, the channel mapping of the rendered clip will match the entire 
timeline, all in one clip.

10	 In the Output Track 1 menu, choose Stereo (Stereo). 

NOTE  For educational purposes, the main output busses in this project were 
named after their format: Stereo and 5.1. Newer versions of DaVinci Resolve 
include the bus format in parentheses after the bus name, so you’ll know the 
format of the bus. If the stereo bus was named Mix, you would see Mix (Stereo) 
in the Output Track dropdown menu. 

To simultaneously output additional busses or tracks, click the Add (+) button to the 
right of the Output Track 1 menu to add another output track. 

11	 Click the Add (+) button to the right of the Output Track dropdown menu. Set the 
Output Track 2 dropdown to 5.1 (5.1). 
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Next, set the Audio Normalization for the rendered files. Rather than simply Normalize 
to loudness standard as you can in the Fairlight page, you’ll normalize with the 
Optimize to standard option. 

NOTE  The Optimize to standard option is unique to the deliver page and first 
plays through and measures the true peak and loudness. Then, based on the 
true peak, it looks at the loudness you have and the loudness you should have 
and adjusts the level accordingly, with an internal limiter on the input level to 
prevent exceeding the true peak. 

12	 In the Audio Normalization controls, check the Normalize Audio option. Then enable 
“Optimize to standard.” In the Standard dropdown menu, choose ITU-R BS. 1770-4. 
Also, below the Target levels, check the boxes for Output Track 1 and Output Track 2 to 
ensure that the “Optimize to standard” normalization is applied to both output tracks. 

13	 Click the File tab and add a custom name as you would for any other output. In this 
case, let’s name the file PPN_Podcast_Intro_mix.

Finally, you need to select a destination for the mixed file. 

14	 Click the Browse button to change the location of your mixed file to the Desktop folder. 
Create a new folder on the Desktop called PPN Podcast Intro. Click Save. 
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15	 When you’re done selecting your drive destination, click Add to Render Queue.

16	 In the lower-right corner of the Render Queue, click Render All.

17	 When your file is finished rendering, head to your Desktop to locate and audition your 
finished stereo and 5.1 mixes named PPN_Podcast_Intro_mix_A01 and PPN_Podcast_
Intro_mix_A02. Change the A01 in the first clip’s filename to Stereo and the A02 in the 
second clip’s name to 5.1. 

Congratulations! You’ve bounced and delivered a variety of mixes from two 
different projects. 
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Explore the Mixes!
Before moving on to the last lesson, this is a great time to go back to the Fairlight page and 
explore the timeline, panning, automation, levels, busses, effects, and processing. Have 
fun and take a moment to look back at all your work throughout this book to record, edit, 
balance, enhance, and mix the podcast intro and the TML surf scene. Well done! Imagine 
what you’ll be able to do with your own projects!

Lesson Review
1	 Which meter is used to measure loudness during playback?

a)	 Bus meter

b)	 Loudness meter

c)	 Track meter

d)	 Delivery compliance meter

2	 True or False? It is possible to analyze the True Peak and Loudness measurement of a 
clip in the Fairlight timeline without playing the clip.

3	 Which steps are necessary to show the Loudness History graph in the timeline (choose 
all that apply)?

a)	 Toggle on Automation 

b)	 Right-click the bus track header and choose Show Loudness History from the 
context menu

c)	 Choose Show Loudness History in the Loudness meter options menu

d)	 Enable the Loudness History graph option in User Preferences 

4	 What factor determines the channel configuration of a bounced mix?

a)	 Selected tracks 

b)	 The type of track that is bounced

c)	 Bouncing matches the channel mapping of the A1 track

d)	 The channel format of the bus that is bounced
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5	 In the Fairlight page, where will you find the Export audio files option? 

a)	 Fairlight menu

b)	 Right-click context menu in the timeline

c)	 Timeline menu

d)	 Inspector

e)	 All of the above

6	 Where can you apply Normalization (choose all that apply)?

a)	 In the Fairlight page timeline right-click context menu

b)	 In the File tab of the Fairlight page Inspector

c)	 In the media pool 

d)	 In the Export Audio Files dialog

e)	 In the deliver page 
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Answers
1	 b 

2	 True. You can use the Analyze Audio Levels dialog to analyze levels without playback.

3	 a

4	 d. A bounced mix follows the channel format of the bus selected in the Bounce Mix to 
Track window.

5	 b

6	 a, d, e. Normalization can be applied in the timeline right-click menu, the Export Audio 
Files dialog, and the deliver page.
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Fairlight’s immersive audio tools and 
workflows for immersive formats, 
including Ambisonics and Dolby Atmos, 
require DaVinci Resolve Studio. If 
you’re working with DaVinci Resolve, 
you can read through the steps 
to understand how the immersive 
tools work in the Fairlight page. You 
can also import and listen to binaural, 
stereo, and surround sound versions of 
the projects. 

NOTE  DaVinci Resolve 20.1 Studio 
includes improvements to the 
Immersive toolsets and the 
addition of the Apple Spatial Audio 
Format (ASAF). You’ll find more 
information on the 20.1 update 
and the new ASAF workflows in the 
DaVinci Resolve Reference Manual 
available in the Help menu.

Lesson 11

Exploring Immersive 
Audio Integration
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DaVinci Resolve Studio offers fully integrated support for ground-up creation of immersive 
audio projects in a variety of formats, including MPEG-H, Auro 3D, Sony 360 RA, 
Ambisonics, and Dolby Atmos production, and playback, mixing, and rendering with bed 
tracks, busses, and monitoring. In this lesson, you’ll explore integrated Ambisonics and 
Dolby Atmos tools while you work with the Podcast Intro, Fusion VFX, and a professionally 
produced Dolby Atmos demo project to explore at a high level the workflows and 
integration built right into the Fairlight page. Then, you’ll import the same master file 
through the Fairlight Immersive tools to re-create the entire Dolby Atmos immersive 
mix, where you can visualize the panning automation for the flying objects and export 
a new master file right in the timeline. 

NOTE  If you need to download the media for this lesson, go back to the “Getting 
Started” section at the beginning of this book and use the R20 Fairlight Part 4 link 
to download the Lesson 11 media. You can also download the Part 4 link via the 
Training page available in the DaVinci Resolve Help menu. 

Enabling Immersive Toolsets 
The Fairlight page in DaVinci Resolve Studio includes all the tools you need for creating, 
mixing, and delivering original immersive audio content. You can start with a standard 5.1 
or 7.1 surround sound mix and add an immersive format bus or busses to use the 
immersive tools to enhance the soundtrack to an immersive format such as Dolby Atmos. 
You can also start your mix with an immersive format bus, mix the entire show that way, 
and create standard stereo and surround sound downmixes from the immersive mix. 
Whichever method you use, the first step in working with the integrated immersive audio 
tools in DaVinci Resolve is to enable the project for an immersive format. 

To enable a project for an immersive audio format, go to the System Preferences > Video 
and Audio I/O > Immersive Audio settings. Then, you can create immersive busses and 
tracks as needed. From there, you can add content or split multichannel tracks into mono 
tracks so they can be panned as individual objects. Use your imagination and the 3D space 
view to pan objects in any way you choose. 

For this exercise, you’ll enable the Ambisonics and Dolby Atmos options on your system so 
you can work with those immersive formats. 
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1	 Open DaVinci Resolve if necessary.

2	 Open your Podcast Intro Combo project. 

3	 Choose DaVinci Resolve > Preferences to open the System Preferences window. 

4	 Click Video and Audio I/O in the sidebar, if necessary, to show the Immersive 
Audio options.

At the bottom of the Video and Audio I/O settings, you’ll see the Immersive Audio 
formats that you can enable and work with in DaVinci Resolve Studio. You can enable 
as many formats as you choose.

5	 Check the Enable Ambisonics and Enable Dolby Atmos options, if necessary. 
Then click Save.

Once you have enabled an immersive format, you can create busses and tracks to support 
that format. You can also access the immersive toolset in the Fairlight page. 
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What Is Ambisonics? 
Ambisonics is a versatile audio technique widely used in post-production to create 
immersive, three-dimensional soundscapes. Unlike traditional surround sound 
systems that are limited to specific speaker layouts, Ambisonics captures or 
synthesizes sound from every direction—horizontally and vertically—using a 
full-sphere approach. In post-production, sound designers can manipulate and 
position audio sources freely in 360° space, allowing for a highly realistic and 
dynamic listening experience. This is especially valuable in virtual reality (VR), 
augmented reality (AR), gaming, immersive video and audio headsets, and 
immersive cinema, where spatial audio greatly enhances realism. One of 
Ambisonics’ biggest advantages is its flexibility: recordings can be “decoded” for 
various playback formats (stereo, surround sound, binaural headphones, etc.) 
without needing to redo the mix. This adaptability and immersive quality make 
Ambisonics an essential tool in modern audio post-production workflows.

Adding Ambisonics to 
a Stereo Timeline 
For narrative scripted podcasts, First-Order Ambisonics (FOA) is the most common format 
used. It captures 3D sound using just four channels (W, X, Y, Z), making it lightweight and 
easy to record, edit, and stream—ideal for podcast listeners using regular headphones. 
FOA is also widely supported by spatial audio tools and binaural renderers, making 
production simpler. While higher-order formats offer more detail, FOA provides enough 
immersion without the extra complexity, making it the go-to choice for creating spatial 
audio in podcasts.

It’s one thing to read about Ambisonics; it’s another to experience it. In this exercise, you’ll 
work with a simple mono sound effect of a clip panned from right to left over time. You’ll 
start by listening to playback in stereo, and then add a first-order ambisonics bus and 
compare the immersive binaural output to the stereo output. You’ll learn more about 
binaural sound shortly. For now, let’s open the timeline and play the mono clip. 
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One more thing before you start: grab some headphones and put them on so you can 
experience the immersive sound along the way!

1	 Open the 11 Ambisonics Start timeline. 

The timeline opens with one mono sound effect clip, Dog walking, in the A1 Dog 
Walking track. 

2	 If necessary, ensure that automation is toggled on and that you can see the L/R pan 
curve in the track. 

3	 Open the Audio Pan window and place it below the track. Click the 3D button to see 
the Left/Right panning view.

4	 In the viewer, enable Show Tracker Controls. Select the A1 track header. 

5	 Play the timeline from the beginning and listen to the sound in stereo as you watch the 
panner and Dog Walking pan tracker move across the viewer. 

As expected, the track sounds like someone walking a dog from right to left. Next, 
you’ll add an ambisonics bus, assign the track to the bus, and listen to the binaural 
output during playback.

6	 Choose Fairlight > Bus Format.

7	 In the Bus Format dialog, click Add Bus. 

8	 In the Format dropdown menu, choose “Ambisonics 1st order.” 
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What Is the Difference Between First-Order Ambisonics and 
Higher-Order Ambisonics?
First-order ambisonics (FOA) and higher-order ambisonics (HOA) are both 
methods of capturing and reproducing 3D sound, but they differ in detail and 
precision. FOA uses just four channels to represent sound coming from all 
directions, which gives a basic but useful sense of space—good enough for 
ambient sounds or simpler audio environments. HOA builds on this by using more 
channels (such as 9, 16, or more), allowing for much finer detail in the way sound 
moves and where it comes from. This makes HOA much better for situations where 
precise 3D sound is important, such as in virtual reality or immersive film sound 
design. In audio post-production, FOA might be chosen for simplicity and lighter 
processing, while HOA is used when realism and accurate spatial audio are key. 
DaVinci Resolve 20 Studio offers up to 5th-order ambisonics, which includes 36 
channels for precision audio placement. 

9	 Name the new bus Ambi 1OA (Ambisonics 1st Order).

10	 Click OK.

Now that you’ve added the ambisonics bus, you’ll need to assign the track to that bus. 

11	 Expand the mixer to see the track and two busses.

12	 In the A1 channel strip Bus Outputs controls, click the Add button (+) and add the 
Ambi 1OA bus. 
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You’ve added an ambisonics bus and assigned it to the track. Next, you’ll monitor the 
ambisonics bus and listen to the difference during playback. 

What Is Binaural Sound?
Binaural sound simulates 3D audio through regular headphones by mimicking 
how our ears naturally hear sounds in the real world. In audio post-production for 
ambisonics, binaural rendering is used to “decode” the ambisonic sound field into 
a format that makes it sound like it’s coming from all around you—left, right, 
above, behind—when you’re listening with headphones. This is incredibly useful 
for monitoring ambisonics, especially in VR, immersive video headsets, or 360° 
video work, because it gives the sound designer a realistic preview of how the 
spatial audio will feel to the end listener, without needing a complex multi-
speaker setup.

Changing the Monitoring Format
When working with immersive audio formats, Fairlight Monitoring controls offer additional 
format controls to change the format anytime, even during playback. This flexible format 
monitoring makes it possible to listen to playback in different standard speaker 
configurations in your studio as well as binaural sound via headphones. Let’s try it. First, 
you’ll change the Control Room monitoring to the Ambi 1OA output bus. 

1	 In the Fairlight Monitoring controls, click the Control Room monitoring dropdown 
menu and choose the Ambi 1OA bus. When the secondary Format Monitoring control 
appears to the right of the Control Room monitoring menu, click the Format 
Monitoring menu arrow and choose Binaural. 
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2	 Start playback and listen to a few seconds of the ambisonics binaural sound.

This time, the sound feels more realistic, as though you are in the same location as the 
dog walking. Don’t worry if you aren’t sure whether you hear the difference; with the 
Format Monitoring dropdown menu, you can switch between binaural and stereo 
during playback. 

3	 Start playback from the beginning of the clip and monitor the binaural sound. After a 
few seconds, change the Format Monitoring to 2.0 (stereo) and continue listening. 
Switch back and forth between 2.0 and Binaural as often as needed to hear the 
difference. When you’re finished comparing the two formats, set the format to Binaural. 

Wow! What a difference ambisonic sound can make in transforming a simple mono 
recording from sounding two-dimensional and flat to realistic, 3D, and immersive. If you 
still aren’t convinced, that’s fine. Just wait until you hear the next example. 

NOTE  DaVinci Resolve includes 3D Cartesian and Spherical versions of the panner, 
which lets you do the spatial audio positioning when working in immersive audio 
formats. With DaVinci Resolve 20.1, if you wish to switch the panner format, you will 
be prompted to clear the track’s pan automation first.

Using the Spherical Panner
Ambisonics uses a spherical panner because it places sounds around the listener in full 3D 
space—not just left and right, but also above, below, and behind. This helps create a 
realistic, immersive audio experience by accurately controlling the direction of each sound. 
One advantage of ambisonics is the use of elevation to place the sound above or below the 
listener. The example of the dog walking needs an elevation lower than the listener’s torso 
to more accurately place the dog and the dog walker’s footfalls on the sidewalk as they 
walk past the listener. The second example you’ll work with is the stereo sound of a 
helicopter circling, which has been panned to an elevation higher than the listener’s torso, 
as it would be if it were flying overhead. In this exercise, you’ll use the 3D Spherical view in 
the Audio Pan window as you play the two example timelines. 

1	 Open the Audio Pan window.
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2	 Click the Spherical button to the left of the 3D button. Click Yes in the Change 
Coordinate System dialog.



652Lesson 11  Exploring Immersive Audio Integration

The Audio Pan changes to Spherical view. In Spherical view, the coordinate controls 
change accordingly from Left/Right, Front/Back and Up/Down to Azimuth, Elevation, and 
Distance. The 3D Spherical view includes a torso in the center to represent the listener. 

3	 Set the Elevation to -20.0. Play the clip and drag the Azimuth control back and forth 
while listening to the Spherical panning. Feel free to try a different perspective view to 
see the panner’s location in relation to the listener within the sphere. 

4	 When finished, close the Audio Pan window.

Now that you’ve listened to the first example, let’s move on to a more interesting 
stereo clip. 

5	 Open the 11a Ambi Helicopter timeline.

6	 Open the Audio Pan window to see the 3D Spherical view of the Helicopter track. If 
necessary, click the first perspective button to show the back of the listener’s torso 
and the panner near the top of the sphere above the listener. 

This timeline includes the Helicopter Circling clip in a stereo track. An Ambisonics 
1st-order bus named AMBI AO1 has already been added to the timeline. You’ll also see 
the Azimuth pan curve showing in the A1 Helicopter track. 

In the Audio Pan window, you can clearly see that the helicopter sound is panned 
above the listener; however, from this perspective, you can’t tell whether the sound is 
in front of or behind the listener. 
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7	 Move the playhead to the first frame if needed.

8	 Click the third perspective button to see the overhead view of the 3D sphere.

From this perspective, you can see that the panners are centered behind the listener, 
and the Azimuth amount is -180 degrees. As a quick pan-geometry refresher, within 
the 360-degree sphere, the center in front of the listener is 0, and the exact opposite is 
-180. For this example, the helicopter sound starts at -180 and does a complete circle 
around the listener. 

9	 Set the monitoring to AMBI A01, 2.0 (stereo). Play the clip once to see and hear the 
helicopter circling in stereo as you watch the panner circle the torso in the Audio 
Pan window. 

Let’s play it again. This time, you’ll monitor the binaural sound and show the tracker 
and coordinates in the viewer when the sound is within the visible frame area of the 
360-degree view. 
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10	 Select the A1 Helicopter track. In the viewer, set the viewer to Show Tracker Controls 
and Show Tracker Coordinates. Then, set the monitoring to AMBI A01, Binaural. 

11	 Play the clip once from the beginning to see and hear the helicopter circling as you 
watch the Audio Pan window and the viewer to see the tracker and coordinates. 

The difference between stereo and binaural monitoring of the same timeline is 
remarkable. The stereo monitoring sounds okay and gives the impression of a helicopter 
sound moving from right to left. The Binaural monitoring, on the other hand, is far more 
immersive, as if the listener is standing outside as a helicopter circles overhead. You get 
the sense of space, height, and movement from the sound in a much more natural, 
realistic way. 

NOTE  This helicopter sound is a simple smartphone home recording of a 
helicopter in the neighborhood, complete with the trickling sound of the pool 
water moving in the foreground because the pump was on at the time. Think of 
the possibilities of professional high-quality recordings, or better yet, ambisonic 
recordings that capture the full spherical sound without the need for panning. 
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Working with Ambisonics Meters 
The Spherical pan view offers visual feedback of where the sound is panned during 
playback. DaVinci Resolve also offers two ambisonics meters: Sonar and Power Map. Sonar 
meters show where sounds are coming from in all directions, like a 3D radar, while power 
map meters show how much sound energy is coming from different directions, 
highlighting the loudest spots. These meters are available as an overlay in the viewer or as 
a Fairlight FX plug-in and are useful for visualizing the audio and aligning the immersive 
sound with the picture. 

In this exercise, you’ll turn on the ambisonics meter in the viewer and see the difference 
between the Sonar and Power Map meters for yourself. To use the ambisonics meters 
in the viewer, you first need to enable 360-degree viewer mapping in the Video Viewer 
tools menu. In DaVinci Resolve 20.1, the 360 Viewer Mapping option has been changed 
to Immersive.

1	 In the Video Viewer tools menu, enable 360 Viewer Mapping. Then, in the Ambisonics 
Meter submenu, click On, and select the Sonar option.

When the viewer is set to 360 mapping, 0 degrees is straight ahead in the center, 
while 180 and -180 degrees are the far left and far right edges, respectively, wrapping 
around like a full circle. 

2	 Resize the viewer in the monitoring panel to make it larger, and move the audio pan 
window to the left of the viewer for side-by-side comparison. 
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3	 Move the playhead to the beginning of the timeline. Then select the A1 Helicopter 
track header.

The Audio Pan window shows the sound currently panned to the back center of the 
sphere at -180 degrees.

The pan tracker coordinates are on the right edge of the viewer at -180 degrees. 

4	 Start playback to see the movement of the green sonar meter overlay and tracker. 
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The tracker indicates panning, while the sonar meter indicates the actual location of 
the sound within the 360-degree view. Now, let’s take a look at the power map meter.

5	 In the Video Viewer tools Ambisonics meter submenu, choose Power Map. 

6	 Play the clip once from the beginning. 

The power map meter overlay clearly shows the sound energy and the hot spots 
where the sound is loudest. Now, let’s see how the meters work with a more complex 
ambisonics clip.

7	 Open the timeline 11b Park FX Example.

This timeline includes two ambisonics clips created from the park sound effects in the 
Post Park Normal podcast intro. As the track names suggest, the A1 1st-Order track 
contains a 1st-order ambisonics clip, while the A2 3rd-Order track contains a 3rd-order 
ambisonics clip. 
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NOTE  Ambisonics clips—whether recorded with an ambisonics microphone 
or created by bouncing panned tracks through an ambisonics bus—already 
contain all the spatial sound information, so no additional panning is needed. 
The only adjustments you might make in the Audio Pan window are Rotate, 
Pitch, or Roll, to align the sound with 180° or 360° video.

You won’t need the audio pan window or a larger viewer for this exercise. Let’s reset 
the UI Layout to tidy things up, and then open the Ambisonics meter plug-in on the 
Bus1 channel strip so you can view both sonar and power map meters while listening 
to the ambisonics clips.

8	 Choose Workspace > Reset UI Layout.

9	 In the mixer, Bus1 channel strip, click the controls icon on the Ambisonics meter 
plug-in to open the meter. Then move the meter to the left of the viewer to see them 
side by side. 

10	 In the Ambisonics meter options menu (…), set the meter to Sonar if necessary.

11	 Play the clip in the A1 track and listen to the familiar park soundscape while watching 
the sonar and power map meters.

Both meters tell the same story with different visuals and emphasis. Now let’s play the 
3rd-order ambisonics clip. This is a higher-order clip rendered from the exact same 
timeline. The difference is that the ambisonics bus was set to 3rd-order ambisonics, so 
the clip was rendered with more information. 
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12	 Mute the A1 track and unmute the A2 track. Play the 3rd-order ambisonics clip and 
watch the ambisonics meters.

This time, the meters show more specific locations for the sounds. 

13	 Close the ambisonics meter window. 

Speaking of meters, let’s look at the ambisonics track and bus meters in the mixer and 
monitoring panel. The A1 track includes four audio channels, while the A2 track 
includes 16 audio channels. How many channels do you expect to see in the mixer and 
monitoring panel for the ambisonics tracks and bus? 

14	 Start playback from the beginning of the timeline and look at the track meters, 
monitoring panel, and mixer. 

How many channels were displayed for each ambisonics track? One. That’s right, only 
one channel is shown in the meters. Why? Ambisonics metering usually shows just one 
summed meter because ambisonics encodes sound as a whole sound field, not as 
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separate channels like stereo or surround. The summed meter reflects the total 
energy in the sound field rather than the levels of individual directions or speakers.

NOTE  To see individual channel levels for ambisonics tracks or busses, choose 
Fairlight > Immersive Audio > Ambisonics Channel Metering. 

Now that you’ve seen the ambisonics meters in action and listened to the binaural sound 
of mono, stereo, and ambisonics clips, let’s look at the individual sounds that make up the 
ambisonics clip and how they interact with each other. 

Visualizing Moving Sounds with 
the Fairlight Space View 
The Immersive Audio toolset in the Fairlight menu includes the Space View. This unique 
audio scope offers a spatial representation of the flying objects (sounds assigned to an 
immersive bus) and bed sounds (sounds assigned to channel-based busses). You can use 
the Space View to visualize the relationship between channel-based tracks, immersive 
tracks with panned objects, and the overall space where the audience will experience the 
immersive sound. In this exercise, you’ll open the Space View to see an overhead view of all 
the sounds in context during playback. 

1	 Open the timeline 11c Ambi Park FX. If necessary, set the monitoring controls to 
monitor the AMBI Bus in the Binaural Format.
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This is the same podcast intro you worked on in previous lessons. The only difference 
is that a 1st-order ambisonics bus was added, and some sound effects tracks have 
been assigned to it. These tracks include: A9–A13, A15, and A16. 

2	 Play the timeline once and listen to the tracks assigned to the Bus 11 AMBI Bus. Feel 
free to use the sonar or power map meter overlay in the viewer. 

Some tracks assigned to the Ambi Bus have pan automation; others are static but are 
placed strategically in the panoramic, or ambisonic, spherical space. For example, the 
Birds track has been panned with the birds placed high in the front left and back right 
of the spherical panner. The active sounds, such as the dog walking, skateboard, and 
bike, have all been panned lower than the viewer’s torso and are moving in different 
directions in front of or behind the listener. 

To visualize the placement of all the different sounds, you can use the Space View and 
adjust the perspective view just like the Audio Pan window. 

3	 Choose Fairlight > Immersive Audio > Space View. 
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At the bottom of the Space View window, check the options for Ambisonics Metering 
and Show Beds, and in the Objects menu, choose Show all. Here, you can see colored 
spheres that represent each track. Mono tracks have one sphere. Channel-based 
tracks have one sphere for each channel. For example, the stereo Ambience track has 
two spheres showing near the center left and center right positions. The color of the 
spheres in the Space View is based on their track color. The “Show active level only” 
checkbox lets you choose to show all the track objects (unchecked) or only the tracks 
with active levels (checked). 

4	 If necessary, uncheck the Show Beds option to remove the spheres for the tracks 
assigned only to channel-based busses.

NOTE  If working in DaVinci Resolve 20.1, you’ll see a few new controls at 
the bottom of the Space View including a new Scene Mode menu. Set the 
Scene Mode to Room, if needed, so you can follow along with the steps 
and screenshots.
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5	 Click the third perspective view button to change the Space View to overhead view. 
Start playback from the beginning of the clips. During playback, watch the objects in 
the Space View. 



664Lesson 11  Exploring Immersive Audio Integration

6	 When finished, stop playback and close the Space View. 

Next, you’ll bounce the sound from the AMBI bus to a new track. 

What Is the Difference Between A-Format and  
B-Format Ambisonics Clips?
A-format ambisonics is the raw audio captured from a specific ambisonics 
microphone’s capsules. B-format is the processed version that separates the 
sound into channels (such as W, X, Y, Z) representing different directions, 
making it ready for spatial mixing and playback. Most ambisonics microphones 
include plug-ins or software to convert A-format ambisonics recordings into 
B-format processed clips. Third-party plug-ins are available online, including free 
plug-ins that can be used with DaVinci Resolve to convert A-format to B-format 
right in the timeline. 

Bouncing an Ambisonics 
Mix in the Timeline
To bounce an ambisonics mix to a track in the Fairlight page, you need an ambisonics bus 
to which you can then assign any tracks you want included in the ambisonics file. The 
tracks assigned to the ambisonics bus can be mono, stereo, or an ambisonics track 
containing B-format ambisonics clips. In this exercise, the tracks have already been 
assigned to the ambisonics bus. All you need to do is bounce the mix of that bus to a new 
track, just as you would with any bus. The track format and ambisonics order will match the 
current format of the ambisonics bus. 

Before bouncing the ambisonics bus to a new track, let’s take a moment to adjust the 
levels of the A9-A13, A15 and A17 tracks to taste. 

1	 Play the timeline and adjust the levels of the tracks if needed. Consider reducing the 
level of the A17 Ambience track. It seems a little heavy (dominant) for this park scene. 
You may also want to slightly reduce the sound of the birds. 
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2	 Move the playhead to the first frame of the timeline and press I to mark an In point. 

3	 Choose Timeline > Audio > Bounce Mix to Track. 

4	 In the Bounce Mix to Track dialog, set the Bus 11 AMBI Bus Destination Track to 
New Track.

5	 Click OK. 

A new track appears beneath the Music track with the bounced 1st-order ambisonics 
clip in the track. Let’s change the ambisonics bus to a higher order and bounce the 
bus again. 

6	 Choose Fairlight > Bus Format.
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7	 In the Bus Format dialog, change the AMBI Bus Format to Ambisonics 3rd order. 
Click OK. 

8	 Choose Timeline > Audio > Bounce Mix to Track.

9	 In the Bounce Mix to Track dialog, change the Bus 11 AMBI Bus Destination Track to 
New Track. Click OK.

A new track appears below the previously bounced track. 

10	 Select the Audio 24 and Audio 25 tracks in the timeline and increase their height to see 
the format and ambisonics clips within.
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In the mixer, you’ll see that the new tracks are assigned to the stereo bus. Why? 
Because all new tracks are automatically assigned to the first bus. In this case, the first 
bus is stereo. 

NOTE  If you didn’t complete the previous exercise and bounce the ambisonics 
mix to a track, feel free to open the timeline 11d AMBI Park FX Bounced.

11	 Change the Bus Output assignments in the mixer for the two new tracks to the 
AMBI bus. 
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12	 Solo one of the new ambisonics tracks containing the bounced ambisonics park fx, and 
listen to the results. 

Well done! You have successfully followed the full workflow for creating an ambisonics file 
from separate clips and tracks to create an immersive soundscape. 

NOTE  If you decide to go back and do more mixing with the effects and then 
bounce again, make sure you mute the new tracks so you don’t accidentally double 
your sounds. 

When you’re ready to render a finished channel-based mix of the full soundtrack, change 
the AMBI bus monitoring from Binaural to a channel-based format that matches your final 
mix setup. When delivering your mix, either play the original sound effects assigned to the 
ambisonics bus or mute them and use the bounced versions of those sounds—just make 
sure they are properly assigned to the ambisonics bus. Then, route the ambisonics bus to 
your main surround sound FX Submix bus or the main mix bus. In this example, the sound 
effects routed to the ambisonics bus are also routed to the stereo and FX 5.1 submix bus. 
In this case, you would need to decide which you want to use. Disable any bus assignments 
on a track you don’t want to include in the mix. 

Rendering an Ambisonics Track 
in the Deliver Page
If you are using ambisonics for creative sound design and have rendered your mix to an 
ambisonics track, as you did in the previous exercise, you can then render that track in the 
deliver page as an ambisonics file. In this exercise, you’ll go to the deliver page, choose 
both ambisonics tracks as the output source, and render them to a new folder on your 
system. For this exercise, you’ll continue working with the same timeline. 

1	 If necessary, mark an In point at the beginning of the timeline. 

2	 Unsolo and unmute the Audio 24 and Audio 25 tracks. 

3	 Name the Audio 24 track FOA Park. Name the Audio 25 track HOA Park. 
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4	 Click the Deliver button or press Shift-8 to go to the deliver page. 

5	 In the deliver page timeline area, scroll down until you see the A24 and A25 tracks. 

6	 In the deliver page Render Settings, choose the Audio Only preset.

First, you’ll set up the FOA (First Order Ambisonics) track and add it to the render 
queue. Then, you’ll set up the HOA (Higher Order Ambisonics) track to render and add 
it to the queue. 

7	 In the File Name field, type AMBI Park FX FOA. 

8	 Set the Location to the PPN Podcast Intro folder on your Desktop that you created for 
deliverables in the previous lesson. If you didn’t make a folder then, make one now. 
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9	 In the Audio tab, choose the settings as shown.

10	 Set the Output Track menu to Timeline Track. Then set the Track Number field to 24, 
which is the Ambisonics 1st-order track.

11	 Click Add to Render Queue.

12	 In the Render Queue, click Render All. 

13	 Repeat the previous steps 7–12. This time, change the File Name to AMBI Park FX 
HOA, and in Step 10 set the Output Track number to 25, which is the Ambisonics 
3rd-order track. 

14	 When you are finished, check the PPN Podcast Intro folder on your Desktop to see the 
rendered Ambisonics Park FX clips. 

These clips are ready to use in another project or add to your immersive sound effects 
library. Next, you’ll step away from ambisonics to explore some of the integrated Dolby 
Atmos toolset in the Fairlight page. 
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What Does Dolby Atmos Do?
Dolby Atmos has become the immersive audio standard for film and episodic 
content creation. Dolby Atmos adds a height element to surround sound formats 
to immerse the listener and uses a combination of audio objects, panning 
metadata, and traditional channel-based bussing and panning. This, along with 
the Dolby Atmos Renderer, optimizes the playback experience for a wide variety 
of monitoring configurations. 

Working with Dolby Atmos 
in the Fairlight Page
Dolby Atmos mixing is a more advanced and flexible way of creating immersive audio 
compared to traditional surround sound mixing. In surround sound, audio is placed in 
specific channels—such as front left, front right, or rear speakers—so sounds are tied to 
certain speaker positions. Dolby Atmos, on the other hand, allows sound to be treated as 
“objects” that can move freely in a 3D space, including above the listener. This means 
mixers can place and move sounds anywhere around the audience for a more immersive 
experience. While surround sound is limited to a fixed number of speakers, Dolby Atmos 
can adapt to many different setups, from home theaters to headphones.

Any type of project—from a podcast or music mix to a feature film—can be mixed and 
exported as a Dolby Atmos master file. These master files can then be imported, played 
back, and re-rendered into various standard delivery formats. In this set of exercises, you’ll 
explore some of the Dolby Atmos tools and features available in the Fairlight page of 
DaVinci Resolve Studio. You’ll begin by opening a 7.1 surround sound version of the 
Fusion VFX timeline. Then, you’ll assign tracks to a Dolby Atmos Master bus as objects or to 
the 7.1 surround sound bus as part of a 7.1 bed. 

In Dolby Atmos, busses are called beds or bed busses once they’re routed to the Dolby 
Atmos Master bus. Next, you’ll import a completed Dolby Atmos master file to see and 
hear a professionally produced example. Finally, you’ll open a Dolby Atmos version of the 
Podcast Intro Combo timeline to examine how it was created, modify the settings, and 
export a new Dolby Atmos master file yourself.
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NOTE  To simplify the mixer for screenshots, some mixer controls, including EQ, 
Dynamics, and Bus Sends, were hidden via the mixer options menu. Hiding mixer 
elements does not disable them and can help streamline the mixer controls so you 
can focus on the elements you need at any given time. 

Converting a Surround  
Sound Channel-Based Mix  
to Dolby Atmos 
When mixing Dolby Atmos in a DAW like DaVinci Resolve, you don’t need to change your 
bed buses, such as 7.1, to 7.1.4. In fact, Atmos beds are limited to 7.1 channels—seven 
surround channels plus one LFE. The additional height channels (the “.4” in 7.1.4) are not 
part of the bed; instead, they come from audio objects, which can be placed anywhere in 
3D space using object-based panning.

The first step to converting a standard channel-based mix to a Dolby Atmos mix is to add a 
Dolby Atmos Master bus. Once you’ve added the Dolby Atmos Master bus to the timeline, 
you can assign tracks to the channel-based bed bus or as objects to the Master bus. 
Channel-based busses are assigned to the Master bus and become a Bed bus. 

In this exercise, you’ll work with a 7.1 Surround Sound mix in progress of the Fusion VFX 
project. First, you’ll look at the existing bussing with the 7.1 surround sound output. Then, 
you’ll add a Dolby Master bus and assign the 7.1 mix bus to the master. Finally, you’ll assign 
a group of guitar tracks with a lot of panning movement to the Dolby Master bus as objects 
that will be placed in 3D space using object-based panning. Let’s get started! 
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1	 Open your Fusion VFX v1 project. Then open the timeline 
11 Circles Dolby Atmos Start. 

This timeline includes the instrumental bridge through to the outro to the song 
“Circles.” Keep in mind, this is a mix in progress with track levels that need adjusting 
and balancing, along with other processing and sweetening. If you look at the mixer 
and monitoring panel, you’ll see that there is only one bus named 7.1 Mix. You can also 
see that all the tracks are assigned to the 7.1 Mix bus. That means, at the moment, the 
only monitoring format available in the monitoring controls is 7.1. 
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Let’s add a Dolby Atmos Master bus. Then, you can monitor the project in other bus 
formats, including surround sound, Dolby Atmos, and binaural. 

2	 Choose Fairlight > Bus Format. 

3	 In the Bus Format window, click Add Bus. 

4	 Name the new bus Master. 

5	 In the Format menu, choose Dolby Atmos > Dolby Atmos Master. Then change the bus 
color to purple.

6	 Click OK. 
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7	 Scroll the mixer if needed to reveal the new Dolby Atmos Master bus to the right of the 
7.1. Mix bus. 

The Dolby Atmos Master bus is easy to recognize because it is the only bus with a 
Dolby badge at the top of the mixer. Next, you’ll assign the 7.1 bus to the Master bus. 

8	 In the mixer Bus Outputs, assign the 7.1 Mix bus to the Master bus. 

That’s it! By simply adding a Dolby Atmos Master bus and assigning the main output bus to 
the Master bus, you can now start mixing and monitoring the project in Dolby Atmos. But 
wait… there’s more. Let’s start with monitoring. 

NOTE  Whenever you add a Dolby Atmos Master bus to a DaVinci Resolve project, 
the default monitoring format is Dolby Atmos 7.1.4, which consists of 7 standard 
surround channels, 1 LFE (subwoofer) channel, and 4 overhead height channels. 
The overhead speakers are necessary for the immersive Dolby Atmos experience. 
You can change the monitoring format anytime via the Monitoring 
dropdown menu.

Changing the Monitoring Format 
If the monitoring speakers connected to your DaVinci Resolve system aren’t set up for 
Dolby Atmos 7.1.4 playback, you can change the monitoring channel format to match your 
system. In this exercise, you’ll change the monitoring format of the Dolby Atmos Master 
bus to stereo and then binaural so that you can monitor it through your computer 
speakers or headphones. 
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In the monitoring controls above the mixer, you can now monitor playback in any standard 
channel format, as well as immersive Dolby formats with 2, 4, or even 6 overhead speakers 
for playing flying objects in 3D space. 

Earlier in this lesson, you changed the playback format for an ambisonics bus using the 
Fairlight monitoring controls. Monitoring Dolby Atmos is similar to ambisonics in that the 
monitoring is flexible. When monitoring a Dolby Atmos Master bus through the Fairlight 
Immersive tools, the internal Dolby Atmos Renderer playback format options are also 
integrated right into the Fairlight monitoring controls. Here, you can change the 
monitoring format anytime, even during playback. Let’s try it. 

1	 Start playback at the beginning of the timeline and look at the Control Room meters in 
the monitoring panel and bus meters in the mixer. 

Here, you can see that both the Control Room meters and the Master bus meter in the 
mixer show 12 channels to represent the current 7.1.4 monitoring format. 

2	 Continue playback. In the Fairlight Monitoring controls, click the dropdown menu 
arrow to the right of the default monitoring format 7.1.4 to show the menu.
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3	 Choose 2.0 from the monitoring menu to change the playback format to stereo. 

The Control Room meters and Master bus meter in the mixer show 2 channels to 
match the current 2.0 (stereo) monitoring format.

NOTE  The default Dolby Atmos Loudness metering is a 6-channel, 5.1 
downmix from the internal Dolby Atmos Renderer. There are four Dolby Atmos 
Loudness formats available in the Loudness Meter options menu, including 
Follow C/R, 5.1 Downmix, Stereo Downmix, and Stereo Direct Downmix. The 
Follow C/R option matches the current monitoring format as shown in the 
Control Room meter and monitoring settings. You can learn more about these 
settings in the DaVinci Resolve Reference Menu available in the Help menu. 

4	 Choose Binaural from the monitoring menu to change the playback format. Play the 
timeline from the beginning to hear the binaural sound.

5	 Toggle back and forth between 2.0 and Binaural monitoring in the monitoring 
dropdown menu during playback. When finished, leave the monitoring set to Binaural 
and stop playback.

Great. You now know how to change the monitoring. Next, you’ll assign the flying guitars 
as objects to the Master bus. First, you’ll need to locate the flying guitar tracks. 

NOTE  Dolby Atmos master files can contain up to a maximum of 128 channels. 
The first 10 channels are reserved for the bed track. The bed track or tracks 
represent the standard channel-based mix, such as 5.1 (6 channels) or 7.1 (8 
channels). Starting with 11, the remaining channels can be used for objects or 
additional beds. 
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Assigning and Viewing Tracks as Objects
In Dolby Atmos, bed tracks are audio channels (usually 7.1.2) that remain fixed in the 
speaker layout, and are used for elements such as music, ambience, or sounds that don’t 
need to move. Object tracks, on the other hand, are individual sounds (up to 118) that can 
be precisely placed and moved in 3D space using pan metadata. Object tracks are ideal for 
sound effects or anything that needs dynamic positioning. When mixing, use bed tracks 
for static or background elements to save processing power, and use object tracks for 
sounds requiring spatial movement or exact placement. 

Assigning a track as an object for monitoring in 3D space is as easy as assigning the track 
to the Dolby Atmos Master bus instead of the bed bus. Panning automation on the object 
tracks is then processed by the Dolby Atmos renderer and played through the overhead 
speakers. Binaural monitoring through the Dolby Atmos render offers a simulation 
through headphones to emulate a Dolby Atmos listening experience. 

In this mix-in-progress timeline, there are only five tracks with pan automation. You will 
assign these tracks as objects for this exercise.

1	 In the timeline, increase the track height for all tracks until you can clearly see the 
automation dropdown menu in the track headers.

2	 In the mixer, select the A35–A39 channel strips. These are lime green GTR tracks amid 
the numerous navy colored GTR tracks. 

The A35–A39 channel strips brighten in the mixer, and tracks are visible and brighten 
in the timeline. You can also clearly see the lime green clips and L/R Pan curve on the 
selected tracks. 

These selected tracks are all currently assigned to the 7.1 Mix bus. Let’s change that 
assignment to the Master bus. For this maneuver, you can change all the selected 
tracks at once by using the handy Option/Alt modifier. 
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3	 In the mixer, Option/Alt-click the 7.1 Mix Bus Outputs bus assignment for any of the 
selected channels and change it to Master. 

Now that you’ve assigned the selected tracks as object tracks, let’s see them in the 
Space View. 

4	 Choose Fairlight > Immersive Audio > Space View.

5	 Start playback from the beginning to see the objects moving about the 3D space. 

The lime green object spheres match the track color. You can also show the location of 
the tracks assigned to the bed busses by selecting Show Beds in Space View controls. 
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6	 Continue playback. At the bottom of the Space View window, check the Show 
Beds option. 

You can see colored spheres for all the tracks and where the corresponding sound has 
been panned within the 3D space. 

7	 Stop playback. Close the Space View window. 

So far, you have added a Dolby Atmos Master bus and assigned the 7.1 Mix bus as a bed 
bus and 5 GTR tracks as objects. Next, you’ll enable the Dolby Atmos Renderer in 
DaVinci Resolve preferences so you can show objects in the mixer and even export a Dolby 
Atmos master file from your mix in the timeline. 
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Enabling the Dolby Atmos  
Renderer in Preferences
At the beginning of this lesson, you enabled Ambisonics and Dolby Atmos in the Video and 
Audio I/O Immersive Audio preferences. To control Dolby Atmos objects in the mixer and 
output a Dolby Atmos master file in DaVinci Resolve, you’ll also need to enable one more 
Video and Audio option.

1	 Choose DaVinci Resolve > Preferences to open the System Preferences window. 

2	 Click Video and Audio I/O in the sidebar, if necessary, to show the Immersive 
Audio options.

At the bottom of the Video and Audio I/O settings, you’ll see the Dolby Atmos options. 
Here, you can enable the Dolby Atmos Renderer. This is a necessary step for 
generating original Dolby Atmos content and rendering a Dolby Atmos master file. 
Once enabled, you can have seamless workflows between working with the internal 
Dolby Atmos Renderer in DaVinci Resolve and an external Dolby Atmos Renderer, as 
either external hardware or software, as needed. 

3	 Check the Enable Dolby Atmos Renderer option. Then click Save. In the subsequent 
dialog, click OK.
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Since the dialog indicated that Preferences have been updated and changes will take 
effect the next time Resolve is started, this is a good time to save, close, and then 
reopen DaVinci Resolve. Although this step might not be necessary on all systems, 
quitting and restarting DaVinci Resolve will ensure that the newly enabled Dolby 
Atmos Renderer is ready to go on your timeline.

4	 Choose File > Save Project. 

5	 Choose File > Close Project. 

6	 Choose File > Open Recent Project and choose your Fusion VFX v1 project. 

7	 Once the project is open, in the mixer options menu, enable the Immersive 
Objects option. 

8	 Expand the Mixer height as needed to see the Immersive controls. Locate tracks A35–
A39 to see their active Immersive channel assignments. 

The orange In button in the Immersive controls for each track indicates that all these 
tracks could be assigned as objects. However, only the lime green A35–A39 tracks have 
green Immersive channel assignments designating them as objects. Now that you’ve seen 
how to convert a 7.1 channel-based mix to Dolby Atmos with the addition of a Master bus 
and assign tracks as objects, let’s look at a finished Dolby Atmos master file. 

NOTE  If you have not already downloaded R20 Fairlight Part 4, please follow the 
instructions for downloading the lesson media in the “Getting Started” section of 
this book. 
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Adding a Dolby Atmos Master File 
to the Media Pool and Timeline 
In this exercise, you’ll create a new project where you’ll explore the Dolby Atmos master 
file “Nature’s Fury.” First, you’ll import the “Nature’s Fury” video and audio files into the 
media pool and utilize some built-in Fairlight page features to quickly create a timeline 
from the video clip. Next, you’ll add the “Natures Fury” Dolby Atmos audio clip to a new 
track and instantly transform the timeline stereo output bus to a Dolby Atmos 7.1.4 bus. 
Finally, you’ll sync the video and stereo clips to the Dolby Atmos clip in the timeline. The 
media for this project is located in the R20 Fairlight Part 4 folder within your R20 Fairlight 
Book Media folder. 

1	 Open DaVinci Resolve if necessary. Choose File > New Project. 

2	 In the Create New Project dialog, name the project Natures Fury and choose a Media 
Location such as Documents, Desktop, or the root level of your system. Click Create.

3	 Show the media pool.

4	 In the media pool options menu (…), select the Show All Clips option if necessary.
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5	 Press Command-I (macOS) or Ctrl-I (Windows) to open the Import Media dialog.

6	 In the Import Media dialog, navigate to the R20 Fairlight Book Media > R20 
Fairlight Part 4 > Lesson 11 Dolby Atmos folder. Select both of the media files: 
NaturesFury.mp4 and NaturesFury.wav. Click Open. 

The media files appear in the media pool library. In DaVinci Resolve, you can instantly 
create the first timeline in a new project by simply dragging a clip from the media pool 
to the empty space in the timeline area. Let’s try it. 

NOTE  You can check the file format of a selected clip in the media pool or 
timeline via the File tab of the Inspector. A Dolby Atmos Master file, like 
NaturesFury.wav, will be identified as such in the Audio Codec and Audio 
Format fields.
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7	 Display video tracks in the Timeline View Options menu. Drag the NaturesFury.mp4 
video clip from the media pool to the empty timeline space. 

Since you made the timeline with a video clip, you’ll see both the video and audio 
tracks in the timeline. 

8	 Press Shift-Z to fit the clip horizontally to the timeline window. 

9	 Zoom vertically until you can clearly see the waveform in the A1 track. Play the 
beginning of the clip.

Notice that the Bus1 output bus, Control Room, and Loudness meters are all stereo to 
match the channel format of the clip that you used to create the timeline. 
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Normally, adding another audio clip to a new track will create a track that matches the 
channel format of the new clip. However, the Dolby Atmos integration in 
DaVinci Resolve goes one step further and also creates a Dolby Atmos output bus. 

10	 Drag the NaturesFury.wav audio clip from the media pool to the empty timeline 
space below the A1 track. Align the clip in the A2 track with the beginning of the 
timeline. 

11	 Solo the A2 track and start playback.

Notice that the Bus 1 output bus, Control Room, and Loudness meters are now 
12 channels wide to accommodate the default 7.1.4 Dolby Atmos format. 

In this example, to sync the video and stereo clips in the V1 and A1 tracks to the Dolby 
Atmos clip in the A2 track, you simply drag them into position. 

12	 In the timeline, select the video clip in V1 and the audio clip in A1. Drag the selected 
clips to the right until they align with the end of the clip in the A2 track. 
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13	 Solo the A2 track, if necessary, and play part of the timeline. Watch the viewer to see 
that the video and audio are in sync. Continue playback and unsolo A2. The audio 
tracks should be in sync with one another. Continue playback. Experiment with soloing 
or muting the tracks to hear one, the other, and then both. When you’re satisfied that 
they are in sync, stop playback. 

14	 Hide the media pool. Mute the A1 track. 

15	 Drag the A2 track header downward to vertically zoom the track until you clearly see all 
of the channels in the Dolby Atmos master file. 

The Dolby badge in the clip header indicates that the clip is a Dolby Atmos master file 
that is playing through the internal Dolby Atmos Renderer in DaVinci Resolve.

16	 Show the Inspector and click the File tab to see the audio configuration of the 12 
channels within the Dolby Atmos 7.1.4 master file. 

NOTE  In DaVinci Resolve, you cannot edit the individual channels of a Dolby 
Atmos master file in the timeline. This is to maintain the integrity of the Dolby 
Atmos master. You can, however, sync, trim, or move the master file as needed 
within the timeline for packaging and delivery. You can also combine multiple 
master files in the same track and render a new master.  
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Changing the Playback Format 
Whenever you add a Dolby Atmos master file to a DaVinci Resolve project, the default 
channel format is Dolby Atmos 7.1.4, which breaks down as 7 standard surround channels, 
1 LFE (subwoofer) channel, and 4 overhead height channels. The overhead speakers are 
necessary for the immersive Dolby Atmos experience. If the monitoring speakers 
connected to your DaVinci Resolve system aren’t set up for Dolby Atmos 7.1.4 playback, 
you can change the channel format to match your system. In this exercise, you’ll change 
the channel format of the Dolby Atmos master file in the A2 track to Stereo so that you can 
monitor it through your computer speakers or headphones. 

An advantage of working with a Dolby Atmos master file rather than a standard channel-
based file is that the Dolby Atmos master files can be played in any standard format 
through the internal Dolby Atmos Renderer. Changing the channel format of a Dolby 
Atmos master file only changes how it will play back through the internal Dolby Atmos 
Renderer built into DaVinci Resolve. All the channels and embedded metadata are retained 
for packaging and delivery. 

In this exercise, you’ll change the format of the A2 clip from Dolby Atmos 7.1.4 to stereo 
using the Clip Attributes dialogue. 

1	 Double-click the Dolby Atmos master file in the A2 track to open the Clip Attributes for 
that clip. In the Clip Attributes dialog, click the Audio tab. Then set the Format 
to Stereo.
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2	 Click OK. 

The A2 track now contains a two-channel stereo clip in a 12-channel 7.1.4 track. 

The Audio Configuration in the Inspector also shows that the clip is 2-channel stereo.

3	 Hide the Inspector. 

4	 Right-click the A2 track header and choose Change Track Type To > Stereo.

5	 Adjust the vertical zoom to reduce the height of the A2 track to match the A1 track 
height. Notice that the stereo clip in the A2 track still has a Dolby badge indicating that 
it is a Dolby Atmos master file.

You can generate your own channel-based files right from the Dolby Atmos master file, 
so there is no need to keep the A1 stereo track showing in the timeline. In fact, you 
don’t need to see the video track either. 

6	 In the Tracks Index Tracks list, hide the visibility (eye icon) for the V1 Video 1 track as 
well as the A1 Audio 1 track. 

The Video 1 and Audio 1 tracks (V1 and A1) are no longer visible in the timeline. Keep in 
mind that hiding an audio or video track does not disable or mute it. 

7	 In the Tracks Index, mute the A1 Audio 1 track if necessary, and then hide the Index.

In the next exercise, you’ll use the internal Dolby Atmos Renderer to generate a stereo and 
5.1 downmix from the master file in the A2 track. 

Bouncing Stereo and 5.1  
Re-Renders
The internal Dolby Atmos Renderer in the Fairlight page not only lets you play a Dolby 
Atmos master file in any standard channel format, but also lets you generate different 
channel-based versions from an Atmos master. These newly generated files are called 
re-renders rather than downmixes because the Dolby Atmos renderer processes how 
object-based audio is folded down into traditional formats to intelligently create channel-
based formats from the Atmos Master.
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In this exercise, you’ll use the power of the internal Dolby Atmos Renderer to generate a 
stereo and a 5.1 downmix file from the Dolby Atmos master file. The DaVinci Resolve 
immersive toolset makes it easy to render multiple downmixes simultaneously through the 
Bounce Mix to Track dialog. The internal Dolby Atmos render will do all the processing 
under the hood. First, you’ll need to mark the clip. 

1	 Press R for the Range Selection tool. Click the master file in the A2 track to select the 
track and set a range for the entire clip.

2	 Press A for the Standard Selection tool. 

3	 Choose Timeline > Audio > Bounce Mix to Track.

The Bounce Mix to Track dialog offers three default options for bouncing downmixes 
right to the timeline: Dolby Atmos Master, Stereo, and 5.1. You can also customize the 
settings to choose a different format to bounce. 
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4	 In the Bounce Mix to Tack dialog, set the Destination track for the Atmos Render Stereo 
and Atmos Render 5.1 to New Track. 

5	 Click OK. 

A progress dialog indicates the time remaining to render Stereo to Track 3, and 5.1 
to Track 4. Once finished, you’ll find the stereo and 5.1 re-renders in tracks 3 and 4, 
respectively. 

6	 Feel free to solo and listen to the re-renders in the A3 and A4 tracks. 

Before moving on to delivery, let’s change the A2 track and master file back to 7.1.4. 
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7	 Right-click the A2 track header and choose Change Track Type to > Dolby Atmos > 7.1.4. 

8	 Double-click the clip in the A2 track. In the Clip Attributes Audio tab, change the 
Format to Dolby Atmos 7.1.4. 

9	 Click OK.

The Dolby Atmos master file and its track are now in their original format of 7.1.4. 

Exploring Delivery Options
DaVinci Resolve offers two Dolby Atmos deliverable formats in the deliver page, including 
an audio-only ADM broadcast wave format (BWF) and an MXF IAB format for IMF video and 
audio packaging. When delivering either format from a Dolby Atmos master file, the 
delivery options and results will be based on the Render Settings on the deliver page. In 
this exercise, you’ll render both options. 

One thing to remember about the Dolby Atmos integration in DaVinci Resolve Studio is 
that a Dolby Atmos master file always retains the Bed and Object information to scale up 
or down to play in any standard Dolby Atmos or channel-based format. 

In the next series of exercises, you’ll render two Dolby Atmos master files from the 
Nature’s Fury project. 

1	 In the timeline, mark an In point at 01:00:30:00 and an Out point at 01:01:00:00. 

2	 In the deliver page Render Settings panel, adjust the following settings as follows: 

	— Select the Audio Only render preset.

	— In the File Name field, type NF Dolby Atmos 30sec.

	— Location: Browse to the Desktop and create a new folder  
named NF Dolby Atmos Deliverables.

	— Audio Format: Wave

	— Codec: ADM BWF

	— Sample Rate: Same as project (to match project)

	— Bit Depth: 24

To render a Dolby Atmos master file, you’ll need to be sure that the Output Track and 
Track Number are set to the timeline track containing the Dolby Atmos master file. In 
this example, the A2 track (currently 7.1.4 format) contains the Dolby Atmos master file. 

	— Output Track 1: Timeline Track

	— Track Number: 2
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When you change the Track Number to 2, the FFOA timecode at 01:00:00:00 becomes 
active and checked automatically. You can use the FFOA to set the start of actual audio 
in the ADM master file. Preparing a project for ADM delivery usually includes adding a 
2-pop (1-frame 1 kHz tone) 2 seconds before the first frame of action for sync 
to picture. 

3	 Click Add to Render Queue.

Next, you’ll use the IMF Netflix preset to deliver an IMF IAB package containing the 
video and Dolby Atmos master file. 

4	 At the top of the Render Settings panel, select the IMF > Netflix preset.

Since this is a preset, you won’t change the Video, Audio, or File settings. You’ll only 
need to check the Output Track and Track Number to ensure they are set to the correct 
timeline track on the Audio tab. 
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5	 Click the Audio tab, if necessary, to see the audio settings. 

6	 Click the Output Track 1 dropdown menu to see the options, including Timeline Track, 
All Timeline Tracks, and IAB Track File. 

For this exercise, you’ll use the Timeline Track option. 

NOTE  When creating an IMF package with a Dolby Atmos master file in the 
deliver page, the All Timeline Tracks option can be used if you want to render 
additional channel-based tracks, such as the stereo and 5.1 downmixes, along 
with an IAB Dolby Atmos master file in the same package. 

Any timeline track that does not contain a Dolby Atmos master file will render 
a file based on the track’s channel configuration. The IAB Track File option lets 
you browse to and select the original Dolby Atmos master file at the Finder 
level and copy it directly into the IMF package rather than render a 
new master file. 

If you’re working with a Dolby Atmos master file as a pre-existing IAB.mxf, or 
you’ve imported an existing Dolby Atmos master file format to the timeline, 
the Dolby Atmos Master is packaged without modification. However, if a Dolby 
Master File is in the timeline, it can be trimmed, cut, and synced to video 
before authoring to IMF.

For example, if the export is the same frame rate and the clip is simply 
trimmed, the source master file is fully copied into the IMF. 
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7	 Set the options at the bottom of the Render Settings Audio panel as follows: 

	— Output Track 1: Timeline Track

	— Track Number: 2

	— Export as Dolby Atmos IMF IAB (This option should be checked automatically when 
you select a track containing a Dolby Atmos master file.)

8	 Click Add to Render Queue.

9	 In the Render Queue, deselect both render jobs, if necessary. Click Render All. 



696Lesson 11  Exploring Immersive Audio Integration

10	 At the Finder level of your system, locate the NF Dolby Atmos Deliverables folder and 
view the contents. 

Here, you should find an IMF package NF Dolby Atmos 30sec (folder) containing numerous 
XML files as well as the IAB Dolby Atmos .mxf master file and the Video .mxf file. Additionally, 
there should be a Broadcast Wave File (BWF) named NF Dolby Atmos 30sec.wav.

Check Your Deliverables
You’ve generated two 30-second Dolby Atmos files from the original Dolby Atmos master 
file. Before moving on to the next section, it’s a good idea to import and verify that your 
deliverables worked as expected. In the Fairlight page, import the contents of the NF Dolby 
Atmos Deliverables folder. Make a new timeline from the IMF and ADM files. In the timeline, 
expand the audio track vertically to see if it has the Dolby badge and is in the default 7.1.4 
Dolby Atmos master file format. 

Importing a Dolby Atmos Master
So far, you have added a Dolby Atmos Master bus to a 7.1 timeline to begin mixing Dolby 
Atmos. You’ve also added a Dolby Atmos master file to the timeline, created re-renders, 
and delivered the master file in two different formats. Now, it’s time to step things up a 
notch and import the same Dolby Atmos master file through the Fairlight page > 
Immersive Tools menu. This method of importing a file will generate a new timeline that 
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will re-create the full Dolby Atmos mix, complete with content, bed and object tracks, 
panning automation metadata for the flying objects, and VCA groups to control the object 
tracks based on the group assignments before generating the master file. Once you have 
imported a Dolby Atmos master file through the Fairlight Immersive tools, you can utilize 
additional immersive tools, including the Space View scope, Renderer Settings, and 
real-time playback monitoring via the internal Dolby Atmos Renderer. 

1	 Choose Fairlight > Immersive Audio > Import Master File.

2	 In the Finder window, navigate to the R20 Fairlight Book Media > R20 Fairlight Part 4 > 
Lesson 11 Dolby Atmos > NaturesFury.wav file. 

3	 Click Open. 

Once you click Open, the following things will happen:

	— A new timeline will be created.

	— The timeline will be populated with newly rendered content necessary to re-create 
the Dolby Atmos mix. 

	— Automation is turned on so that all panning automation on the object tracks will 
be active during playback and rendering.

	— The new timeline contains all the bed (standard channel mix), object (mono tracks 
with panning metadata), and VCA groups (faders to control groups of tracks) with 
the playhead at the start of the newly generated clips. 

	— The new timeline’s timecode and position of the content will be based on the 
timecode of the original Dolby Atmos master file. In this case, the timeline starts at 
00:00:00:00, and the clips start at 00:59:58:00 with a 2-pop on the first audio 
frame. The sound (FFOA) starts at 01:00:00:00. 
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TIP  When working with a timeline with a large gap between the start of the 
timeline and the first clip, it’s easy to scroll too far in one direction and lose 
sight of the clips in the timeline. If that happens, you can use the Up Arrow and 
Down Arrow keys to quickly jump forward or back to the head or tail of the 
timeline clips. 

4	 Play the beginning of the clips in the timeline.

This is the exact same master file that you were working with before, only this time 
you have an all-access backstage pass to see the full behind-the-scenes mix, including 
every track, waveform, panner, and fader needed to output the Dolby Atmos 
master file. 

Identifying Bed, Object, and VCA Groups
Now that you have imported the Dolby Atmos master file, let’s take a moment to identify its 
various components in the timeline. These include the A1 Composite Bed track, 
subsequent object tracks, and the four VCA groups that can be used to control the levels of 
the corresponding object tracks. Dolby Atmos master files can contain up to a maximum of 
128 channels. The first 10 channels are reserved for the bed track. The bed track or tracks 
represent the standard channel-based mix, such as 5.1 (6 channels) or 7.1 (8 channels). 
When you import a Dolby Atmos master file through the Fairlight Immersive tools, the bed 
track (A1) matches the channel format of the bed track when the original master file was 
created. In this case, the Dolby Atmos bed track in A1 is 7.1.2 (7 surround channels, 1 LFE, 
and 2 overhead channels), hence the first 10 channels. The remaining 118 channels can be 
used for additional beds or mono objects. This example includes a 7.1.2 bed track and the 
maximum allowable 118 object tracks, plus four VCA groups with faders. 

1	 Hide the media pool. 

2	 Expand the mixer as far as you can toward the left.
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3	 Double-click the track meters in the monitoring panel to double-stack the meters 
so that you can monitor all 109 tracks at once. 

NOTE  By default, bed tracks are purple, and object tracks are green, similar 
to what you will find in the external Dolby Atmos Renderer available in the 
Dolby Atmos Production Suite and Dolby Atmos Mastering Suite. 

For more detailed information about Dolby Atmos and the Dolby Atmos 
Renderer, go to https://professional.dolby.com/siteassets/content-creation/
dolby-atmos/dolby_atmos_renderer_guide.pdf.

4	 Increase the height of the A1 track header until you can see all the channels in 
the timeline. 

https://professional.dolby.com/siteassets/content-creation/dolby-atmos/dolby_atmos_renderer_guide.pdf
https://professional.dolby.com/siteassets/content-creation/dolby-atmos/dolby_atmos_renderer_guide.pdf
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You can see 10 audio channels, but there are no visible labels on the stem 
channels—yet.

5	 Choose Fairlight > View Clip Info Display. 

6	 In the Clip Info Display dialog, enable the Stem option. Then click OK. 

The contents of the A1 bed track are just what you would expect to see for a 7.1 mix, 
with the added Left top surround (Lts) and Right top surround (Rts) channels. 

7	 Zoom vertically to reduce the height of all the tracks as much as possible. 

You can read the first word in each object track’s header and quickly identify the types 
of object tracks by name: Dialogue, Music, or Effects. For training purposes, these 
names were added to the original master file to match the VCA groups in the mixer. 
Otherwise, when importing a master file through the Fairlight Immersive tools, 
unnamed object tracks would be named “Object” with a sequential number starting 
with the first object track.
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NOTE  The VCA groups were added along with the track names to 
demonstrate how they are incorporated as embedded metadata when 
generating a Dolby Atmos master file. 

8	 Select the first Dialog Object track, A2, and zoom vertically to increase the height of 
the tracks until you can see the track name. 

The first object track in A2 is labeled accordingly as Dialog Object 1. 

Next, let’s look at the VCA groups in the mixer. VCA groups let you adjust relative levels 
of all tracks in a group, even if they have automation applied. 
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9	 In the mixer, expand the bus section toward the left until you can see the channel 
strips for Bus 2 and all four VCA groups. 

These VCA faders can be used to adjust the levels of all the member tracks, even with 
automation turned on. 

10	 In the mixer, drag the Dialog VCA fader up and down to see all the faders in the Dialog 
group move simultaneously, relative to the movement of the VCA fader.

11	 Double-click the Dialog VCA fader to reset the level of the VCA group and all member 
tracks to unity.

12	 In the mixer, drag the left edge of the Main bus channel strip toward the right to reveal 
more track channel strips and hide the VCA channel strips. 



703Lesson 11  Exploring Immersive Audio Integration

NOTE  To show the VCA controls in the mixer, enable VCA in the mixer options 
menu. You can assign tracks to VCA groups in the VCA controls located between 
the Bus Outputs and Track Name fields on each channel strip in the mixer. Click 
the VCA control to open the dropdown menu where you can change the group, 
choose No Group, or open the VCA Assign window. You can rename VCA groups in 
the Tracks Index by clicking the VCA name field in the Name column. 

Revealing Auto-Patching to the 
Internal Dolby Atmos Renderer
The last stop on this master file timeline tour is patching to the internal Dolby Atmos 
Renderer. As you already know, the internal Dolby Atmos Renderer handles all the 
processing under the hood, so you can play the master file, generate re-renders, or deliver 
a new master file. When you import a master file via the Fairlight Immersive tools, the bed 
and object tracks are automatically patched to the internal Dolby Atmos Renderer. This is 
the same patching you would do manually if you were mixing and creating original Dolby 
Atmos content in DaVinci Resolve. 

1	 Choose Fairlight > Patch Input/Output. 

2	 In the Patch Input/Output window, set the Source to Bus Out and the Destination to 
Dolby Atmos Send. 
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Here, you can see that the 10 Composite Bed channels are patched to the first 10 
channels of the Dolby Atmos Send. 

3	 Set the Source to Track Direct. 

Here, the object track channels starting at Dialog Object 1 are patched to the sends 
starting with Send 11. 

4	 Close the Patch Input/Output window. 

Syncing Video From an A/V Source Clip
If you have a video-only clip to sync to the audio tracks in the timeline, you can drag it right 
from the media pool to the timeline and move it into position for sync. That isn’t the case 
here, since the video clip for this project includes a stereo track. Currently, in the Fairlight 
page, there is no way to add video only from a source clip that includes audio. So for this 
exercise, you’ll jump over to the edit page where you can edit just the video from an A/V 
source clip to the timeline. 

1	 Press Shift-4 to go to the edit page. Press the Down Arrow to move the playhead to the 
beginning of the clips in the timeline.

2	 In the media pool, double-click the NaturesFury.mp4 clip to load it into the 
source viewer.
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3	 Hover your pointer over the source viewer until you see an overlay with a video clip 
icon on the left and an audio waveform icon on the right. 

This editing overlay allows you to edit video only or audio only from the source clip. In 
this case, you want to edit video only.

4	 Drag the video-only overlay to the empty Video track in the timeline. 

Now that the video clip is in the timeline, you can sync the tail of the clip to the tail of 
the audio clips. If snapping is turned on, the tail of the video clip should snap to the 
end of the audio. 

5	 In the V1 track, drag the video clip into position so that the last frame aligns with the 
last frame of the audio clips.

6	 Press Shift-7 to go to the Fairlight page. 
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Now that you’ve imported the Nature’s Fury Dolby Atmos master file and synced the video, 
you can move on to the next exercise, where you’ll watch and listen to the panning and 
immersive sound during playback. 

Exploring the “Flying Objects” 
and Pan Metadata
In this self-guided exercise, you’ll utilize tools and skills you’ve already learned as you watch 
and listen to this professionally produced Dolby Atmos timeline. Take your time as you do 
the following: 

	— Set the monitoring to Binaural (if using headphones) or a channel-based speaker setup 
to match your current speaker configuration. 

	— Notice the Immersive controls in the mixer channel strips that indicate which channels 
are objects and which Dolby Atmos Send they are assigned to in the Patch Input/
Output window. 

	— Play the timeline clips from start to finish while listening to and watching the video. 

	— Increase the track height until you see the automation dropdown menu in the track 
headers. Then press Command-Option (macOS) or Ctrl-Alt (Windows) while setting one 
of the automation dropdown menus to Pan > L/R Pan. Now you can see the left/right 
pan automation curve for all tracks. 

	— Scroll down to the tracks A28–A34 or any other tracks with busy automation curves. 

	— In the Fairlight menu, choose Immersive Audio > Space View. Watch the objects in 
Space View during playback. Feel free to experiment with different settings to show all, 
show only selected, etc. 



707Lesson 11  Exploring Immersive Audio Integration

NOTE  Setting a playback monitoring format automatically updates the Patch 
Input/Output settings accordingly. If you’re monitoring through external speakers, 
set the monitoring to match your speaker setup. Doing so does not change the 
Dolby Atmos delivery format. 

Showing the Dolby Atmos Renderer Settings
Dolby Atmos master files can be monitored with speaker layouts that include overhead 
speakers for immersive playback and more traditional 7.1, 5.1, and stereo formats.

When a Dolby Atmos master is monitored in 5.1 or stereo, controls determine how the 
overhead content and rear surround content are derived: either directly from the renderer 
or downmixed from an intermediate layout. These are referred to as downmix settings. 

1	 Choose Fairlight > Immersive Audio > Renderer Settings.
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Downmix settings work in conjunction with trim controls when monitoring in 5.1.2, 5.1, 
and stereo. The automatic setting provides algorithmic dynamic trims that are 
appropriate for the vast majority of content. In some cases, more specific control of 
rear surround and height content is needed, along with adjustment of the front/back 
balance to ensure dialogue intelligibility and balance with the floor speakers. Manual 
trim controls are provided for this purpose. Remember that any changes to these 
controls are applied to the entire master. Manual trim control should be considered 
an advanced setting.

2	 In the Trim Controls, click the Manual option to engage the Trims and Front/Back 
Balance controls for manual adjustment.

3	 Click the Automatic option to return the Renderer settings to the Automatic controls 
using the automatic Dolby Atmos algorithms to calculate the downmix trims. 

4	 Click Cancel to close the dialog.

NOTE  The learning.dolby.com webpage provides detailed information about 
Dolby Atmos workflows for downmixing to 5.1 and stereo, as well as using the 
Dolby Atmos Renderer Downmix and Trim Controls.

Importing the Podcast  
Intro Master File
Now, let’s step into a different project you’ve been working with since the first lesson and 
import a Dolby Atmos ADM master file for the Post Park Normal podcast intro. As you’ve 
just witnessed, when you import a Dolby Atmos master file in the Fairlight page, new 
media is rendered in a new timeline to re-create the Dolby Atmos mix. These newly 
rendered files appear in the media pool and media location designated on your system. 

In this exercise, you’ll import a simple Dolby Atmos mix with 1 bed bus and 11 object tracks 
to see and hear the results. To simplify the steps, an empty bin named Imported Master 
File has already been added to the Lesson 11 Timelines folder. 

http://learning.dolby.com
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1	 Open your Podcast Intro Combo project. 

2	 In the media pool, Lesson 11 bin, open the 11e Dolby Atmos Bus and Bed timeline.

This is the 5.1 mix of the Post Park Normal podcast intro with 23 tracks, 4 submix 
busses, a 5.1 comp bed bus, and a 5.1.4 Dolby Atmos Master bus. You’ll work more with 
this timeline shortly. First, let’s import the Dolby Atmos master file created from this 
timeline. 

3	 In the media pool, Lesson 11 bin, double-click the Imported Master File bin to open it.

As you can see, the bin is empty, but not for long.
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4	 Choose Fairlight > Immersive Audio > Import Master File.

5	 In the Finder window, navigate to the R20 Fairlight Book Media > R20 Fairlight Part 4 > 
PPN Intro Combo 1 Comp bed.wav file. 

6	 Click Open. 

A new timeline is created, complete with a 5.1 Comp bed track and 12 object tracks. 
The rendered files are located in the Imported Master File bin in the media page.

7	 Extend the mixer to show all tracks and busses, and then press Shift-Z to fit timeline 
clips horizontally in the visible timeline area. 
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8	 If necessary, set the monitoring controls to Binaural if you are listening with 
headphones, or whichever format matches your current monitoring speaker 
configuration. 

9	 Play the timeline once from the beginning to hear the Dolby Atmos mix of your 
podcast intro.

Wow! This podcast intro has come a long way since you created it from scratch in 
Lesson 1. Let’s quickly look at the Patch Input/Output settings for the Dolby Atmos 
Send to see how the master was patched before rendering. 

10	 Choose Fairlight > Patch Input/Output.

11	 In the Patch Input/Output window, set the Source to Track Direct and the Destination 
to Dolby Atmos Send. 

Here you can see that the six 5.1 bus channels were patched to the first six channels in 
the Dolby Atmos Send, and 12 FX channels were patched to 12 Dolby Atmos sends. The 
VO, music, ambience, and a few FX tracks were assigned to the bed bus and therefore 
don’t have associated object tracks. 

Remember, there can only be 128 channels in a Dolby Atmos master file, and the first 
10 channels are reserved for bed bus channels. Other than those restrictions, you can 
assign objects to any open object sends between Send 11 and Send 128. 

12	 Feel free to explore the Space View and panning curves on this timeline before moving 
on to the next exercise.

In the next exercise, you’ll create an original Dolby Atmos ADM master from the 
Fairlight timeline. 
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Creating Original Dolby Atmos 
Content in DaVinci Resolve
DaVinci Resolve Studio makes it easy to patch, mix, and export any soundtrack into a Dolby 
Atmos master file via the internal Dolby Atmos Renderer. In this set of exercises, you’ll 
continue working with your Podcast Intro Combo project as you follow the workflow from a 
5.1 mix to a rendered Dolby Atmos ADM master. A Dolby Atmos ADM (Audio Definition 
Model) is a standardized file format, based on the Broadcast Wave Format (BWF), that 
stores both audio and metadata for Dolby Atmos mixes. First, you’ll reopen the 11e 
timeline, enable the Dolby Atmos Renderer, and patch the bed and object tracks to the 
Dolby Atmos Sends for the bed bus and objects going to the renderer. Once patched, you 
can export an original Dolby Atmos master file right from the Fairlight page. 

1	 In the Media Pool > Timelines > Lesson 11 bin, open the 11e Dolby Atmos Bus  
and Bed timeline. 

Earlier in this lesson, you enabled the Dolby Atmos Renderer in the preferences. Let’s 
verify that the renderer has been enabled, since this is a necessary step for generating 
a Dolby Atmos master file in DaVinci Resolve. 

2	 Choose DaVinci Resolve > Preferences. In the Preferences window, System preferences 
tab > Video and Audio I/O, scroll down to the Dolby Atmos settings and make sure that 
the Dolby Atmos Renderer is enabled. If necessary, enable the Dolby Atmos Renderer 
and then quit and reopen DaVinci Resolve. 

3	 Open the 11e Dolby Atmos Bus and Bed timeline, if necessary.

4	 In the mixer, notice that there are four 5.1 (6 channels) submix busses, including FX 5.1, 
bgFX 5.1, MX 5.1, and DX 5.1. 

These submix busses are all routed to the lime-green 5.1 Comp bus. 
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5	 While in the mixer, look for the 5.1 Comp bus assigned to the Dolby Atmos Master bus.

Notice that the tracks are all either assigned to a submix bus, which is in turn assigned 
to the 5.1 Comp bus as part of the bed mix, or assigned to the Master bus as objects. 

Now that you’ve identified the timeline bussing for this mix, let’s assign the tracks and 
busses to the renderer. 

Using the Patch I/O Window to Patch 
Channels to the Renderer
Which sounds should be busses and which are objects is very subjective, depending on 
how you want to mix your soundtrack and the amount of control you want to retain versus 
assign to the Dolby Atmos Renderer. For this simple podcast intro timeline, the sounds 
controlled by the VO characters—such as the book, dog, skateboard, bike, and camera—
will all be objects. Fixed sounds—such as birds, park ambience, and music—will continue as 
channel-based bed sounds. The helicopter and dragon sounds will all be objects, except 
the Roar track, which will continue as a bed sound. Let’s start by patching the bed bus 
channels, followed by the object tracks to the Dolby Atmos Sends.

1	 Choose Fairlight > Patch Input/Output. 

2	 Set the Source to Bus Out and the Destination to Dolby Atmos Send.

In the Source area, you can see all six channels for each of the five busses, including FX 
5.1, bgFX 5.1, MX 5.1, DX 5.1, and 5.1 Comp. This version of the 5.1 Dolby Atmos mix has 
all four submix busses assigned to the 5.1 Comp bus and the 5.1 Comp bus assigned to 
the Master as the only bed bus for this mix. Therefore, you’ll only need to assign the six 
5.1 Comp channels (lime-green) on the Source side to the first six Bed Sends on the 
Destination side. 
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3	 On the Source side of the Patch Input/Output window, select all six lime-green 5.1 bus 
channels. Then, on the Destination side, select Bed 1–Bed 6. 

4	 Click Patch.

The Bed bus has been patched to the renderer, but you still need to assign the 
object tracks.

5	 In the Patch Input/Output window, set the Source to Track Direct. 



715Lesson 11  Exploring Immersive Audio Integration

Here, you’ll see all the audio track channels. Now, you only need to choose which 
channels you want to use as objects. You could pick and choose channels, or select 
and patch all the FX channels, then unpatch any channels you don’t want to be 
assigned as objects. In this example, you’ll try the latter option and patch all the FX 
channels, and then unpatch the channels that remain assigned to the bed bus. 

6	 Select all 21 Source channels from Book FX to Music-R. Then, on the Destination side, 
select 21 consecutive sends. 

7	 Click Patch. 

8	 The Sends have been patched to the internal Dolby Atmos Renderer. 

Next, you’ll select and unpatch the channels you don’t want to send as objects. 
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9	 On the Source channels, select Mower FX-L, Mower FX-R, Birds-L, Birds-R, Ambience-L, 
Ambience-R, Roar, Music-L, and Music-R. Click Un-Patch. 

The Patch Input/Output window updates to show the bed and object patching. 

10	 Close the Patch Input/Output window. 

11	 Play the timeline once from the beginning to hear this Dolby Atmos version of the 
podcast intro. 

NOTE  To see which channels are assigned as object sends to the internal 
Dolby Atmos Renderer in the mixer, you’ll need to enable the Immersive 
Objects option in the mixer options menu. 

Exporting a Dolby Atmos Master 
File from the Fairlight Timeline
Once your mix is patched and ready to deliver, you can export a Dolby Atmos master file 
right from the Fairlight page timeline. In this exercise, you’ll go to the Immersive Audio 
tools in the Fairlight menu, where you’ll work with the Export Master File dialog to learn 
another method for exporting an audio-only ADM or IMF IAB Dolby Atmos master file from 
your own mixes and original content. First, you’ll need to mark a range in the timeline that 
you wish to export as a master file. 
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1	 Mark an In point at the beginning of the 11e Dolby Atmos Bed and Bus timeline. 

An Out point will automatically be set after the last frame of media in the timeline. 

2	 Choose Fairlight > Immersive Audio > Export Master.

3	 In the Export Immersive Master dialog, set the following options: 

	— File Name: Tag + Timeline Name

	— Tag: PPN Intro_ 

	— Format: Dolby Atmos ADM BWF

	— Source: Atmos Send Patching (automatic)

	— FFOA: Enabled

4	 Click Export.

5	 In the Export Immersive Master window, navigate to the PPN Podcast Intro folder.

6	 Click Save.

A progress dialog indicates that a new master file is generated from the current timeline. 
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NOTE  If you did not complete the earlier lessons, create a new folder for the PPN 
Intro master file. 

Well done! You’ve generated a new Dolby Atmos master file from an original project. In the 
next exercise, you’ll examine a more complex mix of the same timeline and the 
corresponding master file. 

Exploring a Dolby Atmos Master 
with Multiple Beds and VCAs
In the previous exercises, you worked with a simple Dolby Atmos mix with one 5.1 comp 
bed bus. In this exercise, you’ll create a more complex Dolby Atmos mix with four bed 
busses based on the submix busses and two VCAs for additional control of the mix before 
and after the Dolby Atmos master file is created. You’ve already performed most of the 
tasks in this exercise earlier in this lesson, so you’ll primarily be practicing your skills and 
learning how to create VCAs along the way.

1	 In your Podcast Intro Combo project, open the 
11g Dolby Atmos 4Beds and 2VCAs timeline.

2	 Expand the mixer as needed to see all the busses. 

Here, you can see four 5.1 busses, including FX 5.1, bgFX 5.1, MX 5.1, and DX 5,1. 
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In this timeline, instead of assigning these busses as submix busses to a 5.1 Comp bus, 
and then assigning the 5.1 Comp bed bus to the Dolby Atmos Master bus, each of the 
5.1 submix busses were assigned as bed busses to the Master bus. 

3	 Choose Fairlight > Patch Input/Output to open that window. 

In the Destination Dolby Atmos Send settings of the Patch Input/Output window, you 
can clearly see four busses assigned to the first 24 sends, including DX, FX, MX, and 
bgFX. You can also see that there are 12 object channels assigned to as many sends. 

4	 Close the Patch Input/Output.

Now that you’ve seen how the bed busses and objects are assigned to the renderer, 
let’s create two VCAs. 

Creating VCAs in the Fairlight Mixer
In audio post mixing, a VCA acts like a master volume control for a group of tracks. A VCA is 
a special fader that lets you control the overall volume of a group of tracks at once without 
changing their individual settings, making it easier to adjust and balance your mix. In this 
exercise, you’ll create two VCAs to add level control to the park FX objects and dragon 
sounds. In DaVinci Resolve, both VCAs and bed busses are incorporated when you 
generate a new Dolby Atmos master file and offer additional controls for playback and 
re-renders from the master file. 

1	 In the mixer, look for the park sound FX that are not assigned as objects. Hint: They will 
not be assigned to the Master bus or have a green send number in the Immersive 
Objects area of the mixer. 
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2	 Select the following park-related FX channel strips in the mixer: A8 Book FX—A13 
Camera FX. Option/Alt-click the VCA field above the track names for the selected track 
and choose VCA 1. 

3	 In the mixer, select the A20–A22 Wing Flaps tracks.
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4	 Option/Alt-click the VCA field for the selected tracks and choose VCA 2.

You can clearly see the VCA name beneath the designated tracks in the VCA row on 
the mixer. 

NOTE  To open the full VCA Assign window where you can see and modify VCA 
assignments, choose VCA Assign from the bottom of the VCA dropdown menu in 
the mixer. 

Customizing VCAs
Once you’ve created a VCA, you can change the name and color in the Tracks Index.

In this exercise, you’ll name VCA 1 “Park-FX” and VCA 2 “Dragon.” You’ll also change the 
color of the Dragon VCA to brown. 

1	 Hide the media pool, if necessary. 

2	 Show the Tracks Index. 

At the bottom of the Tracks Index, you’ll see the current VCAs listed. 

3	 In the Tracks Index Name column, name VCA1 Park-FX and VCA2 Dragon. 
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Now that you’ve named the VCAs, let’s change the Dragon VCA to brown. 

4	 In the Tracks Index, right-click VCA2 and choose Change Track Color > Brown. 

The new VCA names are also visible in the mixer.

That’s it. You’ve customized the VCAs in just a few simple clicks. 

NOTE  Adding VCAs and multiple bed busses won’t change the sound of your mix; 
instead, they offer more control during the mix, and when working with a 
rendered master file. Additionally, there are more custom re-render options in the 
Bounce Mix to Track window when a master file has multiple bed busses, such as 
when rendering a full mix or individual bed busses. 

Exploring the Multi-Bed 
Dolby Atmos Mix
This last exercise will be a self-guided exploration of the Dolby Atmos podcast intro with 
four bed busses and two VCAs. Using the skills you’ve learned in this lesson, you’ll import a 
finished master file and test the VCAs in the mixer. 

1	 Using the Immersive Audio toolset in the Fairlight menu, import the PPN Intro  
Combo w VCAs.wav master file located in the R20 Fairlight Part 4 folder. Tip: Before 
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importing, remember to open the bin in the media pool where you want the imported 
timeline and rendered files to be located. You can use the Imported Master File bin. 

2	 Play the timeline and look at the bed busses and object tracks in the timeline and 
mixer. Toggle the monitoring controls between Binaural, 2.0 (stereo), and other Dolby 
Atmos formats. 

Notice that everything set up in the original mix timeline was incorporated into the 
Dolby Atmos master file except the custom track, clip, and VCA colors. 

NOTE  The Dolby Atmos renderer uses only three colors across all platforms: 
purple for bed busses, blue for the Master bus, and green for the object 
tracks. Once you’ve imported a Dolby Atmos file, you can change the track and 
VCA colors while working in DaVinci Resolve. 

3	 Use the Space View to see the relationship of the bed sounds and objects in 3D space. 

4	 Open the 11g Dolby Atmos 4Beds and 2VCAs timeline. Adjust the faders and mix to 
your liking. Export a new master file from the Immersive Audio toolset in the 
Fairlight menu.

5	 Feel free to experiment with the individual track levels, busses, and VCAs. 

That concludes your Dolby Atmos exploration for this lesson. Feel free to revisit the 
Nature’s Fury project and use it as a study guide for observing, listening to, and exploring 
Dolby Atmos integration in DaVinci Resolve Studio.
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NOTE  If you want to learn more about working with Dolby Atmos, you’ll find more 
information at the Dolby.com website. Here are some helpful links to some of the 
Dolby Atmos resources: 

https://www.dolby.com/technologies/dolby-atmos/

https://professional.dolby.com/content-creation/Dolby-Atmos-for-content-creators/

Lesson Review
1	 True or False? Immersive formats such as Ambisonics and Dolby Atmos require the 

Studio version of DaVinci Resolve.

2	 Where do you enable a project for Immersive workflows? 

a)	 Inspector

b)	 New Project window

c)	 System Preferences 

d)	 Dolby Atmos Renderer settings

3	 How many channels are in a 1st-order ambisonics track?

a)	 1

b)	 2

c)	 3

d)	 4

e)	 There are no channels in ambisonics tracks

4	 Which Ambisonics Meters are available in the viewer (choose all that apply)

a)	 Spherical

b)	 Power Map

c)	 Sonar

d)	 Waterfall

e)	 Image Mapping

http://Dolby.com
https://www.dolby.com/technologies/dolby-atmos/
https://professional.dolby.com/content-creation/Dolby-Atmos-for-content-creators/
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5	 In DaVinci Resolve 20 Studio, you can export which types of Dolby Atmos master files?

a)	 XML and AAF

b)	 ATMOS and BWF

c)	 PCM and IMF IAB

d)	 IMF IAB and ADM BWF (.wav)

6	 Where are the Immersive tools located in the Fairlight page?

a)	 Fairlight menu

b)	 Dolby Atmos Render menu

c)	 Patch Input/Output window

d)	 Mixer

7	 Where in the Fairlight page do you find the option to import a Dolby Atmos master file 
so it will re-create the full mix, including content, automation, bed, and object tracks?

a)	 File menu

b)	 Fairlight menu

c)	 Media pool

d)	 Mixer

8	 What does the 2 represent if you are monitoring a Dolby Atmos 7.1.2 master file? 

a)	 Overhead channels 

b)	 LFE subwoofer channels

c)	 Immersive channels

d)	 Object channels 
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Answers
1	 True. 

2	 c. Immersive audio formats including Dolby Atmos are enabled in the Video and Audio 
I/O panel of the System Preferences window.

3	 d. First-order ambisonics comprises four channels.

4	 b, c

5	 d. You can export IMF IAB and ADM BWF master files from either the Fairlight timeline 
or the deliver page. 

6	 a

7	 b. You can import a master file in the media pool as a single clip that will play back 
through the Dolby Atmos Renderer, or import a master file through the Fairlight menu 
Immersive tools to re-create the entire mix.

8	 a

Congratulations! 
You have completed The Fairlight Audio Guide to DaVinci Resolve 20 and are ready to explore 
more editing, visual effects, color grading, and audio mixing functionality using the 
additional certified books in this series. Completing all the lessons in this book has 
prepared you to become a certified DaVinci Resolve user. You can take the online 
certification exam by following the link below to earn your certificate.

We also invite you to become part of the DaVinci Resolve community by joining the web 
forum on the Blackmagic Design website: https://forum.blackmagicdesign.com

There, you can ask further questions about the creative aspects of editing, color 
correction, visual effects, and audio mixing. 

We hope you have found DaVinci Resolve’s professional audio tools intuitive to learn and a 
perfect fit to become the hub of your creative workflow. 

Test your skills by taking the online assessment located on the Blackmagic Design 
DaVinci Resolve Training page—The Fairlight Audio Guide to DaVinci Resolve 20 
Online Exam: www.blackmagicdesign.com/products/davinciresolve/training

https://forum.blackmagicdesign.com
http://www.blackmagicdesign.com/products/davinciresolve/training
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Index
NUMBERS
3D audio, simulating, 649
3D pan controls, exploring, 351–356
4-in-1 Modulation plug-in, 445–448. 

See also modulation

A
A024_C006_04047FE_001 video 

clip, 92, 95–97
A/B Comparison toolset, 431–432
Add Tracks dialog, 19
ADR (automated dialogue 

replacement), 267
ADR cue lists, importing, 282–287
ADR cues

creating manually, 275–277
creating with AI Tools (Studio), 308–310
finishing setting, 277
recording in timeline, 278–281
sorting, 284–285

ADRCues_TML Harper Surfs Scene 
v2.csv, 283

ADR panel, Video Streamer settings, 279
ADR Record panel, working in, 278–279
ADR session, setting up, 268–277
ADR Setup panel, 270
ADR timeline, exploring, 282. 

See also timelines
ADR tracks, arming for recording, 271
A-format ambisonics, 664
AI Audio Assistant, mixing soundtracks 

with, 609–612
AI processing tools (Studio), working 

with, 601–612
AI speech-to-text transcription 

(Studio), 153–158
AI tools

Create ADR Cues options, 285
creating ADR cues with, 308–310
dialogue editing, 121
speech-to-text editing toolset, 128

aligning and splitting clips, 133
Alt key. See keyboard shortcuts
Ambi 10A bus, 648
AMBIENCE field, 20
AMBI Park FX FOA file, 669
AMBI Park FX HOA file, 670
ambisonics

adding to stereo timeline, 646–654
A- and B-format, 664
overview, 646

ambisonics clips, 658
ambisonics meters, working with, 655–664
ambisonics mix, bouncing in 

timeline, 664–670
ambisonics track, rendering in deliver 

page, 668–670
American loudness standards, 543
Analyze Audio Levels dialog, 619
AR (augmented reality), 646
Arm button, 26, 258
Arrow tool, 269
ASAF (Apple Spatial Audio Format), 644
atmospheric sounds, 450
attenuate, defined, 372
attributes, removing, 315–316
audio. See also sound

placing in panoramic sound 
field, 342–350

retiming with Elastic Wave time 
controls, 402–413

slipping in timeline, 481–482
transcribing, 154–155

audio channels
audio syncing and setting in source 

clips, 91–96
maximum number of, 95

audio channel shortcut menu, 124
audio clips. See clips
Audio Configuration controls, 91, 98
audio controls, adjusting, 375



728Index

audio edit, finessing, 66–70
audio files, importing, 5–10
audio format, changing, 98
audio levels, analyzing, 619
audio metering, setting for recording, 255
Audio Pan controls, 348. See also Panning 

controls
Audio panel, 90
Audio Pan window, opening, 650
audio post-production, dynamic 

range in, 369
audio problems, finding, 368–373
audio recordings, choosing locations 

for, 253–256
audio repairs. See also dialogue repairs 

with Fairlight FX plug-ins
finding problems, 368–373
gating low-level noise, 373–376
implementing, 414–415

audio scrollers, using for 
synchronization, 197–204

audio standard. See Dolby Atmos
audio track layers. See also tracks

showing, 139–140
working with, 136–140

audio transitions, adding to timeline in 
edit page, 234

auto-leveling, applying to balance 
clips, 333–342

automation
clearing from tracks, 356
working with, 569

automation controls
locating, 9
setting, 562–566

automation curves, 243, 570–571
automation toolbar, opening, 242
automation toolset, 561
Auto monitoring style, 259
Auto Sync feature, 91–96
auxiliary bus effects parameters, 

customizing, 513–515

auxiliary echo bus
creating, 505–516
sending track signals to, 510–513

B
backpack field, 184
Backpack Movement 2 clip, 185–186
backup timeline 1h Intro v1 Finished, 78
Band enable button, 371
band filter type, 371
Beep settings, using with ADR 

sessions, 273
beep track patching, revealing in ADR cue 

list, 286–287
bell-curve filters, 372
B-format ambisonics, 664
bgFX bus, 492
Bike Bells 1 clip, 187
Bike By 1 clip, 188–189
Bike By 2 sound effect, 188–189
Bike Chain 2 clip, 187
binaural sound, 649
bins list, showing and hiding, 13
Birds channel strip, 480
Birds clip, loading into preview player, 21
BIRDS field, 20
Birds tracks, 477
Blackmagic Cloud Store, xxvi
Blackmagic Design DaVinci Resolve 

Training page, 726
Blackmagic Design Training and 

Certification Program, xiv
Blackmagic Design website, 726
Book Pages Turning clip, 42
Book Pages Turning Flutter clip, 36, 175
BOOK track, 42
Boots on Rocky Dirt Footsteps clip, 301
bounced files, previewing, 630
Bounced VO Comps bin, 146–147
bouncing

ambisonic mix in timeline, 664–670
audio clips with plug-ins, 389
busses to create stems, 627–628
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mixes in Fairlight page, 624–628
mixes to tracks, 448–450

bouncing selections to layers, 146–148
bus assignments, deleting, 499–501
Bus Assign window, viewing bus mapping 

in, 501–503
Bus Format pane, 507
Bus Format window, 493, 506, 508
bus mapping, viewing in Bus Assign 

window, 501–503
busses. See also auxiliary echo bus;  

Flex Bus format; FX Waves bus
adding, 506
auto-ducking with sidechain 

compression, 578–583
bouncing to create stems, 627–628
monitoring, 497–498
naming, 492
using to simplify mixing, 491–505
working with in mixer, 503–505

busses and video tracks, hiding, 102–103
bus tracks, appearance in timeline, 493

C
caching audio clips with plug-ins, 389
Camera Click fx v3 clip, 174
Cancel button, using with sound 

effects, 188
certification, getting, xiv
Chain FX plug-ins, exploring, 595–601
characters, listing, 284–285
checkerboard editing on dialog tracks

performing, 106–109
splitting clips, 109–113

Clear Track Automation, 356
clicks, removing at sample level, 399–402
Clip Attributes dialog, 89–90
clip color, choosing, 265
Clip EQ, using to reduce low frequencies, 

369–373. See also EQ (equalization)
clip format

matching with timeline tracks, 23
showing, 93

Clip Info Display dialog, 24, 123
clip levels

adjusting, 324–325
balancing, 332
balancing in timeline, 62–66
changing using keyframes, 326–328
changing within clips, 70–73
resetting, 315–316

Clip Name option, 369
clip names versus filenames, 18
clip normalization, 333–337
clips. See also stacked clips in timeline; 

timeline clips
adding to timeline, 20–27
adjusting timing of, 69–70
applying auto-leveling to 

balance, 333–342
balancing, 333–342
balancing ranges of, 328–332
dragging, 7
editing and arranging in timeline, 49–56
enabling and disabling, 152–153
fitting horizontally, 124
marking, 317
marking and editing portions of, 34–37
moving, 118, 129
moving between tracks, 113–119
previewing in media pool, 13–18
relinking, 149
reversing in timeline, 453
selecting, 44, 135
selecting and deselecting, 316
selecting in groups, 485
solo-scrubbing with multi-tool, 170–171
splitting, 109–113, 131, 179–183
splitting and aligning, 132–133
splitting and nudging, 67–69
splitting in layers, 143–144
trimming and moving to layers, 141–144
trimming in timeline, 28–31

clip volume levels, changing in 
Inspector, 11–13
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COFFEE track, 42
Command key. See keyboard shortcuts
Command keys, using for shortcuts, 116
comparing sound, 431–432
compressing dialogue tracks, 572–578
Compressor control, 572–578
control dials, resetting, 241
Control Room monitoring

changing, 497–498
resetting, 501

Copy command, 116
Cross and Streamer, changing 

colors of, 279
crossfades. See also fades

adding in timeline, 231–235
applying between music sections, 522

Ctrl key. See keyboard shortcuts
Cue Sort menu, 285
customized presets, saving, 426–427. 

See also presets
custom settings, working with, 425–426. 

See also settings
Cut command, 116

D
Dangerous Music M19.wav clip, 236
Dangerous Music R19 clip, 16, 57, 59–61, 63
DaVinci Resolve, downloading, xv
DaVinci Resolve 20 quick setup, xv–xxii
DaVinci Resolve User Manual, 

accessing, 197
DaVinci Resolve web forum, 726
dB (decibel) levels, 319, 369
Decompose Preserving Audio Data 

dialog, 229
De-Hummer 

plug-in, 376–388. See also hum
deleting, bus assignments, 499–501
deliver page

opening, 635
Optimize to standard option, 638
rendering ambisonics tracks in, 668–670
rendering mixes in, 635–639

delivery options, exploring, 692–693
dialogue. See also futzing dialogue to 

simulate PA system; offscreen 
dialogue; voices

altering to fit context of scene, 421–427
clarity, 592–595
evaluating with ADR recording, 405–409
futzing to simulate PA system, 428–440
repairing with Fairlight FX 

plug‑ins, 376–388
sweetening with EQ, 586–592

dialogue clip levels
adjusting, 324–325
balancing, 317–318, 332
balancing ranges of clips, 328–332
changing using keyframes, 326–328
establishing target levels, 319–323
reading meters, 318

dialogue editing
AI-based tools, 121
preparing multichannel clips for, 89–98
preparing timeline for, 98–106

Dialogue Editor, 82. See also editing
dialogue editors

opening and playing project, 83–89
overview, 82
project preparation, 125–126

dialogue equalization, 584–585
dialogue frequency level, 585
Dialogue Leveler, working with, 337–342. 

See also target dialogue levels
Dialogue Matcher, 602
dialogue mixer, explained, 369
dialogue repairs with Fairlight FX plug-ins. 

See also audio repairs
combining plug-ins, 385–388
implementing, 376–380
reducing noise, 381–385

dialogue repairs with Track FX 
(Studio), 392–399

Dialogue Separator, working with,  
397–398
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dialogue tracks
applying equalization to, 583–595
checkerboard editing on, 106–121
compressing, 572–578

DIM button, 15, 62
Direction controls, using with speed 

changes, 455
Director track, 108
disabling and enabling clips, 152–153
displays. See monitors
Distortion plug-in, 432–435
Dog walking clip, 168
Dog walking.m4a clip, 168
Dolby Atmos. See also multi-bed Dolby 

Atmos mix
bed tracks, 678
bouncing stereo and 5.1 

re‑renders, 689–692
busses, 671
changing monitoring format, 675–677
changing playback format, 688–689
checking deliverables, 696
converting surround sound channel-

based mix to, 672–680
creating IMF packages with, 694
default Loudness metering, 677
delivery options, 692–696
explained, 671
IAB master files, 694
importing podcast intro master 

file, 708–711
learning more about, 724
Master bus, 674–675
tracks as objects, 678–680
working with in Fairlight page, 671

Dolby Atmos content, creating in 
DaVinci Resolve, 712–718

Dolby Atmos master file
adding to media pool and 

timeline, 683–687
bed, object, and VCA groups, 698–703
bed, object and VCA groups, 698–703
beds and VCAs, 718–719

creating IMF packages with, 694
exporting from Fairlight 

timeline, 716–718
“flying objects” and pan 

metadata, 706–707
identifying, 684
Immersive Objects option, 716
importing, 696–708
integrity of individual channels, 687
maximum channels, 677
with multiple beds and VCAs, 718–719
syncing video from A/V source 

clip, 704–706
Dolby Atmos mix, exploring, 722–723
Dolby Atmos Renderer

colors, 723
enabling in Preferences, 681
patching channels to, 713–716
revealing auto-patching to, 703–704
showing settings, 707–708

Dolby Atmos workflows, 708
Doppler preset, 447
doubling a track, 464
downloading

DaVinci Resolve, xv
Fairlight Sound Library, xxiii–xxv

dragging clips, 7
Dragon Roar and Vocals timeline, 458
dragon vocals, changing human voices 

to, 458–459
dragon wing flap sound effect, 470
Drinking Coffee_001 clip, 34
Drinking Coffee clip, 42, 71
dual monitors, using, 547. 

See also monitors
Dual Screen layout, 87
dubbing mixer, 536. See also mixer
Ducker, using to lower music or FX 

tracks, 552–559
duration markers. See also markers

converting In and Out to, 206
setting, 37–41
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DX bus, naming, 492
DX Echo bus, 507, 515–516
dynamic range in audio 

post‑production, 369

E
echo bus, creating, 505–516
Echo controls window, 514
Echo plug-in, 422–425, 436–440
Echo Preset dialog, 426
Echo window, 508
editing. See also Dialogue Editor

and arranging clips in timeline, 49–56
automation curves with standard 

tools, 570–571
with Focus mode multi-tool, 167–173
nested timelines, 225–226
pan curve in timeline, 361–363
portions of clips, 34–37
with Range Selection tool, 52–55
samples to correct waveforms, 401–402
tracks, 41–42
voiceover takes in timeline, 127–136

editing music. See also music
to the beat, 208–215
in track layers, 215–223

edits, tightening, 144–148. See also 
patchwork quilt edit

Edit shortcuts, using to split and align 
clips, 132–133

Elastic Wave audio retiming
applying pitch changes to clips, 412–413
evaluating dialogue with ADR 

recording, 405–409
preparing timeline for, 403–405
speed keyframes to retime 

waveform, 409–411
Enable/Disable shortcut, 152–153
END Intro Here marker, 32

EQ (equalization). See also Clip EQ
applying to dialogue tracks, 583–595
applying to limit high and low 

frequencies, 429–430
sweetening dialogue with, 586–592

EQ carving, applying for dialogue 
clarity, 592–595

EQ controls, 371
EQ graphs

sweeping graphical controls in, 372
working with, 594

EQ Matcher, 601
EQ plug-ins, exploring, 595–601
Equalizer Type dropdown menu, 592
exporting

Dolby Atmos master file from Fairlight 
timeline, 716–718

files from timeline, 631–633
and renaming stems as multichannel 

files, 628–630
Ext City Ambience.wav audio clip, 

locating, 7

F
fader automation, recording, 567–571
Fader Level curve, 570
fader levels

adjusting, 565
automating, 559–562

faders, controlling, 505
fades. See also crossfades; post-fader 

metering; “Pre fader metering on tracks” 
option

adding, 64–65
customizing in timeline, 221–223

Fairlight Audio Guide to DaVinci Resolve 20 
Online Exam, 726

Fairlight Desktop Console, mixing with, 559
Fairlight FX plug-ins. See also processor-

intensive plug-ins
4-in-1 Modulation, 445–448
Chain FX, 595–601
combining, 385–388
Distortion, 432–435 
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Echo, 422–425, 436–440
EQ, 595–601
Gain, 595–601
repairing dialogue with, 376–388
returning to default settings, 384
Reverb, 436–440
toggling on and off, 329

Fairlight page
bouncing mixes in, 624–628
floating windows in, 578
Loudness meters, 617
working with Dolby Atmos in, 671

Fairlight Sound Library, 
downloading, xxiii–xxv

Fairlight Space View, visualizing moving 
sounds with, 660–664

Fairlight Timeline Templates.drp, 526
File Inspector, Audio Configuration 

section of, 91
filenames versus clip names, 18
files, exporting from timeline, 631–633
filters, using to reduce low 

frequencies, 372
Fixed Playhead Mode, using for scrolling 

playback, 100–101. See also playhead
Flex Bus format, 501. See also busses
FOA (First-Order Ambisonics) 

format, 646, 648
FOA Park track, 668
Focus mode multi-tool

editing with, 166–173
features of, 175
solo-scrubbing with, 170–171
working with edit selection 

range, 171–173
Foley footsteps

finishing, 306–307
recording to picture, 304–306

Foley Sampler. See also sound effects
adding sound effects to, 296–297
exploring, 295–296

mapping and splitting sounds, 300–304
modifying sample mapping, 298–300
recording footsteps to picture, 304–306

Foley Sampler instrument, saving, 308
footsteps. See Foley footsteps
frequencies. See high and low frequencies
Frequency Analyzer plug-in, 370
front-to-back extended sound, creating, 

462–464. See also sound
full screen, watching video in, 471
Futz 1 PA EXT preset, 442
Futz 2 track, 443
futzing dialogue to simulate PA system, 

428–440. See also dialogue
FX, practicing, 294. See also sound effects
FX bus, 492
FX group, 489
FX timeline, moving into master 

timeline, 517–521
FX tracks, lowering using Ducker, 552–559
FX Waves bus, automating, 571. 

See also busses

G
gain line, manipulating, 63, 72
gain plug-ins, exploring, 595–601
gating low-level noise, 373–376
GEN FX track, 288
Groundskeeper 2 track, 264
Groundskeeper track, 257
groups

activating and deactivating, 487
modifying, 489–490

Groups panel, 484

H
HarperSurf_Day1_05.wav clip, 93
Harper track, 108
head or tail, using for multi-tool snapping 

for, 174–183
Helicopter Circling clip, 652
helicopter sound, 654
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high and low frequencies, 
limiting, 429–430

high- and low-pass filters, 372
high-and low-shelf filters, 372
HOA (Higher-Order Ambisonics) 

format, 648
HOA Park track, 668
horizontal zooming, 10
Horizontal Zoom slider, 130
hum. See also De-Hummer plug-in

removing before noise, 386
working with, 378

human voices, changing to dragon 
vocals, 458–459

Hyperlight film, 197–203

I
immersive toolsets, enabling, 644–645
importing

ADR cue lists, 282–287
audio files, 5–10
Dolby Atmos master file, 696–708
podcast intro master file, 708–711

In and Out marks, scrubbing with, 59–60
In and Out points

marking, 36–37
updating, 39

Insert button, 329
Inspector

accessing plug-ins in, 380
applying pitch changes to clips 

in, 412–413
applying speed changes to clips 

in, 454–456
Audio Configuration in, 689
changing clip volume levels in, 11–13
changing source audio in, 96–98
checking file format of clips in, 684
Equalizer controls in, 370–371
making adjustments in, 328
selecting clips in, 94–95
switching to Track Inspector, 393

interface layouts, saving, 539
interface toolbar, 8, 10
INT Hollow Wood Door sound effect, 193
ITU BS.1770-1 and ITU BS.1770-4 loudness 

metering, 617
ITU-R BS.1770-4 loudness measurement 

preset, 618–620

J
J key, scrubbing with, 38–41
JKL keys

scrubbing with, 38–41
using to navigate frames, 205
using to split and align clips, 132–133
using to split clips, 109–113
using with takes in track layers, 266

jog bar playhead, 13
“Jump to” options, setting, 101–102

K
Kauai Film Academy, 87
Keyboard Customization layout, 82
keyboard shortcuts

assigning for recording, 263
Copy, 116
creating, 418–421
Cut, 116
deselecting ranges, 55
fitting clips horizontally, 124
fitting timeline clips horizontally, 10, 25
In points, 39
moving clips, 129
moving clips between tracks, 113–119
moving playhead, 38
moving tracks, 117
Out points, 39
Paste, 116
playing marked sections, 37, 39
Project Settings window, 254
Razor, 109
Ripple Cut, 128
rotating perspective, 354
Select All clips, 120
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selecting clips or tracks, 44
selecting tracks, 114
splitting clips, 131
timeline navigation, 9
Trim to Selection, 53
using in preview player, 35
using in timeline, 35
zooming out horizontally, 119
zooming timeline, 87

keyframes. See also left-right keyframe
adding and deleting, 71
using to change clip levels, 326–328

K key, scrubbing with, 38–41

L
Lawn Mower Up and Away clip, 14, 22
layered clips, nudging or dragging, 145
layers

bouncing selections to, 146–148
splitting clips in, 143–144
trimming and moving clips to, 141–144

“Learn to Surf” scene, 537
left-right keyframe, setting, 77. 

See also keyframes
lesson files, getting, xxii–xxiii
lesson timelines, locating in media pool, 

84–85, 253. See also timelines and clips
Levi track, 108
library. See Sound Library
Link Group dialog, 478–479
List View button, 18
L key, scrubbing with, 38–41
Lock button, 26
Logo Fly Out marker, 207
Loop button, 9
looped playback, 123, 372. 

See also playback
looping, explained, 267
Loop Jog, scrubbing audio at sample level 

with, 103–106
loudness. See also volume level

American standards, 543
monitoring and analyzing, 616–623

Loudness curves, 622
loudness history curves, showing in 

timeline, 620–623
loudness levels, analyzing and 

normalizing, 618–620
Loudness meters, 617, 622
low and high frequencies, 

limiting, 429–430
low frequencies, reducing, 369–373
low-level noise, gating, 373–376. 

See also noise
LUFS (loudness unit scale), 617

M
macOS setup, xv–xxii
marked sections, playing, 37, 39
marker list, sorting, 165
markers. See also duration markers

selecting, 33
working with, 31–33

Markers Index, finishing spotting 
list in, 162–167

marking
and adding music to timeline, 57–62
and editing portions of clips, 34–37
In and Out points, 36–37

“marking the clip,” 317
Mark In/Out buttons, 13, 37
Marley track, 108
master bin list, 13
media pool

checking file format of clips in, 684
previewing audio clips in, 13–18
toolbar, 13
waveforms, 13

Media Pool button, locating, 5
Metadata panel, showing, 93
metering and thumbnail waveform 

colors, 16
Meter plug-in, 322
meters

locating, 26
single-row and dual-row, 523
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Meters button, 73, 86
meters in Fairlight mixer, reading, 318
microphone, setting up, 248–249
MIDI pop-up menu, 296
mixer. See also dubbing mixer

choosing processing order in, 435–436
expanding and contracting, 494

mixer channel strips, reducing 
height of, 494

mixes
bouncing in Fairlight page, 624–628
bouncing to tracks, 448–450, 626
monitoring and analyzing loudness 

in, 616–623
sweetening, 572

mixing
with Fairlight Desktop Console, 559
simplifying using busses, 491–505

mixing and sweetening project 
preparation, 537–539

mixing consoles, 559
mixing teams, working in parallel, 476
Modify Group dialog, 490
modulation, using to transform noise, 

443–451. See also 4-in-1 Modulation 
plug-in

monitoring busses, 497–498
monitoring format, changing, 649–650
monitoring levels, setting using reference 

tracks, 540–547
Monitoring panel

hiding, 86
showing, 73

monitoring track input, 259–260
monitoring video only, 85–87
monitors, using Dual Screen  

layout with, 87. See also dual monitors
mono audio channels, switching in 

timeline, 121–125
mono tracks, combining as multichannel 

link groups, 476–483. See also tracks
mouse, 51, 124
moving sounds, visualizing, 660–664. 

See also sound

MOWER field, 20
multi-bed Dolby Atmos mix, exploring, 

722–723. See also Dolby Atmos
Multichannel Boom Only timeline, 97
Multichannel Dialogue bin, 92, 95
multichannel group, unlinking, 482–483
Multichannel Test timeline, 95
multilayered sound effects, analyzing, 

464–469. See also sound effects
multi-tool, 269
multi-tool snapping, using to head or 

tail, 174–183
music. See also editing music; podcast 

music
editing in track layers, 215–223
editing to the beat, 208–215
lowering using Ducker, 552–559
marking and adding to timeline, 57–62
trimming and facing in track 

layers, 217–218
music-based soundtrack, sound design FX 

for, 470–472
music mix, nesting and 

decomposing, 521–525
Music Remixer (Studio), working 

with, 236–244
MUSIC track, 61
music tracks, lowering using 

Ducker, 552–559
Mute button, 15, 26, 190
Mute monitoring style, 259
MX bus, 492

N
NaturesFury.mp4 media file, 684–685, 705
Natures Fury project, 683
NaturesFury.wav media file, 684, 686, 697
nested timelines. See also timelines

decomposing, 229–230
editing, 225–226
working with, 223–230, 517–525
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NF Dolby Atmos Deliverables folder, 696
noise. See also low-level noise

choosing as System Generator 
Source, 289

reducing, 381–385
transforming using modulation, 443–451

Noise Reduction plug-in, 376–388
normalization, 333–337
Normalize Audio Level, 335, 620
normalizing and analyzing loudness 

levels, 618–620
notch filters, 372
notes. See also Project Notes window

accessing, 262
finishing, 72

nudging and splitting clips, 67–69

O
offscreen dialogue effect, 422–425, 427. 

See also dialogue
Open Recent Project, 126
Option key. See keyboard shortcuts
Out points. See In and Out points

P
pan curve, editing in timeline, 361–363
panner format, switching, 650
Panning controls, 74. See also Audio Pan 

controls; spherical panner
panoramic sound field, placing audio 

in, 342–350
Pan tracker, seeing in viewer, 77
pan trackers

setting, 76
viewing, 358–364

pan tracking controls, using in 
viewer, 350–358

Paste command, 116
PA system, simulating, 428–440
patched tracks, setting, 287
patching tracks for recording, 256–260

Patch Input/Output window, 
257–258, 289, 293

patchwork quilt edit, finishing, 148–153. 
See also edits

Path Settings window, 260, 287
peak levels, indicating, 16
peak meters, 617. See also peak meters
peaks and ranges, reading for 

dialogue, 318
perspective, rotating, 354
per-track automation controls, showing in 

mixer, 561. See also tracks
PFX track, 108
Photographer marker, 165
pitch, using with human voices and 

dragon vocals, 458–459
pitch and time, using to alter 

sound, 452–459
pitch changes, applying to clips, 456–457
playback, scrolling, 100–101.  

See also looped playback
playback volume level, controlling, 15–17
Play button, 9
playhead. See also Fixed Playhead Mode

locating, 8
moving, 14
moving to beginning of clip, 38
moving to Out point, 77

playing and resizing tracks in 
timeline, 8–10

Please_2444.wav clip name, 238
plug-in controls, accessing, 380
plug-ins. See also processor-intensive 

plug-ins
4-in-1 Modulation, 445–448
Chain FX, 595–601
combining, 385–388
Distortion, 432–435 
Echo, 422–425, 436–440
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plug-ins (continued)
EQ, 595–601
Gain, 595–601
presets, 425–426
repairing dialogue with, 376–388
returning to default settings, 384
Reverb, 436–440
toggling on and off, 329

plug-in window, opening, 513
podcast intro, playing with sound 

effects, 190
podcast intro master file, 

importing, 708–711
Podcast Intro v1.drt timeline, 124
Podcast Intro v1 field, 34
podcast music, adding, 235–236. 

See also music
Pointer mode selection tool, 124
Pointer tool, 71
post-fader metering, 255. See also fades
Post Park Normal Intro project, 125–126
“Post Park Normal” Sci-Fi podcast, 2
Post Roll and Pre Roll controls, 270–271
PPN_Podcast_Intro_mix file, 638
PPN Intro Combo 1 Comp bed.wav file, 710
PPN Intro Combo w VCAs.wav 

master file, 722
PPN Intro Scripts bin, 251
PPN Podcast Intro folder, 638
“Pre fader metering on tracks” option, 255. 

See also fades
Pre Roll and Post Roll controls, 270–271
presets, naming, 427. See also customized 

presets
Presets Library, saving and applying track 

presets in, 440–443
previewing

ambience and background sound 
effects, 17

audio clips in media pool, 13–18
bounced files, 630
scenes for context, 314–316

preview transport controls, 13. See also 
transport controls in toolbar

problems with audio, finding, 368–373
processor-intensive plug-ins, dealing with, 

389–391. See also plug-ins
project notes

accessing, 262
finishing, 72

Project Notes window, 527–528. 
See also notes

projects
creating, 3–4
opening, 126

Project Settings window, opening, 254

R
rack controls, swiping n or off, 47
Raina track, 108
Range Mode button, 52–55
ranges, deselecting, 55
ranges and peaks, reading for 

dialogue, 318
Range Selection tool, selecting and editing 

with, 52–55
Range tool, 71, 75, 109–113, 122, 135, 269
Razor shortcut, 109
Record button, 9, 265
recording

ADR cues in timeline, 278–281
built-in System Generator, 287–293
fader automation, 567–571
patching tracks for, 256–260
takes in timeline, 261–263
takes in track layers, 263–267

Recordings bin, 253, 278
Record Seed Name dialog, 264
reference tracks, using to set monitoring 

levels, 540–547. See also tracks
Rehearse button, 279
relinking clips, 149
Remove Attributes dialog, 315–316
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rendering mixes in deliver page, 635–639
repairing audio. See audio repairs
re-recording mixer, 536
retiming clips, 402–413
Reverb plug-in, 436–440
Reversed track, 453
Rewind button, 9
Ripple Cut, 128
RMS (Root Mean Square) meters, 617
RUNNER_007 clip, 126
Runner comp_bounce clip, 126
Runner VO6 Layers track, 138
Runner VO6 t1 track, 137
Runner VO6 t3 track, 137
Runner voiceover, 249
Running clip, 174

S
samples

editing to correct waveforms, 401–402
resetting, 401

Save Project As, 125
saving

customized presets, 426–427
Foley Sampler instrument, 308
interface layouts, 539
settings for quick comparison, 431–432
timeline configuration in Presets 

Library, 530–531
scenes, previewing for context, 314–316
Sci-Fi podcast intro, building, 2
scream, dialogue level for, 319
screens. See monitors
scrolling playback, 100–101
scrubbing. See also solo-scrubbing with 

multi-tool
audio at sample level, 103–106
with JKL keys, 38–41
with In and Out marks, 59–60
toggling, 104

Search button, 155–156

Select All command, 120
selection range, resizing, 205
selections, bouncing to layers, 146–148
settings, saving for quick comparison, 

431–432. See also custom settings
shelf filters, 372
Shift key. See keyboard shortcuts
Show/hide bin list, 13
sibilance, sweeping for, 590
sidechain compression, auto-ducking 

busses with, 578–583
sidechain compression controls, 

test‑driving, 582–583
signal-to-noise ratio (SNR), 369
Skateboard SFX, auditioning and 

confirming, 189
slipping audio in timeline, 481–482
Slosh marker, 35
Slurp marker, 35
Smart Zoom, working with, 424.  

See also zoom controls in toolbar
snapping to head or tail of clip, 174–183
SNR (signal-to-noise ratio), 369
Solo button, 26, 150
solo-scrubbing with multi-tool, 170–171. 

See also scrubbing
song edit, finishing, 218–220
song outro, fixing, 226–227
sound. See also audio; front-to-back 

extended sound; moving sounds
altering using pitch and time, 452–459
degrading, 432–435
generating with System 

Generator, 287–293
recording, 294
thickening, 460–472

sound cues, marking with video 
scrollers, 204–208

sound designer, role of, 418
sound design FX, exploring for music-

based soundtrack, 470–472
Sound Design FX timeline, 288
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sound effects. See also Foley Sampler; FX; 
multilayered sound effects

auditioning in timeline, 186–189
canceling, 188
naming, 427

Sound Library
using sync point in, 192–197
working with, 183–190

soundtracks, mixing with AI Audio 
Assistant, 609–612

source audio, changing in Inspector, 96–98
source audio clips, 13–14
source audio waveforms, 13. 

See also waveforms
Source Channel dropdown, 90
source clip markers, navigating 

between, 35
source clip names, changing, 18
source clips, creating tracks with, 60–62
spaces, simulating, 436–440
Space View. See Fairlight Space View
Spd-100 p-12 track, 457
speech-to-text editing toolset, 

AI-based, 128
speed changes, applying to clips in 

Inspector, 454–456
spherical panner, using, 650–654. See also 

Panning controls
splitting and aligning clips, 133
splitting and nudging clips, 67–69
splitting clips, 109–113, 131, 179–183
spotting list, finishing in Markers 

Index, 162–167
SPPM (Sample Peak Program Meter) 

plug-in, 322
Spread control, 349
stacked clips in timeline, using Enable to 

audition, 152–153. See also clips
START VO marker, 33. See also voiceover 

takes
stems

creating by bouncing busses, 627–628
renaming and exporting as multichannel 

files, 628–630

stereo and 5.1 mixes, rendering in 
deliver page, 635–639

Stereo clip, 639
stereo mixes, rendering in deliver 

page, 635–639
stereo spread of tracks, 

controlling, 346–350
Stop and Go to Last Position option, 187
Stop button, 9
Streamer and Cross, changing 

colors of, 279
submix and track levels, setting, 548–551
submix busses, assigning tracks 

to, 494–497
submix track groups, creating, 490. 

See also track groups
sweeping graphical controls in EQ 

graph, 372
sweetening

dialogue with EQ, 586–592
mixes, 572

synchronization, using scrollers 
for, 197–204

syncing audio automatically, 94
sync point, using in Sound Library, 192–197
System Generator, recording, 287–293
system requirements, xiv

T
tail or head, using for multi-tool snapping 

for, 174–183
Take 1 field, 40, 42
Take 2 marker, 40
takes

aligning in separate tracks, 129–131
recording in timeline, 261–263
recording in track layers, 263–267
separating in timeline, 127–128

Taking Clothes Off clip, 297
target dialogue levels, establishing, 

319–323. See also Dialogue Leveler
templates. See timeline template
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Test Tone Settings, changing for System 
Generator, 291–293

three-button mouse, working with, 51
time and pitch, using to alter 

sound, 452–459
timecode display, locating, 8
timeline clips, disabling for multi-track 

composite, 134–136. See also clips
timeline configuration preset, applying to 

timeline, 531–532
timeline marker, adding at playhead 

position, 166
timeline ruler, locating, 8
Timeline Scrolling, setting, 100
timeline template, creating, 525–532
timeline tracks, matching with clip 

format, 23
Timeline View Options menu, 88
timelines. See also ADR timeline; lesson 

timelines; nested timelines
creating, 5–10, 95
exporting files from, 631–633
with gaps, 698
moving to start and end of, 9
resetting for balancing clip 

levels, 120–121
zooming, 87

timelines and clips. See also lesson 
timelines

1c A1 to A3 Trimmed timeline, 31
1d A1 to A6 Move timeline, 45
2a Checkerboard Edit Start timeline, 

1092b First Clips Split timeline, 113
2c Checkerboard Edit Finished, 120
2f Ref Finished Scene timeline, 84
2 Intro Combo Finished 

timeline, 149, 153
2 Intro Combo Start timeline, 150, 153
2 Intro Combo to Tighten timeline, 151
2 Multichannel Start timeline, 99
2 Runner Split Stacks timeline, 134
2 V06 Layers to Tighten backup 

timeline, 144
2 VO6 Runner Layers Start timeline, 139

2 VO6 Split 2 Tracks backup 
timeline, 133–134

3a Fusion VFX add Music timeline, 
224–225, 228

3a Intro Combo 3 FX added timeline, 178
3b Intro Combo FX added timeline, 190
3b Music Edit Start timeline, 225
3c Intro Combo FX and Pan, 236
3c Music Edit Layers add 3rd clip, 218
3d Intro Combo FX and Music v1 

timeline, 235
3f Music Edit Finished V2 timeline, 227
3h Fusion VFX add crossfades Start 

timeline, 231
3 HL Pod Sync with scrollers 

timeline, 197
3 Intro Combo FX Start timeline, 162
3 Sync Sound to Picture 

timeline, 191–192
3 TML Music Remix Scene timeline, 240
3 TML Trailer Music Start timeline, 236
4a ADR Setup timeline, 277, 308
4b Harper Surfs Scene ADR Cues, 282
4c Foley Sampler timeline, 295
4 Groundskeeper VO timeline, 251
4 Runner Voiceover, 250
4 Sound Design FX Recorded 

timeline, 294
5a Normalize Dialogue timeline, 332
5 Balance Dialogue Clips timeline, 314
5b Dialogue Balanced timeline, 336
5c Dialogue Leveler timeline, 337
5d Pan Track Start timeline, 342
5e Pan Window Start timeline, 346
5 Intro Combo to Pan timeline, 358, 360
5.1 clip, 639
5.1 mixes, rendering in deliver 

page, 635–639
6a Noise Reduction timeline, 381
6a Nosie Reduction timeline, 398
6b Combo FX to Cache, 385, 399
6c Track FX timeline, 392
6d Fix Music Cue, 399
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timelines and clips (continued)
6e ADR Elastic Wave timeline, 403
6 Quick Fixes Start timeline, 368
7 Fusion VFX MP v1 timeline, 470
7 Futz PA Start, 428
7 Offscreen Echo Start timeline, 422–425
7 Sound Design Waves Start 

timeline, 444
8a Groups Finished and Submix Busses 

timeline, 494
8b Groups and Submix Busses Finished 

timeline, 503
8c FX premix timeline, 517
8 Circles for VFX v2 full timeline, 522
8 Dad and Harper Add FX timeline, 518
8 Fusion VFX add Music Mix 

timeline, 521, 524
8 Link Group and Track Groups Finished 

timeline, 491
8 Link Group and Track Groups 

timeline, 477
8 Surf Add Aux Echo timeline, 505
8 Surf Aux Echo Finished timeline, 516
9a Ducker Start timeline, 552
9 Balance Start timeline, 548
9b FX Waves Bus Snap Start 

timeline, 560
9c Dynamics Start timeline, 573
9d Dynamics Sidechain timeline, 578
9e EQ Start timeline, 586
9f EQ Carving timeline, 592
9 Full Surf Scene References 

timeline, 541
9g New Plugins timeline, 596
9 Mix Balance and Pan Start 

timeline, 537
9 Studio Additional Tools 

timeline, 602, 605
9 Studio - AI Audio Assistant 

timeline, 609
10 Deliver Stereo and 5.1 timeline, 634
10 Full Surf Scene timeline, 616, 618, 621
10 Surf Scene to Bounce timeline, 624
10 Surf Scene to Export timeline, 630

11a Ambi Helicopter timeline, 652
11 Ambisonics Start timeline, 647
11b Park FX Example timeline, 657
11c Ambi Park FX timeline, 660
11 Circles Dolby Atmos Start 

timeline, 673
11d AMBI Park FX Bounced timeline, 667
11e Dolby Atmos Bus and Bed timeline, 

709, 712, 717
11g Dolby Atmos 4Beds and 2VCAs 

timeline, 718, 723
24 LUFS loudness standard, 543
100 Tracks 10 Busses timeline, 529–530
100-track template, creating, 532
2024-06-20 0659 clip, 17
2024-06-20 0659.wav clip, 18

timing of clips, adjusting, 69–70
TML (Too Much Life) project, 

preparing, 83, 191
TML Audio Post.dra, 83
TML Audio Post project

described, 87
getting information about, 87
opening, 83
trailer, 236

TML Audio Post project, opening, 
trailer, 87

TML Deliverables folder, 631–632
TML project, preparing, 191
TML Surf Scene preset, 426
TML Surf Scene v2 preset, 514
Toggle Automation button, 9, 242
toolbar, transport and zoom controls in, 8
tools, switching between, 269
track and submix levels, setting, 548–551
Tracker Controls, showing, 74
Track FX (Studio), repairing dialogue 

with, 392–399
track groups. See also submix track groups

creating for mixing, 488–490
working with, 483–490

track height, adjusting, 9–10, 49
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track input, monitoring, 259–260
Track Inspector, switching to, 393
track layers

editing music in, 215–223
recording takes in, 263–267
trimming and fading music in, 217–218

track name field, 26
track number, 26
track presets, saving and applying in 

Presets Library, 440–443
track presets, saving and applying in 

Presets Library, 440–443
tracks. See also audio track layers; mono 

tracks; per-track automation controls; 
reference tracks

adding, 19–20
assigning to submix busses, 494–497
coloring and reordering, 42–47
creating and editing, 41–42
creating and naming, 19–20
creating with source slips, 60–62
doubling to thicken sound, 460–472
dragging in tracks list, 46
duplicating, 443
evaluating during playback, 25–27
moving, 117
naming, 492
panning from viewer, 73–78
patching for recording, 256–260
playing and resizing in timeline, 8–10
selecting, 44, 114
sending to DX Echo bus, 515–516
showing and hiding, 47–49

track signals, sending to auxiliary 
bus, 510–513

Tracks Index
features of, 47
moving and coloring tracks in, 45–47
moving tracks in, 405

Tracks Index Name column, 721
track type, changing, 256

Track Waveform Zoom options, 99
Transcribing Audio dialog, 154–155
Transcription window, 157–158
transients, using to split clips, 179–183
transparent waveform, seeing, 130. 

See also waveforms
transport controls in toolbar, 8–9. See also 

preview transport controls
trimming

clips in timeline, 28–31
and moving clips to layers, 141–144

Trim to Selection, 53
truck doors, syncing, 196–197
True Peak, 619. See also peak meters
two-button mouse, 124

U
Undo command, 119

V
VCAs

creating in Fairlight mixer, 719–722
customizing, 721–722

vertical zooming, 10
video

auto-panning to (Studio Only), 357–358
watching in full screen, 471

video only, monitoring, 85–87
video scrollers

marking sound cues with, 204–208
using for synchronization, 197–204

video track and busses, hiding, 102–103
VO 1 Book_006 clip, 17, 38
VO 1 Book clip, 40
VO 1 track, 42
VO 4 Skateboard clip, 157
VO 6 Runner clip, 154
VO6 Runner to Edit.drt, 126
VO6 Runner to Edit timeline, 134
VO 7 Groundskeeper, Record 

Seed Name, 264
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vocal presence, finding sweet spot for, 590
VO group, 489
voiceover takes. See also START VO marker

aligning in separate tracks, 129–131
creating multi-track composite, 134–136
editing in timeline, 127
JKL and Edit shortcuts, 132–133
separating in timeline, 127–128
splitting and aligning clips, 132–133

voice profile, creating, 609
voices. See also dialogue

converting, 605–609
dialogue level for, 319

volume field, 26
volume level, adjusting, 9–13, 15–17. 

See also loudness
VR (virtual reality), 646

W
waveform colors, 16
waveforms, displaying in media pool, 13. 

See also source audio waveforms; 
transparent waveform

waveform zoom level, adjusting, 51
waves, designing and bouncing, 451
whisper, dialogue level for, 319
Windows setup, xv–xxii
Wing Flaps track, 485

Z
zoom controls in toolbar, 8. See also Smart 

Zoom
zooming out horizontally, 119, 130
zoom sliders, using, 10
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DaVinci Resolve 20 features a dedicated Fairlight audio page built  
right in! This official Blackmagic Design hands on training guide 
will teach you the art of sound editing, sweetening, recording, 
mixing and delivering. Beginning audio editors and assistants 
will find clear, workflow driven lessons, while seasoned audio 
professionals will quickly learn Fairlight’s user friendly tools for 
creating incredible soundtracks. Best of all, you never need to 
send projects out to another application because Fairlight is just  
a click away from your editing timeline!

What You’ll Learn
•	 Navigating and customizing the Fairlight page

•	 Working with the Fairlight Sound Library

•	 Creating and editing dialogue, music and sound effects tracks

•	 Recording voiceover, ADR and Foley tracks

•	 Working with audio track layers to stack, split and build a composite

•	 Balancing clips and tracks

•	 Repairing and replacing unwanted sounds like clicks, pops and hums

•	 Using Track FX to improve dialogue tracks

•	 Enhancing and sweetening tracks with native EQ and dynamics

•	 Automating track changes over time

•	 Using busses, nested timelines and track groups to simplify mixing

•	 Finishing your soundtrack, bouncing tracks and delivering a final mix

•	 Exploring the Fairlight immersive sound integration toolset.

Who This Book Is For
This book is designed for both beginners and professionals. 
Beginners will find clear lessons to get up and running quickly.  
If you’re a professional switching from another system, you’ll find 
lessons that cover everything from recording and editing tracks 
to mixing and finishing. You’ll also find dozens of pro tips and 
tricks that will help you work smarter and faster!

Professional Recording and ADR Tools

Powerful AI Based Dialogue Repair

Full Digital Audio Workstation 

 The Fairlight Audio Guide to

Immersive Audio Integration
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